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About this User Manual

This User Manual describes how to manually perform upgrade procedures for the 
800xA Base System and Functional Area software. 

All 800xA Base System and Functional Area software described in this User 
Manual will be upgraded from latest revisions of System Version 5.0 Service Pack 2 
or System Version 4.1 to the latest release of System Version 5.1.

Unless otherwise noted, the version of all 800xA Base System and Functional Area 
software described in this instruction is the latest release of 800xA 5.1. The 
procedures described require Windows Administrator privileges.

This User Manual does not include information on site planning, engineering 
planning, software configuration, network design, security measures, tools, 
maintenance, etc. that can be found in other 800xA User Manuals. 

Version Described in this Document
All information and procedures described in this document are specific to the latest 
release of 800xA 5.1 that includes latest revisions and Feature Packs.

Any security measures described in this document, for example, for user access, 
password security, network security, firewalls, virus protection, etc., represent 
possible steps that a user of an 800xA System may want to consider based on a 
risk assessment for a particular application and installation. This risk assessment, 
as well as the proper implementation, configuration, installation, operation, 
administration, and maintenance of all relevant security related equipment, 
software, and procedures, are the responsibility of the user of the 800xA System.



User Manual Conventions   About this User Manual

24 3BSE036342-511 G

 

User Manual Conventions
Microsoft Windows conventions are normally used for the standard presentation of 
material when entering text, key sequences, prompts, messages, menu items, screen 
elements, etc.

Feature Packs

Feature Packs are intended to release new features and functions in between system 
version releases. Feature Packs are intended as "add-ons" to an already available 
system version. Feature Packs allow a more agile response to market requirements 
without revising or releasing a system version.

Feature Packs are available to holders of a Sentinel agreement. The expiry date of 
the sentinel agreement is checked at installation time, and the license system will 
continue to remind the user until a license file with a valid Sentinel expiry date is 
installed.

Users are not forced to adopt the Feature Pack. A new installation can choose to 
install the main version only, or to also add the Feature Pack. An existing 
installation can choose to stay on the main version, or to install the Feature Pack at 
any time.

A Feature Pack is compatible with one particular system version, including revision 
level. Feature Packs follow the life cycle of its main system version (transitions to 
Classic and Limited will follow the system version the Feature Pack is compatible 
with).

Feature Packs are accumulative. If additional features become available after the 
initial Feature Pack release, the Feature Pack is updated (a new version of it). This 
means there is only one Feature Pack available per system version. 

A Feature Pack is one package. Users cannot "pick and choose" among features. 
Separate features can however be released. Those will be purchased through a price 
list, and will be possible to install independent from other features and Feature 
Packs. 

Revisions contain error corrections only. A user can choose to update to the current 
revision and keep the installation at that level. This means users will get the recently 
found problems corrected, and the functionality of the system will remain like it was 
at the point in time when the original installation was made. This improves the 
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stability of the actual installation, and the user does not have to adopt any new 
functions, updated user interfaces or anything else that differs from before the 
revision was installed.

The Feature Pack installation kits will in many cases contain also the revision (this 
is the case for Feature Pack 1 on 800xA 5.1), which means that when checking the 
installation after it is done there is usually only one entry in addition to the base 
installation. For some functional areas in 800xA, where the whole installation of it 
is replaced when an update is made, there is only one entry visible for the whole 
functional area. An installation that has the Feature Pack installed at some point in 
time needs to follow that track (the Feature Pack cannot be uninstalled).

Revisions to features released in Feature Packs will be part of upcoming Feature 
Packs, or possibly pure Feature Pack revisions when there are no longer new 
features added to the system version (this is when the system version is in classic 
life cycle). In practice this means that users have to install consecutive Feature 
Packs in order to have revisions to previously released feature.

The Feature Pack content (including text, tables, and figures) included in this 
User Manual is distinguished from the existing content using the following 
two separators:

Feature Pack Functionality______________________________________________________________________

<Feature Pack Content>

___________________________________________________________________________________________

Feature Pack functionality included in an existing table is indicated using a 
table footnote (*):
*Feature Pack Functionality

Unless noted, all other information in this User Manual applies to 800xA Systems 
with or without a Feature Pack installed.

Warning, Caution, Information, and Tip Icons

This publication includes Warning, Caution, and Information where appropriate 
to point out safety related or other important information. It also includes Tip to 
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point out useful hints to the reader. The corresponding symbols should be 
interpreted as follows:

Although Warning hazards are related to personal injury, and Caution hazards are 
associated with equipment or property damage, it should be understood that 
operation of damaged equipment could, under certain operational conditions, result 
in degraded process performance leading to personal injury or death. Therefore, 
fully comply with all Warning and Caution notices.

Terminology
A complete and comprehensive list of Terms is included in System 800xA System 
Guide Functional Description (3BSE038018*). The listing includes terms and 
definitions that apply to the 800xA System where the usage is different from 
commonly accepted industry standard definitions and definitions given in standard 

Electrical warning icon indicates the presence of a hazard which could result in 
electrical shock.

Warning icon indicates the presence of a hazard which could result in personal 
injury.

Caution icon indicates important information or warning related to the concept 
discussed in the text. It might indicate the presence of a hazard which could 
result in corruption of software or damage to equipment/property.

Information icon alerts the reader to pertinent facts and conditions.

Tip icon indicates advice on, for example, how to design your project or how to 
use a certain function
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dictionaries such as Webster’s Dictionary of Computer Terms. Terms that uniquely 
apply to this instruction are listed in the following table.

Related Documentation
A complete list of all documents applicable to the 800xA System is provided in 
System 800xA Released User Documents, 3BUA000263*. This document lists 
applicable Release Notes and User Instructions. It is provided in PDF format and is 
included on the Release Notes/Documentation media provided with the system. 
Released User Documents are updated with each release and a new file is provided 
that contains all user documents applicable for that release with their applicable 
document number. Whenever a reference to a specific instruction is made, the 
instruction number is included in the reference.

Term/Acronym Description

Backup 800xA Backup: Backup using the 800xA Backup Definition aspect.

Functional Area Backup: Backup via defined tools or copy of Functional Area 
configuration and/or data to a safe media for items not covered by 800xA 
Backup.

The specific operations called out for the Functional Area within the 
Backup/Restore procedure in System 800xA Maintenance (3BSE046784*) for 
same version to same version backup and restore.

Restore 800xA Restore: Restore via Configuration Wizard.

Functional Area Restore: Restore via defined tools or copy of Functional Area 
configuration and/or data from a safe media for items not covered by 800xA 
Backup.

The specific operations called out for the Functional Area within the 
Backup/Restore procedure in System 800xA Maintenance (3BSE046784*) for 
same version to same version backup and restore.

Upgrade Moving from one 800xA release to a later 800xA release, whether it be a major 
or minor release. 

Update Adding service packs, patches, hot fixes, or rollups to an existing 800xA System.
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Section 1  Introduction

This instruction describes how to upgrade to ABB Industrial IT 800xA 5.1. It covers 
the following scenarios:

• Upgrading Redundant Domain Controllers.
• Upgrading 800xA 5.0 SP2 to 800xA 5.1 Online.
• Upgrading 800xA 5.0 SP2 to 800xA 5.1 Offline.
• Upgrading 800xA 4.1 to 800xA 5.1 Offline.
• Upgrading 800xA 3.1 SP3 to 800xA 5.0 SP2.

This document reflects 800xA System and Functional Area software at the time 
of release. All 800xA System and Functional Area Release Notes must be read 
and understood before performing any automated or manual installation, post 
installation, or upgrade procedures. The Release Notes contain any last minute 
changes that must be performed when installing or upgrading the 800xA System. 
All Release Notes can be found on the CD labeled System Version 5.1 Released 
Documents.

If virus checking software is installed on a node, disable it until after the 800xA 
System is installed and configured (post installation).
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Supported Upgrade/Update Paths

The supported upgrade/update paths of System 800xA 5.1 Feature Pack 4 Revision 
E are described in the Section: Upgrade Matrix in the System 800xA Software 
Product Life Cycle Plan (3BSE049081).

Upgrading directly from 800xA 5.0 or 800xA 5.0 SP1a to 800xA 5.1 Feature 
Packs is not supported. If running this version, it is necessary to upgrade to the 
latest revision of 800xA 5.0 SP2 and then to latest revision of 800xA 5.1 before 
upgrading to latest 800xA 5.1 Feature Pack.

Upgrading directly from 800xA 4.0 to 800xA 5.1 is not supported. If running this 
version, it is necessary to upgrade to the latest revision of 800xA 4.1 before 
upgrading to 800xA 5.1.

Upgrading directly from 800xA 3.1 SP3 to 800xA 5.1 is a two-step process. It is 
necessary to upgrade to 800xA 5.0 SP 2 before upgrading to 800xA 5.1. Perform 
the procedures in Section 6, Upgrading 800xA 3.1 SP3 to 800xA 5.0 SP2 and 
then in Section 3, Upgrading 800xA 5.0 SP2 to 800xA 5.1 Online or Section 4, 
Upgrading 800xA 5.0 SP2 to 800xA 5.1 Offline.

Refer to System 800xA Upgrade (3BSE036342*) for information on upgrading a 
SB 2.1/2 800xA System.

800xA for DCI was not included with the initial release of 800xA 5.1 and thus 
800xA for DCI upgrade instructions are not documented in this user manual. 
Refer to 800xA for DCI 5.1 Installation (3BUA001686*) user manual for upgrade 
of 800xA for DCI 5.1.

If it is upgrade from 800xA 5.0 SP2 revisions (32-bit) to 800xA 5.1 revisions (64-
bit), upgrade.ini file is used to plan the system. Perform the procedures in 
Section 3, Upgrading 800xA 5.0 SP2 to 800xA 5.1 Online or Section 4, 
Upgrading 800xA 5.0 SP2 to 800xA 5.1 Offline.

If it is upgrade from 800xA 5.1 Revisions or Feature Packs (32-bit) to 800xA 5.1 
Revisions or Feature Packs (64-bit), then the System Planner of 64-bit must be 
used to re-plan the system. For more information on planning the system, refer to 
System 800xA System Planning (3BSE041389*).
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Graphics
800xA 5.1 supports Process Graphics 2 as a default with optional VB Graphics 
extensions that can be installed and loaded when upgrading. 800xA 5.0 SP2 
supported VB Graphics as the default with Process Graphics 2 extensions that could 
be installed and loaded. 800xA SV 5.0 SP1 and earlier supported VB Graphics as 
the default with no option for Process Graphics 2.

Customers upgrading from previous 800xA versions can still view and modify their 
VB Graphics, but they must install their previously licensed version of Visual 
BASIC 6.0 with SP6 in order to do so. They must also install and load the VB 
Graphics extensions. 

New 800xA 5.1 customers should not install the VB Graphics extensions as they 
will only have the VB runtime and will not be able to create and/or modify VB 
graphics.

Reference Instructions
The following instructions are used in conjunction with this one. These instructions 
are needed to perform the required installation, post installation, and backup/restore 
procedures.

• If performing the upgrade manually:

– System 800xA Manual Installation (3BSE034678*).

– System 800xA Post Installation (3BUA000156*).

– System 800xA Maintenance (3BSE046784*).

• If performing the upgrade using System Installer:

– System 800xA Automated Installation (3BSE034679*).

Online Upgrade
Online Upgrade makes it possible to upgrade an existing 800xA System (latest 
revision of 800xA 5.0 SP2 or later) without a process shutdown. Plant operations are 
not disturbed while upgrading server and client software, including OCS 
connectivity services, and AC 800M Controllers (processor units and 
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communication interfaces (CI)). The 800xA System being upgraded must have 
redundant Aspect and Connectivity Servers, and redundant AC 800M Controllers 
consisting of two redundant processing units connected to I/O modules either 
directly to the modulebus or via various CI modules.

Online Upgrade Controller Level allows AC 800M controllers to be upgraded with 
new firmware versions online. Online upgrade is initiated from Control Builder by a 
nine-step wizard. 

• The nodes are upgraded in the following order:

– Domain Controller. 

– One redundant Aspect Server.

– One redundant 800xA for Harmony Configuration Server for each 
redundant 800xA for Harmony Configuration Server configuration.

– 800xA for AC 870P/Melody Configuration Server.

– One redundant Connectivity Server for each redundant Connectivity 
Server configuration.

– Third Aspect Server (if 2oo3 redundancy).

– Some clients.

– IM Server.

– All other Application Servers (Batch, Asset Optimization, PC, Network 
and Software Monitoring, etc.).

– All other nodes except Primary Aspect Server.

– Primary Aspect Server.

This procedure is only applicable to the latest revision of 800xA 5.0 SP2 to 
800xA 5.1 upgrade path with redundant Aspect and Connectivity Servers. Refer 
to Section 3, Upgrading 800xA 5.0 SP2 to 800xA 5.1 Online for more 
information.

The OCS connectivity services are possible to upgrade online; however, the OCS 
system itself is upgraded following the rules defined for the OCS system being 
used.
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– The client and server level is upgraded and the plant is fully operable, 
although the controllers are not upgraded. The controller level is upgraded 
as follows:  

– Some redundant Controller pairs (and CEX units if needed).

– Remaining redundant Controller pairs (if desired).

– Nonredundant controllers (no CEX units). Upgrading nonredundant 
controllers will require minimal plant downtime.

Supported Operating Systems
System 800xA 5.1 version runs on 64-bit (x64) and 32-bit (x86) operating systems. 
The initial System 800xA 5.1 version was 32-bit and Revision A had separate media 
boxes for 64- and 32-bit operating systems. The later revisions and feature packs are 
in a single media supporting both options. New installations should be installed on 
64-bit operating systems. However, if desired older hardware and available 
operating system licenses can be used, it is possible to install the 800xA software on 
a 32-bit operating system.

It is possible to install mixed 64- and 32-bit systems. The most common use case is 
when a client is added or exchanged. Here it is possible to use a 64-bit node with 64-
bit operating system, even if the rest of the system is running on 32-bit. Exchanging 
a Connectivity Server or even an Aspect Server to a node running on a 64-bit 
operating system is possible under certain circumstances. It is recommended to 
discuss this with Product Management. Swapping nodes to a 32-bit operating 
system on a system generally running on a 64-bit operating system is not considered 
as a relevant use case and should not be done.

The supported operating systems, service packs, and hot fixes are listed in System 
800xA 5.1, 5.0, 4.x, 3.1 Third Party Software (3BUA000500). This document can be 
found in ABB SolutionsBank. 

This instruction does not contain procedures for upgrading the AC 800M 
controller level. Refer to Appendix C, Online Upgrade Controller Level for a 
general description.

Server Operating System and Workstation Operating System will be used 
throughout the remainder of this document.
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The same capabilities and performance as the previously released 32-bit version 
apply also to the 64-bit version.

The US English version of the operating system is required even if a translation 
NLS package for System 800xA is used.

Upgrades from previous versions that are still supported (Version 4.1, 5.0 SP2) to 
the new 64-bit version is supported, including on-line upgrade for 5.0.

The following conditions affect the decision on which operating system to use:

• Certain 800xA Server types can run on the Workstation Operating System as 
well as on the Server Operating System. The Server Operating System must be 
used for the following applications:

– Domain Server.

– Aspect Server when it runs the Domain Controller and Domain Name 
System (DNS).

– Batch Server (except in a Single Node Engineering System).

– Information Management Server.

– Servers that run Asset Optimization (except in a Single Node Engineering 
System).

– 800xA for Harmony Connectivity Server, Configuration Server, and 
Configuration Server with Connectivity Server.

– 800xA for AC 870P/Melody Connectivity Server and Configuration 
Server.

– 800xA for MOD 300 Connectivity Server.

• Systems using the Workstation Operating System for the Aspect Server nodes 
are limited to nine PC nodes, not counting Domain Server nodes. Systems 
using the Workstation Operating System for any other server nodes, other than 
the Aspect Server nodes, are limited to 11 PC nodes, not counting the Domain 
Server nodes. These limitations depend on Microsoft licensing rules for the 
Workstation Operating System and Internet Information Services (IIS).

The IM Server can only be installed on a Single Node Engineering System if the 
Operating System is the Server Operating System.
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• The Workstation Operating System may be used in most other instances, 
although some performance benefits may be gained by using the Server 
Operating System. If the Server Operating System is not required, then the 
Workstation Operating System is generally recommended.

• The Windows operating system may be purchased from any Microsoft reseller.

• Preconfigured servers/clients that come from the server/client manufacturer 
must be preconfigured by the server/client manufacturer to meet 800xA System 
specifications. If they are not, they must be reconfigured by the user to meet 
800xA System specifications.

• Existing nodes that are not running the Workstation Operating System or the 
Server Operating System must be reformatted and the compatible Operating 
System must be installed.

• Click Advanced when installing the Workstation Operating System or the 
Server Operating System. This is required to delete the existing partition and 
recreate a new one. Failure to perform this step will leave old data on the hard 
drive.

Planning for the Upgrade
Planning for the upgrade can save time and resources. The upgrade paths in this 
instruction are presented in sequential order; however, depending on the plant 
performing the upgrade, some of the actions can be performed in advance or in 
parallel. For example, the upgrade flows are written to reflect upgrading and using 
existing servers and clients. If new servers and clients are being used, prepare those 
before beginning the upgrade (load and configure the Windows Operating System, 
third party software, etc.), or while performing the pre-upgrade procedures.

For optimal software prerequisites, refer to Third Party Software System 800xA 
(3BUA000500*). The prerequisites depend on the functions installed in the system, 
or on each node type. This document is accessible from ABB SolutionsBank.

For an upgrade, performance will be determined by the actual hardware of the 
system. System performance after the upgrade is completed will be determined by 
the hardware being upgraded. Memory size and processor speed have a direct 
impact on system performance. Refer to System 800xA Verified Third Party 
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Products (3BSE046579*) for a list of hardware verified for use with the 800xA 
System. This document is accessible from ABB SolutionsBank.

1. 800xA Licensing: Order the licenses required for the current system version 
and revision. Licenses from previous versions will not work.

2. AC 800M Licensing: The licensing model for the AC 800M Control Software 
Integration has changed beginning with 800xA 5.1. Licensing is now scaled on 
installed controller capacity instead of licensing on connected signals and 
devices to the controllers (CLPs). 
Each installed controller or redundant pair in the plant requires a separate 
Control Software license. Each controller type has its own license, where the 
price of it depends on the capacity of the controller. Existing CLP-based 
licenses must be converted to new licenses based on the installed controller 
capacity. 
ABB requires data from the existing system in order to perform the conversion. 
The data is collected by running the License Report Tool in the existing system.

a. Copy LicenseReport.exe from the following directory on 800xA 
System Installation DVD 1 to a directory on any node in the old system. 
Engineering & Development\Control Builder 
M\Tools\LicenseReport

b. Verify the system is running. 

c. Double-click LicenseReport.exe. 

d. A file named LicenseReport.bin is created a few seconds later in the 
newly created directory. 

e. The file contains signature data unique for the actual system, and is in an 
encrypted format. Provide this file while requesting an upgrade to the new 
800xA 5.1 licenses.

3. If new servers and clients are being used, prepare those before beginning the 
upgrade (load and configure the Windows Operating System, third party 
software, etc.). 

The LicenseReport.exe file can alternatively be downloaded from ABB 
SolutionsBank (document identity 3BSE062832).



Section 1  Introduction Planning for the Upgrade

3BSE036342-511 G 37

 

4. Consider other issues that are important prior to starting the upgrade, such 
as:

Concurrent access to the current 800xA System version and the 800xA 5.1 
system is recommended until the upgrade has been performed. This makes it 
possible to easily retrieve any data or files that have been missed. Concurrent 
access depends upon many different factors, including:

– Configuration of the existing system.
– Desired configuration of the 800xA 5.1 system.
– Server and client use strategy.
– Configuration of user and user groups.
– Use of service accounts.
– Domain controllers.
– Redundancy.
– Logical and physical networks.

One strategy is to leave a minimal part of the existing system intact, such as an 
Aspect Server, while preparing a major part of the 800xA 5.1 System. Another 
strategy is to prepare a minimal 800xA 5.1 System.

Retaining an Aspect Server from the existing system minimizes the time it 
takes to retrieve data or files from it. A disk drive image provides a quick way 
to recover, but often it requires no hardware upgrade. Try to delay the upgrade 
of the hardware in one Aspect Server as long as possible.

If it is not necessary to do the complete upgrade in one process, it may be 
possible to perform the upgrade in steps by stopping selected system functions 
or by stopping some parts of the plant, or a combination of the two. 

5. Prepare the Device Library (select the set of devices used at the customer site 
and prepare the files on a transportable media, ready to install). The latest files 
at the time of the 800xA 5.1 are available on DVD2, DVD3, and DVD4. Check 
for newer version of Device Libraries in ABB SolutionsBank.

6. Refer to System Installer on page 38 and determine whether or not System 
Installer can be used to perform the upgrade.

The following considerations may vary depending on the system version being 
upgraded and if the upgrade will be performed online or offline.
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System Installer
Upgrades from the latest revisions of 800xA 5.0 SP2 to 800xA 5.1 and from 
800xA 4.1 to 800xA 5.1 can be executed either semi-automatically using the 
System Installer as described in System 800xA Automated Installation 
(3BSE034679*), or manually as described in this instruction.

The System Installer is more efficient since it performs many of the time-consuming 
and difficult tasks, and verifies that the software is installed in the correct order, the 
desired configurations are supported, etc.

System Configuration Console
Some procedures described in this instruction use the 800xA System Configuration 
Wizard. A new feature, the System Configuration Console, can also be used to 
perform many of these procedures. Refer to System 800xA Tools (2PAA101088*) for 
information and instructions on using the System Configuration Console.

System Language Package
The 800xA System includes support for US English only. Translations of the 
operator interface (System 800xA Language Packages) are released separately after 
the main release of the 800xA System. Upgrade of a system including a Language 
Package requires an upgrade of the Language Package when it is released.

Refer to the Language Package release notes for information on upgrading a 
Language Package to 800xA 5.1. 

Precautions
There are third party backup/restore and disk imaging utilities that are useful when 
software or data becomes corrupted to the point that the node will no longer 
function correctly. A limited number of hardware failures can also be compensated 
for by using these utilities. However, it is important to understand the limitations 
and ramifications associated with these utilities. In some cases (such as corrupted 
data, corrupted software, or hard disk failures) these utilities can be useful while in 
other cases (such as replacing a node) these utilities may be of limited use.
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It is recommended that a third party backup/restore and/or disk imaging utility be 
used to save (and restore if necessary) an image of node hard disks after installation 
of third party software and/or after installing all software.

The 800xA System import/export utility can be used to save 800xA System 
information one portion at a time. However, the 800xA System backup utility is the 
functional equivalent of exporting all 800xA System information at one time. The 
critical difference between these utilities is that individually exported portions of 
800xA System information can be imported back into the original system or into a 
completely different system while backed up 800xA System information can only 
be used to restore a specific system on specific nodes. The 800xA System allows for 
scheduled 800xA System backups. Refer to System 800xA Maintenance 
(3BSE046784*) for information on performing precautionary scheduled 800xA 
System backups.

Windows Hardening
Use the stand-alone Windows Config Tool, which is part of the System Installer 
package, to perform automated Windows hardening for the 800xA System. Refer to 
System 800xA Post Installation (3BUA000156*) for more information.

Firmware Memory Consumption
When upgrading, consideration should be given to memory usage in the controller. 
The firmware size has grown slightly, resulting in slightly less free memory for user 
applications. However, this is offset by improvements in application and library 
handling, and for most projects, the net difference in memory usage is insignificant. 

If PM851, PM856, or PM860 controllers with a small amount of free memory in are 
being used, refer to the instructions in System 800xA System Guide Technical Data 
and Configuration (3BSE041434*) for information on memory requirements.
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Section 2  Upgrading Redundant Domain
Controllers

This section covers the following:

• Upgrading redundant Domain Controllers from Windows Server 2003 to 
Windows Server 2008. 

• Replacing server hardware without losing contact with the Active Directory 
(AD) and Domain Name Service (DNS).

Prerequisites
The following is required before starting the Domain Controller upgrade procedure:

• Windows Server 2003 support tools must be installed.

• Must be logged on to the schema master as a member of the Enterprise 
Admins, Schema Admins, and Domain Admins groups in the forest root 
domain.

• Ensure that Windows 2003 Server or later is installed on all Domain 
Controllers in the forest.

• ADPREP/forestprep must be run on the schema master.

• Ensure that replication is working throughout the entire forest. Ensure that all 
Domain Controllers are up and running and that the schema master has been up 
long enough for a complete replication cycle to occur for the Schema partition. 

There may be some 800xA software on nodes (such as 800xA RNRP on the 
Domain Controller node) that does not include Process Portal software. The 
operating system and 800xA software on these nodes also requires upgrading.
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Upgrading Combined Domain Controllers/Aspect Servers 
The upgrade order described in this section must be changed when upgrading 
800xA Systems with combined Domain Controllers/Aspect Servers. Rather than 
upgrading both Domain Controllers before everything else in the 800xA System, the 
first Domain Controller must stay a part of the 800xA 5.0 SP2 System until the end 
of the upgrade where it will be upgraded with the 800xA 5.0 SP2 Primary Aspect 
Server.

Preparation
Prepare for the upgrade by ensuring that the following are available:

• Windows Server 2008 Installation DVD media.

• New server hardware installed with Windows Server 2008.

• System 800xA Manual Installation (3BSE034678*) for Domain Controller 
installation procedures.

• IP addresses planned for the new servers.

• Domain name must adhere to Windows conventions for Windows Server 2008 
Domain Controllers.

• Firewall disabled on the Windows Server 2003 Domain Controllers as well as 
on the new servers.

• Backups/disk images taken on both Windows Server 2003 Domain Controllers.

• Both Windows Server 2003 Domain Controllers up and running.

Preparing the Active Directory to Accept Windows Server 2008

Perform the following to prepare the existing Windows Server 2003 AD for 
accepting Windows Server 2008 before running dcpromo on the secondary Domain 
Controller.

• This procedure must be performed on the Domain Controller that holds the 
schema master role.

• Administrative credentials: An account that is a member of all of the following 
groups is required to perform this procedure:



Section 2  Upgrading Redundant Domain Controllers Preparing the Active Directory to Accept 

3BSE036342-511 G 43

 

– Enterprise Admins.
– Schema Admins.
– Domain Admins for the domain that contains the schema master.

1. Log on to the schema master as a member of the Enterprise Admins, Schema 
Admins, and Domain Admins groups in the forest root domain.

2. Insert the Windows Server 2008 DVD into the CD or DVD drive.

If Windows Server 2008 R2 DVD is inserted the following message is 
displayed (Figure 1), ignore this message by clicking OK and continue with the 
following steps.

a. Select:

Start > All Programs > Accessories

b. Right-click Command Prompt.

c. Select Run as Administrator.

d. Select The following user in the dialog box that appears.

e. Enter the administrator user name and password and click OK.

f. Type the following command, and then press ENTER:

CD or DVD drive letter:\support\adprep\adprep32

/forestprep

g. A warning will appear stating that Window 2000 Server SP4 or later must 
be running. Type C and press ENTER. 

Run netdom query fsmo on any Domain Controller to ensure which Domain 
Controller hosts the schema master role. Make a record of who has the different 
roles.

Figure 1. Windows Setup Error Message
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3. Allow the operation to complete (this can take several minutes to several 
hours).

4. Allow the changes to replicate throughout the forest before preparing any 
domains for a Windows Server 2008 Domain Controller.Wait 15 to 30 minutes, 
and then check the Windows Event Viewer for any related error or warning 
messages.

Preparing a Domain for Windows Server 2008

Perform the following to identify the domain infrastructure operations master (also 
known as flexible single master operations or FSMO) role holder.

• This procedure must be performed on the Domain Controller that holds the 
schema master role.

• Administrative credentials: An account that is a member of the Domain 
Admins group is required to perform this procedure. Membership in the 
Enterprise Admins group is not sufficient to perform this procedure.

1. Login as a member of the Domain Admins group to the Domain Controller 
node that holds the schema master role.

2. Step f can only be run with the Domain Controller in Native Mode. Select:

Start > All Programs > Administrative Tools > Active Directory 
Domains and Trusts

Right-click the domain name and select Raise Domain Functional 
Level... from the menu

3. Select Windows Server 2003 in the Select an available domain functional 
level drop-down list box.

4. Click OK.

5. Insert the Windows Server 2008 DVD into the CD or DVD drive.

If Windows Server 2008 R2 DVD is inserted the following message is 
displayed (Figure 1), ignore this message by clicking OK and continue with the 
following steps.

a. Select:
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Start > All Programs > Accessories

b. Right-click Command Prompt.

c. Select Run as Administrator.

d. Select The following user in the dialog box that appears.

e. Enter the administrator user name and password and click OK.

f. Type the following command, and then press ENTER:

CD or DVD Drive letter:\support\adprep\adprep32 /domainprep 
/gpprep

6. Allow the operation to complete (this can take several minutes).

7. Allow the changes to replicate throughout the forest before installing a 
Windows Server 2008 Domain Controller.

Preparing a Forest for a Read-Only Domain Controller

Perform the following to prepare a forest for a Read-Only Domain Controller 
(RODC).

1. Login to any Domain Controller in the forest as a member of the Enterprise 
Admins group.

2. Insert the Windows Server 2008 DVD into the CD or DVD drive.

If Windows Server 2008 R2 DVD is inserted the following message is 
displayed (Figure 1), ignore this message by clicking OK and continue with the 
following steps.

a. Select:

Start > All Programs > Accessories

b. Right-click Command Prompt.

c. Select Run as Administrator.

d. Type the following command, and then press ENTER:

CD or DVD Drive letter:\support\adprep\adprep32 /rodcprep

3. Allow the operation to complete.
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4. Allow the changes to replicate throughout the forest before removing the 
redundant Domain Controller.

Removing the Redundant Domain Controller
A redundant Windows Server 2003 Domain Controller can be removed using the 
Windows interface.

Perform the following to remove the redundant Windows Server 2003 Domain 
Controller by using the Windows interface.

• This procedure must be performed on the redundant Windows Server 2003 
Domain Controller.

• Administrative credentials: An account that is a member of following group is 
required to perform this procedure:

– Domain Admins.

1. Verify that both Domain Controllers are global catalog servers.

a. Start AD Sites and Services.

b. Navigate to NTDS Settings of one Domain Controller in the left pane.

c. Right-click NTDS Settings and select Properties from the context 
menu to open the NTDS Settings Properties dialog box.

d. Verify that the Global Catalog check box is selected under the General 
tab.

e. Repeat for the other Domain Controller.

2. If the Domain Controller is a global catalog server, a message box appears 
warning about the effect of removing a global catalog server from the 
environment. Click OK to continue.

3. Select:

Start > Run

4. Enter dcpromo in the Run dialog box and click OK.

5. Click Next in the Welcome to the Active Directory Installation Wizard dialog 
box.
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6. Make no selection in the This server is the last domain controller in the 
domain dialog box and click Next.

7. Type and confirm a secure password for the local Administrator account in the 
Administrator Password dialog box and click Next.

8. Click Next in the Summary dialog box.

9. Click Finish in the Completing the Active Directory Installation Wizard dialog 
box.

10. Click Restart Now in the Active Directory Installation Wizard dialog box.

11. Remove the server from the domain.

12. Select:

Start > All Programs > Administrative Tools > DNS

13. Remove the DNS Role.

a. Click Add or remove a role in the Manage Your Server Wizard.

b. Read and follow the steps in the Preliminary Steps dialog box and click 
Next.

c. Select DNS server in the Server Role dialog box and click Next.

d. Select the Remove the DNS server role check box in the Role Removal 
Confirmation dialog box and click Next.

e. Click Finish in the DNS Server Role Removed dialog box.

14. Move to the remaining Windows Server 2003 Domain Controller node, select:

Start > All Programs > Administrative Tools

a. Verify that the redundant Domain Controller node has been removed from 
Active Directory Users and Computers. If it has not, remove it manually.

b. Verify that the redundant Domain Controller node has been removed from 
Active Directory Sites and Services. If it has not, remove it manually.

c. Verify that the redundant Domain Controller node has been removed from 
DNS. If it has not, clean all the traces in the Name Server Tab for both 
Forward Lookup and Reverse Lookup Zones.
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Installing an Additional Windows Server 2008 Domain 
Controller

Perform the following to install an additional Windows Server 2008 Domain 
Controller in an existing domain using the Windows interface.

• This procedure must be performed on the additional Windows Server 2008 
Domain Controller.

• Login as a local administrator.

• Administrative credentials: Check that there is an account available that is a 
member of Domain Admins in the domain in which the additional Domain 
Controller is being installed. It is required to perform Step 14 of this procedure:

1. Open Windows Control Panel.

2. Double-click Administrative Tools.

3. Double-click Server Manager to launch the Server Manager.

4. Click Add Roles in the Roles Summary.

5. Review the information in the Before You Begin dialog box and click Next.

6. Click the Active Directory Domain Services check box in the Select Server 
Roles dialog box. Select Add Required Features on the popup that is 
displayed and click Next.

7. Review the information in the Active Directory Domain Services dialog box 
and click Next.

8. Click Install in the Confirm Installation Selections dialog box.

9. In the Installation Results dialog box click Close this Wizard and launch the 
Active Directory Domain Services Installation Wizard (dcpromo.exe).

10. Click Next in the Welcome to the Active Directory Domain Services 
Installation Wizard dialog box.

11. Review the warning about the default security settings for Windows Server 
2008 Domain Controllers in the operating system Compatibility dialog box and 
click Next.

Ensure that all networks are disabled except networks that are used for the 800xA 
System (Plant Network and/or Control Network).
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12. Click Existing Forest and Add a Domain Controller to an Existing Domain 
in the Choose a Deployment Configuration dialog box and click Next.

13. Type the name of any existing domain in the forest where it is planned to install 
the additional Domain Controller in the Network Credentials dialog box.

14. Click My Current Logged On Credentials or Alternate Credentials under 
Specify the Account Credentials to use to Perform the Installation and click 
Set.

15. Provide the user name and password for an account that can install the 
additional Domain Controller in the Windows Security dialog box.

16. Click Next when the credentials are provided.

17. Select the domain of the additional Domain Controller in the Select a Domain 
dialog box and click Next.

18. Select a site from the list or select the option to install the Domain Controller in 
the site that corresponds to its IP address in the Select a Site dialog box and 
click Next.

19. Make the following selections in the Additional Domain Controller Options 
dialog box and click Next.

– DNS Server: This option is selected by default so that the Domain 
Controller can function as a Domain Name System (DNS) server. 

– Global Catalog: This option is selected by default. It adds the global 
catalog, read-only directory partitions to the Domain Controller, and 
enables global catalog search functionality.

The installer must be a member of the Domain Admins group to install an 
additional Domain Controller.

If Read-only Domain Controller is not installed a message appears: You will 
not be able to install a read-only domain controller in this 
domain because “adprep /rodcprep” was not yet run. Do you 
want to continue? Click Yes to proceed.



Installing an Additional Windows Server 2008 Domain Controller Section 2  Upgrading Redundant 

50 3BSE036342-511 G

 

– Read-only Domain Controller: This option is not selected by default and 
is not possible to select.

20. Type or browse to the volume and folder locations for the following in the 
Location for Database, Log Files, and SYSVOL dialog box and click Next.

– Database file.
– Directory service log files.
– System volume (SYSVOL) files.

21. Type and confirm the restore mode password in the Directory Services Restore 
Mode Administrator Password dialog box and click Next. This password must 
be used to start AD DS in Directory Service Restore Mode (DSRM) for tasks 
that must be performed offline.

ABB recommends disabling the IPv6 protocol.

If static IPv4 and IPv6 addresses are not assigned to the network adapters, a 
warning message box might appear advising the setting of static addresses for 
both of these protocols before continuing. If static IPv4 address have been 
assigned to the network adapter and the organization does not use IPv6, this 
message can be ignored by clicking Yes, the computer will use a dynamically 
assigned IP address (not recommended).

A message box may appear that indicates that - A delegation for this DNS 
server cannot be created because the authoritative parent 
zone cannot be found or it does not run Windows DNS server. 
If you are integrating with an existing DNS infrastructure, 
you should manually create a delegation to this DNS server 
in the parent zone to ensure reliable name resolution from 
outside the domain <domain name>. Otherwise, no action is 
required. Do you want to continue? Click Yes and disregard the 
message if this is the case.

Windows Server Backup backs up the directory service by volume. For backup 
and recovery efficiency, store these files on separate volumes that do not contain 
applications or other nondirectory files.
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22. Review the selections in the Summary dialog box. Click Back to change any 
selections. Click Next when the selections are accurate to install.

23. Click Next when the selections are accurate to install AD DS.

24. Click Finish in the Completing the Active Directory Domain Services 
Installation Wizard dialog box.

Transferring the FSMO Roles to the Secondary Domain 
Controller

Perform the following to transfer the FSMO roles to the Secondary Domain 
Controller:

• Transferring the Schema Master Role on page 51.

• Transferring the Domain Naming Master Role on page 53.

• Transferring the RID Master, PDC Emulator, and Infrastructure Master Roles 
on page 54.

Transferring the Schema Master Role

Perform the following to transfer the Schema Master Role.

• This procedure must be performed on the Windows Server 2003 Domain 
Controller that is the Role Holder.

To transfer the Schema Master Role it is necessary to:

• Register the Schmmgmt.dll.
• Run the Active Directory Schema Master snap-in.

To save the selected settings to an answer file that can be used to automate 
subsequent AD DS operations, click Export Settings, type the name for the 
answer file, and click Save.

Select either the Reboot on Completion check box to have the server restart 
automatically, or restart the server to complete the AD DS installation when 
prompted.
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Registering Schmmgmt.dll

Perform the following to register Schmmgmt.dll.

1. Select:

Start > Run

2. Enter regsvr32 schmmgmt.dll in the Run dialog box and click OK.

3. Click OK when the message indicating that the operation succeeded appears. 

Running the Active Directory Schema Master Snap-in

Perform the following to run the Active Directory Schema Master Snap-in.

1. Select:

Start > Run

2. Enter mmc in the Run dialog box and click OK.

3. Click Add/Remove Snap-in on the File menu.

4. Click Add.

5. Click Active Directory Schema.

6. Click Add.

7. Click Close.

8. Click OK.

9. Right-click Active Directory Schema in the console tree and select 
Change Domain Controller to launch the Change Domain Controller dialog 
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box (Figure 2).

10. Select Specify Name.

11. Type the name of the Domain Controller that will be the new role holder and 
click OK.

12. Right-click Active Directory Schema in the console tree and select 
Operations Master.

13. Click Change.

14. Click Yes to confirm the transferring of the role.

15. Accept the question that follows and click Close.

Transferring the Domain Naming Master Role

Perform the following to transfer the Domain Naming Master Role.

1. Open Active Directory Domains and Trusts from Administrative Tools.

2. Right-click Active Directory Domains and Trusts and select Connect to 
Domain Controller to launch the Connect to Domain Controller dialog box 

Figure 2. Change Domain Controller Dialog Box

Perform Step 2 and Step 3 only if not on the Domain Controller to which the role 
will be transferred.
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(Figure 3).

3. Select an available Domain Controller list, click the Domain Controller that 
will be the new role holder, and click OK.

4. Right-click Active Directory Domains and Trusts in the console tree 
and select Operations Master.

5. Click Change.

6. Click Yes to confirm the transferring of the role.

7. Accept the question that follows and click Close.

Transferring the RID Master, PDC Emulator, and Infrastructure Master Roles

Perform the following to transfer the RID Master, PDC Emulator, and Infrastructure 
Master Roles.

1. Open Active Directory Users and Computers from Administrative Tools.

2. Right-click Active Directory Users and Computers and select Connect to 
Domain Controller.

Figure 3. Connect to Domain Controller Dialog Box

Perform Step 2 and Step 3 only if not on the Domain Controller to which the role 
will be transferred.
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3. Perform one of the following:

– Type the name of the Domain Controller that will be the new role holder in 
the Enter the Name of Another Domain Controller dialog box and click 
OK.

-or- 

– Select an available Domain Controller list, click the Domain Controller 
that will be the new role holder, and click OK.

4. Right-click Active Directory Users and Computers in the console 
tree.

5. Point to All Tasks.

6. Click Operations Masters to launch the Operations Masters dialog box 
(Figure 4).

Figure 4. Operations Master Dialog Box
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7. Click the appropriate tab for the master role to transfer (RID Master, PDC 
Emulator and Infrastructure), and then click Change.

8. Click OK to confirm transferring of the role and click Close.

Removing the Remaining Windows Server 2003 Domain 
Controller

The remaining Windows Server 2003 Domain Controller can be removed using the 
Windows interface.

Perform the following to remove the remaining Windows Server 2003 Domain 
Controller by using the Windows interface.

• This procedure must be performed on the remaining Windows Server 2003 
Domain Controller.

• Administrative credentials: An account that is a member of following group is 
required to perform this procedure:

– Domain Admins.

1. Verify that both Domain Controllers are global catalog servers.

a. Start AD Sites and Services.

b. Navigate to NTDS Settings of one Domain Controller in the left pane.

c. Right-click NTDS Settings and select Properties from the context 
menu to open the NTDS Settings Properties dialog box.

d. Verify that the Global Catalog check box is selected under the General 
tab.

e. Repeat for the other Domain Controller.

2. If the Domain Controller is a global catalog server, a message box appears 
warning about the effect of removing a global catalog server from the 
environment. Click OK to continue.

3. Select:

Start > Run
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4. Enter dcpromo in the Run dialog box and click OK.

5. Click Next in the Welcome to the Active Directory Installation Wizard dialog 
box.

6. Make no selection in the This server is the last domain controller in the 
domain dialog box and click Next.

7. Type and confirm a secure password for the local Administrator account in the 
Administrator Password dialog box and click Next.

8. Click Next in the Summary dialog box.

9. Click Finish in the Completing the Active Directory Installation Wizard dialog 
box.

10. Click Restart Now in the Active Directory Installation Wizard dialog box.

11. Remove the server from the domain.

12. Select:

Start > All Programs > Administrative Tools > DNS

13. Remove the DNS Role.

a. Click Add or remove a role in the Manage Your Server Wizard.

b. Read and follow the steps in the Preliminary Steps dialog box and click 
Next.

c. Select DNS server in the Server Role dialog box and click Next.

d. Select the Remove the DNS server role check box in the Role Removal 
Confirmation dialog box and click Next.

e. Click Finish in the DNS Server Role Removed dialog box.

14. Move to the Windows Server 2008 Domain Controller node, select:

Start > All Programs > Administrative Tools

a. Verify that the remaining Windows Server 2003 Domain Controller node 
has been removed from Active Directory Users and Computers. If it has 
not, remove it manually.
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b. Verify that the remaining Windows Server 2003 Domain Controller node 
has been removed from Active Directory Sites and Services. If it has not, 
remove it manually.

c. Verify that the remaining Windows Server 2003 Domain Controller node 
has been removed from DNS. If it has not, clean all the traces in the Name 
Server Tab for both Forward Lookup and Reverse Lookup Zones.

Installing an Additional Windows Server 2008 Domain 
Controller

Perform the following to install an additional Windows Server 2008 Domain 
Controller in an existing domain using the Windows interface.

• This procedure must be performed on the additional Windows Server 2008 
Domain Controller.

• Login as a local administrator.

• Administrative credentials: Check that there is an account available that is a 
member of following group as it is required to perform Step 14 of this 
procedure:

– Domain Admins in the domain in which the additional Domain Controller 
is being installed.

1. Open Windows Control Panel.

2. Double-click Administrative Tools.

3. Double-click Server Manager to launch the Server Manager.

4. Click Add Roles in the Roles Summary.

5. Review the information in the Before You Begin dialog box and click Next.

6. Click the Active Directory Domain Services check box in the Select Server 
Roles dialog box. Select Add Required Features on the popup that is 
displayed and click Next.

7. Review the information in the Active Directory Domain Services dialog box 
and click Next.
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8. Click Install in the Confirm Installation Selections dialog box.

9. In the Installation Results dialog box click Close this Wizard and launch the 
Active Directory Domain Services Installation Wizard (dcpromo.exe).

10. Click Next in the Welcome to the Active Directory Domain Services 
Installation Wizard dialog box.

11. Review the warning about the default security settings for Windows Server 
2008 Domain Controllers in the operating system Compatibility dialog box and 
click Next.

12. Click Existing Forest and Add a Domain Controller to an Existing Domain 
in the Choose a Deployment Configuration dialog box and click Next.

13. Type the name of any existing domain in the forest where it is planned to install 
the additional Domain Controller in the Network Credentials dialog box.

14. Click My Current Logged On Credentials or Alternate Credentials under 
Specify the Account Credentials to use to Perform the Installation and click 
Set.

15. Provide the user name and password for an account that can install the 
additional Domain Controller in the Windows Security dialog box.

16. Click Next when the credentials are provided.

17. Select the domain of the additional Domain Controller in the Select a Domain 
dialog box and click Next.

18. Select a site from the list or select the option to install the Domain Controller in 
the site that corresponds to its IP address in the Select a Site dialog box and 
click Next.

Ensure that all networks are disabled except networks that are used for the 800xA 
System (Plant Network and/or Control Network).

The installer must be a member of the Enterprise Admins group or the Domain 
Admins group to install an additional Domain Controller.

If Read-only Domain Controller is not installed a message appears: You will 
not be able to install a read-only domain controller in this 
domain because “adprep /rodcprep” was not yet run. Do you 
want to continue? Click Yes to proceed.



Installing an Additional Windows Server 2008 Domain Controller Section 2  Upgrading Redundant 

60 3BSE036342-511 G

 

19. Make the following selections in the Additional Domain Controller Options 
dialog box and click Next.

– DNS Server: This option is selected by default so that the Domain 
Controller can function as a Domain Name System (DNS) server. Clear 
the option if it is not desired to have the Domain Controller be a DNS 
server.

– Global Catalog: This option is unselected by default. If selected, it adds 
the global catalog, read-only directory partitions to the Domain Controller, 
and enables global catalog search functionality.

– Read-only Domain Controller: This option is not selected by default and 
is not possible to select.

20. Type or browse to the volume and folder locations for the following in the 
Location for Database, Log Files, and SYSVOL dialog box and click Next.

– Database file.
– Directory service log files.

ABB recommends disabling the IPv6 protocol.

If static IPv4 and IPv6 addresses are not assigned to the network adapters, a 
warning message box might appear advising the setting of static addresses for 
both of these protocols before continuing. If static IPv4 address have been 
assigned to the network adapter and the organization does not use IPv6, this 
message can be ignored by clicking Yes, the computer will use a dynamically 
assigned IP address (not recommended).

A message box may appear that indicates that - A delegation for this DNS 
server cannot be created because the authoritative parent 
zone cannot be found or it does not run Windows DNS server. 
If you are integrating with an existing DNS infrastructure, 
you should manually create a delegation to this DNS server 
in the parent zone to ensure reliable name resolution from 
outside the domain <domain name>. Otherwise, no action is 
required. Do you want to continue? Click Yes and disregard the 
message if this is the case.
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– System volume (SYSVOL) files.

21. Type and confirm the restore mode password in the Directory Services Restore 
Mode Administrator Password dialog box and click Next. This password must 
be used to start AD DS in Directory Service Restore Mode (DSRM) for tasks 
that must be performed offline.

22. Review the selections in the Summary dialog box. Click Back to change any 
selections. Click Next when the selections are accurate to install.

23. Click Next when the selections are accurate to install AD DS.

24. Click Finish in the Completing the Active Directory Domain Services 
Installation Wizard dialog box.

Required 800xA Software
The only 800xA software installed on a separate Domain Controller node is:

• 800xA Common Third Party Install Tool.
• RNRP.
• Diagnostics Collection Tool.

Windows Server Backup backs up the directory service by volume. For backup 
and recovery efficiency, store these files on separate volumes that do not contain 
applications or other nondirectory files.

To save the selected settings to an answer file that can be used to automate 
subsequent AD DS operations, click Export Settings, type the name for the 
answer file, and click Save.

Select either the Reboot on Completion check box to have the server restart 
automatically, or restart the server to complete the AD DS installation when 
prompted.
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Section 3  Upgrading 800xA 5.0 SP2 to 800xA
5.1 Online

Online Upgrade makes it possible to upgrade an existing 800xA System (800xA 5.0 
SP2 or later) without a process shutdown. Plant operations are not disturbed while 
upgrading server and client software, including OCS connectivity services, and 
AC 800M Controllers (processor units and communication interfaces (CI)).

The 800xA System being upgraded must have redundant Aspect and Connectivity 
Servers, and redundant AC 800M Controllers consisting of two redundant 
processing units connected to I/O modules either directly to the modulebus or via 
various CI modules. The client and server level can be upgraded without upgrading 
the controllers.

800xA Systems without redundant Aspect and Connectivity Servers require a 
process shutdown (refer to Section 4, Upgrading 800xA 5.0 SP2 to 800xA 5.1 
Offline).

Control Builder M Compatibility Issues
Refer to the compatibility issues detailed in Appendix B, Control Builder M 
Compatibility Issues before beginning the upgrade.

Redundancy is not supported for the Batch Management and IM combined node 
type.

The OCS connectivity services are possible to upgrade online. The OCS 
controller level is upgraded following the rules defined for the OCS system being 
upgraded.

This instruction addresses only the client and server level software. It does not 
provide detailed instruction for upgrading the controller level; however, a high 
level discussion about the controller level appears in Appendix C, Online 
Upgrade Controller Level.
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Considerations
The following considerations must be taken into account before performing the 
upgrade.

• Unless otherwise indicated, the person performing this upgrade must use the 
same user account that was used during the installation of the 800xA System 
software.

• To guarantee the functionality of the upgraded system, follow these 
instructions carefully and perform them in a well defined order.

• It is recommended that a disk image be taken of all disks on each node before 
beginning and after completing the upgrade.

• Backing up the aspect directory (800xA System Backup), reports, history data, 
graphics, and other application data is required before performing the upgrade.

• Take an inventory of all software on all nodes in the 800xA System before 
performing the upgrade.

Upgrade Flow
This section is organized so that the instructions are presented in the proper upgrade 
order. Do not skip any steps that pertain to 800xA software being used in the current 
or upgraded system. Refer to Planning for the Upgrade on page 35 for additional 
information and ideas on how to streamline the upgrade process.

All paths require, after backup and before restore, installing the 800xA System 
software and creating the system as if it were a new installation.

Central Licensing System

Online Upgrade
The following is the online upgrade procedure. The remainder of this section 
provides detailed information and procedures and they will be referred to in this 
procedure.

Order the 800xA licenses required for the current system version and revision. 
The 800xA 5.0 SP2 licenses will not work.
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1. Document all Windows settings including the domain, DNS, policies, users, 
etc. 

2. Refer to the Diagnostics Collection Tool section in System 800xA Tools 
(2PAA101888*) and run the Software Analyzer from the Primary Aspect 
Server in the 800xA 5.0 SP2 System. This allows for an analysis of the 
software installed on the different nodes in the 800xA System with an 
opportunity to correct errors in the 800xA 5.0 SP2 System before upgrading. 
This is especially helpful when using the System Installer to generate setup 
packages based on the 800xA 5.0 SP2 System. If there is missing or incorrect 
software in that version, the System Installer will duplicate that installation in 
the 800xA 5.1 System.

3. Refer to Appendix D, Consistency Check and perform the necessary 
consistency checks.

4. Refer to Appendix E, Recording the Number of Aspects and Objects and 
record the number of aspects and objects in the system before performing the 
800xA System Backup.

5. It is important to create backups of node hard disks and the 800xA System 
before starting the upgrade procedures. Valid backups ensure that the system 
can be restored if necessary.

a. It is recommended that a third party backup/restore and/or disk imaging 
utility be used to save (and restore if necessary) all disks on each node 
before starting the upgrade procedures.

b. This procedure only applies to installations with IEC 61850 Connect 
installed, which use a user-defined Graphic Library for applications. 

While updating from previous system version, it is observed in Functional 
Structure that all PG2 Faceplate Element and PG2 Graphic Element 
aspects have the same name as Faceplate Element. 

Before performing System Backup in the previous system revision, select 
Object Type Structure > IEC61850 user-defined Library and perform the 
following for all PG2 Faceplate Element and PG2 Graphic Element 
aspects of all Conducting Equipment objects: 

Perform a consistency check before performing the 800xA System backup. 
Failure to do so could result in problems when restoring the system after the 
upgrade.
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– Right-click the aspect and select Details option. 

– In the Aspect info tab, 

- Remove Auto Instantiate aspect and Template aspect. 

- Select the Inheritance Enabled option. 

– Perform Upload operation with the relevant scd file.

c. This step only applies to installations using the Application Scheduler 
and/or Calculations Services:

– Open a Plant Explorer Workplacet.

– Use the Structure Selector to open the Service Structure.

– Select the Scheduling Service Object (Calculations Service Object).

– Select the Service Definition aspect.

– Click the Configuration tab.

– Clear the Enabled check box and click Apply.

– The Schedules/Calculations will have to be manually enabled following 
the upgrade.

d. Perform the 800xA System backup from the Maintenance Structure 
(Aspect Directory backup type). 

The 800xA Backup/Restore function makes it possible to make an online 
backup of the Aspect Directory on the Primary Aspect Server in the 
800xA 5.0 SP2 System and restore it to the new Primary Aspect Server in 
the 800xA 5.1 System.

Use the updated scd file if the Step b is performed in running Plant conditions, to 
ensure that there are no disturbances after performing the upload operation.

Avoid engineering or any other changes especially to the Aspect system during 
the 800xA Backup process.
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A full backup stores all aspect objects and aspect data (application data) in 
the Aspect Directory.

All system extensions that are part of the system must be installed and 
loaded on the node where the backup will be taken (usually the primary 
Aspect Server node). 

When backing up a system with Environments, both the Production and 
Engineering Environments will be included in the backup. Only the 
current version of each aspect will be included in the backup. This means 
that all version history will be removed.

– Open a Plant Explorer Workplace.

– Use the Structure Selector to open the Maintenance Structure.

– Create a Full Backup Definition object.

– Configure the Scope and Storage tabs.

– Check the disk space and path in the Storage tab. A large configuration 
could require a minimum of five gigabytes of free space.

– Start the backup process.

– Refer to the How to Make a Full Backup topic in System 800xA 
Maintenance (3BSE046784*) for more detailed information on performing 
the 800xA System Backup.

6. Place the process in a low level of production where the likelihood of process 
upsets is minimized.

7. If Batch Management is installed and running, all batches must be in the 
complete state (no running batches or active phases).

Verify the Batch Management Servers are operating normally before and during 
800xA System backups of systems containing Batch Management nodes. This 
will ensure the backup of all batch data. 

It is only possible to perform the 800xA System backup from the Production 
Environment.
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8. Refer to Pre-Upgrade Procedures on page 83 and perform the pre-upgrade 
procedures that are applicable to the installed system.

Redundant Aspect Server

1. Remove a redundant Aspect Server from the 800xA 5.0 SP2 System via the 
Remove Server feature in the Configuration Wizard. This server can be a stand-
alone Aspect Server or it can be combined with a redundant Connectivity 
Server. If working in a domain this server needs to be removed from the 
Domain Controller. When this server is upgraded it will become the Primary 
Aspect Server in the 800xA 5.1 System.

2. Reformat the hard drive.

3. Install the new operating system defined for the 800xA 5.1 System. Click 
Advanced when installing the Workstation Operating System or the Server 
Operating System. This is required to delete the existing partition and recreate 
a new one. Failure to perform this step will leave old data on the hard drive.

4. Refer to Section 2 - Prerequisites in:

– Manual Upgrades - System 800xA Manual Installation (3BSE034678*).

– Automated Upgrades using System Installer - System 800xA Automated 
Installation (3BSE034679*).

and perform all procedures relating to operating system settings, Windows 
service packs, miscellaneous Windows components installation, other third 

Do not make any configuration changes such as modifying displays, modifying or 
deleting objects, etc. as these changes to the 800xA 5.0 SP2 System will be lost 
from this point forward.

Do not perform the pre-upgrade procedures for Information Management at this 
point in the upgrade process. This must be performed immediately before 
upgrading the IM Server to allow the history and event data to be stored, without 
losing data, in the history and event storage in the Connectivity Servers while 
upgrading the IM Server. History and event storage will not be able to collect all 
of the data if the time period between disconnecting the IM Server from the 
800xA 5.0 SP2 System and reconnecting it to the 800xA 5.1 System is too long.

The other redundant Aspect Server, if running 2oo3 redundancy, will be removed 
from the 800xA 5.0 SP2 System later.
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party software, group policy, 800xA Service User privileges, and Windows 
updates and hot fixes.

5. Refer to System 800xA Manual Installation (3BSE034678*) and install the 
800xA 5.1 Central Licensing System Server software and install the license 
file, as this will be the Primary Aspect Server in the 800xA 5.1 System. This 
step is not necessary if performing an automated upgrade using System 
Installer.

6. Refer to System 800xA Manual Installation (3BSE034678*) and install all 
800xA 5.1 System software per the software inventory taken earlier. This step 
is not necessary if performing an automated upgrade using System Installer.

7. Refer to Requirements for VB Graphics Extension Software on page 102 to 
install Visual BASIC 6.0 with SP6 and the VB Graphics extensions if 
required.

Feature Pack Functionality______________________________________________________________________

8. Perform the system update to the latest Feature Pack:

• Use the System Feature Pack Update Tool (FUT) to perform the update. Refer 
to the System 800xA 5.1 System Feature Pack Update Tool (2PAA107435*) for 
user instructions.

___________________________________________________________________________________________

9. Perform the 800xA System Restore.

Refer to Requirements for VB Graphics Extension Software on page 102 before 
performing the 800xA System Restore.

Perform this procedure only on the first Aspect Server connected to the 800xA 
5.1 System.

The User Account that is used for 800xA System restore via the Configuration 
Wizard must be a member of the following groups:
• IndustrialITUser.
• IndustrialITAdmin.
• Local Administrators.
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The backup/restore utility supports the restoring of 800xA system information. 
The following steps outline the 800xA system restore procedure.

10. Start the restore procedure.

a. Select:

Start > All Programs > ABB Industrial IT 800xA > System > 
Configuration Wizard

b. The Select Type of Configuration dialog box appears. Select Restore 
System and click Next.

c. When a dialog box appears with the Generate new system id check box 
available, select the check box. This is necessary because during online 
upgrade there will be two systems in one network.

d. Enter a system name and click Next.

e. Change the first Aspect Server to the last Aspect Server (this is now going 
to be the Primary Aspect Server) in the Node Configuration dialog box 
under the Primary nodes frame.

f. Change the first Aspect Server to last Aspect Server in the Primary nodes 
frame and click Next.

11. Check for messages in the log file (select the View Log check box in the 
Configuration Wizard). Refer to Appendix A, Warning and Error Messages to 
resolve any received warning or error messages.

12. Check the CPU load in the node. The System Message service may generate a 
high load (>90%). If this continues for longer than approximately 10 minutes, 
restart the service.

Refer to System 800xA Maintenance (3BSE046784*) for more information on 
restoring the system.

Restart the node when advised during the restore procedure.

If a message appears stating that a full deploy of the Generic Control Network is 
needed, click OK.
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13. Refer to Appendix E, Recording the Number of Aspects and Objects and 
record the number of aspects and objects in the system. Compare these values 
to those recorded when the system was backed up. 

14. Verify the affinity settings to ensure best system performance. Refer to System 
800xA Post Installation (3BUA000156*) for more information on how to 
configure affinity.

15. Refer to Appendix D, Consistency Check and perform the necessary 
consistency checks.

16. Load the VB Graphics Extensions.

a. Refer to Table 1 for a list of VB Graphics extensions available to be 
loaded.

Perform this procedure only if the restored system makes use of VB graphics.

Table 1. VB Graphics Extensions

Directory Software

800xA Connectivities AC 800M Connect VB Graphics Extension

ABB 800xA for Advant Master VB Graphics Extension

ABB 800xA for Harmony VB Graphics Extension

ABB 800xA for IEC61850 VB Graphics Extension

ABB 800xA for MOD 300 VB Graphics Extension

ABB 800xA for Safeguard VB Graphics Extension

ABB PLC Connect VB Graphics Extension

Asset Optimization ABB Asset Optimization VB Graphics Extension

ABB PC, Network and Software Monitoring VB Graphics 
Extension

Batch Management Batch VB Graphics Extension

Batch Advanced Templates VB Graphics Extension

Device Management & Fieldbuses ABB Device Management FOUNDATION Fieldbus VB 
Graphics Extension
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b. Start the Configuration Wizard from the primary Aspect Server node. 
Select:

Start > All Programs > ABB Industrial IT 800xA > System > 
Configuration Wizard

c. Open the System Extension Load dialog box by going to:

System Administration > Select System > System Extension Load

d. A view appears with the available VB Graphics extensions listed in the left 
pane. Select the system extension to load in the list in the left pane and 
move it to the list in the right pane by clicking >. To move all the system 
extensions from the left pane to the right pane, click >>.

e. The red cross, green check mark, and warning icons indicate the status of 
the dependency evaluation.

– The green check mark indicates that the system extension must be loaded 
first.

– The red cross icon indicates that the system extension can not be loaded 
until the one with the green check mark icon is loaded.

– The warning icon indicates that the system extension can be loaded, but 
that there is additional information available in the Description frame in 
the lower part of the dialog box. The additional information can, for 
example, be that the system extension contains aspect types that are not 
environment aware.

f. If the list in the right pane contains more than one system extension, click 
Press header to autosort to sort the system extension load order with 
regard to dependencies.

g. All system extensions in the right pane should be marked with the green 
check mark or the warning icon.

h. Click Next and the Apply Settings dialog box appears.

i. Click Finish to load all system extensions.
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j. A progress dialog box is shown during the load. Click View Log to view 
log messages during load.

k. When the load operation is finished, click Finished and view the 
Configuration Wizard log to verify that no errors occurred during the load.

l. Close the Configuration Wizard.

m. Refer to Post Upgrade Procedures on page 105 and perform the applicable 
post upgrade procedures for the upgraded server.

Redundant 800xA for Harmony and 800xA for AC 870P/Melody Servers

1. Remove a redundant 800xA for Harmony Configuration Server, 800xA for 
Harmony Configuration Server with Connectivity Server, or 800xA for AC 
870P/Melody Configuration Server via the Remove Server feature in the 
Configuration Wizard. If working in a domain this server needs to be removed 
from the Domain Controller.

2. Reformat the hard drive. 

3. Install the new operating system defined for the 800xA 5.1 System. Click 
Advanced when installing the Server Operating System. This is required to 
delete the existing partition and recreate a new one. Failure to perform this step 
will leave old data on the hard drive.

4. Refer to Section 2 - Prerequisites in:

– Manual Upgrades - System 800xA Manual Installation (3BSE034678*).

The load is aborted if:
• The user clicks Abort.

• An error occurs; for example, if the Configuration Wizard fails to load a file 
into the system.

An aborted system extension load can be resumed from the System Extension 
Maintenance dialog box.

Operation and monitoring of the plant are only possible from clients in the 
800xA 5.0 SP2 System at this point in the upgrade process.

Perform this procedure only if 800xA for Harmony or 800xA for 
AC 870P/Melody are installed in the 800xA System.
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– Automated Upgrades using System Installer - System 800xA Automated 
Installation (3BSE034679*).

and perform all procedures relating to operating system settings, Windows 
service packs, miscellaneous Windows components installation, other third 
party software, group policy, 800xA Service User privileges, and Windows 
updates and hot fixes.

5. Refer to System 800xA Manual Installation (3BSE034678*) and install all 
800xA 5.1 System software per the software inventory taken earlier. This step 
is not necessary if performing an automated upgrade using System Installer.

6. Refer to Requirements for VB Graphics Extension Software on page 102 to 
install Visual BASIC 6.0 with SP6 and the VB Graphics extensions if required.

7. Point the Central Licensing Client to the new 800xA 5.1 Central Licensing 
Server.

8. Connect the server to the upgrade 800xA 5.1 System via the Connect Node 
feature in the Configuration Wizard.

9. Refer to Post Upgrade Procedures on page 105 and perform the applicable post 
upgrade procedures for the upgraded server.

10. Repeat this procedure for every redundant 800xA for Harmony Configuration 
Server, 800xA for Harmony Configuration Server with Connectivity Server, or 
800xA for AC 870P/Melody Configuration Server.

Redundant Connectivity Servers

1. Remove a redundant Connectivity Server from the 800xA 5.0 SP2 System via 
the Remove Server feature in the Configuration Wizard. If working in a domain 
this server needs to be removed from the Domain Controller.

2. Reformat the hard drive. 

3. Install the new operating system defined for the 800xA 5.1 System. Click 
Advanced when installing the Workstation Operating System or the Server 

Upgrade the servers one-by-one in order to keep redundancy of the system as 
long as possible.

Operation and monitoring of the plant are only possible from clients in the 800xA 
5.0 SP2 System at this point in the upgrade process.
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Operating System. This is required to delete the existing partition and recreate 
a new one. Failure to perform this step will leave old data on the hard drive.

4. Refer to Section 2 - Prerequisites in:

– Manual Upgrades - System 800xA Manual Installation (3BSE034678*).

– Automated Upgrades using System Installer - System 800xA Automated 
Installation (3BSE034679*).

and perform all procedures relating to operating system settings, Windows 
service packs, miscellaneous Windows components installation, other third 
party software, group policy, 800xA Service User privileges, and Windows 
updates and hot fixes.

5. Refer to System 800xA Manual Installation (3BSE034678*) and install all 
800xA 5.1 System software per the software inventory taken earlier. This step 
is not necessary if performing an automated upgrade using System Installer.

6. Refer to Requirements for VB Graphics Extension Software on page 102 to 
install Visual BASIC 6.0 with SP6 and the VB Graphics extensions if required.

7. Point the Central Licensing Client to the new 800xA 5.1 Central Licensing 
Server.

8. Connect the server to the upgraded 800xA 5.1 System via the Connect Node 
feature in the Configuration Wizard.

9. Refer to Post Upgrade Procedures on page 105 and perform the applicable post 
upgrade procedures for the upgraded server.

10. Repeat this procedure for every redundant Connectivity Server.

Upgrade the servers one-by-one in order to keep redundancy of the system as 
long as possible.

Operation and monitoring of the plant are only possible from clients in the 800xA 
5.0 SP2 System at this point in the upgrade process.
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Redundant Aspect Server (2oo3 Redundancy Only)

1. Remove the other redundant Aspect Server (if 2oo3 redundant) from the 800xA 
5.0 SP2 System via the Remove Server feature in the Configuration Wizard. If 

working in a domain this server needs to be removed from the Domain 
Controller.

2. Reformat the hard drive. 

3. Install the new operating system defined for the 800xA 5.1 System. Click 
Advanced when installing the Workstation Operating System or the Server 
Operating System. This is required to delete the existing partition and recreate 
a new one. Failure to perform this step will leave old data on the hard drive.

4. Refer to Section 2 - Prerequisites in:

– Manual Upgrades - System 800xA Manual Installation (3BSE034678*).

– Automated Upgrades using System Installer - System 800xA Automated 
Installation (3BSE034679*).

and perform all procedures relating to operating system settings, Windows 
service packs, miscellaneous Windows components installation, other third 
party software, group policy, 800xA Service User privileges, and Windows 
updates and hot fixes.

5. Refer to System 800xA Manual Installation (3BSE034678*) and install all 
800xA 5.1 System software per the software inventory taken earlier. This step 
is not necessary if performing an automated upgrade using System Installer.

6. Refer to Requirements for VB Graphics Extension Software on page 102 to 
install Visual BASIC 6.0 with SP6 and the VB Graphics extensions if required.

7. Point the Central Licensing Client to the new 800xA 5.1 Central Licensing 
Server.

8. Connect the server to the upgraded 800xA 5.1 System via the Connect Node 
feature in the Configuration Wizard.

Perform this procedure only if the Aspect Servers in the 800xA System have 
2oo3 redundancy.
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9. Refer to Post Upgrade Procedures on page 105 and perform the applicable post 
upgrade procedures for the upgraded server.

Clients

1. Remove some clients from the 800xA 5.0 SP2 System via the Remove Client 
feature in the Configuration Wizard. If working in a domain the clients need to 
be removed from the Domain Controller.

2. Reformat the hard drive on each client. 

3. Install the new operating system defined for the 800xA 5.1 System on each 
client. Click Advanced when installing the Workstation Operating System. 
This is required to delete the existing partition and recreate a new one. Failure 
to perform this step will Refer to Section 2 - Prerequisites in:

– Manual Upgrades - System 800xA Manual Installation (3BSE034678*).

– Automated Upgrades using System Installer - System 800xA Automated 
Installation (3BSE034679*).

and perform all procedures relating to operating system settings, Windows 
service packs, miscellaneous Windows components installation, other third 
party software, group policy, 800xA Service User privileges, and Windows 
updates and hot fixes.

4. Refer to System 800xA Manual Installation (3BSE034678*) and install all 
800xA 5.1 System software per the software inventory taken earlier. This step 
is not necessary if performing an automated upgrade using System Installer.

5. Refer to Requirements for VB Graphics Extension Software on page 102 to 
install Visual BASIC 6.0 with SP6 and the VB Graphics extensions if required.

Operation and monitoring of the plant are only possible from clients in the 
800xA 5.0 SP2 System at this point in the upgrade process.

Do not remove all of the clients from the 800xA 5.0 SP2 System at this point. 
Keeping some clients in the 800xA 5.0 SP2 System will allow the operators to 
continue to observe and control the process.

The procedure for the client nodes can be performed one-by-one or in a group.
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6. Point the Central Licensing Client to the new 800xA 5.1 Central Licensing 
Server on each client.

7. Connect each client to the upgraded 800xA 5.1 System via the Connect Node 
feature in the Configuration Wizard.

8. Refer to Post Upgrade Procedures on page 105 and perform the applicable post 
upgrade procedures for the upgraded server.

Information Management Server

1. Check that history and event data storage is available in the Connectivity 
Servers to overlap, with margin, the time it takes to upgrade the IM Server. This 
includes time to:

– Reformat the hard drive.

– Load all required software.

– Connect the IM Server to the 800xA 5.1 System.

– Reboot the IM Server.

– Collect data from the Connectivity Servers from the time when the IM 
Server was removed from the 800xA 5.0 SP2 System.

2. Perform the Information Management Pre-Upgrade Procedures on page 453 in 
Appendix , Information Management Upgrade.

3. Remove the IM Server from the 800xA 5.0 SP2 System via the Remove Server 
feature in the Configuration Wizard. If working in a domain this server needs to 
be removed from the Domain Controller.

4. Reformat the hard drive. 

5. Install the new operating system defined for the 800xA 5.1 System. Click 
Advanced when installing the Server Operating System. This is required to 
delete the existing partition and recreate a new one. Failure to perform this step 
will leave old data on the hard drive.

6. Refer to Section 2 - Prerequisites in:

Operation and monitoring of the plant are only possible from clients in the 800xA 
5.0 SP2 System at this point in the upgrade process.
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– Manual Upgrades - System 800xA Manual Installation (3BSE034678*).

– Automated Upgrades using System Installer - System 800xA Automated 
Installation (3BSE034679*).

and perform all procedures relating to operating system settings, Windows 
service packs, miscellaneous Windows components installation, other third 
party software, group policy, 800xA Service User privileges, and Windows 
updates and hot fixes.

7. Refer to System 800xA Manual Installation (3BSE034678*) and install all 
800xA 5.1 System software per the software inventory taken earlier. This step 
is not necessary if performing an automated upgrade using System Installer.

8. Refer to Requirements for VB Graphics Extension Software on page 102 to 
install Visual BASIC 6.0 with SP6 and the VB Graphics extensions if required.

9. Point the Central Licensing Client to the new 800xA 5.1 Central Licensing 
Server.

10. Verify that the ABB Process Administration Service (PAS) is set to manual in 
the Services Control Panel (run Services.msc from the Run dialog box). Stop 
the service if it is running.

11. Connect the server to the upgraded 800xA 5.1 System via the Connect Node 
feature in the Configuration Wizard.

12. Reboot the node.

13. Refer to Information Management Post Upgrade Procedures on page 458 in 
Appendix , Information Management Upgrade and perform the applicable post 
upgrade procedures for the upgraded server.

Operation and monitoring of the plant are only possible from clients in the 800xA 
5.0 SP2 System at this point in the upgrade process.
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Application Servers 

1. Remove an Application Server from the 800xA 5.0 SP2 System via the 
Remove Server feature in the Configuration Wizard. If working in a domain 
this server needs to be removed from the Domain Controller.

2. Reformat the hard drive. 

3. Install the new operating system defined for the 800xA 5.1 System. Click 
Advanced when installing the Server Operating System. This is required to 
delete the existing partition and recreate a new one. Failure to perform this step 
will leave old data on the hard drive.

4. Refer to Section 2 - Prerequisites in:

– Manual Upgrades - System 800xA Manual Installation (3BSE034678*).

– Automated Upgrades using System Installer - System 800xA Automated 
Installation (3BSE034679*).

and perform all procedures relating to operating system settings, Windows 
service packs, miscellaneous Windows components installation, other third 
party software, group policy, 800xA Service User privileges, and Windows 
updates and hot fixes.

5. Refer to System 800xA Manual Installation (3BSE034678*) and install all 
800xA 5.1 System software per the software inventory taken earlier. This step 
is not necessary if performing an automated upgrade using System Installer.

6. Refer to Requirements for VB Graphics Extension Software on page 102 and 
install the required VB Graphics extension software.

7. Point the Central Licensing Client to the new 800xA 5.1 Central Licensing 
Server.

8. Connect the server to the upgraded 800xA 5.1 System via the Connect Node 
feature in the Configuration Wizard.

Perform the procedures for the Application Servers (Batch Management, Asset 
Optimization, PC, Network and Software Monitoring, etc.) one at a time.

When upgrading redundant Batch Management Servers, the Primary Batch 
Server must be upgraded first, followed by the Secondary Batch Server. Do not 
upgrade the Secondary Batch Server followed by the Primary Batch Server.
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9. Refer to Post Upgrade Procedures on page 105 and perform the applicable post 
upgrade procedures for the upgraded server.

10. Repeat this procedure for every Application Server.

11. Operators should move to the 800xA 5.1 System to operate and control the 
plant at this point in the upgrade process. 

Remaining Nodes

1. Remove the remaining nodes in the 800xA 5.0 SP2 System and connect them 
to the 800xA 5.1 System. If working in a domain these nodes need to be 
removed from the Domain Controller.

2. Repeat the applicable procedures for the remaining nodes in the 800xA 5.0 SP2 
System, except for the 800xA 5.0 SP2 Primary Aspect Server.

800xA 5.0 SP2 Primary Aspect Server

Upgrade the 800xA 5.0 SP2 Primary Aspect Server.

1. Use the Configuration Wizard to stop the 800xA 5.0 SP2 System on the 800xA 
5.0 SP2 Primary Aspect Server.

2. Use the Configuration Wizard to delete the system from the 800xA 5.0 SP2 
Primary Aspect Server.

3. Reformat the hard drive. 

4. Install the new operating system defined for the 800xA 5.1 System. Click 
Advanced when installing the Workstation Operating System or the Server 
Operating System. This is required to delete the existing partition and recreate 
a new one. Failure to perform this step will leave old data on the hard drive.

5. Refer to Section 2 - Prerequisites in:

The 800xA System is now running in nonredundant mode in both the 
800xA 5.0 SP2 and the 800xA 5.1 systems. Operation and monitoring of the 
plant are possible from clients in both systems at this point in the upgrade 
process.

Operation and monitoring of the plant are only possible from clients in the 
800xA 5.1 System at this point in the upgrade process.
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– Manual Upgrades - System 800xA Manual Installation (3BSE034678*).

– Automated Upgrades using System Installer - System 800xA Automated 
Installation (3BSE034679*).

and perform all procedures relating to operating system settings, Windows 
service packs, miscellaneous Windows components installation, other third 
party software, group policy, 800xA Service User privileges, and Windows 
updates and hot fixes.

6. Refer to System 800xA Manual Installation (3BSE034678*) and install all 
800xA 5.1 System software per the software inventory taken earlier. This step 
is not necessary if performing an automated upgrade using System Installer.

7. Refer to Requirements for VB Graphics Extension Software on page 102 and 
install the required VB Graphics extension software.

8. Point the Central Licensing Client to the new 800xA 5.1 Central Licensing 
Server.

9. Connect the server to the upgraded 800xA 5.1 System via the Connect Node 
feature in the Configuration Wizard.

10. Refer to Post Upgrade Procedures on page 105 and perform the applicable post 
upgrade procedures for the upgraded server.

Remaining Steps

1. Refer to System 800xA Post Installation (3BUA000156*) and configure 
Windows Firewall and Windows Services on every node in the 800xA System.

2. It is important to create backups of node hard disks and the 800xA System after 
completing the upgrade procedures. Valid backups insure that the system can 
be restored if necessary.

a. It is recommended that a third party backup/restore and/or disk imaging 
utility be used to save (and restore if necessary) all disks on each node 
before starting the upgrade procedures.

b. Perform the 800xA full backup from the Maintenance Structure (Aspect 
Directory backup type).

Operation and monitoring of the plant are only possible from clients in the 
800xA 5.1 System at this point in the upgrade process.
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Pre-Upgrade Procedures
The 800xA System and software require preparatory steps before performing the 
online upgrade. Perform the applicable procedures in the order presented.

Customized Alarm Priority Mapping Aspects

Some customized Alarm Priority Mapping Aspects may be overwritten during the 
upgrade. Record all values in the Alarm Priority Mapping aspects before beginning 
the upgrade so that they can be recreated after the upgrade.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Library Structure.

3. Use the Object Browser to navigate to:

Alarm & Event > Alarm Collector Definitions, Alarm 
Collector Definitions

4. Select a Alarm Collector Definition object with customized Alarm Priority 
Mapping Aspect.

5. Select Alarm Priority Mapping in the Aspect List Area.

6. Record the values in the Alarm Priority Mapping aspects.

7. Repeat for all customized Alarm Priority Mapping aspects.

800xA for AC 800M

Use the following procedure to prepare for the 800xA for AC 800M upgrade:

1. Record the service account settings in the OPC Server Setup Wizard.

2. Control Builder stores its settings (systemsetup.sys) on disk in the following 
directory:

...\ABB Industrial IT Data\Engineer IT Data\Control 
Builder M Professional

Copy this file to a safe media.

3. Save OPC configurations by selecting:

File > Save Configuration
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in the OPC Server Panel.

4. The OPC Server stores configuration files (*.cfg) and settings 
(systemsetup.sys) on disk. Copy these files to a safe media. The 
systemsetup.sys file is located in:

...\ABB Industrial IT Data\Control IT Data\OPC Server 
for AC 800M

The configuration files are stored in the Files folder in the same location.

5. If the system to be upgraded originates from System Baseline 2.1 and has been 
upgraded in steps through system versions, verify that the Control Builder 
projects do not use the old obsolete SB2 (System Baseline 2) libraries (libraries 
of version 1.0-0. For example: ControlStandardLib 1.0/0.

Structured Data Logger

Use the following procedure to prepare for the Structured Data Logger (SDL) 
upgrade.

1. Back up the SQL Server 2000 SDL Database.

a. Open SQL Server Enterprise Manager.

b. Right-click SDL data base and select All Tasks > Backup Database… 
from the context menu.

c. Save the backup file (with .bak extension) to a safe location.
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Engineering Studio Function Designer System Extensions

Use the following procedures to prepare for the Engineering Studio upgrade.

The Function Designer system extensions:

• Signal Extension for AC800M Connect 

• Function Designer for AC800M Connect 

• Topology Designer for AC800M Connect

• CI Extension for AC800M Connect 

• Signal Extension for TRIO Connect 

• Topology Designer for AC800M High Integrity 

• Function Designer for AC 800M Classic 

• Topology Designer for AC800M Classic 

• Function Designer for Fieldbus Builder Profibus/Hart 

• AC 800M Signal Extension Classic 

mainly consist of:

• Functional Planning Object Types, including a Function Settings aspect at the 
Settings Object Type Group.

• Extension Libraries that add Function Designer aspects to Object Types 
(Control Modules, Function Blocks, etc.) created by basic libraries (AC800M 
Connect, AC 800M Classic, etc.).

After loading any of the listed system extensions in the 800xA 5.0 SP2 System, 
some of these aspects may be modified; for example, to adapt Function Settings, or 
to change the color or layout of Function Blocks in Function Diagrams. During the 
800xA System upgrade to 800xA 5.1 the system extensions of the new system are 
loaded. To keep the information about modified aspects, all aspects that were 
created by a Function Designer system extension, but modified later are listed in the 
Configuration Wizard log, and are written to Afw files.

The only way to bring these modifications back into the 800xA 5.1 System is to 
manually merge the changes. Do not import the listed Afw files into the 800xA 5.1 
System, because some additional properties/data might get lost. In the case of 
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Function Settings aspects, record the property settings from the 800xA 5.0 SP2 
System and perform the modifications again in the 800xA 5.1 System. In the case of 
modified Function aspects (e.g. Diagram Template, Component Template), record 
the modifications done in the 800xA 5.0 SP2 System and perform the modifications 
again in the 800xA 5.1 System.

Engineering Studio Add-Ins

Before updating/upgrading the system from previous release to the latest release 
ensure the Engineering Studio Add-Ins are listed in Active Application Add-Ins in 
MS-Excel. 

If the Add-ins are not listed, perform Step 3 through Step 5 to enable them in the 
MS-Excel:

1. Open MS-Excel.

2. Navigate to File > Excel Options > Add-Ins > Active Application Add-ins. 
Refer to Figure 5 to view the Engineering Studio Add-ins.

3. Select COM Add-ins from Manage drop-down and click Go... List of COM 
Add-ins window appears.

All the local language parameters used in the Function Designer need to be 
changed to English before the upgrade. Usage of non-English parameters in the 
Function Diagrams results in errors while generating configuration data.

Figure 5. Engineering Studio Add-Ins
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4. Select all the Engineering Studio Add-ins from the list and click OK.

5. View the Add-Ins in the Active Application Add-ins panel on the Excel 
Options window.

Device Management FOUNDATION Fieldbus

Perform the following to prepare for the Device Management FOUNDATION 
Fieldbus upgrade.

• User-Made Modifications to Library Objects Representing FF Standard 
Blocks.

• Exporting Locally Stored Parameter Value Sets.

User-Made Modifications to Library Objects Representing FF Standard Blocks

User-made modifications to library objects representing FF standard blocks (these 
are blocks supported by the Device Type Standard FBs as indicated in the Block 
Info tab of the block class parameter dialog box) will be overwritten during 
upgrade. If such changes have been made, they can be reconstructed manually. 
Refer to Device Management FOUNDATION Fieldbus on page 122.

Exporting Locally Stored Parameter Value Sets

Export the locally stored parameter value sets as follows:

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Object Type Structure. 

3. Use the Object Browser to navigate to: 

      FF Libraries, Object Type Group

4. Select FF Upload in the Aspect List Area.

5. Click Open Library in Fieldbus Builder FF.

6. Select the Function Block from FF Block Library > Function Blocks 
in the Library view.

7. Double-click on the Function Block to open the properties dialog box for the 
chosen Function Block.
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8. Right-click and select Export from the context menu (Figure 6).

9. Specify the name and location of the .csv file and Click OK.

800xA for Advant Master and 800xA for Safeguard

Perform the following to prepare for the 800xA for Advant Master and 800xA for 
Safeguard upgrade.

• Save the Advant Master Controller Licenses.txt.

Figure 6. Exporting Locally Stored Parameter Value Sets
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• Save the Configuration Files.
• Save the DATHR Files.
• Document the RTA Board Control Aspect Settings.

Save the Advant Master Controller Licenses.txt

Perform the following on the Primary Aspect Server in the 800xA 5.0 SP2 System:

1. Save the following file to a safe location.

– Advant Master Controller Licenses.txt

The default location for the file is:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\Licenses

Save the Configuration Files

The configuration files in the Connectivity Servers can contain special configuration 
settings for Alarm and Event or Data access. Refer to 800xA for Advant Master, 
Configuration (3BSE030340*) for more information about these special 
configuration settings.

If such changes are available in the configuration files, perform the following on 
each 800xA for Advant Master and 800xA for Safeguard Connectivity Server node: 
Save the following files to a safe location:

• AdvDsMasterAdapter.csv

• AdvMbAeOPCServer.csv

The default location for the files is:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\Bin

Save the DATHR Files

Perform the following on each 800xA for Advant Master and 800xA for Safeguard 
Connectivity Server node:

1. Save the following files to a safe location:
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– DATHR1.CD
– DATHR2.CD
– DATHR3.CD

from the folder:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\AdvantBase\Data\RTA\Init\

and record which files belong to which node.

Document the RTA Board Control Aspect Settings

Perform the following on each 800xA for Advant Master and 800xA for Safeguard 
Connectivity Server node:

1. Document the following settings in the RTA Board Control aspect for 
reconfiguration after the upgrade.

– MB300 node and network address.
– 800xA as Clock Master (REVERSED_SYNC_MODE) check box.

800xA for Harmony

Perform the following to prepare for the 800xA for Harmony upgrade.

• Disable Harmony Services on 800xA for Harmony Servers.
• Save 800xA for Harmony Information.

Disable Harmony Services on 800xA for Harmony Servers

Stop the following 800xA for Harmony services on the 800xA for Harmony Server 
node being upgraded.

1. Select:

Start > Control Panel > Administrative Tools > Services

2. Disable the following services:

– Time synchronization daemon.
– SoapSymTagAtomSrv.
– EbDataSyncService.
– EbServerBroker.
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– ABBDiagnosticService.
– DD_xxxx - Where xxxx identifies the semAPI or hAPI device being used 

(this may or may not exist).

Perform the following steps to disable these services:

a. Locate the service in the Services list.

b. Double-click the service to open the Properties dialog box for that service.

c. Change the Startup type to Disabled.

d. Click Apply and then OK.

e. Repeat for each of the services listed.

3. Restart the 800xA for Harmony Server node.

Save 800xA for Harmony Information

Use the following procedure to save 800xA for Harmony information:

1. Create a backup of the Configuration Server database.

a. Select:

Start > All Programs > ABB Industrial IT 800xA > 800xA for OCS 
Systems > Harmony > Configuration > Backup Configuration

b. Click Connect.

c. Click Browse to name the backup file and choose a location to save it.

d. Click Backup.

e. Click Exit when the backup is complete.
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800xA for AC 870P/Melody

Use the following procedure to save 800xA for AC 870P/Melody information:

1. Log in to the 800xA Service account on the Configuration Server node.

a. Create a backup of the Configuration Server database.

b. Select:

Start > All Programs > ABB Industrial IT 800xA > 800xA for Melody 
> Configuration > Backup Configuration

c. Click Connect.

d. Click Backup.

e. Click Exit when the backup is complete.

800xA for MOD 300

Ensure that the configuration data noted in the Customized Data for Backup 
appendix in 800xA for MOD 300 Configuration (3BUR002417*) has been recorded.

Disable the Melody AutoConfigurator service in Plant Explorer > Service 
Structure (the service must be disabled when the system maintenance backup is 
started).

Back up project specific changes (if applicable):

• DHCP Server Configuration.

• ETC Host files for Melody Connectivity Servers from: 
...\Windows\system32\Drivers

• Changes in the Default Object Types (e.g. manual changes for permissions 
in Control Connection Aspects).

• ConvDB changes only on Configuration Server (change to the directory 
...\Program Files\ABB Industrial IT\Configuration and backup the files 
MELCONVERTER.BAT, ConvDB.mdb and ConvDB_<Hostname>.mdb.

ConfigServer node: Ensure that no Commissioning will be done from the 
Melody Composer during this upgrade. 

Save the backup file to a safe media like a network share or removable disk. 
Otherwise, the file will be deleted once an upgrade occurs due to a reload of the 
node.
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IEC 61850 Connect

Make backups for the IEC 61850 CET OPC Server projects. Refer to the topic CET 
Project Maintenance in the System 800xA IEC 61850 Configuration 
(9ARD171387*) user manual to export CET OPC Server projects.

PLC Connect

Perform the following procedure to prepare for the PLC Connect upgrade.

1. If the PLC Connect IEC 60870 feature is installed and configured, the IEC 
configuration must be saved. Refer to the section on configuring the IEC 60870 
driver in System 800xA PLC Connect Configuration (3BSE035041*) for more 
information.

2. If the PLC Connect Communication Server Pre Treatment function is being 
used in the application (refer to System 800xA PLC Connect Configuration 
(3BSE035041*) for more information), make a backup of the Pretreat dll 
(Pretreat3.dll or Pretreat4.dll, be sure to select the version used). The Pretreat 
dll is located in the following folder on the PLC Connect Connectivity Server:

...\ABB Industrial IT\Operate IT\PLC Connect\Bin

3. Make a backup of the application project and source files for the Pretreat dll.

Engineering Studio IO Allocation

Deactivate the auto update mode in IO Allocation.

1. Start the Engineering Workplace.

2. Open the IO Allocation tool on any object by right-clicking on the object and 
selecting Advanced > IO Allocation from the context menu that appears.

3. Verify that no check mark symbol is visible in the Options > Autoupdate 
CBM menu item in the IO Allocation tool.

Handling of IET/CCT projects and PCM 600 projects is not described here as 
they are external tools contributing to the IEC 61850 workflow. They do not 
reside on 800xA System nodes.

The path is the default location of the file. If it has been placed somewhere else, 
make a backup from that location.
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Asset Optimization

Preparing for the Asset Optimization upgrade requires backing up data to a safe 
media.

Use the following procedure to back up Asset Optimization information (perform 
only the steps applicable to the system):

1. Asset Monitoring:

a. If Runtime Asset Monitors are being used in the system, save the Runtime 
Asset Monitor data directory (DeviceRunTimeMSLogicStore) to a safe 
media. This directory stores the runtime information calculated by the 
Runtime Asset Monitors running in this node. This directory is located in:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AssetMonitorEnvironment\Bin

b. If XY Profile Deviation Asset Monitors are being used in the system, save 
the XY Profile Deviation Asset Monitor data directory 
(XY_Reference_Profiles) to a safe media. This directory is located in:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AssetMonitorEnvironment\Bin

c. If Counter Check Asset Monitors are being used in the system, save the 
Counter Check Asset Monitors data directory named:

{66E71F7B-90D6-4E62-9881-38388B24CBDF}

to safe media. This directory exists for each AO Server in the system. 
These directories are located in:

<install drive>:\OperateITData\AoEng\<AO Server ID>\
AmCat\<Counter Check ID>

Where each <AO Server ID> directory represents one AO Server instance 
running on the selected node. The <AO Server ID> directory name is 
formatted as two consecutive GUIDs, for example:

Asset Monitoring directories will be found on every Asset Optimization Server 
node and any other node defined as an Asset Monitoring Server.
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{F9C150F5-2929-4A12-BC28-E00ED6DB1585}{B925E77F-2A82-
41C6-A981-FAB4386D5701}.

2. Maximo Integration: 

a. The MxDef files provide the mapping between the 800xA System 
environment and the Maximo system. If the MxDef files were customized 
per the instructions in System 800xA Asset Optimization Configuration 
(3BUA000118*), back up the customized MxDef files to safe media.

– The customized MxDef Files for Maximo versions 4.1 and 4.1.1 are 
located in the following directory:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\ABBAO\Services\MOM\MxDefs\

– The customized MxDef files for Maximo version 5.1 and 5.2 are located 
in the following directory:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\ABBAO\Services\MOM\MxDefs\Maximo5\MxServer

– The customized MxDef files for Maximo version 6.2 are located in the 
following directory:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AOECSConnector\MaximoDef

b. Back up the AOMaximoModel.xml file to a safe location. A backup of 
AOMaximoModel.xml is necessary because the ECS model for Maximo 
also needs to be modified if the MXDef files are customized.

The model file is available at the following location:

For correct system operation it is important that only the directories identified by 
the Counter Check Asset Monitor category GUID be saved, as other data in the 
tree structure above these directories will not be consistent with a restore.

If using Maximo Integration, the Maximo Integration information (Maximo 
Equipment ID and Maximo Credentials aspects) must be saved from all Asset 
Optimization Server nodes. Refer the Service Structure for the name of the 
Asset Optimization Server nodes.
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...\program files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AOECSConnector\ECSDefinitions

3. SAP/PM Integration: 

a. Although the SAP/PM system is separate from the 800xA System, it is a 
good idea to back up the system in use. Follow SAP/PM standard 
practices for SAP/PM system backup.

b. The SAPPMDef files provide the mapping between the 800xA System 
environment and the SAP/PM system. If the SAPDef files were 
customized per the instructions in System 800xA Asset Optimization 
Configuration (3BUA000118*), back up the customized SAPDef files to 
safe media.

The customized SAPPMDef files for SAP version4.7 are located under:

...\Program Files\ABB Industrial IT\Optimize IT\
Asset Optimization\AOECSConnector\SAPPMDef

c. Back up the AOSAPModel.xml file to a safe location. A backup of 
AOSAPModel.xml is necessary because the ECS model for SAP also 
needs to be modified if the SAPPMDef files are customized.

The model file is available at the following location:

...\program files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AOECSConnector\ECSDefinitions

The pending fault reports residing in the system are available in the following 
directory structure:

...\OperateITData\OptaoACDs

Backup the entire OptaoACDs folder.

If using SAP/PM Integration, the SAP/PM Integration information (SAP 
Equipment ID and SAP Credentials aspects) must be saved from all Asset 
Optimization Server nodes. Reference the Service Structure for the name of the 
Asset Optimization Server nodes.

The pending fault reports residing in the system are available in the following 
directory structure. Backup the entire OptaoACDs folder.

...\OperateITData\OptaoACDs
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4. DMS Calibration Integration:

PC, Network and Software Monitoring

Use the following procedure to prepare for the PC, Network and Software 
Monitoring upgrade.

1. If there are user defined Script, Resource, and Assembly files they need to be 
backed up. The user files are located in:

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Scripts\User

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Assemblies\User

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Resources\User directory

Copy the files in these directories to a safe location.

PC, Network and Software Monitoring Device Library

Use the following procedure to prepare PC, Network and Software Monitoring 
Device Library upgrade:

1. Back up MOF files (if they exist) to a safe location. The MOF files are located 
in:

...\Program Files\ABB Industrial IT\Optimize IT\PC, 
Network and Software Monitoring\MOFS

2. Back up Custom Asset Monitor dlls to a safe location if object types with 
Custom Asset Monitors are loaded. The dlls are located in: 

The DMS Calibration Integration approach is changed in 800xA 5.1. Upgrade of 
DMS Calibration Integration is not supported. Reconfigure the DMS Calibration 
Integration based on an engineered solution.

Contact ABB technical support for more information.
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...\Program Files\ABB Industrial IT\Optimize 
IT\PC, Network and Software Monitoring\Asset 
Monitoring\Bin

SMS and e-mail Messaging

Save all GSM Device hardware information. Record information for the GSM 
device on the SMS and e-mail Messaging GSM Hardware Setup Worksheet shown 
in Table 2.

Table 2. SMS and e-mail Messaging GSM Hardware Setup Worksheet

Item Setting/Value

Spooler Settings

Activate Outbox Spooler Checked (check and leave checked)

Activate Inbox Spooler Checked (check and leave checked)

Interval for Checking for Incoming 
Messages

Value: _____ Seconds Minutes (circle 1)

Port Settings

COM Port Value: COM _____

Baud Rate Value: _____

Data Bits Value: _____

Parity Value: _____

Stop Bits Value: _____

PIN and Properties

Query PIN Checked or Unchecked (circle one)

PIN (only if Query PIN is checked) Value: ___________________

Save PIN (only if Query PIN is 
checked)

Checked or Unchecked (circle one)
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Own Number (telephone number of 
SIM card (including Country Code) 
in GSM hardware)

Value: ___________________

Initialization String for GSM Hardware Value:

_______________________________

_______________________________

_______________________________

_______________________________

General Service Properties

Name (GSM service provider) Value: ___________________

Port Value: COM _____

SMSC Value: ___________________

Default Country Code Value: ___________________

Default Prefix Value: ___________________

Number of Attempts Value: ___________________

Splitting Service Properties

Splitting Checked or Unchecked (circle one)

Optimize Splitting Checked or Unchecked (circle one)

Enumerate Splitting Checked or Unchecked (circle one)

Narrowband Sockets Checked or Unchecked (circle one)

Messaging Service Properties

Add Before Message Blank (verify and do not change)

Use for Delivery Notification Only Unchecked (verify and do not change)

Default Option 0 (verify and do not change)

Table 2. SMS and e-mail Messaging GSM Hardware Setup Worksheet (Continued)

Item Setting/Value
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Batch Management

Verify all the scheduled batches are completed or terminated.

Scheduler Service (Application Scheduler)

Disable Schedules before stopping the servers and performing the upgrade. This is 
performed only once and not on every node. The Schedules will need to be 
manually enabled following the upgrade.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Scheduling Service Object.

4. Select the Service Definition aspect.

5. Click the Configuration tab.

6. Clear the Enabled check box and click Apply.

Calculations Service

Disable Calculations before stopping the servers and performing the upgrade. This 
is performed only once and not on every node. The Calculations will need to be 
manually enabled following the upgrade.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Calculations Service Object.

4. Select the Service Definition aspect.

Message General Properties

Replace CR LF for Incoming 
Messages

Checked or Unchecked (circle one)

Table 2. SMS and e-mail Messaging GSM Hardware Setup Worksheet (Continued)

Item Setting/Value
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5. Click the Configuration tab.

6. Clear the Enabled check box and click Apply.

Basic History Service Data

To save Basic History Service data:

1. Stop the Basic History Server from the Service Structure by the following 
procedure:

a. Open a Plant Explorer Workplace. 

b. Use the Structure Browser to open the Service Structure.

c. Select the Basic History, Service > Basic, Service Group.

d. Select the Service Group Definition aspect.

e. Click the Configuration tab.

f. Clear the Enabled check box and click Apply.

2. Use Windows Backup (not the 800xA Backup) to backup the files in the:

...\OperateITData\History\{provider ID}

directory.

3. Start the Basic History Server manually again from the Service Structure 
following the upgrade.

Process Engineering Tool Integration

Back up Process Engineering Tool Integration information. The project data is 
located in the following directory:

...\Program Files\ABB Industrial IT\Engineer 
IT\Engineering Studio\Process Engineering Tool 
Integration\Xml

Back up the Basic History folder for each Basic History Service Provider in the 
Service Structure. Depending on the system, the Basic History Service data can 
be present on a number of different node types (Connectivity Servers, IM Servers, 
AO Servers, etc.). It is best to search for the directory described in this procedure 
on all nodes, and if there is data present, back up that data.
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Save the entire Xml data directory to a safe media such as a network share or 
removable disk. The directory contains the default mapping files (*.dmf) modified 
on the project, accelerator files (*.acc), and configuration files (*.pcf and *.fcf). 

Requirements for VB Graphics Extension Software

Installing Visual BASIC 6.0 with SP6

All nodes that use the Graphics Builder and the Primary Aspect Server node need a 
Professional or Enterprise Edition of Microsoft Visual BASIC 6.0 with SP6. The 
licensed copy used on the 800xA 5.0 SP2 System must be installed on the 800xA 
5.1 System. Follow the installation procedure provided with Visual BASIC.

Perform these procedures only if the restored system makes use of VB graphics.

• Installing Visual BASIC 6.0 with SP6 must be followed for all nodes that use 
Graphics Builder and the Primary Aspect Server node. This must be done 
before performing the procedures under Perform the 800xA System Restore.

• Installing the VB Graphics Extension Software must be followed for each VB 
Graphics extension software package on all nodes in the 800xA 5.1 System, 
if the base product was installed on the 800xA 5.0 SP2 System. This must 
be done before performing the procedures under Perform the 800xA System 
Restore.

To deploy VB Graphics, the user must belong to the Application Engineer 
IndustrialIT user group and Windows Local Administrators.

Refer to System 800xA Engineering, Process Graphics Migration Tool for 
information on migrating VB Graphics to Process Graphics 2.

Use of an Aero Theme with the Workstation Operating System will lead to screen 
latency issues in the VB Graphics Builder. This is because the Aero theme uses 
advanced rendering schemes. Turn off the Windows Aero theme and switch to 
either none or Windows Classic for use of VB Graphics. The behavior of VB IDE 
in the Workstation Operating System will then be the same as that in Windows 
XP.
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Installing the VB Graphics Extension Software

Perform the following procedure to install the VB Graphics extension software on 
all nodes in the 800xA 5.1 System, if the base product was installed on the 800xA 
5.0 SP2 System.

1. Insert System Installation DVD 5 into the drive.

2. Wait for the Installation AUTORUN screen to appear. 

3. Select:

Manual Installation > VB Graphics Extensions (see Figure 7)

4. Select a VB Graphics extension to install (the installation of the Batch 
Management VB Graphics extensions is described later in this procedure).

5. The Installation Wizard for the selected VB Graphics extension appears. 

6. Follow the Installation Wizard to complete the installation. Choose Typical as 
the installation type.

7. Repeat the procedure for each required VB Graphics extension that appears in 
the Installation AUTORUN Screen.

8. This step only applies to the VB Graphics extensions for Batch Management 
when using System Installer to upgrade the 800xA System. If Batch 
Management was installed manually during the upgrade, the VB Graphics 
extensions for Batch Management were installed at that time.

a. Select:

Manual Installation > Batch Management

b. The Installation Wizard for Batch Management appears. 
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c. Select Modify when the dialog box appears that offers that choice.

d. Select to install the Batch Management VB Graphics extensions in the 
Installation Type dialog box.

e. Follow the Installation Wizard to complete the installation.

Figure 7. Installation AUTORUN Screen



Section 3  Upgrading 800xA 5.0 SP2 to 800xA 5.1 Online Post Upgrade Procedures

3BSE036342-511 G 105

 

Post Upgrade Procedures
The remainder of this section describes how to:

• Migrate the Structured Data Logger SQL Database.
• Restore the backups of the IEC 61850 CET OPC Server projects.
• Restore historical data.
• Restore the necessary data for each Functional Area.

Migrating the Structured Data Logger SQL Database

Perform the following post upgrade procedure for Structured Data Logger (SDL).

1. Open Microsoft SQL Management Studio and connect to the 
SDL_INSTANCE server.

2. Delete SDL database from SDL_INSTANCE if already created during the 
installation.

3. Restore the SDL database using the .bak file (from SQL Server 2000) that was 
stored to a safe location during the pre-upgrade process.

a. Right-click Databases and select Restore Database… from the context 
menu.

b. Select the From Device option and browse for the .bak file that was stored 
to a safe location during the pre-upgrade process.

c. Select/Enter SDL in To database and click OK.

4. Use Windows Explorer to navigate to:

...\Operate IT\Structured Data Logger\vbs

5. Double-click RunCreateScripts_SDL.vbs. This will upgrade the SDL 
database schema.

6. Verify that the SDL Control Application exists in the system and that the SDL 
Log aspects contain data.

Upgrading SDL from 800xA 5.0 SP2 to 800xA 5.1 involves transfer of database 
data from SQL Server 2000 to SQL Server 2008.
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IEC 61850 Connect

Restore the backups of the IEC 61850 CET OPC Server projects. Refer to the topic 
CET Project Maintenance in the System 800xA IEC 61850 Configuration 
(9ARD171387*) user manual to import CET OPC Server projects.

Customized Alarm Priority Mapping Aspects

Some customized Alarm Priority Mapping Aspects may have been overwritten 
during the upgrade. Recreate the Alarm Priority Mapping Aspects using the data 
recorded during Customized Alarm Priority Mapping Aspects on page 83.

Reconfiguring Group Displays

New Group Display aspects that are created and configured in the Object Type 
Structure on the object types and instances in 800xA 5.1 will work correctly even if 
there is more than one aspect with the same name but each aspect has a different 
Aspect Category.

Configured Group Display aspects that existed in the Object Type Structure and 
on the object types and instances in 800xA 5.0 SP2 should have their Aspect 
Categories reconfigured for the aspects to display correctly. (This is required for the 
reference to an aspect to be stored along with its Category ID.)

Upgrading Faceplates

The Faceplate aspects created in all versions prior to 800xA 5.1 use a different 
method to identify the references to faceplate elements or other properties than 
those in 800xA 5.1.

Upgrading a faceplate is optional, but is strongly recommended for the following 
reasons:

• Better runtime performance, as no name server access is required when a 
faceplate is opened.

• More reliable because the references continue to work even if the target object 
is renamed.

Handling of IET/CCT projects and PCM 600 projects is not described here as 
they are external tools contributing to the IEC 61850 workflow. They do not 
reside on 800xA System nodes.
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• Upgraded faceplates function efficiently with the Consistency Checker and 
Reference Tool. This behaves similar to a Process Graphics 2 graphic aspect.

• The upgrade to new reference handling can also repair some broken references.

Refer to the Upgrading Faceplates appendix in System 800xA Engineering Process 
Graphics (3BSE049230*) for the procedure to upgrade the faceplates.

800xA for AC 800M

Perform the following procedure to restore 800xA for AC 800M information:

1. Use the OPC Server Setup Wizard to enter the previously used and recorded 
service account settings.

2. Control Builder stores its settings (systemsetup.sys) on disk in the following 
directory:

...\ABB Industrial IT Data\Engineer IT Data\Control 
Builder M Professional

Copy the previously saved file from the safe media to this folder.

3. The OPC Server stores configuration files (*.cfg) and settings 
(systemsetup.sys) on disk. Add the files saved on the safe media to the system. 
The systemsetup.sys file is located in:

...\ABB Industrial IT Data\Control IT Data\OPC Server 
for AC 800M

The configuration files are stored in the Files folder in the same location.

4. Select File > Load Configuration to restore OPC configurations in the OPC 
Server Panel.

Engineering Studio

Perform the following post upgrade procedures for Engineering Studio:

• Check and Repair AES Variable Table.
• Upgrade Diagram References and Diagram Variables.
• Engineering Studio Function Designer System Extensions
• Deleting Engineering Base Service from the Service Structure.
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Check and Repair AES Variable Table

The Check and Repair AES Variable Table (Applications, Controllers, 
Diagrams/SCMs, and Diagram (Cm) Types) function can be used to:

• Correct possible inconsistent data used for display of online values and external 
cross references.

• Delete obsolete data and reduce aspect size.

Perform the following procedure to use this application.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Object Type Structure.

3. Use the Object Browser to navigate to:

Object Types > Functional Planning > Settings

4. Select Function Upgrade in the Aspect List Area to open the Function 
Upgrade aspect in the Preview Area.

5. Select the Check and Repair AES Variable Table (Applications, 
Controllers, Diagrams/SCMs, and Diagram (Cm) Types) check box and 
click Apply.

6. Click Run Upgrade to perform this upgrade.

Upgrade Diagram References and Diagram Variables

In the 800xA 5.1 System (opposite to the 800xA 5.0 SP2 System) Diagram 
References and Diagram Variables are by default created as Symbol Objects. This is 
not true for Diagram References and Diagram Variables created during upgrade 
(restore) from 800xA 5.0 SP2 Systems. Convert them from Aspect Objects to 
Symbol Objects by use of the conversion function described in the following 
procedure.

1. Open a Plant Explorer Workplace.

Executing the Check and Repair AES Variable Table procedure makes the 
environment support work for Function Designer.

Differences between Aspect Objects and Symbol Objects are described in System 
800xA Engineering, Engineering Studio Function Designer (3BDS011224*).
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2. Use the Structure Selector to open the Object Type Structure.

3. Use the Object Browser to navigate to:

Object Types > Functional Planning > Settings

4. Select Function Upgrade in the Aspect List Area to open the Function 
Upgrade aspect in the Preview Area.

5. Select the Convert Diagram References/Variables from Aspect Objects to 
Symbol Objects check box and click Apply.

6. Click Run Upgrade to perform the upgrade.

Engineering Studio Function Designer System Extensions

Refer to Engineering Studio Function Designer System Extensions on page 85 and 
recreate the configuration changes that were recorded before the upgrade.

Deleting Engineering Base Service from the Service Structure

When the 800xA System is running, delete the Engineering Base Service from the 
Service Structure.

1. Use Windows Explorer to navigate to the following directory:

...\Program Files (x86)\ABB Industrial IT\Engineer IT\
Engineering Studio\DocumentParameterManager\
bin\support

2. Double-click EbServiceCleanUpUtil.exe to delete the service.

This function is not suitable in the case of additional aspects on input/output 
references, e.g. Graphic Elements, for typical diagrams with input/output 
references that will get copied and connected via the Bulk Data Manager.

After the System is upgraded, some of the Function Diagrams appear in the 
modified state. This is due to the modification of Standard and BU specific 
libraries whose blocks are instantiated in the Function diagrams. Perform 
configuration data generation for such Function Diagrams.

The following are some of the instances were Function Diagrams are modified 
when there are:
• Changes in properties of the parameter except FDport in the Control and 

Function block type. 

• Change in the CMT type.
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Device Management and Fieldbuses

Perform the post upgrade procedures for Device Management and Fieldbuses.

Device Library Wizard

Perform the following post upgrade procedures for Device Library Wizard.

Restore Device Types

Third party software, such as Device Type Managers for the Device Type must be 
reinstalled since the hard drive of the 800xA System node has been reformatted.

The following steps for Fieldbus Device Types need to be carried out on every 
800xA system node. Perform the System Restore Wizard procedure on the nodes in 
the following sequence:

• Aspect Servers (including redundant Aspect Servers).
• Connectivity Servers (including redundant Connectivity Servers).
• Application Servers.
• Clients.

1. Start the Device Library Wizard. Select:

Restore the Device Types on the Primary Aspect Server node before starting to 
install them on other system nodes. Do not run parallel installations of Device 
Types on other system nodes unless all Device Types are restored on the Primary 
Aspect Server node. Installation of Device Types on other system nodes can be 
done in parallel after they are restored on the Primary Aspect Server node.

If the system contains FOUNDATION Fieldbus Device Types, check the 
following before proceeding to the next step:

• Open a Plant Explorer Workplace.

• Use the Structure Selector to open the Object Type Structure > FF 
Libraries.

• Check to see if there is more than one entry of FF H1 Device Library, 
FF Object Type Group.

• If there is more than one entry, perform FF Upload once so there is only one 
instance of FF H1 Device Library, FF Object Type Group 
present. If there is only one entry, proceed to the next step using the Device 
Library Wizard.
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Start > All Programs > ABB Industrial IT 800xA > Device Mgmt > 
Device Library Wizard

-or-

double-click the Device Library Wizard icon on the desktop.

2. Select the Enable Trace File check box as shown in Figure 8 from the path:

Device Library Wizard > Device Library Wizard Administration > 
Diagnostics

3. Navigate to:

If the Device Library Wizard - Client has not been connected to the Device 
Library Wizard - Server, navigate first to:

Device Library Wizard Administration > Connect Client

and follow the Device Library Wizard Procedure

Figure 8. Enabling the Trace File
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Device Type Administration > System Restore Wizard

4. Choose the second option in the System Restore Wizard as shown in Figure 9 
and click Next.

5. Choose the first option as shown in Figure 10 and click Next.

Figure 9. System Restore Wizard (1)

Figure 10. System Restore Wizard (2)
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6. Depending on which fieldbus protocol is used in the previous system version 
environment, insert one of the delivered Device Library system DVDs in the 
DVD drive (e.g. Device Library HART – DVD).

7. Click Browse and navigate to the DVD drive.

8. When the drive has been selected in the Browse for folder dialog box, click OK 
in that dialog box and then Next in the ABB Device Library Wizard. This step 
may take one or two minutes to complete.

9. The Device Library Wizard scans the 800xA System for fieldbus device types 
that are already used and compares the results with the contents of the DVD. 
Device Types available in the 800xA System and the DVD are shown in the 
Extract tab of the Device Library Wizard (Figure 11).

10. Device Types available in the 800xA System but not on the DVD are displayed 
in the Missing tab. If there are any Device Types showing in the Missing tab, 
navigate to the Browse dialog box by clicking Back and inserting a new Device 
Library DVD in the DVD drive. 

11. Click Next to start the extraction process.

12. Repeat Step 6 to Step 11 for each fieldbus protocol if more than one fieldbus 
protocol is used.

Figure 11. Extract Device Type Files
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13. There may be some Object Types that are either customer created, or are the 
latest Device Types downloaded from ABB SolutionsBank. These will not be 
available on the DVDs. The Device Library Wizard will prepare a list for these 
Device Types (Figure 12). Install these Device Types manually.

14. Repeat this procedure until all Device Types are extracted to the 800xA System 
node and the Missing tab does not list any device types.

15. If the Device Library DVDs do not contain all Device Types used in the 
previous system version, the missing Device Types must be downloaded from 
ABB SolutionsBank.

Figure 12. List of Files to be Manually Installed

During extraction, if a dialog box pops up asking for an overwrite, select No and 
continue.

It is only possible to complete the Wizard if all Device Types have been 
successfully extracted.
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16. When the extraction process is completed successfully, the Device Types need 
to be re-installed on the 800xA System node. Click Next to launch the Re-
installation of Device Types dialog box shown in Figure 13.

17. Follow the Device Library Wizard procedure to complete the installation. The 
Device Library Wizard will automatically navigate to the main window after 
the process is completed.

18. Exit the Device Library Wizard and repeat the procedure on the other 800xA 
System nodes, if applicable.

19. Perform the Configure OPC P/H Server on the 800xA 5.1 Primary Aspect 
Server.

Figure 13. Re-install Device Types Dialog Box

If, during installation the Device Library Wizard main window becomes hidden 
in the background:
• Open Windows Task Manager.

• Select the Device Library Wizard in the Applications tab.

• Select: Windows > Bring to Front
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Device Management PROFIBUS & HART

Perform the following post upgrade procedures for Device Management 
PROFIBUS & HART.

Compressing Aspect Data

The aspect data in the system is compressed using the Data Compression Tool. This 
tool is available from System 800xA 5.1 Feature Pack 4 Revision D and System 
800xA Revision D (see Figure 14).

After the system upgrade, perform the following to compress the aspect data using 
the Data Compression Tool:

1. Double-click and open the Data Compression Tool from the following location:

C:\Program Files (x86)\ABBIndustrialIT\EngineerIT\FieldbusBuilder
\bin\DMAspectDataCompression.exe

The Data Compression Tool is opened as shown in Figure 14.

AC800M Connect and AC800M High Integrity system extensions must be loaded 
before loading PROFIBUS Device Integration Library - Basic and HART Device 
Integration Library - Basic system extension. Therefore, install AC800M Connect 
and AC800M high Integrity also when installing Device Management 
PROFIBUS and HART.

The callouts in Figure 14 represent the corresponding steps in this procedure.
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 2. Select Control Network on the Data Compression Tool. 

3. Expand the Control Network group and select a project or a controller from 
the list.

4. Click BrowsePath to browse and select a folder location to save the .csv file.

5. Click Compress to compress the aspect data. 

A message will be displayed stating the actual number of device instances in 
the project and the actual number of device instances that are compressed using 
the tool as shown in Figure 15.

Figure 14. Data Compression Tool
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The Data written successfully in the following path: <path specified in Step 4> 
will be displayed at the bottom of the tool upon successful completion of aspect 
data compression as shown in Figure 16.

6. Click Exit.

OPC Server PROFIBUS & HART 

After system upgrade, PH OPC service providers may be reconfigured. For more 
information on configuration of PROFIBUS & HART devices (Fieldbus Builder 

Figure 15. Data Compression Details Message

Figure 16. Successful Completion of Device Types Compression
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PROFIBUS/HART, OPC Server, DTM’s and Device Type Objects in 800xA), refer 
to System 800xA Device Management PROFIBUS & HART Configuration 
(3BDD011934*) manual.

License Count Tool

License Count Tool is an User Interface tool that counts and verifies the list of 
licenses for the device types. The User Interface for this tool is available in the 
System 800xA 5.1 Feature Pack 4 Revision E and System 800xA Revision E release 
(see Figure 17).

After the system upgrade, the licenses required for the device types in the new 
system must be checked and verified. 

Perform the following to check the licenses for the device types in the system:

1. Run the License Count Tool from the following location:

C:\Program Files (x86)\ABBIndustrialIT\EngineerIT\FieldbusBuilder
\bin\LicenseCounting.exe

This step must be performed after project upgrade as mentioned in 800xA for AC 
800M Post-upgrade procedures.



Device Management and Fieldbuses Section 3  Upgrading 800xA 5.0 SP2 to 800xA 5.1 Online

120 3BSE036342-511 G

 

2. On the License Counting wizard, expand the Root element, select the Control 
Network, and then click Count License as shown in Figure 17.

A message stating the number of device type instances in the system and the 
number of licenses required is displayed as shown in the Figure 18.

Figure 17. License Count Tool Wizard

If there is more than one control network, you need to individually select the 
network and click Count License to know the number of licenses used per 
control network.

Figure 18. License Count Message
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3. Perform the following to verify the number of licenses used in the system:

a. Open a Plant Explorer workplace.

b. Use the structure selector to select the Control Structure.

c. Click Root and select License Usage in the Aspect List area.

d. Check the number of licenses used in the system for the 800xA 
FIELDBUS Profibus and Hart feature. Refer to Figure 19 for more 
information.

Figure 19. License Usage Aspect in Control Structure

The number of licenses displayed by the License Count Tool and the number 
displayed against the License Usage aspect in the Control Structure must be the 
same.
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Device Management FOUNDATION Fieldbus

Perform the following to complete updating Device Management FOUNDATION 
Fieldbus.

1. Update LD 800HSE Linking Devices: Update all LD 800HSE linking devices 
to the latest firmware version released for this system environment following 
the update procedure described in the user instructions for the particular device. 

2. Check, Save, and Upload FF Libraries:

a. Open a Plant Explorer Workplace.

b. Use the Structure Selector to open the Object Type Structure.

c. Use the Object Browser to navigate to:

FF Libraries, Object Type Group

d. Select FF Management in the Aspect List Area.

e. Click Open Project.

f. Check the libraries for plausibility.

g. Exit Fieldbus Builder FF and save changes if prompted to do so.

h. Return to the Plant Explorer Workplace and select FF Upload in the 
Aspect List Area. 

i. If the traffic light symbol shows red, click Upload.

j. The green traffic light symbol indicates that the FF libraries have been 
synchronized.

Do not change the IP address of the OPC server FF during the online plant 
update. Changing the HSE IP address of the PC changes the HSE Default 
Gateway entry in the HSE subnet network configuration dialog, which in turn 
reboots all CI860 at subsequent configuration downloads.

Refer to Field IT, Foundation Fieldbus Linking Device, LD 800HSE, Version 
Table (3BDS009910) in ABB SolutionsBank for the latest linking device 
firmware released for this system environment.

From Downloads Explorer, navigate to:

Control Products and Systems/800xA/Device Management Foundation 
Fieldbus/Foundation Fieldbus Linking Device LD800HSE
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3. Optional: Reconstruct User-made Changes to Library Objects representing FF 
Standard Blocks: 

During upgrade, user-made changes to library objects representing FF 
standard blocks have been overwritten. Important substitutions have been 
logged.

a. If such changes were made, display the substitutions as follows:

– Open a Plant Explorer Workplace.

– Use the Structure Selector to open the Object Type Structure.

– Use the Object Browser to navigate to:

FF Libraries, Object Type Group

– Select FF Upload in the Aspect List Area.

– Select Library Merge Logger tab and read the log.

b. For reconstructing user-made changes, reapply the changes to the library 
objects manually.

4. Check, Save, Commission, and Upload the HSE Subnet.

a. Open a Plant Explorer Workplace.

b. Use the Structure Selector to open the Control Structure.

c. Use the Object Browser to navigate to:

HSE Subnet

d. Select FF Management in the Aspect List Area.

e. Click Open Project.

f. Check to see if the configured HSE subnet ID is used for the OPC Server 
FF configuration in FF Network > Properties and modify it if required.

g. Check whole project for plausibility.

This step is only required if changes were made to library objects representing FF 
standard blocks.

Perform the following procedure for each HSE Subnet.
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h. If required, perform device assignment for all linking devices LD 
800HSE. Typically, no device assignment is lost during the upgrade.

i. If required, perform precommissioning/commissioning for all objects for 
which this is necessary (discernible from engineering status). A 
precommissioning may be required if the firmware has been 
changed.

j. Exit Fieldbus Builder FF and save changes if prompted to do so.

k. Return to the Plant Explorer Workplace and select FF Upload in the 
Aspect List Area.

l. If the traffic light symbol shows red, click Upload HSE Subnet.

m. The green traffic light symbol indicates that the HSE Subnet has been 
synchronized.

5. Check whether the blocks of used devices from 800xA 5.0 SP2 use the 
datatype bitstring and that the value is uploaded into the configuration 
database. Upload these parameters from the device to the configuration 
database again. 

Perform the following procedure for each HSE Subnet:

a. Open a Plant Explorer Workplace.

b. Use the Structure Selector to open the Control Structure.

c. Use the Object Browser to navigate to HSE Subnet.

d. Select FF Management in the Aspect List Area.

e. Click Open Project to open the subnet in FBB FF.

f. Identify the devices containing Function Block with Parameter datatype as 
bitstring.

g. Upload all parameters of datatype bitstring from the device to the 
configuration database.

To assign all H1 devices in one step, use the Assign all devices function from the 
HSE Subnet context menu: Object > Assign all devices...

For downloading use the online dialog from the HSE Subnet context menu: 
Object > Online Dialog...
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6. Import the locally stored parameter value sets as follows:

a. Open a Plant Explorer Workplace.

b. Use the Structure Selector to open the Object Type Structure. 

c. Use the Object Browser to navigate to: 

      FF Libraries, Object Type Group

d. Select FF Management in the Aspect List Area.

e. Click Open Project to open the FF Libraries project in Fieldbus Builder 
FF.

f. Open the block properties dialog for the Function Block where the 
parameters were exported during the pre-upgrade procedure.

g. Right-click on the dialog box and select Import from the context menu.

h. Browse the .csv file and restore the value sets.

i. Right-click and select Store parameter value set from the context menu.

j. Specify an appropriate name for the new value set and click OK.

k. Click Cancel. Do NOT overwrite the Initial Instance Parameters with the 
imported parameters, and then close the block properties dialog box. 

PROFINET IO Feature Pack 1.2

Some settings on CI871 are reset to default values when performing the upgrade of 
PROFINET IO Feature Pack 1.2 to 800xA 5.1. The following are affected:

• Default Gateway.
• Red.Eth.recovery time.
• Watchdog factor.

Check the CI871 settings after upgrade and enter the previous values if the settings 
are changed. 

Ensure that the stored value sets are imported to the corresponding Function 
Blocks.
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800xA for Advant Master and 800xA for Safeguard 

Perform the following post upgrade procedures for 800xA for Advant Master and 
800xA for Safeguard.
• Copy the Advant Master Controller Licenses.txt.
• Update the Configuration Files.
• Copy the DATHR Files.
• Reconfigure RTA Board Control Aspect Settings.

Copy the Advant Master Controller Licenses.txt

Perform the following on the Primary Aspect Server in the 800xA 5.1 System:

1. Copy the following updated file:

– Advant Master Controller Licenses.txt

The default location to copy the file in the 800xA 5.1 system:

For 64-bit:

...\Program Files (x86)\ABB Industrial IT\Operate 
IT\AC 400 Connect\Licenses

For 32-bit:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\Licenses

Update the Configuration Files

For each Connectivity Server, compare the following files saved in a safe location 
during the 800xA for Advant Master pre upgrade phase:

• AdvDsMasterAdapter.csv

• AdvMbAeOPCServer.csv

with the installed version of the files at the following location:

For 64-bit:

...\Program Files (x86)\ABB Industrial IT\Operate IT\AC 400 
Connect\Bin
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For 32-bit:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\Bin

If any customization was done to the old files, update the installed version of the 
files with the corresponding changes.

Copy the DATHR Files

Perform the following on each Connectivity Server node:

1. Copy the saved files:

– DATHR1.CD
– DATHR2.CD
– DATHR3.CD

to the folder:

...\ProgramData\ABB\AC400Connect\AdvantBase\Data\
RTA\Init\

to the node where they belong.

Reconfigure RTA Board Control Aspect Settings

1. Open the MB 300 RTA Settings dialog box in Configuration Wizard and 
reconfigure:

– MB 300 Node and Network Numbers.

– Check 800xA as Clock Master (REVERSED_SYNC_MODE) in case 
the time synchronization key REVERSED_SYNC_MODE was 
previously enabled.

If the RTA board IP is configured different than the default IP (172.16.168.50), 
change the RTA board IP in the registry of Advant Connectivity Server before 
proceeding.

Path: HKEY_LOCAL_MACHINE > SYSTEM > CurrentControlSet > 
Services > PU410 > Parameters > slvBoard

Change the IP in string IPAddress.
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2. Always Restart the RTA board.

3. The Audible property must be 0 for events and 1 for alarms 800xA for Advant 
Master version 4.1 SP1 RU6 and newer. Refer to System 800xA Configuration 
(3BDS011222*) for configuration of audible alarms.

Safeguard standardevent 300 - 326 does not comply with this rule before 
800xA for 800xA for Advant Master Version 5.0 SP2. The Event numbers 
where the Audible property should be changed from 1 to 0 are:

– EVENT302.
– EVENT305.
– EVENT310.
– EVENT312.
– EVENT320.
– EVENT321.
– EVENT322.
– EVENT325.

800xA for Harmony

Use the following procedure to restore 800xA for Harmony information:

1. Log in to the 800xA Installing User account (or a local Administrator account) 
on the Configuration Server or Configuration Server with Connectivity Server 
node.

2. Restore the 800xA for Harmony Configuration information that was saved 
during 800xA for Harmony on page 90.

a. Select:

Start > All Programs > ABB Industrial IT 800xA > 800xA for OCS 
Systems > Harmony > Configuration > Restore Configuration

b. Click Connect in the Harmony Connect Configuration Backup/Restore 
window.

c. Enter the name of the Harmony Configuration Server database backup file 
in the Backup File field.

d. Click Restore.
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e. If a prompt appears indicating that the system version does not match the 
backup version, click Yes.

f. If the message Services must be stopped, REBOOT system now 
then restart this application! is displayed, restart the node and 
repeat Step a through Step e.

g. The Backup/Restore program compares the old configuration in the 
backup file to the current configuration of the newly installed system. If 
the hosts of the Primary and Redundant Connectivity Servers do not 
match, a dialog box will appear allowing the user to map the old 
Connectivity Server node names to the new Connectivity Server node 
names.

h. Leave the Create Missing Servers in Installed Configuration (Disaster 
Recovery) check box disabled.

i. Click Exit when the restore operation is complete.

800xA for AC 870P/Melody

Perform the following post upgrade procedures for 800xA for AC 870P/Melody.

• Restore 800xA for AC 870P/Melody Information.
• Additional 800xA for AC 870P/Melody Configuration Steps.

Restore 800xA for AC 870P/Melody Information

Perform the following procedure to restore 800xA for AC 870P/Melody 
information:

1. Log in to the 800xA Installing User account (or a local Administrator account) 
on the Configuration Server node.

Restore existing backups for project specific changes (if available) for: (Refer 
also to 800xA for AC 870P/Melody on page 92.)
• DHCP Server Configuration.

• ETC Host files for 800xA for AC 870P/Melody Connectivity Servers.

• Changes in the Default Object Types.

• ConvDB changes of the Configuration Server.
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2. Restore the 800xA for AC 870P/Melody Configuration information that was 
saved during 800xA for AC 870P/Melody on page 92.

a. Select:

Start > All Programs > ABB Industrial IT 800xA > 800xA for AC 
870P Melody > Configuration > Restore Configuration

b. Click Connect in the Melody Connect Configuration Backup/Restore 
window.

c. Enter the name of the Melody Configuration Server database backup file 
in the Backup File field.

d. Click Restore.

e. If a prompt appears indicating that the system version does not match the 
backup version, click OK.

f. If the message Services must be stopped, REBOOT system now 
then restart this application! is displayed, restart the node and 
repeat Step a through Step e.

g. Click Exit when the restore operation is complete.

Additional 800xA for AC 870P/Melody Configuration Steps

Perform the following configuration steps after adding the 800xA for 
AC 870P/Melody Configuration Server to the 800xA System.

1. Melody Executive Service Provider.

2. Tag Importer.

3. Enable the Melody AutoConfigurator service in Plant Explorer > Service 
Structure.

4. Replication Monitor Internet Explorer Security Settings.

If there are specific faceplates in use (process industries or utilities), the 
faceplates must also be upgraded. Refer to the faceplate related documents for 
further instructions.

Information on performing these additional configuration steps can be found in 
800xA for AC 870P/Melody Configuration (3BDD011741*) and System 800xA 
Post Installation (3BUA000156*).
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Perform the following configuration steps after adding each 800xA for AC 
870P/Melody Connectivity Server to the 800xA System.

1. Melody Executive Service Provider.

2. OPC Data Source Definition.

3. Alarm and Event Provider Setup.

4. Replication Monitor Internet Explorer Security Settings.

800xA for MOD 300

1. Re-initialize PAS System Services on the Connectivity Server.

2. Initialize the OMF settings to start system services. Use the Administrative 
Tools in Windows Control Panel to select:

PAS > Settings

This displays the Communications Configuration Tool.

a. Select Yes at the message 

Would you like to revert back to saved settings?

This opens the Communication Settings display.

b. Select OK on the Communication Settings display to save the settings and 
close the window.

c. Select OK to the message:

Settings have been saved . ...

d. Select OK when the message appears that indicates the settings have been 
changed. A restart is always required if the Control Network Setting, OMF 
Memory, or TCP/IP enabled setting are changed.

The PAS System Services will not start until the communications settings are 
initialized as described in the following steps.

The message: 

Would you like to revert back to saved settings?

is displayed if settings were previously saved. To restore the previous settings, 
perform Step a through Step d.
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3. Restart Windows at this time. 

4. Reverse_Time synch will be disabled following the re-installation of PAS. If 
the Connectivity Server node sets the time on the Real-Time Accelerator Board 
(RTAB), Reverse_Time_Synch must be enabled. Refer to the 800xA for 
MOD 300 section in System 800xA Post Installation (3BUA000156*).

5. If any objects were customized, those changes must be implemented again on 
objects delivered with 800xA for MOD 300 Version 5.1.

6. Update the registry settings previously recorded. Refer to 800xA for MOD 300 
Configuration (3BUR002417*).

PLC Connect

Perform the following post upgrade procedures for PLC Connect.

Modify Installation for IEC 60870 or Basic Project Objects

If either the IEC 60870 or Basic Project Objects features were installed:

1. Use standard Windows procedures to access Programs and Features in 
Windows Control Panel. 

2. Select ABB PLC Connect. 

3. Select Change/Modify.

4. The InstallShield Wizard for PLC Connect appears. Refer to System 800xA 
Manual Installation (3BSE034678*) to select and install the desired features.

5. If the IEC60870 feature is installed refer to System 800xA PLC Connect 
Configuration (3BSE035041*) and reload the saved IEC configuration.

Restoring the Pretreat dll

To restore the Pretreat dll:

1. If the PLC Connect Communication Server Pre Treatment function is being 
used in the application, copy the Pretreat dll file (Pretreat3.dll or Pretreat4.dll) 
from the backup location to the same folder as it was backed up from on the 
PLC Connect Connectivity Server. If the default folder is used, that location is:
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...\ABB Industrial IT\Operate IT\PLC Connect\Bin

2. Register the Pretreat dll file (refer to System 800xA PLC Connect 
Configuration (3BSE035041*) for more information).

3. Restart the PLC Connect Connectivity Server for the changes to take effect.

4. Restore the project and source files for the Pretreat dll.

Update the Sattbus Configuration

Perform the following if the Sattbus protocol is used for any of the controllers:

1. Select the PLC Controller Configuration aspect for the controller that uses 
Sattbus protocol and click Edit Driver.

2. Configure the Common System Settings and click OK.

3. Restart the Connectivity Server.

Redeploy the PLC Connect Configuration

To redeploy the PLC Connect configuration:

1. Use the Structure Selector to open the Control Structure in the Plant Explorer 
Workplace.

2. Use the Object Browser to navigate to the first Generic Control Network 
object.

3. Select Deploy in the Aspect List Area.

4. Press the SHIFT key and click Deploy in the Preview Area to ensure that a full 
deploy is done. 

5. The deploy begins and the progress is displayed in the Preview Area. The 
deploy is completed when Deploy ended is displayed.

6. Repeat the procedure for any additional Generic Control Network objects.

Asset Optimization

Use the following procedure after updating Asset Optimization. Perform only the 
steps applicable to the system.
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1. Asset Monitoring: 

a. If Runtime Asset Monitors are being used in the system, restore the 
Runtime Asset Monitor data directory (DeviceRunTimeMSLogicStore) to 
the following directory:

...\Program Files (x86)\ABB Industrial IT\Optimize 
IT\Asset Optimization\AssetMonitorEnvironment\Bin 

b. If XY Profile Deviation Asset Monitors are being used in the system, 
restore the XY Profile Deviation Asset Monitor data directory 
(XY_Reference_Profiles) to the following directory:

...\Program Files (x86)\ABB Industrial IT\Optimize 
IT\Asset Optimization\AssetMonitorEnvironment\Bin

c. If Counter Check Asset Monitors are being used in the system, restore the 
Counter Check Asset Monitors data directory named:

{66E71F7B-90D6-4E62-9881-38388B24CBDF}

from safe media. This directory exists for each AO Server in the system. 
These directories are located in:

<install drive>:\OperateITData\AoEng\<AO Server ID>\
AmCat

Where each <AO Server ID> directory represents one AO Server instance 
from which the directory:

{66E71F7B-90D6-4E62-9881-38388B24CBDF}

was originally saved from. The <AO Server ID> directory name is 
formatted as two consecutive GUIDs, for example:

{F9C150F5-2929-4A12-BC28-E00ED6DB1585}{B925E77F-2A82-
41C6-A981-FAB4386D5701}.

Asset Monitoring directories must be restored on every Asset Optimization 
Server node defined in the system.

The saved data contains the Runtime Asset Monitor data present at the time of the 
save. Use the Runtime Asset Monitor faceplate to reset the Asset Monitors by 
adding the lost time to their accumulated run time or with some known values 
based on other records. Ignore any alarms occurring during the backup.
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2. Maximo Integration:  

a. Refer to System 800xA Asset Optimization Configuration (3BUA000118*) 
to configure ECS.

b. If the MxDef files were customized, restore the MxDef files to the 
following directory:

...\Program Files (x86)\ABB Industrial IT\Optimize 
IT\Asset
Optimization\AOECSConnector\MxDef\

Refer to System 800xA Asset Optimization Configuration (3BUA000118*) 
for more information on MxDef files.

c. Restore the AOMaximoModel file to the following location if the ECS 
model was customized:

...\Program Files (x86)\ABB Industrial IT\Optimize 
IT\Asset Optimization\AOECSConnector\ECSDefinitions

d. Ensure that the ABB Maximo Connectivity system extension is loaded.

3. SAP/PM Integration:  

cpmPlus Enterprise Connectivity Version 4.0 (ECS 4.0) must be installed in order 
to access Maximo Server Version 6.2.

The Maximo Integration information (Maximo Equipment ID and Maximo 
Credentials aspects) must be restored on all Asset Optimization Server nodes. 
Reference the Service Structure for the Asset Optimization Server.

The pending fault reports residing in the system can be restored to the following 
directory structure:

...\OperateITData\OptaoACDs

Restore the entire OptaoACDs folder.

cpmPlus Enterprise Connectivity Version 4.0 (ECS 4.0) must be installed in order 
to access SAP Server Version 4.7.

The SAP/PM Integration information (SAP Equipment ID and SAP Credentials 
aspects) must be restored on all Asset Optimization Server nodes. Reference the 
Service Structure for the Asset Optimization Server.
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a. Refer to System 800xA Asset Optimization Configuration (3BUA000118*) 
to configure ECS.

b. If the SAPDef files were customized, restore the SAPDef files to the 
following directory:

...\Program Files (x86)\ABB Industrial IT\Optimize 
IT\Asset Optimization\AOECSConnector\SAPPMDef

c. Restore the AOSAPModel file to the following location if the ECS model 
was customized:

...\Program Files (x86)\ABB Industrial IT\Optimize 
IT\Asset Optimization\AOECSConnector\ECSDefinitions

Refer to System 800xA Asset Optimization, Configuration (3BUA000118*) for 
more information on SAPDef files.

d. Ensure that the ABB SAP Connect system extension is loaded. 

4. DMS Calibration Integration.

5. Asset Monitors that are assigned (via the Configure option drop-down list box 
on the Asset Monitor Instance on an Object) to a particular AO Server object 
and Asset Optimization Server aspect (by Object name:Aspect name pair), will 
not be correctly configured after the upgrade. The AOServer property will be 
unconfigured and the following error message will appear:

Unable to resolve AO Server for this Asset Monitor 
configuration

The pending fault reports residing in the system can be restored to the following 
directory structure:

...\OperateITData\OptaoACDs

Restore the entire OptaoACDs folder.

The DMS Calibration Integration approach is changed in 800xA 5.1. Upgrade of 
DMS Calibration Integration is not supported. Reconfigure the DMS Calibration 
Integration based on an engineered solution.

Contact ABB technical support for more information.
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This must be resolved before the Asset Monitor Logic can be loaded into an 
AO Server:Asset Optimization Server for execution. Refer to the Object Type 
Structure for Asset Optimization, Object Type Group:AO Server, Object Type.

6. After a restore of a 800xA 5.0 SP2 system, the Asset Optimization Server 
(Monitor Server/Engine) is running. The AO Server tab of the Asset 
Monitoring Server aspect will show a status of good: AM Engine running. 

a. Clicking the Asset Monitors tab and selecting AMs assigned to this AO 
Server will show that the values in the Status column are NOT Loaded, 
enabled. 

b. Click Load all AMs to reload all enabled Asset Monitors assigned to this 
AO Server. 

PC, Network and Software Monitoring

In the 800xA 5.1 and later releases, a set of IT Asset type objects are deprecated. 
The new enhancements, Process Graphics 2 and Native Language Support (NLS), 
are not applied to deprecated IT Asset type objects. Replacements of deprecated IT 
Asset type objects are delivered in PNSM Device Library. It is recommended to 
migrate deprecated IT Asset type objects to PNSM Device Library in case the 
system being upgraded has all Process Graphics 2 graphics and no VB graphics. 
Refer to Appendix H, Mapping of Deprecated IT Asset Object Types.

The following steps describe the migration procedure.

1. Download IT Asset type objects in PNSM Device Library that replaces the 
deprecated IT Asset type objects which are used in the current configuration. 
The download link is http://www.abb.com/controlsystems.

2. Migrate each deprecated IT Asset type object to its replacement IT Asset type 
object in PNSM Device Library

:The Enable Write Access check box must be selected in the Asset Monitor Data 
Source aspect before loading Runtime Asset Monitors into the AO Server. Refer 
to System 800xA Asset Optimization Configuration (3BUA000118*) for more 
information.

Migration from deprecated IT Asset type objects to the PC, Network and 
Software Monitoring Device Library is not mandatory in case the system being 
upgraded already has VB graphics.

http://www.abb.com/controlsystems
http://www.abb.com/controlsystems
http://www.abb.com/controlsystems
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a. Instantiate and configure PNSM Device Library objects.

b. Delete deprecated IT Asset type objects.

3. To upgrade to a newer version of the Light Generic Computer Process object 
type, it is required to delete all old instances and replace them with the newer 
version of the Light Generic Computer Process object type. Refer to the 
Process Monitoring section of System 800xA PC, Network and Software 
Monitoring Configuration.

Perform the following post upgrade procedure for PC, Network and Software 
Monitoring.

1. If user defined Script, Resource, and Assembly files were backed up, copy the 
saved files from the safe media to the following directories:

...\Program Files (x86)\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Scripts\User

...\Program Files (x86)\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Assemblies\User

...\Program Files (x86)\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Resources\User

800xA for Harmony/Melody Connectivity Server Node Update

The following procedure is only applicable to 800xA for Harmony and 800xA for 
Melody Connectivity Server nodes.

Reconfigure all applications referring to deprecated IT Asset type objects. For 
example, Logging of OPC data into history archive.

There are more PC, Network and Software Monitoring steps that need to be 
performed after the system extension maintenance has been performed. Refer to 
PC, Network and Software Monitoring on page 147.

Do not perform this procedure on a server node that is running Shadow OPC 
Server as AfwService.
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Determining the Node Running ShadowOPC Server as AfwService

To identify the node that is running ShadowOPC Server as AfwService:

1. Refer to System 800xA 5.1 PC, Network and Software Monitoring 
Configuration (3BUA000447*) and verify that the Shadow OPC Service is 
configured.

2. Open a Plant Explorer Workplace.

3. Use the Structure Selector to open the Control Structure.

4. Use the Object Browser to navigate to:

IT Server, IT OPC Server Network

5. Select OPC Data Source Definition in the Aspect List Area.

6. Click View in the Preview Area to launch the Service Group Definition dialog.

7. Select service provider from the Providers list.

8. Click View to launch the Service Provider Definition dialog.

9. The Node in the Configuration tab is the name of the node that is running 
ShadowOPC Server as AfwService.

10. Close all dialogs.

Applying the Update

Perform the following procedure on all 800xA for Harmony and 800xA for Melody 
Connectivity Server nodes.

1. Insert the System Version 5.1 Released Documents CD into the drive.

2. Use Windows Explorer to locate and copy ABBShadowOPC.exe.config in 
the Updates directory on the CD.

3. Use Windows Explorer to navigate to the following directory on the local hard 
drive:

...:\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin

4. Make a backup of the existing ABBShadowOPC.exe.config file.
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5. Paste the file copied in Step 2 to the hard drive location navigated to in Step 3.

6. Restart the node.

7. After the restart, use Windows Task Manager to verify the KeepAliveApp.exe 
in not in the list of processes.
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PNSM Device Library Restore Procedure

Perform the following post upgrade procedure for PNSM Device Library:

1. Copy the MOF files from the safe location to the directory, if MOF files were 
backed up:

...\Program Files\ABB Industrial IT\Optimize IT\PC, 
Network and Software Monitoring\MOFS

2. Copy the Custom Asset Monitor dlls from the safe location to the 
following location for object types with Custom Asset Monitors:

...\Program Files\ABB Industrial IT\Optimize 
IT\PC, Network and Software Monitoring\Asset 
Monitoring\Bin

Use the Register.dll bat file present in the Object Type to register this dll 
automatically.

3. Copy the Windows Management Instrumentation (WMI) repository to the 
directory if the files were backed up. Perform the following steps to back up 
and restore the the WMI repository.

a. Right-click Computer and select Manage. Computer Management is 
displayed.

b. Expand Configuration on the left panel. Select WMI Control.

c. Right-click WMI Control and select Properties. The Properties dialog 
box is displayed.

d. Click Backup/Restore Tab.

e. Click Back Up Now..., Specify a name for your backup file 
window is displayed. 
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f. Enter the name of the backup file and click Save.

g. Click Restore Now..., Specify a backup file to restore window 
is displayed.

h. Select the file and click Open to restore the backed up file.

SMS and e-mail Messaging

Reconfigure the GSM Device hardware information recorded in the save operation 
(refer to SMS and e-mail Messaging on page 98).

Figure 20. WMI Backup File

It may be necessary to stop and start the Messenger Server Service in the Service 
Structure after the SMS and e-mail Messaging restore operation.
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Batch Management

Verify that the primary Batch Server is in primary mode (P is displayed in the 
Windows Task bar) and the secondary Batch Server is in secondary mode (S 
displayed in the Windows Task bar). If the proper modes are not displayed, enable 
the Batch Service Group before proceeding.

To enable the Batch Service Group:

1. Open a Plant Explorer Workplace.

2. Select the Service Structure.

3. Select the Services\Batch Service, Service\batch_group_name, Service 
Group\Service Group Definition aspect.

4. Select the Configuration tab.

5. Select the provider that is currently the secondary Batch Server.

6. Select the Enabled check box and click Apply.

7. Select the provider that is currently the primary Batch Server.

8. Select the Enabled check box and click Apply.

Batch data can be reloaded to the batch database from wherever it was archived. 

Perform the following to view any Batch data archived from SV5.0 or previous 
versions of the Batch product:

1. Create a Virtual Machine (VM) node with the existing system version and its 
components.

2. Restore Batch data using the Batch Restore window onto this virtual machine.

Once the restored data is in the batch database, it can be viewed using the Batch 
History Overview window. 

Do not restore directly from CDs or DVDs. Restore from hard disk drives which can 
be restored from CDs or DVDs using commercially available software.

The Batch history archive and restore aspect has been removed in SV5.1.
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Selecting the Alarm Server

To select the Alarm Server:

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Use the Object Browser to select:

Services > Event Collector, Service > 
Batch_AE_Service, Service Group

4. Select Service Group Definition in the Aspect List Area.

5. Select the Special Configuration tab in the Preview Area.

6. Select Produce IT Batch OPC AE Server in the Alarm Server field.

7. Click Apply.

Basic History Service

Restore the Basic History Service data as follows. Perform this procedure on every 
node where the Basic History Service is running.

1. Stop the Basic History Server from the Service Structure by the following 
procedure:

a. Open a Plant Explorer Workplace. 

b. Use the Structure Browser to open the Service Structure. 

c. Select the Basic History, Service > Basic, Service Group. 

d. Select the Service Group Definition aspect. 

e. Click the Configuration tab. 

f. Clear the Enabled check box and click Apply.

2. If it is necessary to keep historical data for the time since the upgraded system 
was started, copy the current Basic History log files in the following directory:

Always perform the Toolbar configuration as described in System 800xA Batch 
Management Configuration and shutdown script procedure as described in the 
Batch Management section of System 800xA Post Installation (3BUA000156*).
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...\OperateITData\History\{provider ID}

to a temporary directory.

These files will be inserted by using the Archive Tool.

3. Delete all files under:

...\OperateITData\History\{provider ID}

4. Restore the files from the backup of Basic History Service Data to:

 ...\OperateITData\History\{provider ID}

5. Start the Basic History Service from the Service Structure.

6. If Step 2 was performed:

a. Open the AdvHtArchiveTool located by default in the following directory:

...\Program Files\ABB Industrial IT\Operate IT\Process 
Portal A \bin

b. Use the File/Select/Open Archive command and browse to the directory 
containing the history log files.

c. Open the Action/Insert Data into Logs command.

d. Accept the default values in the Time Selection dialog box.

e. Click OK to start the insertion of the saved data to the logs.

Calculations Service

Calculations that were disabled prior to the upgrade must be enabled by selecting 
the Enabled check box in the Calculations dialog box. Refer to the section on 
Calculations in System 800xA Information Management Data Access and Reports 
(3BUF001094*). 

To enable the Calculations Service:

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Calculations Service Object.

4. Select the Service Definition aspect.
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5. Click the Configuration tab.

6. Select the Enabled check box and click Apply.

Scheduling Service (Application Scheduler)

Schedules that were disabled prior to the upgrade must be enabled by selecting the 
Enabled check box in the Scheduling dialog box. Refer to the section on 
Scheduling in System 800xA Information Management Data Access and Reports 
(3BUF001094*). 

To enable the Scheduling Service:

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Scheduling Service Object.

4. Select the Service Definition aspect.

5. Click the Configuration tab.

6. Select the Enabled check box and click Apply.

Process Engineering Tool Integration

Use the following procedure after updating Process Engineering Tool Integration:

Restore the backed up data directory (in preparation-step prior to upgrade) to the 
installed directory of Process Engineering Tool Integration. Restore the entire Xml 
directory contents to:

...\Program Files\ABB Industrial IT\Engineer 
IT\Engineering Studio\Process Engineering Tool 
Integration\Xml

Miscellaneous Procedures
Perform the following procedures:

• Upgrade Control Builder M Projects.
• PC, Network and Software Monitoring.
• Add Autostart Shortcut.
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Upgrade Control Builder M Projects

800xA 5.1 Feature Pack 4 has introduced a new (major) version. The 800xA 5.0 
SP2 version of BasicHWlib (5.0-2) and the 800xA 5.1 version of 
BasicHWlib (5.1-0) can coexist with the new version (5.1-1) in the 800xA System, 
and must be used if any controllers are going to stay with the firmware from 800xA 
5.0 SP2 and/or 800xA 5.1.

The Control Builder project upgrade will be started automatically the first time the 
project is opened. It can also be explicitly triggered by starting an empty Control 
Builder and selecting:

Tools > Maintenance > Upgrade Project

During the upgrade Control Builder asks if the user wants to use the new (5.1-1) or 
old (5.0-2 or 5.1-0) BasicHWLib version for the controllers in the project. If the 
intention is to upgrade controller firmware the new version should be selected. If the 
intention is to not upgrade controller firmware the old version must be selected.

PC, Network and Software Monitoring

1. Perform the following steps on the PC, Network and Software Monitoring 
Server node.

a. Use the Structure Selector to open the Service Structure in the Plant 
Explorer Workplace.

b. Use the Object Browser to navigate to the:

Services > OpcDA_Connector, Service > SG_IT Server

object. If there is no object to navigate to, skip to Step l (letter l, not 
number 1).

After upgrading a configuration containing one Engineering and one Production 
system to 800xA 5.1 Feature Pack, the Control Builder M projects in the two 
systems should be made identical using the Import/Export tool, Engineering 
Repository, or by recreating the Engineering System using Backup/Restore 
before engineering work is restarted. Otherwise there will be a lot of false 
differences on the AC 800M aspects reported in the import difference report 
when moving solutions between the systems.
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c. Open the OPCDA_Provider_<servername> object and double-click on the 
Service Provider Definition aspect.

d. On the Configuration tab, clear and select the Enabled check box and 
click Apply. The Current field should change to Service.

e. Use the Structure Selector to open the Control Structure.

f. Use the Object Browser to navigate to the IT Server object.

g. Double-click OPC Data Source Definition in the Aspect List Area.

h. Click on the Service Group drop-down menu and select the SG_IT 
Server.

i. Click on the OPCDA_Provider_<servername> which was configured in 
Step c.

j. Click Apply.

k. Skip to Migrate the IT Asset Monitors (Step 2).

l. Use the Structure Selector to open the Control Structure.

m. Use the Object Browser to navigate to the IT Server object.

n. Double-click OPC Data Source Definition in the Aspect List Area.

o. Select New.

p. Click Add and select the appropriate Service Provider from the list.

q. Click OK twice.

r. Click Apply.

2. Migrate the IT Asset Monitors. If Asset Optimization and PC, Network and 
Software Monitoring were installed on the 800xA 5.0 SP2 System, then the 
following must be done for any existing IT Assets that had IT Asset Monitors 
configured for them. 

a. Use the Find Tool in the Plant Explorer Workplace to locate all the IT 
Asset Monitor aspect instances in the Control Structure.

b. Right-click on each of the found aspects and select Goto Object.
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c. Open the IT Device Manager aspect and click Generate to recreate the IT 
Asset Monitor.

d. Repeat Step c for each object in the Find list.

e. Use the Object Browser to navigate to: 

Root, Domain > Asset Optimization, Asset Optimization > 
AO Server 1, AO Server

f. Select Asset Optimization Server in the Aspect List Area.

g. Select the Enabled check box in the AO Server tab and click Apply.

h. Click Load all AMs in the Asset Monitors tab.

Add Autostart Shortcut

If it is desired to enable the autostart of the Operator Workplace on client nodes, 
perform the following:

1. Define a default workplace.

2. The shortcut must be created from the ABB Workplace login window.

3. The shortcut is located in:

...:\Users\Username\AppData\Roaming\Microsoft\Windows\
Start Menu\Programs\Startup

4. Right-click the shortcut and select Properties from the context menu.

5. Add the following to the shortcut target:

/WS

-or-

/WaitForSystem

6. Click OK.

Basic Computer Monitoring will not upgrade properly from a previous version to 
the current version. Use the Basic Computer Monitoring Configuration Tool to 
recreate the configuration.
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Online Upgrade of a Multisystem Integration System
Perform the following to upgrade a Multisystem Integration 800xA System online. 

1. Refer to Online Upgrade on page 64 and perform all steps for the Subscriber 
System.

2. Refer to Online Upgrade on page 64 and perform all steps for each Provider 
System where it is desired to perform an upgrade.

System Backup
Make complete hard disk and 800xA System backups of the upgraded system.
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Section 4  Upgrading 800xA 5.0 SP2 to
800xA 5.1 Offline

Unless otherwise indicated, the person performing this upgrade must use the same 
user account that was used during the installation of the 800xA System software.

Considerations
The following considerations must be taken into account before performing the 
upgrade.

• Unless otherwise indicated, the person performing this upgrade must use the 
same user account that was used during the installation of the 800xA System 
software.

• To guarantee the functionality of the upgraded system, follow these 
instructions carefully and perform them in a well defined order.

• It is recommended that a disk image be taken of all disks on each node before 
beginning and after completing the upgrade.

• Backing up the aspect directory (800xA System Backup), reports, history data, 
graphics, and other application data is required before performing the upgrade.

Upgrading the 800xA System from 800xA 5.0 SP2 to 800xA 5.1 for systems 
without redundant Aspect and Connectivity Servers requires the plant to be shut 
down. To guarantee the functionality of the upgraded system, follow the upgrade 
instructions for the installed products and perform them in the order presented. 

Refer to the 800xA for Harmony section of System 800xA Release Notes New 
Functions and Known Problems (2PAA106188*) before upgrading an 800xA 4.1 
System if 800xA for Harmony is installed on any node in the system.
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• Take an inventory of all software on all nodes in the 800xA System before 
performing the upgrade.

Control Builder M Compatibility Issues
Refer to the compatibility issues detailed in Appendix B, Control Builder M 
Compatibility Issues before beginning the upgrade.

Upgrade Flow
This section is organized so that the instructions are presented in the proper upgrade 
order. Do not skip any steps that pertain to 800xA software being used in the current 
or upgraded system. Refer to Planning for the Upgrade on page 35 for additional 
information and ideas on how to streamline the upgrade process.

Central Licensing System

System Upgrade
Perform the following to upgrade the 800xA System.

1. Document all Windows settings including the domain, DNS, policies, users, 
etc.

2. Refer to the Diagnostics Collection Tool section in System 800xA Tools 
(2PAA101888*) and run the Software Analyzer from the Primary Aspect 
Server in the 800xA 5.0 SP2 System. This allows for an analysis of the 
software installed on the different nodes in the 800xA System with an 
opportunity to correct errors in the 800xA 5.0 SP2 System before upgrading. 
This is especially helpful when using the System Installer to generate setup 
packages based on the 800xA 5.0 SP2 System. If there is missing or incorrect 
software in that version, the System Installer will duplicate that installation in 
the 800xA 5.1 System.

Order the 800xA licenses required for the current system version and revision. 
The 800xA 5.0 SP2 licenses will not work.
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3. Refer to Appendix D, Consistency Check and perform the necessary 
consistency checks.

4. Refer to Appendix E, Recording the Number of Aspects and Objects and 
record the number of aspects and objects in the system before performing the 
800xA System Backup.

5. It is important to create backups of node hard disks and the 800xA System 
before starting the upgrade procedures. Valid backups insure that the system 
can be restored if necessary.

a. It is recommended that a third party backup/restore and/or disk imaging 
utility be used to save (and restore if necessary) all disks on each node 
before starting the upgrade procedures.

b. This procedure only applies to installations with IEC 61850 Connect 
installed, which use a user-defined Graphic Library for applications. 

While updating from previous system version, it is observed in Functional 
Structure that all PG2 Faceplate Element and PG2 Graphic Element 
aspects have the same name as Faceplate Element. 

Before performing System Backup in the previous system revision, select 
Object Type Structure > IEC61850 user-defined Library and perform the 
following for all PG2 Faceplate Element and PG2 Graphic Element 
aspects of all Conducting Equipment objects: 

– Right-click the aspect and select Details option. 

– In the Aspect info tab, 

- Remove Auto Instantiate aspect and Template aspect. 

- Select the Inheritance Enabled option. 

– Perform Upload operation with the relevant scd file.

Perform a consistency check before performing the 800xA System backup. 
Failure to do so could result in problems when restoring the system after the 
upgrade.

Use the updated scd file if the Step b is performed in running Plant conditions, to 
ensure that there are no disturbances after performing the upload operation.
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c. Perform the 800xA full backup from the Maintenance Structure (Aspect 
Directory backup type).

The 800xA Backup/Restore function makes it possible to make an online 
backup of a node and perform an offline restore of the same node. A full 
backup stores all aspect objects and aspect data (application data) in the 
Aspect Directory.

All system extensions that are part of the system must be installed and 
loaded on the node where the backup will be taken (usually the primary 
Aspect Server node). No changes can be made (especially to the Aspect 
directory) during the 800xA Backup process.

When backing up a system with Environments, both the Production and 
Engineering Environments will be included in the backup. Only the 
current version of each aspect will be included in the backup. This means 
that all version history will be removed.

– Open a Plant Explorer Workplace.

– Use the Structure Selector to open the Maintenance Structure.

– Create a Full Backup Definition object.

– Configure the Scope and Storage tabs.

– Check the disk space and path in the Storage tab. A large configuration 
could require a minimum of five gigabytes of free space.

– Start the backup process.

Avoid engineering or any other changes especially to the Aspect system during 
the 800xA Backup process.

Verify the Batch Management Servers are operating normally before and during 
800xA System backups of systems containing Batch Management nodes. This 
will ensure the backup of all batch data. 

It is only possible to perform the 800xA System backup from the Production 
Environment.
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– Refer to the How to Make a Full Backup topic in System 800xA 
Maintenance (3BSE046784*) for more detailed information on performing 
the 800xA System Backup.

6. Refer to Pre-Upgrade Procedures on page 157 and perform the pre-upgrade 
procedures that are applicable to the installed system.

7. Perform the following procedure to shut down the 800xA System:

a. Stop all external clients to the 800xA System (OPC DA, HDA, and AE 
clients that access the 800xA System) before a system shutdown.

b. From the Configuration Wizard, select System Administration and click 
Next.

c. Select the system to stop and click Next.

d. Select Systems and click Next.

e. From the Systems dialog box, select Stop and click Next.

f. From the Apply Settings dialog box, click Finish.

8. Reformat the hard drives of all 800xA System nodes.

9. Install the new operating system defined for the 800xA 5.1 System on all 
800xA System nodes. Click Advanced when installing the Workstation 
Operating System or the Server Operating System. This is required to delete 
the existing partition and recreate a new one. Failure to perform this step will 
leave old data on the hard drive.

10. Refer to Section 2 - Prerequisites in:

– Manual Upgrades - System 800xA Manual Installation (3BSE034678*).

– Automated Upgrades using System Installer - System 800xA Automated 
Installation (3BSE034679*).

and perform all procedures relating to operating system settings, Windows 
service packs, miscellaneous Windows components installation, other third 

If using the System Installer to perform the upgrade, generate the setup packages 
before shutting down services.

The 800xA System will shut down within a couple of minutes. The time it takes 
to shut down may be more or less depending on the size of the 800xA System.
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party software, group policy, 800xA Service User privileges, and Windows 
updates and hot fixes.

11. Refer to System 800xA Manual Installation (3BSE034678*) and install the 
800xA 5.1 Central Licensing System Server software and install the license 
file, as this will be the Primary Aspect Server in the 800xA 5.1 System. This 
step is not necessary if performing an automated upgrade using System 
Installer.

12. Refer to System 800xA Manual Installation (3BSE034678*) and install all 
800xA 5.1 System software per the software inventory taken earlier. This step 
is not necessary if performing an automated upgrade using System Installer.

13. Refer to Installing the VB Graphics Extension Software on page 176 to install 
Visual BASIC 6.0 with SP6 and the VB Graphics extensions if required.

Feature Pack Functionality______________________________________________________________________

14. Perform the system update to the latest Feature Pack:

• Use the System Feature Pack Update Tool (FUT) to perform the update. Refer 
to the System 800xA 5.1 System Feature Pack Update Tool (2PAA107435*) for 
user instructions.

___________________________________________________________________________________________

15. Refer to Post Upgrade Procedures on page 178 of this instruction and perform 
all necessary steps.

16. Perform all of the procedures described in Miscellaneous Procedures on page 
225.

17. Refer to System 800xA Post Installation (3BUA000156*) and configure 
Windows Services and Windows Firewall.

18. It is important to create backups of node hard disks and the 800xA System after 
completing the upgrade procedures. Valid backups insure that the system can 
be restored if necessary.

a. It is recommended that a third party backup/restore and/or disk imaging 
utility be used to save (and restore if necessary) all disks on each node 
before starting the upgrade procedures.
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b. Perform the 800xA full backup from the Maintenance Structure (Aspect 
Directory backup type).

Pre-Upgrade Procedures
Some 800xA System software requires preparatory steps before shutting down 
800xA System processes. Perform the applicable procedures in the order presented.

Customized Alarm Priority Mapping Aspects

Some customized Alarm Priority Mapping Aspects may be overwritten during the 
upgrade. Record all values in the Alarm Priority Mapping Aspects before beginning 
the upgrade so that they can be recreated after the upgrade.

800xA for AC 800M

Use the following procedure to prepare for the 800xA for AC 800M upgrade:

1. Record the service account settings in the OPC Server Setup Wizard.

2. Control Builder stores its settings (systemsetup.sys) on disk in the following 
directory:

...\ABB Industrial IT Data\Engineer IT Data\Control 
Builder M Professional

Copy this file to a safe media.

3. Save OPC configurations by selecting:

File > Save Configuration

in the OPC Server Panel.

4. The OPC Server stores configuration files (*.cfg) and settings 
(systemsetup.sys) on disk. Copy these files to a safe media. The 
systemsetup.sys file is located in:

...\ABB Industrial IT Data\Control IT Data\OPC Server 
for AC 800M

The configuration files are stored in the Files folder in the same location.
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5. If the system to be upgraded originates from System Baseline 2.1 and has been 
upgraded in steps through system versions, verify that the Control Builder 
projects do not use the old obsolete SB2 (System Baseline 2) libraries (libraries 
of version 1.0-0. For example: ControlStandardLib 1.0/0.

Structured Data Logger

Use the following procedure to prepare for the Structured Data Logger (SDL) 
upgrade.

1. Back up the SQL Server 2000 SDL Database.

a. Open SQL Server Enterprise Manager.

b. Right-click SDL data base and select All Tasks > Backup Database… 
from the context menu.

c. Save the backup file (with .bak extension) to a safe location.

Engineering Studio

Use the following procedures to prepare for the Engineering Studio upgrade.

The Function Designer system extensions:

• Signal Extension for AC800M Connect 

• Function Designer for AC800M Connect 

• Topology Designer for AC800M Connect

• CI Extension for AC800M Connect 

• Signal Extension for TRIO Connect 

• Topology Designer for AC800M High Integrity 

• Function Designer for AC 800M Classic 

• Topology Designer for AC800M Classic 

• Function Designer for Fieldbus Builder Profibus/Hart 

• AC 800M Signal Extension Classic 

mainly consist of:
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• Functional Planning Object Types, including a Function Settings aspect at the 
Settings Object Type Group.

• Extension Libraries that add Function Designer aspects to Object Types 
(Control Modules, Function Blocks, etc.) created by basic libraries (AC800M 
Connect, AC 800M Classic, etc.).

After having loaded such a system extension in the 800xA 5.0 SP2 System, some of 
these aspects may have been modified; for example, to adapt Function Settings, or 
to change the color or layout of Function Blocks in Function Diagrams. During the 
800xA System upgrade to 800xA 5.1 the system extensions of the new system are 
loaded. To keep the information about modified aspects, all aspects that were 
created by a Function Designer system extension, but later on modified are listed in 
the Configuration Wizard log, and are written to Afw files.

The only way to bring these modifications back into the 800xA 5.1 System is to 
manually merge the changes. Do not import the listed Afw files into the 800xA 5.1 
System, because some additional properties/data might get lost. In the case of 
Function Settings, look for each settings property in the 800xA 5.0 SP2 System and 
perform the modifications again in the 800xA 5.1 System. In the case of modified 
Function Aspects (e.g. Diagram Template, Component Template), check the 
modifications done in the 800xA 5.0 SP2 System and perform the modifications 
again in the 800xA 5.1 System.

Engineering Studio Add-Ins

Before updating/upgrading the system from previous release to the latest release 
ensure the Engineering Studio Add-Ins are listed in Active Application Add-Ins in 
MS-Excel. 

If the Add-ins are not listed, perform Step 3 through Step 5 to enable them in the 
MS-Excel:

1. Open MS-Excel.

All the local language parameters used in the Function Designer need to be 
changed to English before the upgrade. Usage of non-English parameters in the 
Function Diagrams results in errors while generating configuration data.
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2. Navigate to File > Excel Options > Add-Ins > Active Application Add-ins. 
Refer to Figure 21 to view the Engineering Studio Add-ins.

3. Select COM Add-ins from Manage drop-down and click Go... List of COM 
Add-ins window appears.

4. Select all the Engineering Studio Add-ins from the list and click OK.

5. View the Add-Ins in the Active Application Add-ins panel on the Excel 
Options window.

Device Management FOUNDATION Fieldbus

Perform the following to prepare for the Device Management FOUNDATION 
Fieldbus upgrade.

• User-Made Modifications to Library Objects Representing FF Standard 
Blocks.

• Exporting Locally Stored Parameter Value Sets.

User-Made Modifications to Library Objects Representing FF Standard Blocks

User-made modifications to library objects representing FF standard blocks (these 
are blocks supported by the Device Type Standard FBs as indicated in the Block 
Info tab of the block class parameter dialog box) will be overwritten during 
upgrade. If such changes have been made, they can be reconstructed manually. 
Refer to Device Management FOUNDATION Fieldbus on page 201.

Figure 21. Engineering Studio Add-Ins
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Exporting Locally Stored Parameter Value Sets

Export the locally stored parameter value sets as follows:

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Object Type Structure. 

3. Use the Object Browser to navigate to: 

      FF Libraries, Object Type Group

4. Select FF Upload in the Aspect List Area.

5. Click Open Library in Fieldbus Builder FF.

6. Select the Function Block from FF Block Library > Function Blocks 
in the Library view.

7. Double-click on the Function Block to open the properties dialog box for the 
chosen Function Block.
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8. Right-click and select Export from the context menu (Figure 22).

9. Specify the name and location of the .csv file and Click OK.

PROFINET IO Feature Pack 1.2

Some settings on CI871 are reset to default values when performing the upgrade of 
PROFINET IO Feature Pack 1.2 to 800xA 5.1. The following are affected:

• Default Gateway.
• Red.Eth.recovery time.
• Watchdog factor.

Figure 22. Exporting Locally Stored Parameter Value Sets
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Check the CI871 settings after upgrade and enter the previous values if the settings 
are changed. 

800xA for Advant Master and 800xA for Safeguard

Perform the following to prepare for the 800xA for Advant Master and 800xA for 
Safeguard upgrade.
• Save the Advant Master Controller Licenses.txt.
• Save the Configuration Files.
• Save the DATHR Files.
• Document the RTA Board Control Aspect Settings.

Save the Advant Master Controller Licenses.txt

Perform the following on the Primary Aspect Server in the 800xA 5.0 SP2 System:

1. Save the following file to a safe location.

– Advant Master Controller Licenses.txt

The default location for the file is:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\Licenses

Save the Configuration Files

The configuration files in the Connectivity Servers can contain special configuration 
settings for Alarm and Event or Data access. Refer to 800xA for Advant Master, 
Configuration (3BSE030340*) for more information about these special 
configuration settings.

If such changes are available in the configuration files, perform the following on 
each 800xA for Advant Master and 800xA for Safeguard Connectivity Server node: 
Save the following files to a safe location:

• AdvDsMasterAdapter.csv

• AdvMbAeOPCServer.csv

The default location for the files is:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\Bin
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Save the DATHR Files

Perform the following on each 800xA for Advant Master and 800xA for Safeguard 
Connectivity Server node:

1. Save the following files to a safe location:

– DATHR1.CD
– DATHR2.CD
– DATHR3.CD

from the folder:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\AdvantBase\Data\RTA\Init\

and record which files belong to which node.

Document the RTA Board Control Aspect Settings

Perform the following on each 800xA for Advant Master and 800xA for Safeguard 
Connectivity Server node:

1. Document the following settings in the RTA Board Control aspect for 
reconfiguration after the upgrade.

– MB300 node and network address.
– 800xA as Clock Master (REVERSED_SYNC_MODE) check box.

800xA for Harmony

Perform the following to prepare for the 800xA for Harmony upgrade.

Disable Harmony Services on 800xA for Harmony Servers

Stop the following 800xA for Harmony services on the 800xA for Harmony Server 
node being upgraded.

1. Select:

Start > Control Panel > Administrative Tools > Services

2. Disable the following services:

– Time synchronization daemon.



Section 4  Upgrading 800xA 5.0 SP2 to 800xA 5.1 Offline 800xA for Harmony

3BSE036342-511 G 165

 

– SoapSymTagAtomSrv.
– EbDataSyncService.
– EbServerBroker.
– ABBDiagnosticService.
– DD_xxxx - Where xxxx identifies the semAPI or hAPI device being used 

(this may or may not exist).

Perform the following steps to disable these services:

a. Locate the service in the Services list.

b. Double-click the service to open the Properties dialog box for that service.

c. Change the Startup type to Disabled.

d. Click Apply and then OK.

e. Repeat for each of the services listed.

3. Restart the 800xA for Harmony Server node.

Save 800xA for Harmony Information

Use the following procedure to save 800xA for Harmony information:

1. Create a backup of the Configuration Server database.

a. Select:

Start > All Programs > ABB Industrial IT 800xA > 800xA for OCS 
Systems > Harmony > Configuration > Backup Configuration

b. Click Connect.

c. Click Browse to name the backup file and choose a location to save it.

d. Click Backup.

e. Click Exit when the backup is complete.
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800xA for AC 870P/Melody

Use the following procedure to save 800xA for AC 870P/Melody information:

1. Log in to the 800xA Service account on the Configuration Server node.

a. Create a backup of the Configuration Server database.

b. Select:

Start > All Programs > ABB Industrial IT 800xA > 800xA for Melody 
> Configuration > Backup Configuration

c. Click Connect.

d. Click Backup.

e. Click Exit when the backup is complete.

800xA for MOD 300

Ensure that the configuration data noted in the Customized Data for Backup 
appendix in 800xA for MOD 300 Configuration (3BUR002417*) has been recorded.

Disable the Melody AutoConfigurator service in Plant Explorer > Service 
Structure (the service must be disabled when the system maintenance backup is 
started).

Back up project specific changes (if applicable):

• DHCP Server Configuration.

• ETC Host files for Melody Connectivity Servers from: 
...\Windows\system32\Drivers

• Changes in the Default Object Types (e.g. manual changes for permissions 
in Control Connection Aspects).

• ConvDB changes only on Configuration Server (change to the directory 
...\Program Files\ABB Industrial IT\Configuration and backup the files 
MELCONVERTER.BAT, ConvDB.mdb and ConvDB_<Hostname>.mdb.

ConfigServer node: Ensure that no Commissioning will be done from the 
Melody Composer during this upgrade. 

Save the backup file to a safe media like a network share or removable disk. 
Otherwise, the file will be deleted once an upgrade occurs due to a reload of the 
node.
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IEC 61850 Connect

Make backups for the IEC 61850 CET OPC Server projects. Refer to the topic CET 
Project Maintenance in the System 800xA IEC 61850 Configuration 
(9ARD171387*) user manual to export CET OPC Server projects.

PLC Connect

1. If the PLC Connect IEC 60870 feature is installed and configured, the IEC 
configuration must be saved. Refer to the section on configuring the IEC 60870 
driver in System 800xA PLC Connect Configuration (3BSE035041*) for more 
information.

2. If the PLC Connect Communication Server Pre Treatment function is being 
used in the application (refer to System 800xA PLC Connect Configuration 
(3BSE035041*) for more information), make a backup of the Pretreat dll 
(Pretreat3.dll or Pretreat4.dll, be sure to select the version used). The Pretreat 
dll is located in the following folder on the PLC Connect Connectivity Server:

...\ABB Industrial IT\Operate IT\PLC Connect\Bin

3. Make a backup of the application project and source files for the Pretreat dll.

Engineering Studio IO Allocation

Deactivate the auto update mode in IO Allocation.

1. Start the Engineering Workplace.

2. Open the IO Allocation tool on any object by right-clicking on the object and 
selecting Advanced > IO Allocation from the context menu that appears.

3. Verify that no check mark symbol is visible in the Options > Autoupdate 
CBM menu item in the IO Allocation tool.

Handling of IET/CCT projects and PCM 600 projects is not described here as 
they are external tools contributing to the IEC 61850 workflow. They do not 
reside on 800xA System nodes.

The path is the default location of the file. If it has been placed somewhere else, 
make a backup from that location.



Asset Optimization Section 4  Upgrading 800xA 5.0 SP2 to 800xA 5.1 Offline

168 3BSE036342-511 G

 

Asset Optimization

Preparing for the Asset Optimization upgrade requires backing up data to a safe 
media.

Use the following procedure to back up Asset Optimization information (perform 
only the steps applicable to the system):

1. Asset Monitoring:

a. If Runtime Asset Monitors are being used in the system, save the Runtime 
Asset Monitor data directory (DeviceRunTimeMSLogicStore) to a safe 
media. This directory stores the runtime information calculated by the 
Runtime Asset Monitors running in this node. This directory is located in:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AssetMonitorEnvironment\Bin

b. If XY Profile Deviation Asset Monitors are being used in the system, save 
the XY Profile Deviation Asset Monitor data directory 
(XY_Reference_Profiles) to a safe media. This directory is located in:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AssetMonitorEnvironment\Bin

c. If Counter Check Asset Monitors are being used in the system, save the 
Counter Check Asset Monitors data directory named:

{66E71F7B-90D6-4E62-9881-38388B24CBDF}

to safe media. This directory exists for each AO Server in the system. 
These directories are located in:

<install drive>:\OperateITData\AoEng\<AO Server ID>\
AmCat\<Counter Check ID>

Where each <AO Server ID> directory represents one AO Server instance 
running on the selected node. The <AO Server ID> directory name is 
formatted as two consecutive GUIDs, for example:

Asset Monitoring directories will be found on every Asset Optimization Server 
node and any other node defined as an Asset Monitoring Server.
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{F9C150F5-2929-4A12-BC28-E00ED6DB1585}{B925E77F-2A82-
41C6-A981-FAB4386D5701}.

2. Maximo Integration: 

a. The MxDef files provide the mapping between the 800xA System 
environment and the Maximo system. If the MxDef files were customized 
per the instructions in System 800xA Asset Optimization Configuration 
(3BUA000118*), back up the customized MxDef files to safe media.

– The customized MxDef Files for Maximo versions 4.1 and 4.1.1 are 
located in the following directory:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\ABBAO\Services\MOM\MxDefs\

– The customized MxDef files for Maximo version 5.1 and 5.2 are located 
in the following directory:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\ABBAO\Services\MOM\MxDefs\Maximo5\MxServer

– The customized MxDef files for Maximo version 6.2 are located in the 
following directory:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AOECSConnector\MaximoDef

b. Back up the AOMaximoModel.xml file to a safe location. A backup of 
AOMaximoModel.xml is necessary because the ECS model for Maximo 
also needs to be modified if the MXDef files are customized.

The model file is available at the following location:

For correct system operation it is important that only the directories identified by 
the Counter Check Asset Monitor category GUID be saved, as other data in the 
tree structure above these directories will not be consistent with a restore.

If using Maximo Integration, the Maximo Integration information (Maximo 
Equipment ID and Maximo Credentials aspects) must be saved from all Asset 
Optimization Server nodes. Refer the Service Structure for the name of the 
Asset Optimization Server nodes.
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...\program files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AOECSConnector\ECSDefinitions

3. SAP/PM Integration: 

a. Although the SAP/PM system is separate from the 800xA System, it is a 
good idea to back up the system in use. Follow SAP/PM standard 
practices for SAP/PM system backup.

b. The SAPPMDef files provide the mapping between the 800xA System 
environment and the SAP/PM system. If the SAPDef files were 
customized per the instructions in System 800xA Asset Optimization 
Configuration (3BUA000118*), back up the customized SAPDef files to 
safe media.

The customized SAPPMDef files for SAP version4.7 are located under:

...\Program Files\ABB Industrial IT\Optimize IT\
Asset Optimization\AOECSConnector\SAPPMDef

c. Back up the AOSAPModel.xml file to a safe location. A backup of 
AOSAPModel.xml is necessary because the ECS model for SAP also 
needs to be modified if the SAPPMDef files are customized.

The model file is available at the following location:

...\program files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AOECSConnector\ECSDefinitions

The pending fault reports residing in the system are available in the following 
directory structure:

...\OperateITData\OptaoACDs

Backup the entire OptaoACDs folder.

If using SAP/PM Integration, the SAP/PM Integration information (SAP 
Equipment ID and SAP Credentials aspects) must be saved from all Asset 
Optimization Server nodes. Reference the Service Structure for the name of the 
Asset Optimization Server nodes.

The pending fault reports residing in the system are available in the following 
directory structure. Backup the entire OptaoACDs folder.

...\OperateITData\OptaoACDs



Section 4  Upgrading 800xA 5.0 SP2 to 800xA 5.1 Offline PC, Network and Software Monitoring

3BSE036342-511 G 171

 

4. DMS Calibration Integration:

PC, Network and Software Monitoring

Use the following procedure to prepare for the PC, Network and Software 
Monitoring upgrade.

1. If there are user defined Script, Resource, and Assembly files they need to be 
backed up. The user files are located in:

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Scripts\User

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Assemblies\User

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Resources\User directory

Copy the files in these directories to a safe location.

PC, Network and Software Monitoring Device Library

Use the following procedure to prepare PC, Network and Software Monitoring 
Device Library upgrade:

1. Back up MOF files (if they exist) to a safe location. The MOF files are located 
in:

...\Program Files\ABB Industrial IT\Optimize IT\PC, 
Network and Software Monitoring\MOFS

2. Back up Custom Asset Monitor dlls to a safe location if object types with 
Custom Asset Monitors are loaded. The dlls are located in: 

The DMS Calibration Integration approach is changed in 800xA 5.1. Upgrade of 
DMS Calibration Integration is not supported. Reconfigure the DMS Calibration 
Integration based on an engineered solution.

Contact ABB technical support for more information.
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...\Program Files\ABB Industrial IT\Optimize 
IT\PC, Network and Software Monitoring\Asset 
Monitoring\Bin

SMS and e-mail Messaging

Save all GSM Device hardware information. Record information for the GSM 
device on the SMS and e-mail Messaging GSM Hardware Setup Worksheet shown 
in Table 3.

Table 3. SMS and e-mail Messaging GSM Hardware Setup Worksheet

Item Setting/Value

Spooler Settings

Activate Outbox Spooler Checked (check and leave checked)

Activate Inbox Spooler Checked (check and leave checked)

Interval for Checking for Incoming 
Messages

Value: _____ Seconds Minutes (circle 1)

Port Settings

COM Port Value: COM _____

Baud Rate Value: _____

Data Bits Value: _____

Parity Value: _____

Stop Bits Value: _____

PIN and Properties

Query PIN Checked or Unchecked (circle one)

PIN (only if Query PIN is checked) Value: ___________________

Save PIN (only if Query PIN is 
checked)

Checked or Unchecked (circle one)

Own Number (telephone number of 
SIM card (including Country Code) 
in GSM hardware)

Value: ___________________
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Initialization String for GSM Hardware Value:

_______________________________

_______________________________

_______________________________

_______________________________

General Service Properties

Name (GSM service provider) Value: ___________________

Port Value: COM _____

SMSC Value: ___________________

Default Country Code Value: ___________________

Default Prefix Value: ___________________

Number of Attempts Value: ___________________

Splitting Service Properties

Splitting Checked or Unchecked (circle one)

Optimize Splitting Checked or Unchecked (circle one)

Enumerate Splitting Checked or Unchecked (circle one)

Narrowband Sockets Checked or Unchecked (circle one)

Messaging Service Properties

Add Before Message Blank (verify and do not change)

Use for Delivery Notification Only Unchecked (verify and do not change)

Default Option 0 (verify and do not change)

Message General Properties

Replace CR LF for Incoming 
Messages

Checked or Unchecked (circle one)

Table 3. SMS and e-mail Messaging GSM Hardware Setup Worksheet (Continued)

Item Setting/Value
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Batch Management

Verify all the scheduled batches are completed or terminated.

Information Management

Refer to Information Management Pre-Upgrade Procedures on page 453 in 
Appendix , Information Management Upgrade to perform the Information 
Management pre-upgrade procedures.

Scheduler Service (Application Scheduler)

Disable Schedules before stopping the servers and performing the upgrade. This is 
performed only once and not on every node. The Schedules will need to be 
manually enabled following the upgrade.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Scheduling Service Object.

4. Select the Service Definition aspect.

5. Click the Configuration tab.

6. Clear the Enabled check box and click Apply.

Calculations Service

Disable Calculations before stopping the servers and performing the upgrade. This 
is performed only once and not on every node. The Calculations will need to be 
manually enabled following the upgrade.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Calculations Service Object.

4. Select the Service Definition aspect.

5. Click the Configuration tab.

6. Clear the Enabled check box and click Apply.
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Basic History Service Data

To save Basic History Service data:

1. Stop the Basic History Server from the Service Structure.

2. Use Windows Backup (not the 800xA Backup) to backup the files in the:

...\OperateITData\History\{provider ID}

directory.

3. Start the Basic History Server again from the Service Structure.

Process Engineering Tool Integration

Back up Process Engineering Tool Integration information. The project data is 
located in the following directory:

...\Program Files\ABB Industrial IT\Engineer 
IT\Engineering Studio\Process Engineering Tool 
Integration\Xml

Save the entire Xml data directory to a safe media such as a network share or 
removable disk. The directory contains the default mapping files (*.dmf) modified 
on the project, accelerator files (*.acc), and configuration files (*.pcf and *.fcf). 

Requirements for VB Graphics Extension Software

Back up the Basic History folder for each Basic History Service Provider in the 
Service Structure. Depending on the system, the Basic History Service data can 
be present on a number of different node types (Connectivity Servers, IM Servers, 
AO Servers, etc.). It is best to search for the directory described in this procedure 
on all nodes, and if there is data present, back up that data.

Perform these procedures only if the restored system makes use of VB graphics.

• Installing Visual BASIC 6.0 with SP6 must be followed for all nodes that use 
Graphics Builder and the Primary Aspect Server node. This must be done 
before performing the procedures under 800xA System Restore

• Installing the VB Graphics Extension Software must be followed for each VB 
Graphics extension software package on all nodes in the 800xA 5.1 System, 
if the base product was installed on the 800xA 5.0 SP2 System. This must 
be done before performing the procedures under 800xA System Restore
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Installing Visual BASIC 6.0 with SP6

All nodes that use the Graphics Builder and the Primary Aspect Server node need a 
Professional or Enterprise Edition of Visual BASIC 6.0 with SP6. The licensed copy 
used on the 800xA 5.0 SP2 System must be installed on the 800xA 5.1 System. 
Follow the installation procedure provided with Visual BASIC.

Installing the VB Graphics Extension Software

Perform the following procedure to install the VB Graphics extension software on 
all nodes in the 800xA 5.1 System, if the base product was installed on the 800xA 
5.0 SP2 System.

1. Insert System Installation DVD 5 into the drive.

2. Wait for the Installation AUTORUN screen to appear. 

3. Select:

To deploy VB Graphics, the user must belong to the Application Engineer 
IndustrialIT user group and Windows Local Administrators.

Refer to System 800xA Engineering, Process Graphics Migration Tool for 
information on migrating VB Graphics to Process Graphics 2.

Use of an Aero Theme with the Workstation Operating System will lead to screen 
latency issues in the VB Graphics Builder. This is because the Aero theme uses 
advanced rendering schemes. Turn off the Windows Aero theme and switch to 
either none or Windows Classic for use of VB Graphics. The behavior of VB IDE 
in the Workstation Operating System will then be the same as that in Windows 
XP.
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Manual Installation > VB Graphics Extensions (see Figure 23)

4. Select a VB Graphics extension to install (the installation of the Batch 
Management VB Graphics extensions is described later in this procedure).

5. The Installation Wizard for the selected VB Graphics extension appears. 

6. Follow the Installation Wizard to complete the installation. Choose Typical as 
the installation type.

7. Repeat the procedure for each required VB Graphics extension that appears in 
the Installation AUTORUN Screen.

Figure 23. Installation AUTORUN Screen
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8. This step only applies to the VB Graphics extensions for Batch Management 
when using System Installer to upgrade the 800xA System. If Batch 
Management was installed manually during the upgrade, the VB Graphics 
extensions for Batch Management were installed at that time.

a. Select:

Manual Installation > Batch Management

b. The Installation Wizard for Batch Management appears. 

c. Select Modify when the dialog box appears that offers that choice.

d. Select to install the Batch Management VB Graphics extensions in the 
Installation Type dialog box.

e. Follow the Installation Wizard to complete the installation.

Post Upgrade Procedures
The remainder of this section describes how to:

• Migrate the Structured Data Logger SQL Database.
• Restore the backups of the IEC 61850 CET OPC Server projects.
• Perform the 800xA Restore procedure.
• Perform a consistency check.
• Load the VB Graphics extensions on the Primary Aspect Server.
• Restore historical data.
• Restore the necessary data for each Functional Area.

Migrating the Structured Data Logger SQL Database

Perform the following post upgrade procedure for Structured Data Logger (SDL).

1. Open Microsoft SQL Management Studio and connect to the 
SDL_INSTANCE server.

2. Delete SDL database from SDL_INSTANCE if already created during the 
installation.

Upgrading SDL from 800xA 5.0 SP2 to 800xA 5.1 involves transfer of database 
data from SQL Server 2000 to SQL Server 2008.
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3. Restore the SDL database using the .bak file (from SQL Server 2000) that was 
stored to a safe location during the pre-upgrade process.

a. Right-click Databases and select Restore Database… from the context 
menu.

b. Select the From Device option and browse for the .bak file that was stored 
to a safe location during the pre-upgrade process.

c. Select/Enter SDL in To database and click OK.

4. Use Windows Explorer to navigate to:

...\Operate IT\Structured Data Logger\vbs

5. Double-click RunCreateScripts_SDL.vbs. This will upgrade the SDL 
database schema.

6. After performing the 800xA System Restore on page 180, verify that the SDL 
Control Application exists in the system and that the SDL Log aspects contain 
data.

IEC 61850 Connect

Restore the backups of the IEC 61850 CET OPC Server projects. Refer to the topic 
CET Project Maintenance in the System 800xA IEC 61850 Configuration 
(9ARD171387*) user manual to import CET OPC Server projects.

Handling of IET/CCT projects and PCM 600 projects is not described here as 
they are external tools contributing to the IEC 61850 workflow. They do not 
reside on 800xA System nodes.
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800xA System Restore

The backup/restore utility supports the restoring of 800xA system information. The 
following steps outline the 800xA system restore procedure.

1. Start the restore procedure.

a. Select:

Start > All Programs > ABB Industrial IT 800xA > System > 
Configuration Wizard

b. The Select Type of Configuration dialog box appears. Select Restore 
System and click Next.

2. Check for messages in the log file (enable the View Log check box in the 
Configuration Wizard). Refer to Appendix A, Warning and Error Messages to 
resolve any received warning or error messages.

3. Check the CPU load in the node. The System Message service may generate a 
high load (>90%). If this continues for longer than approximately 10 minutes, 
restart the service.

4. One node at a time, start up and connect all nodes to the 800xA System in the 
following order:

Refer to Requirements for VB Graphics Extension Software on page 175 before 
performing the 800xA System Restore.

The User Account that is used for 800xA System restore via the Configuration 
Wizard must be a member of the following groups:

• IndustrialITUser.

• IndustrialITAdmin.

• Local Administrators.

Refer to System 800xA Maintenance (3BSE046784*) for more information on 
restoring the system.

Restart the node when advised during the restore procedure.

If a message stating that a full deploy of the Generic Control Network is needed, 
click OK.
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– Aspect Server nodes.
– Connectivity Server nodes.
– Application Server nodes.
– Client nodes.

a. Use the following guidelines while connecting nodes, using the 
Configuration Wizard. This must be performed on the node that is going to 
be connected, not on the node on which the restore was performed.

b. Select the Primary Aspect Server (the server on which the system will run) 
in the Connect to another System on Node drop down-list box, in the 
Connect to System dialog box.

c. If the node is an IM Server, verify that the ABB Process Administration 
Service (PAS) is set to manual in the Services Control Panel (run 
Services.msc from the Run dialog box). Stop the service if it is running.

d. Select Connect Node from the Select Type of Configuration dialog box.

e. Set the current system as the default system when connecting nodes to the 
system.

– In some cases, problems may be encountered when connecting nodes to 
the system. Verify that the system software user settings are correct using 
the Configuration Wizard. Restarting the node again may also solve the 
problem.

– Wait until all services in the newly connected node are up and running 
before connecting the next node. Select the Node Administration 
Structure\connected_node_name\System Status Viewer aspect to monitor 
the status of services. If some services will not start up, restarting the node 
may help.

f. Restart each node after it has been connected to the system.

Do not include services that were stopped manually as part of the pre-upgrade 
procedures. These will be manually restarted later in the post upgrade procedures.

Run the System Software User Settings until OK. Restart if it is not working and 
if the message:

Invalid User

appears.
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5. Refer to Appendix E, Recording the Number of Aspects and Objects and 
record the number of aspects and objects in the system. Compare these values 
to those recorded when the system was backed up. 

6. Verify the affinity settings to ensure best system performance. Refer to System 
800xA Post Installation (3BUA000156*) for more information on how to 
configure affinity.

Consistency Check

Refer to Appendix D, Consistency Check and perform the necessary consistency 
checks.

Loading the VB Graphics Extensions

Perform the following procedure on the Primary Aspect Server to load the VB 
Graphics extensions:

1. Refer to Table 4 for a list of VB Graphics extensions available to be loaded.

Perform this procedure only if the restored system makes use of VB graphics.

Table 4. VB Graphics Extensions

Directory Software

800xA Connectivities AC 800M Connect VB Graphics Extension

ABB 800xA for Advant Master VB Graphics Extension

ABB 800xA for Harmony VB Graphics Extension

ABB 800xA for IEC61850 VB Graphics Extension

ABB 800xA for MOD 300 VB Graphics Extension

ABB 800xA for Safeguard VB Graphics Extension

ABB PLC Connect VB Graphics Extension

Asset Optimization ABB Asset Optimization VB Graphics Extension

ABB PC, Network and Software Monitoring VB Graphics 
Extension
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2. Start the Configuration Wizard from the primary Aspect Server node. Select:

Start > All Programs > ABB Industrial IT 800xA > System > 
Configuration Wizard

3. Open the System Extension Load dialog box by going to:

System Administration > Select System > System Extension Load

4. A view appears with the available VB Graphics extensions listed in the left 
pane. Select the system extension to load in the list in the left pane and move it 
to the list in the right pane by clicking >. To move all the system extensions 
from the left pane to the right pane, click >>.

5. The red cross, green check mark, and warning icons indicate the status of the 
dependency evaluation.

– The green check mark indicates that the system extension must be loaded 
first.

– The red cross icon indicates that the system extension can not be loaded 
until the one with the green check mark icon is loaded.

– The warning icon indicates that the system extension can be loaded, but 
that there is additional information available in the Description frame in 
the lower part of the dialog box. The additional information can, for 
example, be that the system extension contains aspect types that are not 
environment aware.

6. If the list in the right pane contains more than one system extension, click 
Press header to autosort to sort the system extension load order with regard to 
dependencies.

Batch Management Batch VB Graphics Extension

Batch Advanced Templates VB Graphics Extension

Device Management & Fieldbuses ABB Device Management FOUNDATION Fieldbus VB 
Graphics Extension

Table 4. VB Graphics Extensions (Continued)

Directory Software
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7. All system extensions in the right pane should be marked with the green check 
mark or the warning icon.

8. Click Next and the Apply Settings dialog box appears.

9. Click Finish to load all system extensions.

10. A progress dialog box is shown during the load. Click View Log to view log 
messages during load.

11. When the load operation is finished, click Finished and view the Configuration 
Wizard log to verify that no errors occurred during the load.

12. Close the Configuration Wizard.

Customized Alarm Priority Mapping Aspects

Some customized Alarm Priority Mapping Aspects may have been overwritten 
during the upgrade. Recreate the Alarm Priority Mapping Aspects using the data 
recorded during Customized Alarm Priority Mapping Aspects on page 157.

Reconfiguring Group Displays

New Group Display aspects that are created and configured in the Object Type 
Structure on the object types and instances in 800xA 5.1 will work correctly even if 
there is more than one aspect with the same name but each aspect has a different 
Aspect Category.

Configured Group Display aspects that existed in the Object Type Structure and 
on the object types and instances in 800xA 5.0 SP2 should have their Aspect 
Categories reconfigured for the aspects to display correctly. (This is required for the 
reference to an aspect to be stored along with its Category ID.)

The load is aborted if:

• The user clicks Abort.

• An error occurs; for example, if the Configuration Wizard fails to load a file 
into the system.

An aborted system extension load can be resumed from the System Extension 
Maintenance dialog box.
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Upgrading Faceplates

The Faceplate aspects created in all versions prior to 800xA 5.1 use a different 
method to identify the references to faceplate elements or other properties than 
those in 800xA 5.1.

Upgrading a faceplate is optional, but is strongly recommended for the following 
reasons:

• Better runtime performance, as no name server access is required when a 
faceplate is opened.

• More reliable because the references continue to work even if the target object 
is renamed.

• Upgraded faceplates function efficiently with the Consistency Checker and 
Reference Tool. This behaves similar to a Process Graphics 2 graphic aspect.

• The upgrade to new reference handling can also repair some broken references.

Refer to the Upgrading Faceplates appendix in System 800xA Engineering Process 
Graphics (3BSE049230*) for the procedure to upgrade the faceplates.

800xA for AC 800M

Perform the following procedure to restore 800xA for AC 800M information:

1. Use the OPC Server Setup Wizard to enter the previously used and recorded 
service account settings.

2. Control Builder stores its settings (systemsetup.sys) on disk in the following 
directory:

...\ABB Industrial IT Data\Engineer IT Data\Control 
Builder M Professional

Copy the previously saved file from the safe media to this folder.

3. The OPC Server stores configuration files (*.cfg) and settings 
(systemsetup.sys) on disk. Add the files saved on the safe media to the system. 
The systemsetup.sys file is located in:

...\ABB Industrial IT Data\Control IT Data\OPC Server 
for AC 800M
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The configuration files are stored in the Files folder in the same location.

4. Select File > Load Configuration to restore OPC configurations in the OPC 
Server Panel.

Engineering Studio

Perform the following post upgrade procedures for Engineering Studio:

• Check and Repair AES Variable Table.
• Engineering Studio Function Designer System Extensions
• Deleting Engineering Base Service from the Service Structure.

Check and Repair AES Variable Table

The Check and Repair AES Variable Table (Applications, Controllers, 
Diagrams/SCMs, and Diagram (Cm) Types) function can be used to:

• Correct possible inconsistent data used for display of online values and external 
cross references.

• Delete obsolete data and reduce aspect size.

Perform the following procedure to use this application.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Object Type Structure.

3. Use the Object Browser to navigate to:

Object Types > Functional Planning > Settings

4. Select Function Upgrade in the Aspect List Area to open the Function 
Upgrade aspect in the Preview Area.

5. Select the Check and Repair AES Variable Table (Applications, 
Controllers, Diagrams/SCMs, and Diagram (Cm) Types) check box and 
click Apply.

6. Click Run Upgrade to perform this upgrade.

Executing the Check and Repair AES Variable Table procedure makes the 
environment support work for Function Designer.
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Upgrade Diagram References and Diagram Variables

In the 800xA 5.1 System (opposite to the 800xA 5.0 SP2 System) Diagram 
References and Diagram Variables are by default created as Symbol Objects. This is 
not true for Diagram References and Diagram Variables created during upgrade 
(restore) from 800xA 5.0 SP2 Systems. Convert them from Aspect Objects to 
Symbol Objects by use of the conversion function described in the following 
procedure.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Object Type Structure.

3. Use the Object Browser to navigate to:

Object Types > Functional Planning > Settings

4. Select Function Upgrade in the Aspect List Area to open the Function 
Upgrade aspect in the Preview Area.

5. Select the Convert Diagram References/Variables from Aspect Objects to 
Symbol Objects check box and click Apply.

6. Click Run Upgrade to perform the upgrade.

Differences between Aspect Objects and Symbol Objects are described in System 
800xA Engineering, Engineering Studio Function Designer (3BDS011224*).

This function is not suitable in the case of additional aspects on input/output 
references, e.g. Graphic Elements, for typical diagrams with input/output 
references that will get copied and connected via the Bulk Data Manager.
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Engineering Studio Function Designer System Extensions

Refer to Engineering Studio on page 158 and recreate the configuration changes that 
were recorded before the upgrade.

Deleting Engineering Base Service from the Service Structure

When the 800xA System is running, delete the Engineering Base Service from the 
Service Structure.

1. Use Windows Explorer to navigate to the following directory:

...\Program Files (x86)\ABB Industrial IT\Engineer IT\
Engineering Studio\DocumentParameterManager\
bin\support

2. Double-click EbServiceCleanUpUtil.exe to delete the service.

Device Management and Fieldbuses

Perform the post upgrade procedures for Device Management and Fieldbuses.

Device Library Wizard

Perform the following post upgrade procedures for Device Library Wizard.

Restore Device Types

Third party software, such as Device Type Managers for the Device Type must be 
reinstalled since the hard drive of the 800xA System node has been reformatted.

After the System is upgraded, some of the Function Diagrams appear in the 
modified state. This is due to the modification of Standard and BU specific 
libraries whose blocks are instantiated in the Function diagrams. Perform 
configuration data generation for such Function Diagrams.

The following are some of the instances were Function Diagrams are modified 
when there are:

• Changes in properties of the parameter except FDport in the Control and 
Function block type. 

• Change in the CMT type.
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The following steps for Fieldbus Device Types need to be carried out on every 
800xA system node. Perform the System Restore Wizard procedure on the nodes in 
the following sequence:

• Aspect Servers (including redundant Aspect Servers).
• Connectivity Servers (including redundant Connectivity Servers).
• Application Servers.
• Clients.

1. Start the Device Library Wizard. Select:

Start > All Programs > ABB Industrial IT 800xA > Device Mgmt > 
Device Library Wizard

-or-

double-click the Device Library Wizard icon on the desktop.

2. Select the Enable Trace File check box as shown in Figure 24 in the path:

Restore the Device Types on the Primary Aspect Server node before starting to 
install them on other system nodes. Do not run parallel installations of Device 
Types on other system nodes unless all Device Types are restored on the Primary 
Aspect Server node. Installation of Device Types on other system nodes can be 
done in parallel after they are restored on the Primary Aspect Server node.

If the system contains FOUNDATION Fieldbus Device Types, check the 
following before proceeding to the next step:
• Open a Plant Explorer Workplace.

• Use the Structure Selector to open the Object Type Structure > FF 
Libraries.

• Check to see if there is more than one entry of FF H1 Device Library, 
FF Object Type Group.

• If there is more than one entry, perform FF Upload once so there is only one 
instance of FF H1 Device Library, FF Object Type Group 
present. If there is only one entry, proceed to the next step using the Device 
Library Wizard.

If the Device Library Wizard - Client has not been connected to the Device 
Library Wizard - Server, navigate first to:

Device Library Wizard Administration > Connect Client

and follow the Device Library Wizard Procedure
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Device Library Wizard > Device Library Wizard Administration > 
Diagnostics

3. Navigate to:

Device Type Administration > System Restore Wizard

Figure 24. Enabling the Trace File
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4. Choose the second option in the System Restore Wizard as shown in Figure 25 
and click Next.

5. Choose the first option as shown in Figure 26 and click Next.

Figure 25. System Restore Wizard (1)

Figure 26. System Restore Wizard (2)
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6. Depending on which fieldbus protocol is used in the previous system version 
environment, insert one of the delivered Device Library system DVDs in the 
DVD drive (e.g. Device Library HART – DVD).

7. Click Browse and navigate to the DVD drive.

8. When the drive has been selected in the Browse for folder dialog box, click OK 
in that dialog box and then Next in the ABB Device Library Wizard. This step 
may take one or two minutes to complete.

9. The Device Library Wizard scans the 800xA System for fieldbus device types 
that are already used and compares the results with the contents of the DVD. 
Device Types available in the 800xA System and the DVD are shown in the 
Extract tab of the Device Library Wizard (Figure 27).

10. Device Types available in the 800xA System but not on the DVD are displayed 
in the Missing tab. If there are any Device Types showing in the Missing tab, 
navigate to the Browse dialog box by clicking Back and inserting a new Device 
Library DVD in the DVD drive. 

11. Click Next to start the extraction process.

12. Repeat Step 6 to Step 11 for each fieldbus protocol if more than one fieldbus 
protocol is used.

Figure 27. Extract Device Type Files
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13. There may be some Object Types that are either customer created, or are the 
latest Device Types downloaded from ABB SolutionsBank. These will not be 
available on the DVDs. The Device Library Wizard will prepare a list for these 
Device Types (Figure 28). Install these Device Types manually.

14. Repeat this procedure until all Device Types are extracted to the 800xA System 
node and the Missing tab does not list any device types.

15. If the Device Library DVDs do not contain all Device Types used in the 
previous system version, the missing Device Types must be downloaded from 
ABB SolutionsBank.

Figure 28. List of Files to be Manually Installed

During extraction, if a dialog box pops up asking for an overwrite, select No and 
continue.

It is only possible to complete the Wizard if all Device Types have been 
successfully extracted.
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16. When the extraction process is completed successfully, the Device Types need 
to be re-installed on the 800xA System node. Click Next to launch the Re-
installation of Device Types dialog box shown in Figure 29.

17. Follow the Device Library Wizard procedure to complete the installation. The 
Device Library Wizard will automatically navigate to the main window after 
the process is completed.

18. Exit the Device Library Wizard and repeat the procedure on the other 800xA 
System nodes, if applicable.

Figure 29. Re-install Device Types Dialog Box

If, during installation the Device Library Wizard main window becomes hidden 
in the background:
• Open Windows Task Manager.

• Select the Device Library Wizard in the Applications tab.

• Select: Windows > Bring to Front
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Device Management PROFIBUS & HART

Perform the following post upgrade procedures for Device Management 
PROFIBUS & HART.

Compressing Aspect Data

The aspect data in the system is compressed using the Data Compression Tool. This 
tool is available from System 800xA 5.1 Feature Pack 4 Revision D and System 
800xA Revision D (see Figure 30).

After the system upgrade, perform the following to compress the aspect data using 
the Data Compression Tool:

1. Double-click and open the Data Compression Tool from the following location:

C:\Program Files (x86)\ABBIndustrialIT\EngineerIT\FieldbusBuilder
\bin\DMAspectDataCompression.exe

The Data Compression Tool is opened as shown in Figure 30.

AC800M Connect and AC800M High Integrity system extensions must be loaded 
before loading PROFIBUS Device Integration Library - Basic and HART Device 
Integration Library - Basic system extension. Therefore, install AC800M Connect 
and AC800M high Integrity also when installing Device Management 
PROFIBUS and HART.

The callouts in Figure 30 represent the corresponding steps in this procedure.
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 2. Select Control Network on the Data Compression Tool. 

3. Expand the Control Network group and select a project or a controller from 
the list.

4. Click BrowsePath to browse and select a folder location to save the .csv file.

5. Click Compress to compress the aspect data. 

A message will be displayed stating the actual number of device instances in 
the project and the actual number of device instances that are compressed using 
the tool as shown in Figure 31.

Figure 30. Data Compression Tool
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The Data written successfully in the following path: <path specified in Step 4> 
will be displayed at the bottom of the tool upon successful completion of aspect 
data compression as shown in Figure 32.

6. Click Exit.

Figure 31. Data Compression Details Message

Figure 32. Successful Completion of Device Types Compression
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OPC Server PROFIBUS & HART 

After system upgrade, PH OPC service providers may be reconfigured. For more 
information on configuration of PROFIBUS & HART devices (Fieldbus Builder 
PROFIBUS/HART, OPC Server, DTM’s and Device Type Objects in 800xA), refer 
to System 800xA Device Management PROFIBUS & HART Configuration 
(3BDD011934*) manual.

License Count Tool

License Count Tool is an User Interface tool that counts and verifies the list of 
licenses for the device types. The User Interface for this tool is available in the 
System 800xA 5.1 Feature Pack 4 Revision E and System 800xA Revision E release 
(see Figure 33).

After the system upgrade, the licenses required for the device types in the new 
system must be checked and verified. 

Perform the following to check the licenses for the device types in the system:

1. Run the License Count Tool from the following location:

C:\Program Files (x86)\ABBIndustrialIT\EngineerIT\FieldbusBuilder
\bin\LicenseCounting.exe

This step must be performed after project upgrade as mentioned in 800xA for AC 
800M Post-upgrade procedures.
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2. On the License Counting wizard, expand the Root element, select the Control 
Network, and then click Count License as shown in Figure 33.

A message stating the number of device type instances in the system and the 
number of licenses required is displayed as shown in the Figure 34.

Figure 33. License Count Tool Wizard

If there is more than one control network, you need to individually select the 
network and click Count License to know the number of licenses used per 
control network.

Figure 34. License Count Message
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3. Perform the following to verify the number of licenses used in the system:

a. Open a Plant Explorer workplace.

b. Use the structure selector to select the Control Structure.

c. Click Root and select License Usage in the Aspect List area.

d. Check the number of licenses used in the system for the 800xA 
FIELDBUS Profibus and Hart feature. Refer to Figure 35 for more 
information.

Figure 35. License Usage Aspect in Control Structure

The number of licenses displayed by the License Count Tool and the number 
displayed against the License Usage aspect in the Control Structure must be the 
same.
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Device Management FOUNDATION Fieldbus

Perform the following to complete updating Device Management FOUNDATION 
Fieldbus.

1. Update LD 800HSE Linking Devices: Update all LD 800HSE linking devices 
to the latest firmware version released for this system environment following 
the update procedure described in the user instructions for the particular device. 

2. Check, Save, and Upload FF Libraries:

a. Open a Plant Explorer Workplace.

b. Use the Structure Selector to open the Object Type Structure.

c. Use the Object Browser to navigate to:

FF Libraries Object Type Group

d. Select FF Management in the Aspect List Area.

e. Click Open Project.

f. Check the libraries for plausibility.

g. Exit Fieldbus Builder FF and save changes if prompted to do so.

h. Return to the Plant Explorer Workplace and select FF Upload in the 
Aspect List Area.

i. If the traffic light symbol shows red, click Upload.

j. The green traffic light symbol indicates that the FF libraries have been 
synchronized.

3. Optional: Reconstruct User-made Changes to Library Objects representing FF 
Standard Blocks: 

Refer to LD 800HSE Version Table (3BDS009910) in ABB SolutionsBank at for 
the latest linking device firmware released for this system environment.

From Downloads Explorer, navigate to:

Control Products and Systems/800xA/Device Management Foundation 
Fieldbus/Foundation Fieldbus Linking Device LD800HSE

This step is only required if changes were made to library objects representing FF 
standard blocks.
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During upgrade, user-made changes to library objects representing FF 
standard blocks have been overwritten. Important substitutions have been 
logged.

a. If such changes were made, display the substitutions as follows:

– Open a Plant Explorer Workplace.

– Use the Structure Selector to open the Object Type Structure.

– Use the Object Browser to navigate to:

FF Libraries Object Type Group

– Select FF Upload in the Aspect List Area.

– Select Library Merge Logger tab and read log.

b. For reconstructing user-made changes, reapply the changes to the library 
objects manually.

4. Check, Save, Commission, and Upload the HSE Subnet.

a. Open a Plant Explorer Workplace.

b. Use the Structure Selector to open the Control Structure.

c. Use the Object Browser to navigate to:

HSE Subnet

d. Select FF Management in the Aspect List Area.

e. Click Open Project.

f. Check to see if the configured HSE subnet ID is used for the OPC Server 
FF configuration in FF Network > Properties and modify it if required.

g. Check whole project for plausibility.

h. If required, perform device assignment for all linking devices LD 
800HSE. Typically, no device assignment is lost during the upgrade.

i. If required, perform precommissioning/commissioning for all objects for 
which this is necessary (discernible from engineering status). A 

Perform the following procedure for each HSE Subnet.
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precommissioning may be required if the firmware has been 
changed.

j. Exit Fieldbus Builder FF and save changes if prompted to do so.

k. Return to the Plant Explorer Workplace and select FF Upload in the 
Aspect List Area.

l. If the traffic light symbol shows red, click Upload HSE Subnet.

m. The green traffic light symbol indicates that the HSE Subnet has been 
synchronized.

5. Check whether the blocks of used devices from 800xA 5.0 SP2 use the 
datatype bitstring and that the value is uploaded into the configuration 
database. Upload these parameters from the device to the configuration 
database again. 

Perform the following procedure for each HSE Subnet:

a. Open a Plant Explorer Workplace.

b. Use the Structure Selector to open the Control Structure.

c. Use the Object Browser to navigate to HSE Subnet.

d. Select FF Management in the Aspect List Area.

e. Click Open Project to open the subnet in FBB FF.

f. Identify the devices containing Function Block with Parameter datatype as 
bitstring.

g. Upload all parameters of datatype bitstring from the device to the 
configuration database.

6. Import the locally stored parameter value sets as follows:

a. Open a Plant Explorer Workplace.

b. Use the Structure Selector to open the Object Type Structure. 

To assign all H1 devices in one step, use the Assign all devices function from the 
HSE Subnet context menu: Object > Assign all devices...

For downloading use the online dialog from the HSE Subnet context menu: 
Object > Online Dialog...
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c. Use the Object Browser to navigate to: 

      FF Libraries, Object Type Group

d. Select FF Management in the Aspect List Area.

e. Click Open Project to open the FF Libraries project in Fieldbus Builder 
FF.

f. Open the block properties dialog for the Function Block where the 
parameters were exported during the pre-upgrade procedure.

g. Right-click on the dialog box and select Import from the context menu.

h. Browse the .csv file and restore the value sets.

i. Right-click and select Store parameter value set from the context menu.

j. Specify an appropriate name for the new value set and click OK.

k. Click Cancel. Do NOT overwrite the Initial Instance Parameters with the 
imported parameters, and then close the block properties dialog box. 

800xA for Advant Master and 800xA for Safeguard 

Perform the following post upgrade procedures for 800xA for Advant Master and 
800xA for Safeguard.
• Copy the Advant Master Controller Licenses.txt.
• Update the Configuration Files.
• Copy the DATHR Files.
• Reconfigure RTA Board Control Aspect Settings.

Ensure that the stored value sets are imported to the corresponding Function 
Blocks.
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Copy the Advant Master Controller Licenses.txt

Perform the following on the Primary Aspect Server in the 800xA 5.1 System:

1. Copy the following updated file:

– Advant Master Controller Licenses.txt

The default location to copy the file in the 800xA 5.1 system:

For 64-bit:

...\Program Files (x86)\ABB Industrial IT\Operate 
IT\AC 400 Connect\Licenses

For 32-bit:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\Licenses

Update the Configuration Files

For each Connectivity Server, compare the following files saved in a safe location 
during the 800xA for Advant Master pre upgrade phase:

• AdvDsMasterAdapter.csv

• AdvMbAeOPCServer.csv

with the installed version of the files at the following location:

For 64-bit:

...\Program Files (x86)\ABB Industrial IT\Operate IT\AC 400 
Connect\Bin

For 32-bit:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\Bin

If any customization was done to the old files, update the installed version of the 
files with the corresponding changes.

Copy the DATHR Files

Perform the following on each Connectivity Server node:
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1. Copy the saved files:

– DATHR1.CD
– DATHR2.CD
– DATHR3.CD

to the folder:

...\ProgramData\ABB\AC400Connect\AdvantBase\Data\
RTA\Init\

to the node where they belong.

Reconfigure RTA Board Control Aspect Settings

1. Open the MB 300 RTA Settings dialog box in Configuration Wizard and 
reconfigure:

– MB 300 Node and Network Numbers.

– Check 800xA as Clock Master (REVERSED_SYNC_MODE) in case 
the time synchronization key REVERSED_SYNC_MODE was 
previously enabled.

2. Always Restart the RTA board.

3. The Audible property must be 0 for events and 1 for alarms 800xA for Advant 
Master version 4.1 SP1 RU6 and newer. Refer to System 800xA Configuration 
(3BDS011222*) for configuration of audible alarms.

Safeguard standardevent 300 - 326 does not comply with this rule before 
800xA for 800xA for Advant Master Version 5.0 SP2. The Event numbers 
where the Audible property should be changed from 1 to 0 are:

– EVENT302.
– EVENT305.
– EVENT310.

If the RTA board IP is configured different than the default IP (172.16.168.50), 
change the RTA board IP in the registry of Advant Connectivity Server before 
proceeding.

Path: HKEY_LOCAL_MACHINE > SYSTEM > CurrentControlSet > 
Services > PU410 > Parameters > slvBoard

Change the IP in string IPAddress.
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– EVENT312.
– EVENT320.
– EVENT321.
– EVENT322.
– EVENT325.

800xA for Harmony

Use the following procedure to restore 800xA for Harmony information:

1. Log in to the 800xA Installing User account (or a local Administrator account) 
on the Configuration Server or Configuration Server with Connectivity Server 
node.

2. Restore the 800xA for Harmony Configuration information that was saved 
during 800xA for Harmony on page 164.

a. Select:

Start > All Programs > ABB Industrial IT 800xA > 800xA for OCS 
Systems > Harmony > Configuration > Restore Configuration

b. Click Connect in the Harmony Connect Configuration Backup/Restore 
window.

c. Enter the name of the Harmony Configuration Server database backup file 
in the Backup File field.

d. Click Restore.

e. If a prompt appears indicating that the system version does not match the 
backup version, click Yes.

f. If the message Services must be stopped, REBOOT system now 
then restart this application! is displayed, restart the node and 
repeat Step a through Step e.

g. The Backup/Restore program compares the old configuration in the 
backup file to the current configuration of the newly installed system. If 
the hosts of the Primary and Redundant Connectivity Servers do not 
match, a dialog box will appear allowing the user to map the old 
Connectivity Server node names to the new Connectivity Server node 
names.



800xA for AC 870P/Melody Section 4  Upgrading 800xA 5.0 SP2 to 800xA 5.1 Offline

208 3BSE036342-511 G

 

h. Leave the Create Missing Servers in Installed Configuration (Disaster 
Recovery) check box disabled.

i. Click Exit when the restore operation is complete.

800xA for AC 870P/Melody

Perform the following post upgrade procedures for 800xA for AC 870P/Melody.

• Restore 800xA for AC 870P/Melody Information.
• Additional 800xA for AC 870P/Melody Configuration Steps.

Restore 800xA for AC 870P/Melody Information

Perform the following procedure to restore 800xA for AC 870P/Melody 
information:

1. Log in to the 800xA Installing User account (or a local Administrator account) 
on the Configuration Server node.

2. Restore the 800xA for AC 870P/Melody Configuration information that was 
saved during 800xA for AC 870P/Melody on page 166.

a. Select:

Start > All Programs > ABB Industrial IT 800xA > 800xA for AC 
870P Melody > Configuration > Restore Configuration

b. Click Connect in the Melody Connect Configuration Backup/Restore 
window.

c. Enter the name of the Melody Configuration Server database backup file 
in the Backup File field.

d. Click Restore.

e. If a prompt appears indicating that the system version does not match the 
backup version, click OK.

Restore existing backups for project specific changes (if available) for: (Refer 
also to 800xA for AC 870P/Melody on page 166.)

• DHCP Server Configuration.

• ETC Host files for 800xA for AC 870P/Melody Connectivity Servers.

• Changes in the Default Object Types.

• ConvDB changes of the Configuration Server.
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f. If the message Services must be stopped, REBOOT system now 
then restart this application! is displayed, restart the node and 
repeat Step a through Step e.

g. Click Exit when the restore operation is complete.

Additional 800xA for AC 870P/Melody Configuration Steps

Perform the following configuration steps after adding the 800xA for 
AC 870P/Melody Configuration Server to the 800xA System.

1. Melody Executive Service Provider.

2. Tag Importer.

3. Enable the Melody AutoConfigurator service in Plant Explorer > Service 
Structure.

4. Replication Monitor Internet Explorer Security Settings.

Perform the following configuration steps after adding each 800xA for AC 
870P/Melody Connectivity Server to the 800xA System.

1. Melody Executive Service Provider.

2. OPC Data Source Definition.

3. Alarm and Event Provider Setup.

4. Replication Monitor Internet Explorer Security Settings.

800xA for MOD 300

1. Re-initialize PAS System Services on the Connectivity Server.

If there are specific faceplates in use (process industries or utilities), the 
faceplates must also be upgraded. Refer to the faceplate related documents for 
further instructions.

Information on performing these additional configuration steps can be found in 
800xA for AC 870P/Melody Configuration (3BDD011741*) and System 800xA 
Post Installation (3BUA000156*).

The PAS System Services will not start until the communications settings are 
initialized as described in the following steps.
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2. Initialize the OMF settings to start system services. Use the Administrative 
Tools in Windows Control Panel to select:

PAS > Settings

This displays the Communications Configuration Tool.

a. Select Yes at the message 

Would you like to revert back to saved settings?

This opens the Communication Settings display.

b. Select OK on the Communication Settings display to save the settings and 
close the window.

c. Select OK to the message:

Settings have been saved . ...

d. Select OK when the message appears that indicates the settings have been 
changed. A restart is always required if the Control Network Setting, OMF 
Memory, or TCP/IP enabled setting are changed.

3. Restart Windows at this time. 

4. Reverse_Time synch will be disabled following the re-installation of PAS. If 
the Connectivity Server node sets the time on the Real-Time Accelerator Board 
(RTAB), Reverse_Time_Synch must be enabled. Refer to the 800xA for 
MOD 300 section in System 800xA Post Installation (3BUA000156*).

5. If any objects were customized, those changes must be implemented again on 
objects delivered with 800xA for MOD 300 Version 5.1.

6. Update the registry settings previously recorded. Refer to 800xA for MOD 300 
Configuration (3BUR002417*).

PLC Connect

Perform the following post upgrade procedures for PLC Connect.

The message: 

Would you like to revert back to saved settings?

is displayed if settings were previously saved. To restore the previous settings, 
perform Step a through Step d.
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Modify Installation for IEC 60870 or Basic Project Objects

If either the IEC 60870 or Basic Project Objects features were installed:

1. Use standard Windows procedures to access Programs and Features in 
Windows Control Panel. 

2. Select ABB PLC Connect. 

3. Select Change/Modify.

4. The InstallShield Wizard for PLC Connect appears. Refer to System 800xA 
Manual Installation (3BSE034678*) to select and install the desired features.

5. If the IEC60870 feature is installed refer to System 800xA PLC Connect 
Configuration (3BSE035041*) and reload the saved IEC configuration.

Restoring the Pretreat dll

To restore the Pretreat dll:

1. If the PLC Connect Communication Server Pre Treatment function is being 
used in the application, copy the Pretreat dll file (Pretreat3.dll or Pretreat4.dll) 
from the backup location to the same folder as it was backed up from on the 
PLC Connect Connectivity Server. If the default folder is used, that location is:

...\ABB Industrial IT\Operate IT\PLC Connect\Bin

2. Register the Pretreat dll file (refer to System 800xA PLC Connect 
Configuration (3BSE035041*) for more information).

3. Restart the PLC Connect Connectivity Server for the changes to take effect.

4. Restore the project and source files for the Pretreat dll.

Update the Sattbus Configuration

Perform the following if the Sattbus protocol is used for any of the controllers:

1. Select the PLC Controller Configuration aspect for the controller that uses 
Sattbus protocol and click Edit Driver.

2. Configure the Common System Settings and click OK.

3. Restart the Connectivity Server.
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Redeploy the PLC Connect Configuration

To redeploy the PLC Connect configuration:

1. Use the Structure Selector to open the Control Structure in the Plant Explorer 
Workplace.

2. Use the Object Browser to navigate to the first Generic Control Network 
object.

3. Select Deploy in the Aspect List Area.

4. Press the SHIFT key and click Deploy in the Preview Area to ensure that a full 
deploy is done. 

5. The deploy begins and the progress is displayed in the Preview Area. The 
deploy is completed when Deploy ended is displayed.

6. Repeat the procedure for any additional Generic Control Network objects.

Asset Optimization

Use the following procedure after updating Asset Optimization. Perform only the 
steps applicable to the system.

1. Asset Monitoring: 

a. If Runtime Asset Monitors are being used in the system, restore the 
Runtime Asset Monitor data directory (DeviceRunTimeMSLogicStore) to 
the following directory:

...\Program Files (x86)\ABB Industrial IT\Optimize 
IT\Asset Optimization\AssetMonitorEnvironment\Bin 

b. If XY Profile Deviation Asset Monitors are being used in the system, 
restore the XY Profile Deviation Asset Monitor data directory 
(XY_Reference_Profiles) to the following directory:

Asset Monitoring directories must be restored on every Asset Optimization 
Server node defined in the system.

The saved data contains the Runtime Asset Monitor data present at the time of the 
save. Use the Runtime Asset Monitor faceplate to reset the Asset Monitors by 
adding the lost time to their accumulated run time or with some known values 
based on other records. Ignore any alarms occurring during the backup.



Section 4  Upgrading 800xA 5.0 SP2 to 800xA 5.1 Offline Asset Optimization

3BSE036342-511 G 213

 

...\Program Files (x86)\ABB Industrial IT\Optimize 
IT\Asset Optimization\AssetMonitorEnvironment\Bin

c. If Counter Check Asset Monitors are being used in the system, restore the 
Counter Check Asset Monitors data directory named:

{66E71F7B-90D6-4E62-9881-38388B24CBDF}

from safe media. This directory exists for each AO Server in the system. 
These directories are located in:

<install drive>:\OperateITData\AoEng\<AO Server ID>\
AmCat

Where each <AO Server ID> directory represents one AO Server instance 
from which the directory:

{66E71F7B-90D6-4E62-9881-38388B24CBDF}

was originally saved from. The <AO Server ID> directory name is 
formatted as two consecutive GUIDs, for example:

{F9C150F5-2929-4A12-BC28-E00ED6DB1585}{B925E77F-2A82-
41C6-A981-FAB4386D5701}.

2. Maximo Integration:  

a. Refer to System 800xA Asset Optimization Configuration (3BUA000118*) 
to configure ECS.

b. If the MxDef files were customized, restore the MxDef files to the 
following directory:

...\Program Files (x86)\ABB Industrial IT\Optimize 
IT\Asset Optimization\AOECSConnector\MxDef\

Refer to System 800xA Asset Optimization Configuration (3BUA000118*) 
for more information on MxDef files.

cpmPlus Enterprise Connectivity Version 4.0 (ECS 4.0) must be installed in order 
to access Maximo Server Version 6.2.

The Maximo Integration information (Maximo Equipment ID and Maximo 
Credentials aspects) must be restored on all Asset Optimization Server nodes. 
Reference the Service Structure for the Asset Optimization Server.
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c. Restore the AOMaximoModel file to the following location if the ECS 
model was customized:

...\Program Files (x86)\ABB Industrial IT\Optimize 
IT\Asset Optimization\AOECSConnector\ECSDefinitions

d. Ensure that the ABB Maximo Connectivity system extension is loaded.

3. SAP/PM Integration:  

a. Refer to System 800xA Asset Optimization Configuration (3BUA000118*) 
to configure ECS.

b. If the SAPDef files were customized, restore the SAPDef files to the 
following directory:

...\Program Files (x86)\ABB Industrial IT\Optimize 
IT\Asset Optimization\AOECSConnector\SAPPMDef

c. Restore the AOSAPModel file to the following location if the ECS model 
was customized:

...\Program Files (x86)\ABB Industrial IT\Optimize 
IT\Asset Optimization\AOECSConnector\ECSDefinitions

Refer to System 800xA Asset Optimization, Configuration (3BUA000118*) for 
more information on SAPDef files.

The pending fault reports residing in the system can be restored to the following 
directory structure:

...\OperateITData\OptaoACDs

Restore the entire OptaoACDs folder.

cpmPlus Enterprise Connectivity Version 4.0 (ECS 4.0) must be installed in order 
to access SAP Server Version 4.7.

The SAP/PM Integration information (SAP Equipment ID and SAP Credentials 
aspects) must be restored on all Asset Optimization Server nodes. Reference the 
Service Structure for the Asset Optimization Server.
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d. Ensure that the ABB SAP Connect system extension is loaded. 

4. DMS Calibration Integration.

5. Asset Monitors that are assigned (via the Configure option drop-down list box 
on the Asset Monitor Instance on an Object) to a particular AO Server object 
and Asset Optimization Server aspect (by Object name:Aspect name pair), will 
not be correctly configured after the upgrade. The AOServer property will be 
unconfigured and the following error message will appear:

Unable to resolve AO Server for this Asset Monitor 
configuration

This must be resolved before the Asset Monitor Logic can be loaded into an 
AO Server:Asset Optimization Server for execution. Refer to the Object Type 
Structure for Asset Optimization, Object Type Group:AO Server, Object Type.

6. After a restore of a 800xA 5.0 SP2 system, the Asset Optimization Server 
(Monitor Server/Engine) is running. The AO Server tab of the Asset 
Monitoring Server aspect will show a status of good: AM Engine running. 

a. Clicking the Asset Monitors tab and selecting AMs assigned to this AO 
Server will show that the values in the Status column are NOT Loaded, 
enabled. 

b. Click Load all AMs to reload all enabled Asset Monitors assigned to this 
AO Server. 

The pending fault reports residing in the system can be restored to the following 
directory structure:

...\OperateITData\OptaoACDs

Restore the entire OptaoACDs folder.

The DMS Calibration Integration approach is changed in 800xA 5.1. Upgrade of 
DMS Calibration Integration is not supported. Reconfigure the DMS Calibration 
Integration based on an engineered solution.

Contact ABB technical support for more information.

:The Enable Write Access check box must be selected in the Asset Monitor Data 
Source aspect before loading Runtime Asset Monitors into the AO Server. Refer 
to System 800xA Asset Optimization Configuration (3BUA000118*) for more 
information.
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PC, Network and Software Monitoring

In the 800xA 5.1 and later releases, a set of IT Asset type objects are deprecated. 
The new enhancements, Process Graphics 2 and Native Language Support (NLS), 
are not applied to deprecated IT Asset type objects. Replacements of deprecated IT 
Asset type objects are delivered in PNSM Device Library. It is recommended to 
migrate deprecated IT Asset type objects to PNSM Device Library in case the 
system being upgraded has all Process Graphics 2 graphics and no VB graphics. 
Refer to Appendix H, Mapping of Deprecated IT Asset Object Types.

The following steps describe the migration procedure.

1. Download IT Asset type objects in PNSM Device Library that replaces the 
deprecated IT Asset type objects which are used in the current configuration. 
The download link is http://www.abb.com/controlsystems.

2. Migrate each deprecated IT Asset type object to its replacement IT Asset type 
object in PNSM Device Library

a. Instantiate and configure PNSM Device Library objects.

b. Delete deprecated IT Asset type objects.

3. To upgrade to a newer version of the Light Generic Computer Process object 
type, it is required to delete all old instances and replace them with the newer 
version of the Light Generic Computer Process object type. Refer to the 
Process Monitoring section of System 800xA PC, Network and Software 
Monitoring Configuration.

Perform the following post upgrade procedure for PC, Network and Software 
Monitoring.

1. If user defined Script, Resource, and Assembly files were backed up, copy the 
saved files from the safe media to the following directories:

Migration from deprecated IT Asset type objects to the PC, Network and 
Software Monitoring Device Library is not mandatory in case the system being 
upgraded already has VB graphics.

Reconfigure all applications referring to deprecated IT Asset type objects. For 
example, Logging of OPC data into history archive.

http://www.abb.com/controlsystems
http://www.abb.com/controlsystems
http://www.abb.com/controlsystems
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...\Program Files (x86)\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Scripts\User

...\Program Files (x86)\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Assemblies\User

...\Program Files (x86)\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Resources\User

800xA for Harmony/Melody Connectivity Server Node Update

The following procedure is only applicable to 800xA for Harmony and 800xA for 
Melody Connectivity Server nodes.

Determining the Node Running ShadowOPC Server as AfwService

To identify the node that is running ShadowOPC Server as AfwService:

1. Refer to System 800xA 5.1 PC, Network and Software Monitoring 
Configuration (3BUA000447*) and verify that the Shadow OPC Service is 
configured.

2. Open a Plant Explorer Workplace.

3. Use the Structure Selector to open the Control Structure.

4. Use the Object Browser to navigate to:

IT Server, IT OPC Server Network

5. Select OPC Data Source Definition in the Aspect List Area.

6. Click View in the Preview Area to launch the Service Group Definition dialog.

7. Select service provider from the Providers list.

There are more PC, Network and Software Monitoring steps that need to be 
performed after the system extension maintenance has been performed. Refer to 
PC, Network and Software Monitoring on page 225.

Do not perform this procedure on a server node that is running Shadow OPC 
Server as AfwService.
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8. Click View to launch the Service Provider Definition dialog.

9. The Node in the Configuration tab is the name of the node that is running 
ShadowOPC Server as AfwService.

10. Close all dialogs.

Applying the Update

Perform the following procedure on all 800xA for Harmony and 800xA for Melody 
Connectivity Server nodes.

1. Insert the System Version 5.1 Released Documents CD into the drive.

2. Use Windows Explorer to locate and copy ABBShadowOPC.exe.config in 
the Updates directory on the CD.

3. Use Windows Explorer to navigate to the following directory on the local hard 
drive:

...:\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin

4. Make a backup of the existing ABBShadowOPC.exe.config file.

5. Paste the file copied in Step 2 to the hard drive location navigated to in Step 3.

6. Restart the node. 

7. After the restart, use Windows Task Manager to verify the KeepAliveApp.exe 
in not in the list of processes.

PNSM Device Library Restore Procedure

Perform the following post upgrade procedure for PNSM Device Library:

1. Copy the files from the safe location to the directory if MOF files were backed 
up:

...\Program Files\ABB Industrial IT\Optimize IT\PC, 
Network and Software Monitoring\MOFS

2. Copy the Custom Asset Monitor dlls from the safe location to the 
following location for object types with Custom Asset Monitors:
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...\Program Files\ABB Industrial IT\Optimize 
IT\PC, Network and Software Monitoring\Asset 
Monitoring\Bin

Use the Register.dll bat file present in the Object Type to register this dll 
automatically.

3. Copy the Windows Management Instrumentation (WMI) repository to the 
directory if the files were backed up. Perform the following steps to back up 
and restore the the WMI repository.

a. Right-click Computer and select Manage. Computer Management is 
displayed.

b. Expand Configuration on the left panel. Select WMI Control.

c. Right-click WMI Control and select Properties. The Properties dialog 
box is displayed.

d. Click Backup/Restore Tab.

e. Click Back Up Now..., Specify a name for your backup file 
window is displayed. 
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f. Enter the name of the backup file and click Save.

g. Click Restore Now..., Specify a backup file to restore window 
is displayed.

h. Select the file and click Open to restore the backed up file.

SMS and e-mail Messaging

Reconfigure the GSM Device hardware information recorded in the save operation 
(refer to SMS and e-mail Messaging on page 172).

Figure 36. WMI Backup File

It may be necessary to stop and start the Messenger Server Service in the Service 
Structure after the SMS and e-mail Messaging restore operation.
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Batch Management

Verify that the primary Batch Server is in primary mode (P is displayed in the 
Windows Task bar) and the secondary Batch Server is in secondary mode (S 
displayed in the Windows Task bar). If the proper modes are not displayed, enable 
the Batch Service Group before proceeding.

To enable the Batch Service Group:

1. Open a Plant Explorer Workplace.

2. Select the Service Structure.

3. Select the Services\Batch Service, Service\batch_group_name, Service 
Group\Service Group Definition aspect.

4. Select the Configuration tab.

5. Select the provider that is currently the secondary Batch Server.

6. Select the Enabled check box and click Apply.

7. Select the provider that is currently the primary Batch Server.

8. Select the Enabled check box and click Apply.

Batch data can be reloaded to the batch database from wherever it was archived. 

Perform the following to view any Batch data archived from SV5.0 or previous 
versions of the Batch product:

1. Create a Virtual Machine (VM) node with the existing system version and its 
components.

2. Restore Batch data using the Batch Restore window onto this virtual machine.

Once the restored data is in the batch database, it can be viewed using the Batch 
History Overview window. 

Do not restore directly from CDs or DVDs. Restore from hard disk drives which can 
be restored from CDs or DVDs using commercially available software.

The Batch history archive and restore aspect has been removed in SV5.1.
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Selecting the Alarm Server

To select the Alarm Server:

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Use the Object Browser to select:

Services > Event Collector, Service > 
Batch_AE_Service, Service Group

4. Select Service Group Definition in the Aspect List Area.

5. Select the Special Configuration tab in the Preview Area.

6. Select Produce IT Batch OPC AE Server in the Alarm Server field.

7. Click Apply.

Basic History Service

Restore the Basic History Service data as follows. Perform this procedure on every 
node where the Basic History Service is running.

1. Stop the Basic History Server from the Service Structure by the following 
procedure:

a. Open a Plant Explorer Workplace. 

b. Use the Structure Browser to open the Service Structure. 

c. Select the Basic History, Service > Basic, Service Group. 

d. Select the Service Group Definition aspect. 

e. Click the Configuration tab. 

f. Clear the Enabled check box and click Apply.

2. If it is necessary to keep historical data for the time since the upgraded system 
was started, copy the current Basic History log files in the following directory:

Always perform the Toolbar configuration as described in System 800xA Batch 
Management Configuration and shutdown script procedure as described in the 
Batch Management section of System 800xA Post Installation (3BUA000156*).
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...\OperateITData\History\{provider ID}

to a temporary directory.

These files will be inserted by using the Archive Tool.

3. Delete all files under:

...\OperateITData\History\{provider ID}

4. Restore the files from the backup of Basic History Service Data to:

 ...\OperateITData\History\{provider ID}

5. Start the Basic History Service from the Service Structure.

6. If Step 2 was performed:

a. Open the AdvHtArchiveTool located by default in the following directory:

...\Program Files\ABB Industrial IT\Operate IT\Process 
Portal A \bin

b. Use the File/Select/Open Archive command and browse to the directory 
containing the history log files.

c. Open the Action/Insert Data into Logs command.

d. Accept the default values in the Time Selection dialog box.

e. Click OK to start the insertion of the saved data to the logs.

Information Management

Refer to Information Management Post Upgrade Procedures on page 458 in 
Appendix , Information Management Upgrade to perform the Information 
Management post upgrade procedures.

Calculations Service

Calculations that were disabled prior to the upgrade must be enabled by selecting 
the Enabled check box in the Calculations dialog box. Refer to the section on 
Calculations in System 800xA Information Management Data Access and Reports 
(3BUF001094*). 

To enable the Calculations Service:
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1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Calculations Service Object.

4. Select the Service Definition aspect.

5. Click the Configuration tab.

6. Select the Enabled check box and click Apply.

Scheduling Service (Application Scheduler)

Schedules that were disabled prior to the upgrade must be enabled by selecting the 
Enabled check box in the Scheduling dialog box. Refer to the section on 
Scheduling in System 800xA Information Management Data Access and Reports 
(3BUF001094*). 

To enable the Scheduling Service:

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Scheduling Service Object.

4. Select the Service Definition aspect.

5. Click the Configuration tab.

6. Select the Enabled check box and click Apply.

Process Engineering Tool Integration

Use the following procedure after updating Process Engineering Tool Integration:

Restore the backed up data directory (in preparation-step prior to upgrade) to the 
installed directory of Process Engineering Tool Integration. Restore the entire Xml 
directory contents to:

...\Program Files\ABB Industrial IT\Engineer 
IT\Engineering Studio\Process Engineering Tool 
Integration\Xml
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Miscellaneous Procedures
Perform the following procedures:
• Upgrade Control Builder M Projects.
• PC, Network and Software Monitoring.
• Add Autostart Shortcut.

Upgrade Control Builder M Projects

800xA 5.1 Feature Pack 4 has introduced a new (major) version. The 800xA 5.0 
SP2 version of BasicHWlib (5.0-2) and the 800xA 5.1 version of 
BasicHWlib (5.1-0) can coexist with the new version (5.1-1) in the 800xA System, 
and must be used if any controllers are going to stay with the firmware from 800xA 
5.0 SP2 and/or 800xA 5.1.

The Control Builder project upgrade will be started automatically the first time the 
project is opened. It can also be explicitly triggered by starting an empty Control 
Builder and selecting:

Tools > Maintenance > Upgrade Project

During the upgrade Control Builder asks if the user wants to use the new (5.1-1) or 
old (5.0-2 or 5.1-0) BasicHWLib version for the controllers in the project. If the 
intention is to upgrade controller firmware the new version should be selected. If the 
intention is to not upgrade controller firmware the old version must be selected.

PC, Network and Software Monitoring

1. Perform the following steps on the PC, Network and Software Monitoring 
Server node.

a. Use the Structure Selector to open the Service Structure in the Plant 
Explorer Workplace.

After upgrading a configuration containing one Engineering and one Production 
system to 800xA 5.1 Feature Pack, the Control Builder M projects in the two 
systems should be made identical using the Import/Export tool, Engineering 
Repository, or by recreating the Engineering System using Backup/Restore 
before engineering work is restarted. Otherwise there will be a lot of false 
differences on the AC 800M aspects reported in the import difference report 
when moving solutions between the systems.
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b. Use the Object Browser to navigate to the:

Services > OpcDA_Connector, Service > SG_IT Server

object. If there is no object to navigate to, skip to Step l (letter l, not 
number 1).

c. Open the OPCDA_Provider_<servername> object and double-click on the 
Service Provider Definition aspect.

d. On the Configuration tab, clear and select Enabled check box and click 
Apply. The Current field should change to Service.

e. Use the Structure Selector to open the Control Structure.

f. Use the Object Browser to navigate to the IT Server object.

g. Double-click OPC Data Source Definition in the Aspect List Area.

h. Click on the Service Group drop-down menu and select the SG_IT 
Server.

i. Click on the OPCDA_Provider_<servername> which was configured in 
Step c.

j. Click Apply.

k. Skip to Migrate the IT Asset Monitors (Step 2).

l. Use the Structure Selector to open the Control Structure.

m. Use the Object Browser to navigate to the IT Server object.

n. Double-click OPC Data Source Definition in the Aspect List Area.

o. Select New.

p. Click Add and select the appropriate Service Provider from the list.

q. Click OK twice.

r. Click Apply.

2. Migrate the IT Asset Monitors. If Asset Optimization and PC, Network and 
Software Monitoring were installed on the 800xA 5.0 SP2 System, then the 
following must be done for any existing IT Assets that had IT Asset Monitors 
configured for them. 
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a. Use the Find Tool in the Plant Explorer Workplace to locate all the IT 
Asset Monitor aspect instances in the Control Structure.

b. Right-click on each of the found aspects and select Goto Object.

c. Open the IT Device Manager aspect and click Generate to recreate the IT 
Asset Monitor.

d. Repeat Step c for each object in the Find list.

e. Use the Object Browser to navigate to: 

Root, Domain > Asset Optimization, Asset Optimization > 
AO Server 1, AO Server

f. Select Asset Optimization Server in the Aspect List Area.

g. Select the Enabled check box in the AO Server tab and click Apply.

h. Click Load all AMs in the Asset Monitors tab.

Add Autostart Shortcut

If it is desired to enable the autostart of the Operator Workplace on client nodes, 
perform the following:

1. Define a default workplace.

2. The shortcut must be created from the ABB Workplace login window.

3. The shortcut is located in:

...:\Users\Username\AppData\Roaming\Microsoft\Windows\
Start Menu\Programs\Startup 

4. Right-click the shortcut and select Properties from the context menu.

5. Add the following to the shortcut target:

/WS

-or-

/WaitForSystem

Basic Computer Monitoring will not upgrade properly from a previous version to 
the current version. Use the Basic Computer Monitoring Configuration Tool to 
recreate the configuration.
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6. Click OK.

System Backup
Make complete hard disk and 800xA System backups of the upgraded system.
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Section 5  Upgrading 800xA 4.1 to 800xA 5.1
Offline

Unless otherwise indicated, the person performing this upgrade must use the same 
user account that was used during the installation of the 800xA System software.

Functional Area Naming
Some 800xA Functional Area names have been changed since the 800xA 4.1 
release. Table 5 lists the Functional Area names before and after the upgrade.

Upgrading the 800xA System from 800xA 4.1 to 800xA 5.1 requires the plant to 
be shut down. To guarantee the functionality of the upgraded system, follow the 
upgrade instructions for the installed products and perform them in the order 
presented. 

Upgrading from 800xA 4.1 to 800xA 5.1 requires that ABB Industrial IT 800xA 
Core 4.0.0-1 SP1 Rollup 5d (December 2006) or later be installed. If ABB 
Industrial IT 800xA Core 4.0.0-1 SP1 Rollup 5d (December 2006) or later is not 
installed, the backup/restore functionality will fail.

Refer to the 800xA for Harmony section of System 800xA Release Notes New 
Functions and Known Problems (2PAA106188*) before upgrading an 800xA 4.1 
System if 800xA for Harmony is installed on any node in the system.

Table 5. Functional Area Naming

Name in 800xA 4.1 Name in 800xA 5.1

800xA for Melody 800xA for AC 870P/Melody

Control IT for AC 800M 800xA for AC 800M



Considerations Section 5  Upgrading 800xA 4.1 to 800xA 5.1 Offline

230 3BSE036342-511 G

 

Considerations
The following considerations must be taken into account before performing the 
upgrade.

• Unless otherwise indicated, the person performing this upgrade must use the 
same user account that was used during the installation of the 800xA System 
software.

• To guarantee the functionality of the upgraded system, follow these 
instructions carefully and perform them in a well defined order.

• It is recommended that a disk image be taken of all disks on each node before 
beginning and after completing the upgrade.

• Backing up the aspect directory (800xA System Backup), reports, history data, 
graphics, and other application data is required before performing the upgrade.

• Take an inventory of all software on all nodes in the 800xA System before 
performing the upgrade.

Control Builder M Compatibility Issues
Refer to the compatibility issues detailed in Appendix B, Control Builder M 
Compatibility Issues before beginning the upgrade.

Upgrade Flow
This section is organized so that the instructions are presented in the proper upgrade 
order. Do not skip any steps that pertain to 800xA software being used in the current 

FOUNDATION Fieldbus Device Integration Device Management FOUNDATION Fieldbus

HART Device Integration Device Management PROFIBUS & HART

PROFIBUS Device Integration

Table 5. Functional Area Naming (Continued)

Name in 800xA 4.1 Name in 800xA 5.1
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or upgraded system. Refer to Planning for the Upgrade on page 35 for additional 
information and ideas on how to streamline the upgrade process.

Central Licensing System

System Upgrade
Perform the following to upgrade the 800xA System.

1. Document all Windows settings including the domain, DNS, policies, users, 
etc.

2. Refer to the Diagnostics Collection Tool section in System 800xA Tools 
(2PAA101888*) and run the Software Analyzer from the Primary Aspect 
Server in the 800xA 5.0 SP2 System. This allows for an analysis of the 
software installed on the different nodes in the 800xA System with an 
opportunity to correct errors in the 800xA 5.0 SP2 System before upgrading. 
This is especially helpful when using the System Installer to generate setup 
packages based on the 800xA 5.0 SP2 System. If there is missing or incorrect 
software in that version, the System Installer will duplicate that installation in 
the 800xA 5.1 System.

3. If 800xA for MOD 300 is installed, check and delete the MOD Message Class 
object before performing the 800xA System backup.

Delete all MOD Message Class objects below the Message Classes object 
located in:

Library Structure > System Messages > Message Classes

Order the licenses required for the current system version and revision. The 
800xA 4.1 licenses will not work.

A convenient way to delete the Message Class objects is to export the Message 
Classes object, delete it and its descendants, and then import the Message Classes 
object back again.
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4. Refer to Appendix D, Consistency Check and perform the necessary 
consistency checks.

5. The new support for version handling of aspect data will make all digital 
signatures in 800xA 4.1 invalid when upgrading to 800xA 5.1. To simplify the 
upgrade, two applications have been developed to support the re-signing of 
aspects in 800xA 5.1:

• AfwSignatureReport: Used to create a report with information about signed 
aspects in 800xA 4.1.

• AfwSignatureManager: Used in 800xA 5.1 to re-sign these aspects.

Perform the following before upgrading from 800xA 4.1 to 800xA 5.1.

a. Insert 800xA System Installation DVD 1 (for 800xA 5.1) into the drive on 
a client in the 800xA 4.1 800xA System.

b. Copy the AfwSignatureReport.exe from the following directory on 800xA 
System Installation DVD 1 to a directory on the client. 

Engineering & Development\Accessories\Digital 
Signatures Upgrade Tools\SV4

c. Open a Windows Command Prompt.

d. Change to the directory where AfwSignatureReport.exe was copied.

e. Run the following command:

f. AfwSignatureReport <filename>.xml

g. Save the signature report file <fileName>.xml on an external media during 
the upgrade.

6. Check that there is only one External Alarm Service Group and that their 
providers run on Aspect Servers only (not on any Connectivity Server). If not 
(i.e. there is more than one group and/or there are providers running on 
Connectivity Servers), keep only one External Alarm Service Group and move 

Perform a consistency check before performing the 800xA System backup. 
Failure to do so could result in problems when restoring the system after the 
upgrade.

The digital signature must be valid before saving to the report file.
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all providers to that group. Also make sure the providers run on the Aspect 
Servers with a maximum of one provider per Aspect Server.

7. 800xA System backups containing undeployed user created process graphics 
will result in warning and error messages later in the upgrade process. To avoid 
these messages, refer to Industrial IT, 800xA - Engineering, Graphics 
(3BSE030335*) and use the Display Tool to deploy all user created process 
graphics before beginning the 800xA System backup.

8. Refer to Appendix E, Recording the Number of Aspects and Objects and 
record the number of aspects and objects in the system before performing the 
800xA System Backup.

9. It is important to create backups of node hard disks and the 800xA System 
before starting the upgrade procedures. Valid backups insure that the system 
can be restored if necessary.

a. It is recommended that a third party backup/restore and/or disk imaging 
utility be used to save (and restore if necessary) all disks on each node 
before starting the upgrade procedures.

b. Perform the 800xA full backup from the Maintenance Structure (Aspect 
Directory backup type).

The 800xA Backup/Restore function makes it possible to make an online 
backup of a node and perform an offline restore of the same node. A full 
backup stores all aspect objects and aspect data (application data) in the 
Aspect Directory.

Ensure that the Post Installation Procedure for Engineering Studio 4.1.0/0 
Rollup 4 (refer to Release Notes 3BDS011656R4101) has been performed. Refer 
also to Technical Description - Industrial IT System 800xA SV 4.x System 
Software Versions (3BSE037782* (latest revision)).

For background information refer to Product Bulletin - 800xA Eng.Workplace 
Eng. Studio SV 3.1-SV 4.0, Aspect Types falsely reset (3BDS100999).

Avoid engineering or any other changes especially to the Aspect system during 
the 800xA Backup process.

Verify the Batch Management Servers are operating normally before and during 
800xA System backups of systems containing Batch Management nodes. This 
will ensure the backup of all batch data. 
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All system extensions that are part of the system must be installed and 
loaded on the node where the backup will be taken (usually the primary 
Aspect Server node). No changes can be made (especially to the Aspect 
directory) during the 800xA Backup process.

When backing up a system with Environments, both the Production and 
Engineering Environments will be included in the backup. Only the 
current version of each aspect will be included in the backup. This means 
that all version history will be removed.

– Open a Plant Explorer Workplace.

– Use the Structure Selector to open the Maintenance Structure.

– Create a Full Backup Definition object.

– Configure the Scope and Storage tabs.

– Check the disk space and path in the Storage tab. A large configuration 
could require a minimum of five gigabytes of free space.

– Start the backup process.

– Refer to the How to Make a Full Backup topic in System 800xA 
Maintenance (3BSE046784*) for more detailed information on performing 
the 800xA System Backup.

10. Refer to Pre-Upgrade Procedures on page 236 and perform the pre-upgrade 
procedures that are applicable to the installed system.

11. Perform the following procedure to shut down the 800xA System:

a. Stop all external clients to the 800xA System (OPC DA, HDA, and AE 
clients that access the 800xA System) before a system shutdown.

It is only possible to perform the 800xA System backup from the Production 
Environment.

If EBService timeout issues occur while taking a backup of the 800xA 4.1 
System, there is a probability that the DM/PM aspects may be corrupted in the 
backup files. Restoring the corrupted backup files to the 800xA 5.1 System 
results in the following error message:

Import/Export Error: RestoreFromStream failed.
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b. From the Configuration Wizard, select System Administration and click 
Next.

c. Select the system to stop and click Next.

d. Select Systems and click Next.

e. From the Systems dialog box, select Stop and click Next.

f. From the Apply Settings dialog box, click Finish.

12. Reformat the hard drives of all 800xA System nodes.

13. Install the new operating system defined for the 800xA 5.1 System on all 
800xA System nodes. Click Advanced when installing the Workstation 
Operating System or the Server Operating System. This is required to delete 
the existing partition and recreate a new one. Failure to perform this step will 
leave old data on the hard drive.

14. Refer to Section 2 - Prerequisites in:

– Manual Upgrades - System 800xA Manual Installation (3BSE034678*).

– Automated Upgrades using System Installer - System 800xA Automated 
Installation (3BSE034679*).

and perform all procedures relating to operating system settings, Windows 
service packs, miscellaneous Windows components installation, other third 
party software, group policy, 800xA Service User privileges, and Windows 
updates and hot fixes.

15. Refer to System 800xA Manual Installation (3BSE034678*) and install the 
800xA 5.1 Central Licensing System Server software and install the license 
file, as this will be the Primary Aspect Server in the 800xA 5.1 System. This 
step is not necessary if performing an automated upgrade using System 
Installer.

16. Refer to System 800xA Manual Installation (3BSE034678*) and install all 
800xA 5.1 System software per the software inventory taken earlier. This step 
is not necessary if performing an automated upgrade using System Installer.

The 800xA System will shut down within a couple of minutes. The time it takes 
to shut down may be more or less depending on the size of the 800xA System.
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17. Refer to Requirements for VB Graphics Extension Software on page 256 to 
install Visual BASIC 6.0 with SP6 (if required) and the VB Graphics 
extensions.

Feature Pack Functionality______________________________________________________________________

18. Perform the system update to the latest Feature Pack:

• Use the System Feature Pack Update Tool (FUT) to perform the update. Refer 
to the System 800xA 5.1 System Feature Pack Update Tool (2PAA107435*) for 
user instructions.

___________________________________________________________________________________________

19. Refer to Post Upgrade Procedures on page 259 of this instruction and perform 
all necessary steps.

20. Perform all of the procedures described in Miscellaneous Procedures on page 
303.

21. Refer to System 800xA Post Installation (3BUA000156*) and configure 
Windows Services and Windows Firewall.

22. It is important to create backups of node hard disks and the 800xA System after 
completing the upgrade procedures. Valid backups insure that the system can 
be restored if necessary.

a. It is recommended that a third party backup/restore and/or disk imaging 
utility be used to save (and restore if necessary) all disks on each node 
before starting the upgrade procedures.

b. Perform the 800xA full backup from the Maintenance Structure (Aspect 
Directory backup type).

Pre-Upgrade Procedures
Some 800xA System software requires preparatory steps before shutting down 
800xA System processes. Perform the applicable procedures in the order presented. 

Control IT for AC 800M

Use the following procedure to prepare for the Control IT for AC 800M upgrade:
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1. Control Builder stores its settings (systemsetup.sys) on disk in the following 
directory:

...\ABB Industrial IT Data\Engineer IT Data\Control 
Builder M Professional

Copy this file to a safe media.

2. Save OPC configurations by selecting:

File > Save Configuration

in the OPC Server Panel.

3. The OPC Server stores configuration files (*.cfg) and settings 
(systemsetup.sys) on disk. Copy these files to a safe media. The 
systemsetup.sys file is located in:

...\ABB Industrial IT Data\Control IT Data\OPC Server 
for AC 800M

The configuration files are stored in the Files folder in the same location.

4. If the system to be upgraded originates from System Baseline 2.1 and has been 
upgraded in steps through system versions, verify that the Control Builder 
projects do not use the old obsolete SB2 (System Baseline 2) libraries (libraries 
of version 1.0-0. For example: ControlStandardLib 1.0/0.

Device Management FOUNDATION Fieldbus

Perform the following to prepare for the Device Management FOUNDATION 
Fieldbus upgrade.

• User-Made Modifications to Library Objects Representing FF Standard 
Blocks.

• Exporting Locally Stored Parameter Value Sets.

User-Made Modifications to Library Objects Representing FF Standard Blocks

User-made modifications to library objects representing FF standard blocks (these 
are blocks supported by the Device Type Standard FBs as indicated in the Block 
Info tab of the block class parameter dialog box) will be overwritten during 
upgrade. If such changes have been made, they can be reconstructed manually. 
Refer to Device Management and Fieldbuses on page 265.
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Exporting Locally Stored Parameter Value Sets

Export the locally stored parameter value sets as follows:

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Object Type Structure. 

3. Use the Object Browser to navigate to: 

      FF Libraries, Object Type Group

4. Select FF Management in the Aspect List Area.

5. Click Open Project.

6. Select the Function Block from FF Block Library > Function Blocks 
in the Library view.

7. Double-click on the Function Block to open the properties dialog box for the 
chosen Function Block.
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8. Right-click and select Export from the context menu (Figure 37).

9. Specify the name and location of the .csv file and Click OK.

Device Management PROFIBUS & HART

Historical data sets of Device Type Manager (DTM), exported via the Fieldbus 
Management aspect, along with device specific DTM files are stored as files on the 
Primary Aspect Server node. These files and the PROFIBUS/HART OPC Server 

Figure 37. Exporting Locally Stored Parameter Value Sets
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configuration are stored after successful 800xA System backup. The path to this 
folder can be found as follows:

1. Open the Plant Explorer Workplace on the Primary Aspect Server node.

2. Use the Structure Selector to select the Control Structure.

3. Use the Object Browser to select the Root Object type.

4. Select the FBB PH Settings aspect.

5. Record the path information for the Primary Aspect Server found in the FBB 
PH Settings aspect.

6. Use Windows Explorer to copy the folder (default: Fieldbus Builder PH) 
containing device specific configuration files (in the path recorded in Step 5) to 
the 800xA System backup folder, created as described in System 800xA 
Maintenance (3BSE046784*). 

7. If the folder name of the copied folder is not Fieldbus Builder PH, it must be 
renamed to the default folder name (Fieldbus Builder PH) in the 800xA System 
backup folder.

PROFIBUS Device Types

PROFIBUS Device Types in 800xA 5.0 and later are based on Hardware Libraries 
(HWLib). This is different from previous system versions, where these Device 
Types were based on Hardware Definitions (HWD). As a result, the PROFIBUS 
Device Types used in connection with the Device Integration software must be 
linked to new delivered Hardware Libraries to ensure system and upgrade 
compatibility.

If the ABB_TZIDC_110-220_SP_Short module type is used in the Control Structure 
of the Plant Explorer, a special upgrade procedure must be performed to ensure 
upgrade compatibility in 800xA 5.0 and later. This module is delivered with the 
PROFIBUS Device Integration package and its system extensions and is supported 
by the ABB_TZIDC_110-220_YP0_v1_0 PROFIBUS Device Type.

Perform the following procedure only if the exact PROFIBUS Device Type 
described is used. Otherwise, this procedure can be skipped.

The following steps requires Bulk Data Manager (BDM) (Engineering Platform) 
to be installed. Perform the described steps on an Engineering system node.
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1. Open the Engineering Workplace and select the Control Structure.

2. Open the Find Tool.

3. In the <Add attribute> selection box select Structure. 

4. In the <Structure> selection box select Control Structure.

5. In the <Add attribute> selection box select Object Type. This displays all 
instances available in the Control Structure.

6. Select the ABB_TZIDC_110-210_SP_Short module from the displayed list 
and click Search. If the module type is not available, this section can be 
skipped.

7. Open Bulk Data Manager in the Control Structure (right-click on the Root 
node and select Advanced > Bulk Data Manager).

8. Verify that the valid system is selected in the BDM sheet. 

9. Search for and select the ABB_TZIDC_110-220_SP_Short module in the 
Control Structure.

10. Select Control Properties in the Aspect List Area and move it via the drag 
and drop function to the BDM sheet on cell A1 in the Preview Area.

11. A new window will open in which all parameters will be selected. Confirm the 
Complete selection by clicking OK.

12. Select cell A2 in the BDM sheet and enter the text Filter:Control 
Structure.

13. Select the project containing the ABB_TZIDC_110-210_SP_Short module in 
the Control Structure and move it via the drag and drop function into the 
BDM sheet on cell A3.

14. Select the Auto filter option in the Excel sheet (select Data > Filter > 
AutoFilter in the menu bar).

15. Select in line A in the BDM sheet, the column named Source Object (normally 
cell C1) and click Filter.

If the module is used in different projects, the steps must be repeated for the other 
projects.
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16. Search for and select the ABB_TZIDC_110-210_SP_Short module. This will 
now be the only module shown.

17. Enter the text delete for each listed module in the column named Command 
(normally cell A1). The Optional selection function can be used. 

18. Save the changes to the 800xA System by clicking Save All Objects. The 
modules will be deleted in the Control Structure.

19. Remove the text delete for each listed module in the column named 
Command.

20. The captions Short will be exchanged to Long for all listed modules in the 
column named Source Object. The name will now be ABB_TZIDC_110-
210_SP_Long for all listed modules.

21. Save the changes to the 800xA System by clicking Save All Objects. The 
modules will be created in the Control Structure.

800xA for Advant Master and 800xA for Safeguard

Perform the following to prepare for the 800xA for Advant Master and 800xA for 
Safeguard upgrade.
• Save the Advant Master Controller Licenses.txt.
• Save the Configuration Files.
• Save the DATHR Files.
• Document the RTA Board Control Aspect Settings.

Save the Advant Master Controller Licenses.txt

Perform the following on the Primary Aspect server in the 800xA 5.0 SP2 System:

1. Save the following file to a safe location.

– Advant Master Controller Licenses.txt

The default location for the file is:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\Licenses
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Save the Configuration Files

The configuration files in the Connectivity Servers can contain special configuration 
settings for Alarm and Event or Data access. Refer to 800xA for Advant Master, 
Configuration (3BSE030340*) for more information about these special 
configuration settings.

If such changes are available in the configuration files, perform the following on 
each 800xA for Advant Master and 800xA for Safeguard Connectivity Server node: 
Save the following files to a safe location:

• AdvDsMasterAdapter.csv

• AdvMbAeOPCServer.csv

The default location for the files is:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\Bin

Save the DATHR Files

Perform the following on each 800xA for Advant Master and 800xA for Safeguard 
Connectivity Server node:

1. Save the following files to a safe location:

– DATHR1.CD
– DATHR2.CD
– DATHR3.CD

from the folder:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\AdvantBase\Data\RTA\Init\

and record which files belong to which node.

Document the RTA Board Control Aspect Settings

Perform the following on each 800xA for Advant Master and 800xA for Safeguard 
Connectivity Server node:
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1. Document the following settings in the RTA Board Control aspect for 
reconfiguration after the upgrade.

– MB300 node and network address.

– Time synchronization registry key (REVERSED_SYNC_MODE):

HKEY_LOCAL_MACHINE\SOFTWARE\ABB\AFW\SystemModules\
AfwTimeServerAdaptor\1.0-0\Private

800xA for Harmony

Perform the following to prepare for the 800xA for Harmony upgrade.

Save 800xA for Harmony Information

Use the following procedure to save 800xA for Harmony information:

1. Log in to the 800xA for Harmony local service account on the Configuration 
Server or Configuration Server with Connectivity Server node.

2. Create a backup of the Configuration Server database.

a. Select:

Start > All Programs > ABB Industrial IT 800xA > 800xA for OCS 
Systems > Harmony > Configuration > Backup Configuration

b. Click Connect.

c. Click Browse to name the backup file and choose a location to save it.

When upgrading an existing 800xA 4.1 system to 800xA 5.1 using System 
Installer, verify that the Firewall is turned on and then execute the 800xA for 
Harmony 5.0 SP2 HarmonyVerifyHelper.exe file (accepting all defaults) on all 
Harmony Servers and Aspect Servers BEFORE using the System Planner tool or 
performing any other upgrade or update procedure. This file is located on 800xA 
System Installation DVD 1 in the following folder:

System Installer\Installation Tools\Upgrade\
HarmonyVerifyHelper

Save the backup file to a safe media like a network share or removable disk. 
Otherwise, the file will be deleted once an upgrade occurs due to a reload of the 
node.
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d. Click Backup.

e. Click Exit when the backup is complete.

800xA for AC 870P/Melody

Use the following procedure to save 800xA for AC 870P/Melody information:

1. Log in to the 800xA Service account on the Configuration Server node.

a. Create a backup of the Configuration Server database.

b. Select:

Start > All Programs > ABB Industrial IT 800xA > 800xA for Melody 
> Configuration > Backup Configuration

c. Click Connect.

d. Click Backup.

e. Click Exit when the backup is complete.

Disable the Melody AutoConfigurator service in Plant Explorer > Service 
Structure (the service must be disabled when the system maintenance backup is 
started).

Back up project specific changes (if applicable):
• DHCP Server Configuration.

• ETC Host files for Melody Connectivity Servers.

• Changes in the Default Object Types (e.g. manual changes for permissions 
in Control Connection Aspects).

• ConvDB changes only on Configuration Server (change to the directory 
...\Program Files\ABB Industrial IT\Configuration\Melody Tag Importer\.. and 
backup the files MELCONVERTER.BAT, ConvDB.mdb and 
ConvDB_<Hostname>.mdb.

ConfigServer node: Ensure that no Commissioning will be done from the 
Melody Composer during this upgrade. 

Save the backup file to a safe media like a network share or removable disk. 
Otherwise, the file will be deleted once an upgrade occurs due to a reload of the 
node.
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800xA for MOD 300

Ensure that the configuration data noted in the Customized Data for Backup 
appendix in 800xA for MOD 300 Configuration (3BUR002417*) has been recorded.

PLC Connect

1. If the PLC Connect IEC 60870 feature is installed and configured, the IEC 
configuration must be saved. Refer to the section on configuring the IEC 60870 
driver in System 800xA PLC Connect Configuration (3BSE035041*) for more 
information.

2. If the PLC Connect Communication Server Pre Treatment function is being 
used in the application (refer to System 800xA PLC Connect Configuration 
(3BSE035041*) for more information), make a backup of the Pretreat dll 
(Pretreat3.dll or Pretreat4.dll, be sure to select the version used). The Pretreat 
dll is located in the following folder on the PLC Connect Connectivity Server:

...\ABB Industrial IT\Operate IT\PLC Connect\Bin

3. Make a backup of the application project and source files for the Pretreat dll.

Engineering Studio IO Allocation

Deactivate the auto update mode in IO Allocation.

1. Start the Engineering Workplace.

2. Open the IO Allocation tool on any object by right-clicking on the object and 
selecting Advanced > IO Allocation from the context menu that appears.

3. Verify that no check mark symbol is visible in the Options > Autoupdate 
CBM menu item in the IO Allocation tool.

Asset Optimization

Preparing for the Asset Optimization upgrade requires recording the value of the 
OPC Group Update Rate and backing up data to a safe media.

The path is the default location of the file. If it has been placed somewhere else, 
make a backup from that location.
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Record the Value of the OPC Group Update Rate

Use the following procedure to record the value of the OPC Group Update Rate.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Control Structure.

3. Use the Object Browser to navigate to:

Root > Asset Optimization

4. Select Afw OPC-DA Asset Monitor Data Source in the Aspect List 
Area.

5. Record the value of OPC Group Update Rate (ms) shown in the Preview 
Area. This value must be reconfigured after the upgrade.

Back Up Data to Safe Media

Use the following procedure to back up Asset Optimization information (perform 
only the steps applicable to the system):

1. Asset Monitoring:

a. If Runtime Asset Monitors are being used in the system, save the Runtime 
Asset Monitor data directory (DeviceRunTimeMSLogicStore) to a safe 
media. This directory stores the runtime information calculated by the 
Runtime Asset Monitors running in this node. This directory is located in:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AssetMonitorEnvironment\Bin

b. If XY Profile Deviation Asset Monitors are being used in the system, save 
the XY Profile Deviation Asset Monitor data directory 
(XY_Reference_Profiles) to a safe media. This directory is located in:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AssetMonitorEnvironment\Bin

Asset Monitoring directories will be found on every Asset Optimization Server 
node and any other node defined as an Asset Monitoring Server.
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2. Maximo Integration: 

a. The MxDef files provide the mapping between the 800xA System 
environment and the Maximo system. If the MxDef files were customized 
per the instructions in Industrial IT, 800xA - Asset Optimization, 
Configuration (3BUA000118*), back up the customized MxDef files to 
safe media.

– The customized MxDef Files for Maximo versions 4.1 and 4.1.1 are 
located in the following directory:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\ABBAO\Services\MOM\MxDefs\

– The customized MxDef files for Maximo version 5.1 and 5.2 are located 
in the following directory:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\ABBAO\Services\MOM\MxDefs\Maximo5\MxServer

– The customized MxDef files for Maximo version 6.2 are located in the 
following directory:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AOECSConnector\MaximoDef

b. Back up the AOMaximoModel.xml file to a safe location. A backup of 
AOMaximoModel.xml is necessary because the ECS model for Maximo 
also needs to be modified if the MXDef files are customized.

The model file is available at the following location:

...\program files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AOECSConnector\ECSDefinitions

If using Maximo Integration, the Maximo Integration information (Maximo 
Equipment ID and Maximo Credentials aspects) must be saved from all Asset 
Optimization Server nodes. Refer the Service Structure for the name of the 
Asset Optimization Server nodes.

The pending fault reports residing in the system are available in the following 
directory structure:

...\OperateITData\OptaoACDs

Backup the entire OptaoACDs folder.
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3. SAP/PM Integration: 

a. Although the SAP/PM system is separate from the 800xA System, it is a 
good idea to back up the system in use. Follow SAP/PM standard 
practices for SAP/PM system backup.

b. The SAPPMDef files provide the mapping between the 800xA System 
environment and the SAP/PM system. If the SAPDef files were 
customized per the instructions in Industrial IT, 800xA - Asset 
Optimization, Configuration (3BUA000118*), back up the customized 
SAPDef files to safe media.

The customized SAPPMDef files for SAP version4.7 are located under:

...\Program Files\ABB Industrial IT\Optimize IT\
Asset Optimization\AOECSConnector\SAPPMDef

c. Back up the AOSAPModel.xml file to a safe location. A backup of 
AOSAPModel.xml is necessary because the ECS model for SAP also 
needs to be modified if the SAPPMDef files are customized.

The model file is available at the following location:

...\program files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AOECSConnector\ECSDefinitions

4. DMS Calibration Integration:

If using SAP/PM Integration, the SAP/PM Integration information (SAP 
Equipment ID and SAP Credentials aspects) must be saved from all Asset 
Optimization Server nodes. Reference the Service Structure for the name of the 
Asset Optimization Server nodes.

The pending fault reports residing in the system are available in the following 
directory structure. Backup the entire OptaoACDs folder.

...\OperateITData\OptaoACDs

The DMS Calibration Integration approach is changed in 800xA 5.1. Upgrade of 
DMS Calibration Integration is not supported. Reconfigure the DMS Calibration 
Integration based on an engineered solution.

Contact ABB technical support for more information.
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PC, Network and Software Monitoring

Use the following procedure to prepare for the PC, Network and Software 
Monitoring upgrade.

1. If there are user defined Script, Resource, and Assembly files they need to be 
backed up. The user files are located in:

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Scripts\User

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Assemblies\User

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Resources\User directory

Copy the files in these directories to a safe location.

2. Shut down the PC, Network and Software Monitoring Server node.

a. Use the Structure Selector to open the Service Structure in the Plant 
Explorer Workplace.

b. Use the Object Browser to navigate to:

Services > OpcDA_Connector, Service > SG_IT Server, 
Service Group > OPCDA_Provider_Node Name, Service 
Provider

(where Node Name is the name of the PC, Network and Software 
Monitoring Server node).

c. Select Service Provider Definition in the Aspect List Area.

d. Click the Configuration tab to produce a view in the Preview Area. 

e. If the Enabled check box is selected, clear it and click Apply.

PC, Network and Software Monitoring Device Library

Use the following procedure to prepare PC, Network and Software Monitoring 
Device Library upgrade:
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1. Back up MOF files (if they exist) to a safe location. The MOF files are located 
in:

...\Program Files\ABB Industrial IT\Optimize IT\PC, 
Network and Software Monitoring\MOFS

2. Back up Custom Asset Monitor dlls to a safe location if object types with 
Custom Asset Monitors are loaded. The dlls are located in: 

...\Program Files\ABB Industrial IT\Optimize 
IT\PC, Network and Software Monitoring\Asset 
Monitoring\Bin

SMS and e-mail Messaging

Save all GSM Device hardware information. Record information for the GSM 
device on the SMS and e-mail Messaging GSM Hardware Setup Worksheet shown 
in Table 6.

Table 6. SMS and e-mail Messaging GSM Hardware Setup Worksheet

Item Setting/Value

Spooler Settings

Activate Outbox Spooler Checked (check and leave checked)

Activate Inbox Spooler Checked (check and leave checked)

Interval for Checking for Incoming 
Messages

Value: _____ Seconds Minutes (circle 1)

Port Settings

COM Port Value: COM _____

Baud Rate Value: _____

Data Bits Value: _____

Parity Value: _____

Stop Bits Value: _____

PIN and Properties
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Query PIN Checked or Unchecked (circle one)

PIN (only if Query PIN is checked) Value: ___________________

Save PIN (only if Query PIN is 
checked)

Checked or Unchecked (circle one)

Own Number (telephone number of 
SIM card (including Country Code) 
in GSM hardware)

Value: ___________________

Initialization String for GSM Hardware Value:

_______________________________

_______________________________

_______________________________

_______________________________

General Service Properties

Name (GSM service provider) Value: ___________________

Port Value: COM _____

SMSC Value: ___________________

Default Country Code Value: ___________________

Default Prefix Value: ___________________

Number of Attempts Value: ___________________

Splitting Service Properties

Splitting Checked or Unchecked (circle one)

Optimize Splitting Checked or Unchecked (circle one)

Enumerate Splitting Checked or Unchecked (circle one)

Narrowband Sockets Checked or Unchecked (circle one)

Table 6. SMS and e-mail Messaging GSM Hardware Setup Worksheet (Continued)

Item Setting/Value
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Batch Management

1. Verify all scheduled batches are completed or terminated.

2. Disable the Batch Alarm & Event Service Group and Batch Service Group 
before proceeding. To disable the service groups:

a. Open a Plant Explorer Workplace.

b. Use the Structure Selector to open the Service Structure.

c. Use the Object Browser to select:

Services > Event Collector, Service > 
batch_group_name, Service Group

d. Select Service Group Definition in the Aspect List Area.

e. Select the Configuration tab in the Preview Area.

f. Clear the Enabled check box and click Apply.

g. Determine the name of the nodes that are currently Primary and 
Secondary Batch Servers,

h. Use the Object Browser to select:

Services > Batch Service, Service > batch_group_name, 
Service Group

Messaging Service Properties

Add Before Message Blank (verify and do not change)

Use for Delivery Notification Only Unchecked (verify and do not change)

Default Option 0 (verify and do not change)

Message General Properties

Replace CR LF for Incoming 
Messages

Checked or Unchecked (circle one)

Table 6. SMS and e-mail Messaging GSM Hardware Setup Worksheet (Continued)

Item Setting/Value
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i. Select Service Group Definition in the Aspect List Area.

j. Select the Configuration tab in the Preview Area.

k. Select the provider that is currently the Secondary Batch Server.

l. Clear the Enabled check box and click Apply.

m. Select the provider that is currently the Primary Batch Server.

n. Clear the Enabled check box and click Apply.

Information Management

Refer to Information Management Pre-Upgrade Procedures on page 453 in 
Appendix , Information Management Upgrade to perform the Information 
Management pre-upgrade procedures.

Scheduler Service (Application Scheduler)

Disable Schedules before stopping the servers and performing the upgrade. The 
Schedules will need to be manually enabled again following the upgrade. 

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Scheduling Service Object.

4. Select the Service Definition aspect.

5. Click the Configuration tab.

6. Clear the Enabled check box and click Apply.

Calculations Service

Disable Calculations before stopping the servers and performing the upgrade.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Calculations Service Object.

4. Select the Service Definition aspect.



Section 5  Upgrading 800xA 4.1 to 800xA 5.1 Offline Basic History Service Data

3BSE036342-511 G 255

 

5. Click the Configuration tab.

6. Clear the Enabled check box and click Apply.

Basic History Service Data

To save Basic History Service data:

1. Stop the Basic History Server from the Service Structure.

2. Use Windows Backup (not the 800xA Backup) to backup the files in the:

...\OperateITData\History\{provider ID}

directory.

3. Start the Basic History Server again from the Service Structure.

Process Engineering Tool Integration

Back up Process Engineering Tool Integration information. The project data is 
located in the following directory:

...\Program Files\ABB Industrial IT\Engineer 
IT\Engineering Studio\Process Engineering Tool 
Integration\Xml

Save the entire Xml data directory to a safe media such as a network share or 
removable disk. The directory contains the default mapping files (*.dmf) modified 
on the project, accelerator files (*.acc), and configuration files (*.pcf and *.fcf). 

Back up the Basic History folder for each Basic History Service Provider in the 
Service Structure. Depending on the system, the Basic History Service data can 
be present on a number of different node types (Connectivity Servers, IM Servers, 
AO Servers, etc.). It is best to search for the directory described in this procedure 
on all nodes, and if there is data present, back up that data.
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Requirements for VB Graphics Extension Software  

Installing Visual BASIC 6.0 with SP6

All nodes that use the Graphics Builder and the Primary Aspect Server node need a 
Professional or Enterprise Edition of Visual BASIC 6.0 with SP6. The licensed copy 
used on the 800xA 4.1 System must be installed on the 800xA 5.1 System. Follow 
the installation procedure provided with Visual BASIC.

Installing the VB Graphics Extension Software

Perform the following procedure to install the VB Graphics extension software on 
all nodes in the 800xA 5.1 System, if the base product was installed on the 800xA 
4.1 System.

1. Insert System Installation DVD 5 into the drive.

2. Wait for the Installation AUTORUN screen to appear. 

These procedures are applicable to all 800xA Systems.

• Installing Visual BASIC 6.0 with SP6 must be followed for all nodes that use 
Graphics Builder and the Primary Aspect Server node. This must be done 
before performing the 800xA System Restore.

• Installing the VB Graphics Extension Software must be followed for each VB 
Graphics extension software package on all nodes in the 800xA 5.1 System, 
if the base product was installed on the 800xA 4.1 System. This must be 
done before performing the 800xA System Restore.

To deploy VB Graphics, the user must belong to the Application Engineer 
IndustrialIT user group and Windows Local Administrators.

Refer to System 800xA Engineering, Process Graphics Migration Tool for 
information on migrating VB Graphics to Process Graphics 2.

Use of an Aero Theme with the Workstation Operating System will lead to screen 
latency issues in the VB Graphics Builder. This is because the Aero theme uses 
advanced rendering schemes. Turn off the Windows Aero theme and switch to 
either none or Windows Classic for use of VB Graphics. The behavior of VB IDE 
in the Workstation Operating System will then be the same as that in Windows 
XP.
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3. Select:

Manual Installation > VB Graphics Extensions

as shown in Figure 38.

4. Select a VB Graphics extension to install (the installation of the Batch 
Management VB Graphics extensions is described later in this procedure).

5. The Installation Wizard for the selected VB Graphics extension appears. 

Figure 38. Installation AUTORUN Screen



Installing the VB Graphics Extension Software Section 5  Upgrading 800xA 4.1 to 800xA 5.1 Offline

258 3BSE036342-511 G

 

6. Follow the Installation Wizard to complete the installation. Choose Typical as 
the installation type.

7. Repeat the procedure for each required VB Graphics extension that appears in 
the Installation AUTORUN Screen.

8. This step only applies to the VB Graphics extensions for Batch Management 
when using System Installer to upgrade the 800xA System. If Batch 
Management was installed manually during the upgrade, the VB Graphics 
extensions for Batch Management were installed at that time.

a. Select:

Manual Installation > Batch Management

b. The Installation Wizard for Batch Management appears. 

c. Select Modify when the dialog box appears that offers that choice.

d. Select to install the Batch Management VB Graphics extensions in the 
Installation Type dialog box.

e. Follow the Installation Wizard to complete the installation.
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Post Upgrade Procedures
The remainder of this section describes how to:

• Perform the 800xA Restore procedure.
• Load the VB Graphics extensions on the Primary Aspect Server.
• Restore historical data.
• Restore the necessary data for each Functional Area.

800xA System Restore

The backup/restore utility supports the restoring of 800xA system information. The 
following steps outline the 800xA system restore procedure.

1. Start the restore procedure.

a. Select:

Start > All Programs > ABB Industrial IT 800xA > System > 
Configuration Wizard

Refer to Requirements for VB Graphics Extension Software on page 256 before 
performing the 800xA System Restore.

Perform this procedure only on the Primary Aspect Server.

The User Account that is used for 800xA System restore via the Configuration 
Wizard must be a member of the following groups:
• IndustrialITUser.

• IndustrialITAdmin.

• Local Administrators.

Click Yes if during restore a message box appears stating:

A required system extension is not installed Name : 
System_Instruction

Refer to System 800xA Maintenance (3BSE046784*) for more information on 
restoring the system.
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b. The Select Type of Configuration dialog box appears. Select Restore 
System and click Next.

2. Check for messages in the log file (select the View Log check box in the 
Configuration Wizard). Refer to Appendix A, Warning and Error Messages to 
resolve any received warning or error messages.

3. Check the CPU load in the node. The System Message service may generate a 
high load (>90%). If this continues for longer than approximately 10 minutes, 
restart the service.

4. One node at a time, start up and connect all nodes to the 800xA System in the 
following order:

– Aspect Server nodes.
– 800xA for Harmony Configuration Server nodes.
– Connectivity Server nodes.
– Application Server nodes.
– Client nodes.

a. Use the following guidelines while connecting nodes, using the 
Configuration Wizard. This must be performed on the node that is going to 
be connected, not on the node on which the restore was performed.

b. Select the Primary Aspect Server (the server on which the system will run) 
in the Connect to another System on Node drop down-list box, in the 
Connect to System dialog box.

c. If the node is an IM Server, verify that the ABB Process Administration 
Service (PAS) is set to manual in the Services Control Panel (run 
Services.msc from the Run dialog box). Stop the service if it is running.

d. Select Connect Node from the Select Type of Configuration dialog box.

e. Set the current system as the default system when connecting nodes to the 
system.

Restart the node when advised during the restore procedure.

If a message stating that a full deploy of the Generic Control Network is needed, 
click OK.
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– In some cases, problems may be encountered when connecting nodes to 
the system. Verify that the system software user settings are correct using 
the Configuration Wizard. Restarting the node again may also solve the 
problem.

– Wait until all services in the newly connected node are up and running 
before connecting the next node. Select the Node Administration 
Structure\connected_node_name\System Status Viewer aspect to monitor 
the status of services. If some services will not start up, restarting the node 
may help.

f. Restart each node after it has been connected to the system.

5. Refer to Appendix E, Recording the Number of Aspects and Objects and 
record the number of aspects and objects in the system. Compare these values 
to those recorded when the system was backed up. 

6. Verify the affinity settings to ensure best system performance. Refer to System 
800xA Post Installation (3BUA000156*) for more information on how to 
configure affinity.

Consistency Check

Refer to Appendix D, Consistency Check and perform the necessary consistency 
checks.

Loading the VB Graphics Extensions

Perform the following procedure on the Primary Aspect Server to load the VB 
Graphics extensions:

1. Refer to Table 7 for a list of VB Graphics extensions available to be loaded.

2. Start the Configuration Wizard from the primary Aspect Server node. Select:

Do not include services that were stopped manually as part of the pre-upgrade 
procedures. These will be manually restarted later in the post upgrade procedures.

Run the System Software User Settings until OK. Restart if it is not working and 
if the message:

Invalid User

appears.
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Start > All Programs > ABB Industrial IT 800xA > System > 
Configuration Wizard

3. Open the System Extension Load dialog box by going to:

System Administration > Select System > System Extension Load

4. A view appears with the available VB Graphics extensions listed in the left 
pane. Select the system extension to load in the list in the left pane and move it 
to the list in the right pane by clicking >. To move all the system extensions 
from the left pane to the right pane, click >>.

5. The red cross, green check mark, and warning icons indicate the status of the 
dependency evaluation.

– The green check mark indicates that the system extension must be loaded 
first.

Table 7. VB Graphics Extensions

Directory Software

800xA Connectivities AC 800M Connect VB Graphics Extension

ABB 800xA for Advant Master VB Graphics Extension

ABB 800xA for Harmony VB Graphics Extension

ABB 800xA for IEC61850 VB Graphics Extension

ABB 800xA for MOD 300 VB Graphics Extension

ABB 800xA for Safeguard VB Graphics Extension

ABB PLC Connect VB Graphics Extension

Asset Optimization ABB Asset Optimization VB Graphics Extension

ABB PC, Network and Software Monitoring VB Graphics 
Extension

Batch Management Batch VB Graphics Extension

Batch Advanced Templates VB Graphics Extension

Device Management & Fieldbuses ABB Device Management FOUNDATION Fieldbus VB 
Graphics Extension
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– The red cross icon indicates that the system extension can not be loaded 
until the one with the green check mark icon is loaded.

– The warning icon indicates that the system extension can be loaded, but 
that there is additional information available in the Description frame in 
the lower part of the dialog box. The additional information can, for 
example, be that the system extension contains aspect types that are not 
environment aware.

6. If the list in the right pane contains more than one system extension, click 
Press header to autosort to sort the system extension load order with regard to 
dependencies.

7. All system extensions in the right pane should be marked with the green check 
mark or the warning icon.

8. Click Next and the Apply Settings dialog box appears.

9. Click Finish to load all system extensions.

10. A progress dialog box is shown during the load. Click View Log to view log 
messages during load.

11. When the load operation is finished, click Finished and view the Configuration 
Wizard log to verify that no errors occurred during the load.

12. Close the Configuration Wizard.

The load is aborted if:

• The user clicks Abort.

• An error occurs; for example, if the Configuration Wizard fails to load a file 
into the system.

An aborted system extension load can be resumed from the System Extension 
Maintenance dialog box.
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800xA Documentation Maintenance

Delete all documentation aspects (denoted by an open book icon) with a category 
name of Application Manual, Operating Manual, Installation Manual, or Technical 
Reference Manual found in the Product Type Structure.

The System Instructions system extension must be removed (unregistered). To 
unregister the System Instructions system extension from the 800xA system:

1. Use Windows Explorer to navigate to:

...:\Program File\ABB Industrial IT\Operate IT\Process 
Portal A\bin

2. Double-click AfwRemoveSystemInstructions.exe to execute the 
program.

Composite Graphic Elements

There may be a problem accessing objects in composite graphic elements with 
EnableInput set to false after upgrading to 800xA 5.0 SP1 or later.

Refer to Product Bulletin 3BSE052342 for more information.

Previous versions of the 800xA System (800xA 5.0 SP1 and earlier) included a 
system extension for 800xA Documentation. This system extension is no longer 
included.

If any customer-specific documentation aspects have been added, it is necessary 
to browse through the Product Type Structure and delete the 800xA 
documentation aspects individually so that customer-specific documentation will 
not be accidentally deleted.

Use the Find Tool in the Plant Explorer Workplace to find the documentation 
aspects.
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Graphic Overlap Displays

After upgrading from 800xA 4.1 to 800xA 5.1, a graphic overlap display can be 
brought up one time, but not twice. Perform the following so that graphic overlap 
displays can be brought up more than one time.  

Set the following:

• ApartmentCacheSize = 0

Registry Location: 
HKEY_LOCAL_MACHINE\SOFTWARE\ABB\AFW\SystemModules\
WorkplaceApplication\1.0-0\private\WPApartment\ApartmentCacheSize

Reconfiguring Group Displays

New Group Display aspects that are created and configured in the Object Type 
Structure on the object types and instances will work correctly even if there is more 
than one aspect with the same name but each aspect has a different Aspect Category.

Configured Group Display aspects that already exist in the Object Type Structure 
and on the object types and instances should be reconfigured for the aspects to 
display correctly. (This is required for the reference to an aspect to be stored along 
with its Category ID.)

Device Management and Fieldbuses

After installation of 800xA 5.1 software all third party software for Device Type 
Objects used in the previous system version must be reinstalled. Additionally 
PROFIBUS Device Type Objects used in the Control Builder M project must be 
adapted to new delivered Hardware Libraries.

Be extremely careful when making changes in the registry. Do not make any 
changes in the registry without first making a backup copy of the registry. Refer 
to the online help for the registry editor on how to create a backup.
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Restore Device Types

The following steps for Fieldbus Device Types need to be carried out on every 
800xA system node. Perform the System Restore Wizard procedure on the nodes in 
the following sequence:

• Aspect Servers (including redundant Aspect Servers).
• Connectivity Servers (including redundant Connectivity Servers).
• Application Servers.
• Clients.

1. Start the Device Library Wizard. Select:

Start > All Programs > ABB Industrial IT 800xA > Device Mgmt > 
Device Library Wizard

-or-

double-click the Device Library Wizard icon on the desktop.

2. Navigate to:

The procedures in the System Restore Wizard function in the Device Library 
Wizard must be performed for Fieldbus Device Types before restoring the 
Control Builder M project, otherwise the upgrade will fail. The Control 
Builder M upgrade can only be performed once.

Restore the Device Types on the Primary Aspect Server node before starting to 
install them on other system nodes. Do not run parallel installations of Device 
Types on other system nodes unless all Device Types are restored on the Primary 
Aspect Server node. Installation of Device Types on other system nodes can be 
done in parallel after they are restored on the Primary Aspect Server node.

If the system contains FOUNDATION Fieldbus Device Types, check the 
following before proceeding to the next step:
• Open a Plant Explorer Workplace.

• Use the Structure Selector to open the Object Type Structure > FF 
Libraries.

• Check to see if there is more than one entry of FF H1 Device Library, 
FF Object Type Group.

• If there is more than one entry, perform FF Upload once so there is only one 
instance of FF H1 Device Library, FF Object Type Group 
present. If there is only one entry, proceed to the next step using the Device 
Library Wizard.
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Device Type Administration > System Restore Wizard

and choose the first option in the System Restore Wizard as shown in Figure 39 
and click Next.

Figure 39. System Restore Wizard (1)
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3. Choose whether or not this system node has been reformatted as shown in 
Figure 40 and click Next.

4. Depending on which fieldbus protocol is used in the previous system version 
environment, insert one of the delivered Device Library system DVDs in the 
DVD drive (e.g. Device Library HART – DVD).

5. Click Browse and navigate to the DVD drive.

6. When the drive has been selected in the Browse for folder dialog box, click OK 
in that dialog box and then Next in the ABB Device Library Wizard.

7. The Device Library Wizard scans the 800xA System for fieldbus device types 
that are already used and compares the results with the contents of the DVD. 
Device Types available in the 800xA System and the DVD are shown in the 

Figure 40. System Restore Wizard (2)
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Extract tab of the Device Library Wizard (Figure 41).

8. Click Next to start the extraction process.

9. Device Types available in the 800xA System but not on the DVD are displayed 
in the Missing tab. If there are any Device Types showing in the Missing tab, 
Next in the Device Library Wizard is disabled. Navigate to the Browse dialog 
box by clicking Back and inserting a new Device Library DVD in the DVD 
drive. 

10. There may be some Object Types that are either customer created, or are the 
latest Device Types downloaded from ABB SolutionsBank. These will not be 
available on the DVDs. The Device Library Wizard will prepare a list for these 

Figure 41. Extract Device Type Files
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Device Types (Figure 42). Install these Device Types manually.

11. Repeat this procedure until all Device Types are extracted to the 800xA System 
node and the Missing tab does not list any device types.

12. If the Device Library DVDs do not contain all Device Types used in the 
previous system version, the missing Device Types must be downloaded from 
ABB SolutionsBank.

13. When the extraction process is completed successfully, the Device Types need 
to be re-installed on the 800xA System node. Click Next to launch the Re-

Figure 42. List of Files to be Manually Installed

It is only possible to complete the Wizard if all Device Types have been 
successfully extracted.
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installation of Device Types dialog box shown in Figure 43.

14. Follow the Device Library Wizard procedure to complete the installation. If 
Control Builder M is installed on the node, the Device Library Wizard will 
open Control Builder M and decide which device instances are linked to 
Standard Hardware Libraries from Device Integration. If some Device Types 
are custom created or modified then these instances will be linked to custom 
Hardware Libraries at the time of the Control Builder M project upgrade 

Figure 43. Re-install Device Types Dialog Box
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(Figure 44).

Figure 44. Linking to Custom Hardware Libraries

If 

If Control Builder M is not installed on the node, the error message shown in will 
appear. Ignore the message and continue.
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15. The Device Library Wizard will automatically navigate to the main window 
after the process is completed.

16. Exit the Device Library Wizard and repeat the procedure on the other 800xA 
System nodes, if applicable.

Device Management PROFIBUS & HART

Perform the Configure OPC P/H Server on the Primary Aspect Server.

Device Management FOUNDATION Fieldbus

Perform the following to complete upgrading Device Management FOUNDATION 
Fieldbus.

1. Update LD 800HSE Linking Devices: Update all LD 800HSE linking devices 
to the latest firmware version released for this system environment following 
the update procedure described in the user instructions for the particular device. 

2. Check, Save, and Upload FF Libraries:

a. Open a Plant Explorer Workplace.

Figure 45. Error Message

Refer to Field IT, Foundation Fieldbus Linking Device, LD 800HSE, Version 
Table (3BDS009910) in ABB SolutionsBank for the latest linking device 
firmware released for this system environment.

From Downloads Explorer, navigate to:

Control Products and Systems/800xA/Device Management Foundation 
Fieldbus/Foundation Fieldbus Linking Device LD800HSE
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b. Use the Structure Selector to open the Object Type Structure.

c. Use the Object Browser to navigate to:

FF Libraries Object Type Group

d. Select FF Management in the Aspect List Area.

e. Click Open Project.

f. Check the libraries for plausibility.

g. Exit Fieldbus Builder FF and save changes if prompted to do so.

h. Return to the Plant Explorer Workplace and select FF Management in the 
Aspect List Area.

i. If the traffic light symbol shows red, click Upload.

j. The green traffic light symbol indicates that the FF libraries have been 
synchronized.

3. Optional: Reconstruct User-made Changes to Library Objects representing FF 
Standard Blocks: 

During upgrade, user-made changes to library objects representing FF 
standard blocks have been overwritten. Important substitutions have been 
logged.

a. If such changes were made, display the substitutions as follows:

– Open a Plant Explorer Workplace.

– Use the Structure Selector to open the Object Type Structure.

– Use the Object Browser to navigate to:

FF Libraries Object Type Group

– Select FF Management in the Aspect List Area.

– Select Library Merge Logger tab and read log.

b. For reconstructing user-made changes, reapply the changes to the library 
objects manually.

This step is only required if changes were made to library objects representing FF 
standard blocks.
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4. Check, Save, Commission, and Upload the HSE Subnet.

a. Open a Plant Explorer Workplace.

b. Use the Structure Selector to open the Control Structure.

c. Use the Object Browser to navigate to:

HSE Subnet

d. Select FF Management in the Aspect List Area.

e. Click Open Project.

f. Check to see if the configured HSE subnet ID is used for the OPC Server 
FF configuration in FF Network > Properties and modify it if required.

g. Check whole project for plausibility.

h. Perform device assignment for all linking devices LD 800HSE.

i. Perform precommissioning/commissioning for all objects for which this is 
necessary (discernible from engineering status).

j. Exit Fieldbus Builder FF and save changes if prompted to do so.

k. Return to the Plant Explorer Workplace and select FF Upload in the 
Aspect List Area.

l. If the traffic light symbol shows red, click Upload HSE Subnet.

m. The green traffic light symbol indicates that the HSE Subnet has been 
synchronized.

5. Import the locally stored parameter value sets as follows:

a. Open a Plant Explorer Workplace.

b. Use the Structure Selector to open the Object Type Structure.

Perform the following procedure for each HSE Subnet.

To assign all H1 devices in one step, use the Assign all devices function from the 
HSE Subnet context menu: Object > Assign all devices...

For downloading use the online dialog from the HSE Subnet context menu: 
Object > Online Dialog...
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c. Use the Object Browser to navigate to: 

      FF Libraries, Object Type Group

d. Select FF Management in the Aspect List Area.

e. Click Open Project to open the FF Libraries project in Fieldbus Builder 
FF.

f. Open the block properties dialog for the Function Block where the 
parameters were exported during the pre-upgrade procedure.

g. Right-click on the dialog box and select Import from the context menu.

h. Browse the .csv file and restore the value sets.

i. Right-click and select Store parameter value set from the context menu.

j. Specify an appropriate name for the new value set and click OK.

k. Click Cancel. Do NOT overwrite the Initial Instance Parameters with the 
imported parameters, and then close the block properties dialog box. 

800xA for AC 800M

There may be Control Builder M compatibility issues when upgrading from 
800xA 4.1 to 800xA 5.1. Review the issues detailed in 800xA 4.1 to 800xA 5.1 
Compatibility Issues on page 414 before proceeding.

Use the following procedure to restore 800xA for AC 800M information:

1. Control Builder stores its settings (systemsetup.sys) on disk in the following 
directory:

Ensure that the stored value sets are imported to the corresponding Function 
Blocks.

After upgrading a configuration containing one Engineering and one Production 
system to 800xA 5.1, the Control Builder M projects in the two systems should 
be made identical using the Import/Export tool, Engineering Repository, or by 
recreating the Engineering System using Backup/Restore before engineering 
work is restarted. Otherwise there will be a lot of false differences on the 
AC 800M aspects reported in the import difference report when moving solutions 
between the systems.
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...\ABB Industrial IT Data\Engineer IT Data\Control 
Builder M Professional

Copy the previously saved file from the safe media to this folder.

2. New handling for Hardware Types was introduced in 800xA 5.0. All hardware 
types are now packaged in libraries. Because of this all Control Builder 
projects must be upgraded according to the following steps. 

a. Start an empty Control Builder M. 

b. Select:

Tools > Maintenance > Upgrade Project

c. Select the Control Builder project to upgrade. This step will take a while. 
All hardware objects in the Control Structure are redirected by Control 
Builder to use hardware types from libraries. If the project contained 
custom hardware definition files, libraries with corresponding hardware 
types are automatically created by Control Builder.

d. Repeat Step a through Step c for all Control Builder projects.

If the application contains FOUNDATION Fieldbus, HART, or PROFIBUS 
specific configurations, perform post upgrade procedures for Device Types via 
the Device Library Wizard (refer to Device Management and Fieldbuses on page 
265) before upgrading the project in Control Builder M.

During the project upgrade there may be information messages with the 
following text:

"Copy of aspect(s) of category 'Object Type Extension Definition' from the 
type xxxxxx to Hardware Libraries yyyyyy must be performed manually in 
PPA'.

Ignore these messages if the Device Types in use are provided by the ABB 
Device Integration Center and have not been modified by the user.

Otherwise copy the missing aspects manually if it is a user defined device type.
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e. When all Control Builder Projects are upgraded the old hardware types 
should be deleted from the Object Type Structure.

In the Plant Explorer Workplace, navigate to the Object Type Structure 
and browse to:

Object Types > Control System > AC800M/C Connect - 
Controller Hardware

Right-click the Controller Hardware object and select Delete.

3. Modify the application program according to applicable issues in 800xA 4.1 to 
800xA 5.1 Compatibility Issues on page 414.

4. Load the controllers with their firmware and applications. Change Analysis 
Mismatches may be shown for objects in the Standard Libraries during the first 
download after the upgrade. Possible mismatches are:

Mismatch: Variable has changed data type.
Mismatch: Variable not found.
Mismatch: Control Module not found.

The mismatches reflect internal changes in the Standard Libraries. No Cold 
Retain Values will be lost. Click Next Mismatch to continue.

5. The OPC Server stores configuration files (*.cfg) and settings 
(systemsetup.sys) on disk. Add the files saved on the safe media to the system. 
The systemsetup.sys file is located in:

...\ABB Industrial IT Data\Control IT Data\OPC Server 
for AC 800M

The configuration files are stored in the Files folder in the same location.

The following additional messages may appear:
Warning in input file at line XX. SubUnits, 
LogicalNumbers and DiscreteNumbers are mutually 
exclusive.

Warning in input file at line XX. The positions defined 
must match SubUnits, Logical-, or DiscreteNumbers

Ignore these warning messages.
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6. Restore OPC configurations by selecting File > Load Configuration in the 
OPC Server Panel.

800xA for Advant Master and 800xA for Safeguard 

Perform the following post upgrade procedures for 800xA for Advant Master and 
800xA for Safeguard.
• Copy the Advant Master Controller Licenses.txt.
• Update the Configuration Files.
• Copy the DATHR Files.
• Reconfigure RTA Board Control Aspect Settings.

Copy the Advant Master Controller Licenses.txt

Perform the following on the Primary Aspect Server in the 800xA 5.1 System:

1. Copy the following updated file:

• Advant Master Controller Licenses.txt

The default location to copy the file in the 800xA 5.1 system:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\Licenses

Update the Configuration Files

For each Connectivity Server, compare the following files saved in a safe location 
during the 800xA for Advant Master pre upgrade phase:

• AdvDsMasterAdapter.csv

• AdvMbAeOPCServer.csv

with the installed version of the files at the following location:

For 64-bit:

...\Program Files (x86)\ABB Industrial IT\Operate IT\AC 400 
Connect\Bin

Remember to enable autoloading of the configuration and provide the correct 
path to the file.
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For 32-bit:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\Bin

If any customization was done to the old files, update the installed version of the 
files with the corresponding changes.

Copy the DATHR Files

Perform the following on each Connectivity Server node:

1. Copy the saved files:

– DATHR1.CD
– DATHR2.CD
– DATHR3.CD

to the folder:

...\ProgramData\ABB\AC400Connect\AdvantBase\Data\
RTA\Init\

to the node where they belong.

Reconfigure RTA Board Control Aspect Settings

1. Open the MB 300 RTA Settings dialog box in Configuration Wizard and 
reconfigure:

– MB 300 Node and Network Numbers.

– Check 800xA as Clock Master (REVERSED_SYNC_MODE) in case 
the time synchronization key REVERSED_SYNC_MODE was 
previously enabled.

2. Always Restart the RTA board.

3. The Audible property must be 0 for events and 1 for alarms 800xA for Advant 
Master version 4.1 SP1 RU6 and newer. Refer to System 800xA Configuration 
(3BDS011222*) for configuration of audible alarms.
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Safeguard standardevent 300 - 326 does not comply with this rule before 
800xA for 800xA for Advant Master Version 5.0 SP2. The Event numbers 
where the Audible property should be changed from 1 to 0 are:

– EVENT302.
– EVENT305.
– EVENT310.
– EVENT312.
– EVENT320.
– EVENT321.
– EVENT322.
– EVENT325.

800xA for Harmony

Perform the following post upgrade procedures for 800xA for Harmony.

Restore 800xA for Harmony Information

Use the following procedure to restore 800xA for Harmony information:

1. Log in to the 800xA Installing User account (or a local Administrator account) 
on the Configuration Server or Configuration Server with Connectivity Server 
node.

2. Restore the 800xA for Harmony Configuration information that was saved 
during 800xA for Harmony on page 244.

a. Select:

Start > All Programs > ABB Industrial IT 800xA > 800xA for OCS 
Systems > Harmony > Configuration > Restore Configuration

b. Click Connect in the Harmony Connect Configuration Backup/Restore 
window.

c. Enter the name of the Harmony Configuration Server database backup file 
in the Backup File field.

d. Click Restore.

e. If a prompt appears indicating that the system version does not match the 
backup version, click Yes.
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f. If the message Services must be stopped, REBOOT system now 
then restart this application! is displayed, restart the node and 
repeat Step a through Step e.

g. The Backup/Restore program compares the old configuration in the 
backup file to the current configuration of the newly installed system. If 
the hosts of the Primary and Redundant Connectivity Servers do not 
match, a dialog box will appear allowing the user to map the old 
Connectivity Server node names to the new Connectivity Server node 
names.

h. Leave the Create Missing Servers in Installed Configuration (Disaster 
Recovery) check box disabled.

i. Click Exit when the restore operation is complete.

Synchronize the Aspect Directory

Synchronize the Aspect directory with the Harmony Configuration Server using the 
Harmony Synchronizer Aspect, which is part of the Harmony OPC Server network. 
Refer to 800xA for Harmony Configuration (3BUA000157*) for more detailed 
information on how to synchronize.

Check Consistency of Harmony OPC Network Objects

Inherited and copied aspects are inconsistent after upgrading from 800xA 4.1 to 
800xA 5.1. Using the Consistency Check Tool on all Harmony OPC Server 
Network objects will correct this issue.

1. Open a Plant Explorer Workplace.

2. Click the Consistency Check Tool icon at the top of the Plant Explorer 
Workplace to launch the Consistency Check dialog box.

3. Click Add Item to launch the Select Item dialog box.

4. Browse to the root of the Control Structure.
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5. Select all of the Harmony OPC Server Network objects (use Ctrl+Click or 
Shift+Click to select multiple objects).

6. Click Add and Close.

7. Click Check.

800xA for AC 870P/Melody

Perform the following post upgrade procedures for 800xA for AC 870P/Melody.

• Restore 800xA for AC 870P/Melody Information.
• Additional 800xA for AC 870P/Melody Configuration Steps.

Restore 800xA for AC 870P/Melody Information

Perform the following procedure to restore 800xA for AC 870P/Melody 
information:

1. Log in to the 800xA Installing User account (or a local Administrator account) 
on the Configuration Server node.

2. Restore the 800xA for AC 870P/Melody Configuration information that was 
saved during 800xA for AC 870P/Melody on page 245.

a. Select:

Start > All Programs > ABB Industrial IT 800xA > 800xA for Melody 
> Configuration > Restore Configuration

The Consistency Check Tool can take a long period of time to run depending on 
the quantity of data contained within the Aspect System. It is recommended that 
the tool be run on a subset of data (a node (PCU) within the Control Structure) 
to evaluate the time needed prior to selecting the entire OPC Network.

Restore existing backups for project specific changes (if available) for: (Refer 
also to 800xA for AC 870P/Melody on page 245.)

• DHCP Server Configuration.

• ETC Host files for 800xA for AC 870P/Melody Connectivity Servers.

• Changes in the Default Object Types.

• ConvDB changes of the Configuration Server.
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b. Click Connect in the Melody Connect Configuration Backup/Restore 
window.

c. Enter the name of the Melody Configuration Server database backup file 
in the Backup File field.

d. Click Restore.

e. If a prompt appears indicating that the system version does not match the 
backup version, click OK.

f. If the message Services must be stopped, REBOOT system now 
then restart this application! is displayed, restart the node and 
repeat Step a through Step e.

g. Click Exit when the restore operation is complete.

Additional 800xA for AC 870P/Melody Configuration Steps

Information on performing these additional configuration steps can be found in 
800xA for AC 870P/Melody, Configuration (3BDD011741*) and System 800xA Post 
Installation (3BUA000156*).

Perform the following configuration steps after adding the 800xA for 
AC 870P/Melody Configuration Server to the 800xA System.

1. Melody Executive Service Provider.

2. Tag Importer.

3. Enable the Melody AutoConfigurator service in Plant Explorer > Service 
Structure.

Perform the following configuration steps after adding each 800xA for AC 
870P/Melody Connectivity Server to the 800xA System.

1. Melody Executive Service Provider.

2. OPC Data Source Definition.

3. Alarm and Event Provider Setup.

If there are specific faceplates in use (process industries or utilities), the 
faceplates must also be upgraded. Refer to the faceplate related documents for 
further instructions.
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800xA for MOD 300

1. Re-initialize PAS System Services on the Connectivity Server.

2. Initialize the OMF settings to start system services. Use the Administrative 
Tools in Windows Control Panel to select:

PAS > Settings.

This displays the Communications Configuration Tool.

a. Select Yes at the message:

Would you like to revert back to saved settings?

This opens the Communication Settings display.

b. Select OK on the Communication Settings display to save the settings and 
close the window.

c. Select OK to the message:

Settings have been saved . ...

d. Select OK when the message appears that indicates the settings have been 
changed. A restart is always required if the Control Network Setting, OMF 
Memory, or TCP/IP enabled setting are changed.

3. Restart Windows at this time. 

4. Reverse_Time synch will be disabled following the re-installation of PAS. If 
the Connectivity Server node sets the time on the Real-Time Accelerator Board 
(RTAB), Reverse_Time_Synch must be enabled. Refer to the 800xA for 
MOD 300 section in System 800xA Post Installation (3BUA000156*).

5. If any objects were customized, those changes must be implemented again on 
objects delivered with 800xA for MOD 300 Version 5.1.

The PAS System Services will not start until the communications settings are 
initialized as described in the following steps.

The message: 

Would you like to revert back to saved settings?

is displayed if settings were previously saved. To restore the previous settings, 
perform Step a through Step d.



PLC Connect Section 5  Upgrading 800xA 4.1 to 800xA 5.1 Offline

286 3BSE036342-511 G

 

6. Update the registry settings previously recorded. Refer to 800xA for MOD 300 
Configuration (3BUR002417*).

PLC Connect

Perform the following post upgrade procedures for PLC Connect.

Modify Installation for IEC 60870 or Basic Project Objects

If either the IEC 60870 or Basic Project Objects features were installed:

1. Use standard Windows procedures to access Programs and Features in 
Windows Control Panel. 

2. Select ABB PLC Connect. 

3. Select Change/Modify.

4. The InstallShield Wizard for PLC Connect appears. Refer to System 800xA 
Manual Installation (3BSE034678*) to select and install the desired features.

5. If the IEC60870 feature is installed refer to System 800xA PLC Connect 
Configuration (3BSE035041*) and reload the saved IEC configuration.

Restoring the Pretreat dll

To restore the Pretreat dll:

1. If the PLC Connect Communication Server Pre Treatment function is being 
used in the application, copy the Pretreat dll file (Pretreat3.dll or Pretreat4.dll) 
from the backup location to the same folder as it was backed up from on the 
PLC Connect Connectivity Server. If the default folder is used, that location is:

...\ABB Industrial IT\Operate IT\PLC Connect\Bin

2. Register the Pretreat dll file (refer to System 800xA PLC Connect 
Configuration (3BSE035041*) for more information).

3. Restart the PLC Connect Connectivity Server for the changes to take effect.

4. Restore the project and source files for the Pretreat dll.
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Update the Sattbus Configuration

Perform the following if the Sattbus protocol is used for any of the controllers:

1. Select the PLC Controller Configuration aspect for the controller that uses 
Sattbus protocol and click Edit Driver.

2. Configure the Common System Settings and click OK.

3. Restart the Connectivity Server.

Redeploy the PLC Connect Configuration

To redeploy the PLC Connect configuration:

1. Use the Structure Selector to open the Control Structure in the Plant Explorer 
Workplace.

2. Use the Object Browser to navigate to the first Generic Control Network 
object.

3. Select Deploy in the Aspect List Area.

4. Press the SHIFT key and click Deploy in the Preview Area to ensure that a full 
deploy is done. 

5. The deploy begins and the progress is displayed in the Preview Area. The 
deploy is completed when Deploy ended is displayed.

6. Repeat the procedure for any additional Generic Control Network objects.

Engineering Studio

Post upgrade procedures for Engineering Studio include those for IO Allocation, 
Engineering Templates, and Function Designer.
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IO Allocation

800xA 5.1 supports merging of Hart devices and IO signals within one object. If 
Hart devices and IO signals will be merged into one object refer to Industrial IT,
800xA - Engineering, Engineering Workplace, Basic Engineering Functions 
(3BDS011223*). 

IO Allocation has enabled new properties (e.g. Inverted) to be accessible for 
CBM_SignalParameter/CBM_PulseSignalParameter. These properties are 
initialized with a default value. If properties have been changed directly in the 
Hardware Editor of Control Builder M (as they were not supported by IO 
Allocation) these changes are not reflected in 
CBM_SignalParameter/CBM_PulseSignalParameter aspects after the upgrade. 
Therefore, when the menu write Allocation into CBM is performed, values may be 
overwritten with their default value. After upgrading, select controller by controller 
and perform the menu Read Allocation from CBM, which reads the property 
values from Control Builder M and updates the signal objects. 

Engineering Templates for Bulk Data Manager (BDM)

Engineering Templates are typically used from scratch, meaning data is dropped 
into the templates. The result is used for information or documentation. In this case 
no upgrade is required, because the installation of Engineering Studio 5.1 exchanges 
the Engineering Templates in:

...\Documents and Settings\All Users\Desktop

Before working with the IO Allocation function in an upgraded system, check all 
Control Builder Name aspects of CBM_Signal instances to see if they contain a 
valid name.

All Control Builder Name aspects having an empty name or a name not 
introduced by synchronization from the Name aspect must be corrected 
accordingly. This can be performed using a Bulk Data Manager worksheet that 
reads out Name and Control Builder Name. The same worksheet can be used to 
write back the Name.

The following procedure is only required if HART devices and IO signals will be 
merged into one object.

The following procedure is only required when working with IO Allocation and if 
properties of IO boards have been changed directly in Control Builder M.
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However, if a worksheet containing data has been saved in the file system for 
writing back to the 800xA System after upgrade, either:

• Newly create the worksheet based on an Engineering Template delivered with 
Engineering Studio 5.1.

-or-

• Update the worksheet according to the description in:

...\Documents and Settings\All Users\Desktop\ 
Engineering Templates\ Upgrade Description Engineering 
Templates.doc

Function Designer

Modified Aspects of Function Designer System Extension. The Function 
Designer system extensions:

• Signal Extension for AC800M Connect 

• Function Designer for AC800M Connect 

• Topology Designer for AC800M Connect

• CI Extension for AC800M Connect 

• Signal Extension for TRIO Connect 

• Topology Designer for AC800M High Integrity 

• Function Designer for AC 800M Classic 

• Topology Designer for AC800M Classic 

• Function Designer for Fieldbus Builder Profibus/Hart 

• AC 800M Signal Extension Classic 

mainly consist of:

• Functional Planning Object Types, including a Function Settings aspect at the 
Settings Object Type Group.
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• Extension Libraries that add Function Designer Aspects to Object Types 
(Control Modules, Function Blocks, ...) created by basic libraries (AC 800M 
Connect, AC 800M Classic, etc.).

After having loaded such a system extension in the 800xA 4.1 800xA System some 
of these aspects may have been modified; for example, to adapt Function Settings, 
or to change the color or layout of Function Blocks in Function Diagrams. 

During the 800xA System upgrade to 800xA 5.1 the system extensions of the new 
system are loaded. To keep the information about modified aspects, all aspects that 
had been created by a Function Designer system extension, but later on modified are 
listed in the Configuration Wizard log, and are written to Afw files, e.g.:

...\Function Designer\bin\Upgrade\410To501\Function Designer.afw

...\Function Designer\bin\Upgrade\410To501\Function Designer for 
Ac800M Connect.afw

...\Function Designer\bin\Upgrade\410To501\Function Designer for FB 
P/H.afw

The only way to bring these modifications back into the 800xA 5.1 System is to 
manually merge the changes. Do not import the listed Afw files into the 800xA 5.1 
System, because some additional properties/data might get lost. In the case of 
Function Settings, look for each settings property in the 800xA 4.1 System and do 
the modifications again in the 800xA 5.1 System. In the case of modified Function 
Aspects (e.g. Diagram Template, Component Template), check the modifications 
done in the 800xA 4.1 System and do the modifications again in the 800xA 5.1 
System. 

Upgrade Diagram References and Diagram Variables. In the 800xA 5.1 System 
(opposite to the 800xA 4.1 System) Diagram References and Diagram Variables are 
by default created as Symbol Objects. This is not true for Diagram References and 
Diagram Variables created during upgrade (restore) from 800xA 4.1 Systems. 
Convert them from Aspect Objects to Symbol Objects by use of the conversion 
function described in the following procedure.

Differences between Aspect Objects and Symbol Objects are described in 
Industrial IT, 800xA -Engineering, Engineering Workplace, Function Designer 
(3BDS011224*).
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1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Object Type Structure.

3. Use the Object Browser to navigate to:

Object Types > Functional Planning > Settings

4. Select Function Upgrade in the Aspect List Area to open the Function 
Upgrade aspect in the Preview Area.

5. Select the Convert Diagram References/Variables from Aspect Objects to 
Symbol Objects check box and click Apply.

6. Click Run Upgrade to perform the upgrade.

Check and Repair AES Variable Table (Applications, Controllers, 
Diagrams/SCMs, and Diagram (Cm) Types). This function can be used to:

• Correct possible inconsistent data used for display of online values and external 
cross references.

• Delete obsolete data and reduce aspect size.

Perform the following procedure to use this application.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Object Type Structure.

3. Use the Object Browser to navigate to:

Object Types > Functional Planning > Settings

4. Select Function Upgrade in the Aspect List Area to open the Function 
Upgrade aspect in the Preview Area.

5. Select the Check and Repair AES Variable Table (Applications, 
Controllers, Diagrams/SCMs, and Diagram (Cm) Types) check box and 
click Apply.

This function is not suitable in the case of additional aspects on input/output 
references, e.g. Graphic Elements, for typical diagrams with input/output 
references that will get copied and connected via the Bulk Data Manager.
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6. Click Run Upgrade to perform this upgrade.

Deleting Engineering Base Service from the Service Structure

When the 800xA System is running, delete the Engineering Base Service from the 
Service Structure.

1. Use Windows Explorer to navigate to the following directory:

...\Program Files\ABB Industrial IT\Engineer IT\
Engineering Studio\DocumentParameterManager\
bin\support

2. Double-click EbServiceCleanUpUtil.exe to delete the service.

Asset Optimization

Use the following procedure after upgrading Asset Optimization. Perform only the 
steps applicable to the system.

1. Asset Monitoring: 

a. Reconfigure the value of the OPC Group Update Rate:

– Open a Plant Explorer Workplace.

– Use the Structure Selector to open the Control Structure.

– Use the Object Browser to navigate to:

Root > Asset Optimization

– Select Afw OPC-DA Asset Monitor Data Source in the Aspect List 
Area.

– Update the value of OPC Group Update Rate (ms) in the Preview Area 
with the value recorded under Record the Value of the OPC Group Update 
Rate on page 247 and click Apply.

Execute Check and Repair AES Variable Table in order to make the environment 
support work for Function Designer.

Asset Monitoring directories must be restored on every Asset Optimization 
Server node defined in the system.
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b. If Runtime Asset Monitors are being used in the system, restore the 
Runtime Asset Monitor data directory (DeviceRunTimeMSLogicStore) to 
the following directory:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AssetMonitorEnvironment\Bin 

c. If XY Profile Deviation Asset Monitors are being used in the system, 
restore the XY Profile Deviation Asset Monitor data directory 
(XY_Reference_Profiles) to the following directory:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AssetMonitorEnvironment\Bin

2. Maximo Integration:  

a. Refer to System 800xA Asset Optimization Configuration (3BUA000118*) 
to configure ECS.

b. If the MxDef files were customized, restore the MxDef files to the 
following directory:

The saved data contains the Runtime Asset Monitor data present at the time of the 
save. Use the Runtime Asset Monitor faceplate to reset the Asset Monitors by 
adding the lost time to their accumulated run time or with some known values 
based on other records. Ignore any alarms occurring during the backup.

The Runtime Properties aspect on the Runtime Asset Monitor object type has 
been replaced with Runtime Asset Monitor Faceplate Inputs. If any configuration 
changes were made to the Runtime Properties aspect on instances of the object 
prior to taking the 800xA System Backup, the aspect will not be automatically 
deleted. In this case, the Runtime Asset Monitor will fail to load with an Add Item 
error for the Reset Signal. In order to complete the upgrade, search for all 
instances of the Runtime Properties aspect on the Runtime Asset Monitor objects 
and apply any configuration changes made to the new Runtime Asset Monitor 
Faceplate inputs, and then delete the Runtime Properties aspect.

cpmPlus Enterprise Connectivity Version 4.0 (ECS 4.0) must be installed in order 
to access Maximo Server Version 6.2.

The Maximo Integration information (Maximo Equipment ID and Maximo 
Credentials aspects) must be restored on all Asset Optimization Server nodes. 
Reference the Service Structure for the Asset Optimization Server.
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...\Program Files\ABB Industrial IT\Optimize IT\Asset
Optimization\AOECSConnector\MxDef\

Refer to System 800xA Asset Optimization Configuration (3BUA000118*) 
for more information on MxDef files.

c. Restore the AOMaximoModel file to the following location if the ECS 
model was customized:

...\program files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AOECSConnector\ECSDefinitions

d. Ensure that the ABB Maximo Connectivity system extension is loaded.

3. SAP/PM Integration:  

a. Refer to System 800xA Asset Optimization Configuration (3BUA000118*) 
to configure ECS.

b. If the SAPDef files were customized, restore the SAPDef files to the 
following directory:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AOECSConnector\SAPPMDef

c. Restore the AOSAPModel file to the following location if the ECS model 
was customized:

...\program files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AOECSConnector\ECSDefinitions

Refer to Industrial IT, 800xA - Asset Optimization, Configuration 
(3BUA000118*) for more information on SAPDef files.

The pending fault reports residing in the system can be restored to the following 
directory structure:

...\OperateITData\OptaoACDs

Restore the entire OptaoACDs folder.

cpmPlus Enterprise Connectivity Version 4.0 (ECS 4.0) must be installed in order 
to access SAP Server Version 4.7.

The SAP/PM Integration information (SAP Equipment ID and SAP Credentials 
aspects) must be restored on all Asset Optimization Server nodes. Reference the 
Service Structure for the Asset Optimization Server.
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d. Ensure that the ABB SAP Connect system extension is loaded. 

4. DMS Calibration Integration.

5. Asset Monitors that are assigned (via the Configure option drop-down list box 
on the Asset Monitor Instance on an Object) to a particular AO Server object 
and Asset Optimization Server aspect (by Object name:Aspect name pair), will 
not be correctly configured after the upgrade. The AOServer property will be 
unconfigured and the following error message will appear:

Unable to resolve AO Server for this Asset Monitor 
configuration

This must be resolved before the Asset Monitor Logic can be loaded into an 
AO Server:Asset Optimization Server for execution. Refer to the Object Type 
Structure for Asset Optimization, Object Type Group:AO Server, Object Type.

6. After a restore of a 800xA 5.0 SP2 system, the Asset Optimization Server 
(Monitor Server/Engine) is running. The AO Server tab of the Asset 
Monitoring Server aspect will show a status of good: AM Engine running. 

a. Clicking the Asset Monitors tab and selecting AMs assigned to this AO 
Server will show that the values in the Status column are NOT Loaded, 
enabled. 

b. Click Load all AMs to reload all enabled Asset Monitors assigned to this 
AO Server. 

The pending fault reports residing in the system can be restored to the following 
directory structure:

...\OperateITData\OptaoACDs

Restore the entire OptaoACDs folder.

The DMS Calibration Integration approach is changed in 800xA 5.1. Upgrade of 
DMS Calibration Integration is not supported. Reconfigure the DMS Calibration 
Integration based on an engineered solution.

Contact ABB technical support for more information.

:The Enable Write Access check box must be selected in the Asset Monitor Data 
Source aspect before loading Runtime Asset Monitors into the AO Server. Refer 
to System 800xA Asset Optimization Configuration (3BUA000118*) for more 
information.
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PC, Network and Software Monitoring

In the 800xA 5.1 and later releases, a set of IT Asset type objects are deprecated. 
The new enhancements, Process Graphics 2 and Native Language Support (NLS), 
are not applied to deprecated IT Asset type objects. Replacements of deprecated IT 
Asset type objects are delivered in PNSM Device Library. It is recommended to 
migrate deprecated IT Asset type objects to PNSM Device Library in case the 
system being upgraded has all Process Graphics 2 graphics and no VB graphics. 
Refer to Appendix H, Mapping of Deprecated IT Asset Object Types.

The following steps describe the migration procedure.

1. Download IT Asset type objects in PNSM Device Library that replaces the 
deprecated IT Asset type objects which are used in the current configuration. 
The download link is http://www.abb.com/controlsystems.

2. Migrate each deprecated IT Asset type object to its replacement IT Asset type 
object in PNSM Device Library

a. Instantiate and configure PNSM Device Library objects.

b. Delete deprecated IT Asset type objects.

3. To upgrade to a newer version of the Light Generic Computer Process object 
type, it is required to delete all old instances and replace them with the newer 
version of the Light Generic Computer Process object type. Refer to the 
Process Monitoring section of System 800xA PC, Network and Software 
Monitoring Configuration.

Perform the following post upgrade procedure for PC, Network and Software 
Monitoring.

1. If user defined Script, Resource, and Assembly files were backed up, copy the 
saved files from the safe media to the following directories:

Migration from deprecated IT Asset type objects to the PC, Network and 
Software Monitoring Device Library is not mandatory in case the system being 
upgraded already has VB graphics.

Reconfigure all applications referring to deprecated IT Asset type objects. For 
example, Logging of OPC data into history archive.

http://www.abb.com/controlsystems
http://www.abb.com/controlsystems
http://www.abb.com/controlsystems
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...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Scripts\User

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Assemblies\User

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Resources\User

PNSM Device Library Restore Procedure

Perform the following post upgrade procedure for PNSM Device Library:

1. Copy the files from the safe location to the directory if MOF files were backed 
up:

...\Program Files\ABB Industrial IT\Optimize IT\PC, 
Network and Software Monitoring\MOFS

2. Copy the Custom Asset Monitor dlls from the safe location to the 
following location for object types with Custom Asset Monitors:

...\Program Files\ABB Industrial IT\Optimize 
IT\PC, Network and Software Monitoring\Asset 
Monitoring\Bin

Use the Register.dll bat file present in the Object Type to register this dll 
automatically.

3. Copy the Windows Management Instrumentation (WMI) repository to the 
directory if the files were backed up. Perform the following steps to back up 
and restore the the WMI repository.

a. Right-click Computer and select Manage. Computer Management is 
displayed.

b. Expand Configuration on the left panel. Select WMI Control.

c. Right-click WMI Control and select Properties. The Properties dialog 
box is displayed.

d. Click Backup/Restore Tab.



PNSM Device Library Restore Procedure Section 5  Upgrading 800xA 4.1 to 800xA 5.1 Offline

298 3BSE036342-511 G

 

e. Click Back Up Now..., Specify a name for your backup file 
window is displayed. 

f. Enter the name of the backup file and click Save.

g. Click Restore Now..., Specify a backup file to restore window 
is displayed.

h. Select the file and click Open to restore the backed up file.

Figure 46. WMI Backup File
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SMS and e-mail Messaging

Reconfigure the GSM Device hardware information recorded in the save operation 
(refer to SMS and e-mail Messaging on page 251).

Batch Management

Verify that the primary Batch Server is in primary mode (P is displayed in the 
Windows Task bar) and the secondary Batch Server is in secondary mode (S 
displayed in the Windows Task bar). If the proper modes are not displayed, enable 
the Batch Service Group before proceeding.

To enable the Batch Service Group:

1. Open a Plant Explorer Workplace.

2. Select the Service Structure.

3. Select the Services\Batch Service, Service\batch_group_name, Service 
Group\Service Group Definition aspect.

4. Select the Configuration tab.

5. Select the provider that is currently the secondary Batch Server.

6. Select the Enabled check box and click Apply.

7. Select the provider that is currently the primary Batch Server.

8. Select the Enabled check box and click Apply.

Batch data can be reloaded to the batch database from wherever it was archived. 

It may be necessary to stop and start the Messenger Server Service in the Service 
Structure after the SMS and e-mail Messaging restore operation.

During the upgrade, a second Messenger Service Group and Messenger Service 
Provider will be created in the Service Structure. For instance:

Messenger SG_1, Service Group
Messenger SP_1, Service Provider

If there is already a Messenger Service Group and Messenger Service Provider 
configured, the new one may be deleted.

The Batch history archive and restore aspect has been removed in SV5.1.
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Perform the following to view any Batch data archived from SV5.0 or previous 
versions of the Batch product:

1. Create a Virtual Machine (VM) node with the existing system version and its 
components.

2. Restore Batch data using the Batch Restore window onto this virtual machine.

Once the restored data is in the batch database, it can be viewed using the Batch 
History Overview window. 

Do not restore directly from CDs or DVDs. Restore from hard disk drives which can 
be restored from CDs or DVDs using commercially available software.

Selecting the Alarm Server

To select the Alarm Server:

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Use the Object Browser to select:

Services > Event Collector, Service > 
Batch_AE_Service, Service Group

4. Select Service Group Definition in the Aspect List Area.

5. Select the Special Configuration tab in the Preview Area.

6. Select Produce IT Batch OPC AE Server in the Alarm Server field.

7. Click Apply.

Basic History Service

Restore the Basic History Service data as follows. Perform this procedure on every 
node where the Basic History Service is running.

1. Stop the Basic History Server from the Service Structure by the following 
procedure:

Always perform the Toolbar configuration as described in System 800xA Batch 
Management Configuration and shutdown script procedure as described in the 
Batch Management section of System 800xA Post Installation (3BUA000156*).
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a. Open a Plant Explorer Workplace. 

b. Use the Structure Browser to open the Service Structure. 

c. Select the Basic History, Service > Basic, Service Group. 

d. Select the Service Group Definition aspect. 

e. Click the Configuration tab. 

f. Clear the Enabled check box and click Apply.

2. If it is necessary to keep historical data for the time since the upgraded system 
was started, copy the current Basic History log files in the following directory:

...\OperateITData\History\{provider ID}

to a temporary directory.

These files will be inserted by using the Archive Tool.

3. Delete all files under:

...\OperateITData\History\{provider ID}

4. Restore the files from the backup of Basic History Service Data to:

 ...\OperateITData\History\{provider ID}

5. Start the Basic History Service from the Service Structure.

6. If Step 2 was performed:

a. Open the AdvHtArchiveTool located by default in the following directory:

...\Program Files\ABB Industrial IT\Operate IT\Process 
Portal A \bin

b. Use the File/Select/Open Archive command and browse to the directory 
containing the history log files.

c. Open the Action/Insert Data into Logs command.

d. Accept the default values in the Time Selection dialog box.

e. Click OK to start the insertion of the saved data to the logs.
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Information Management

Refer to Information Management Post Upgrade Procedures on page 458 in 
Appendix , Information Management Upgrade to perform the Information 
Management post upgrade procedures.

Calculations Service

Calculations that were disabled prior to the upgrade must be enabled by selecting 
the Enabled check box in the Calculations dialog box. Refer to the section on 
Calculations in Industrial IT, 800xA - Information Management, Operation 
(3BUF001094*). 

To enable the Calculations Service:

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Calculations Service Object.

4. Select the Service Definition aspect.

5. Click the Configuration tab.

6. Select the Enabled check box and click Apply.

Scheduling Service (Application Scheduler)

Schedules that were disabled prior to the upgrade must be enabled by selecting the 
Enabled check box in the Scheduling dialog box. Refer to the section on 
Scheduling in Industrial IT, 800xA - Information Management, Operation 
(3BUF001094*). 

To enable the Scheduling Service:

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Scheduling Service Object.

4. Select the Service Definition aspect.

5. Click the Configuration tab.
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6. Select the Enabled check box and click Apply.

Process Engineering Tool Integration

Use the following procedure after upgrading Process Engineering Tool Integration:

Restore the backed up data directory (in preparation-step prior to upgrade) to the 
installed directory of Process Engineering Tool Integration. Restore the entire Xml 
directory contents to:

...\Program Files\ABB Industrial IT\Engineer 
IT\Engineering Studio\Process Engineering Tool 
Integration\Xml

Update VB Graphics with Newer Dependencies

Use the Display Tool to search for VB graphics with newer dependencies. Use the 
following selections when searching:

• Search in all structures.
• Deploy needed.

Perform a deploy with the auto resolve action on all VB graphics with newer 
dependencies.

Miscellaneous Procedures
Perform the following procedures:

• Resigning Digital Signatures in 800xA 5.1.
• Restart the System.
• Reconfigure Event Collectors.
• Reconfigure Alarm and Event List Configurations.
• Add Autostart Shortcut.

Resigning Digital Signatures in 800xA 5.1

To resign digital signatures in 800xA 5.1:

1. Use Windows Explorer to locate AfwSignatureManager.exe in the 
following directory:
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...\<Base System install directory>/bin

2. Double-click AfwSignatureManager.exe to launch the Signature Manager. 

3. Use the File menu to open the Signature Report file saved before the upgrade.

4. When a signer is selected in the Signer column, the Aspects Signed table will 
show all aspects signed by this signer and information indicating whether the 
signature was valid in the 800xA 4.1 System or not.

5. Select the aspects to re-sign and click Sign. 

6. A Signature dialog box will appear in which to validate the signature.

Restart the System

Restart the system after performing all post upgrade procedures.

Reconfigure Event Collectors

When upgrading from 800xA 4.1 to 800xA 5.1, the Event Collectors that were 
configured to use a special Collection Definition object are obsolete. Reconfigure 
the Event Collectors to use the Collection Definitions objects with the 800xA 5.1 
System.

The Configuration Wizard log shows which Event Collectors need to be 
reconfigured with a message such as:

Objects “(SV4) ABB Hs OPC Alarm Event Server” and “ABB 
Hs OPC Alarm Event Server” represent the same A&E 
Server. Please configure the EventCollector to user the 
new definition.

All Collection Definition objects that come from the backup system have the prefix 
(SV4). These objects are located in:

Library Structure > Alarm & Event > Alarm Collection 
Definitions

Use Ctrl+Shift+Click to select multiple aspects to sign in one operation.
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Reconfigure Alarm and Event List Configurations

In 800xA 5.1, in most cases, the SourceName column contains GUIDs. The 
recommendation in 800xA 5.1 is to reconfigure the Alarm and Event List 
configurations to use the ObjectName column instead of the SourceName column.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Library Structure.

3. Use the Object browser to navigate to and select an Alarm and Event List 
Configuration aspect.

4. Select Alarm and Event List Configuration in the Aspect List Area.

5. Select the Columns tab in the Preview Area.

6. Clear the SourceName check box and select the ObjectName check box.

7. Click Apply.

8. Repeat the procedure for all Alarm and Event List Configuration aspects.

Add Autostart Shortcut

It it is desired to enable the autostart of the Operator Workplace on client nodes, 
perform the following:

1. Define a default workplace.

2. The shortcut must be created from the ABB Workplace login window.

3. The shortcut is located in:

...:\Documents and Settings\UserName\Start 
Menu\Programs\Startup

4. Right-click the shortcut and select Properties from the context menu.

5. Add the following to the shortcut target:

/WS

-or-

/WaitForSystem

6. Click OK.
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System Backup
Make complete hard disk and 800xA System backups of the upgraded system.
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Section 6  Upgrading 800xA 3.1 SP3 to 800xA
5.0 SP2

The person performing this upgrade must use the same user account that was used 
during the installation of the 800xA System software, unless otherwise indicated in 
these instructions.

Functional Area Naming
Some 800xA Functional Area names have been changed since the 800xA 3.1 SP3 
release. Table 8 lists the Functional Area names before and after the upgrade. The 
800xA 3.1 SP3 Functional Area names will be used in this section up to, but not 
including System Upgrade (Upgrade Flow B) on page 334. The 800xA 5.0 SP2 

Upgrading the 800xA System requires the plant to be shut down. To guarantee 
the functionality of the upgraded system, follow these upgrade instructions 
carefully and perform them in the order presented. 

Upgrading directly from 800xA 3.1 SP3 to 800xA 5.1 is a two-step process. It is 
necessary to upgrade to 800xA 5.0 SP 2 before upgrading to 800xA 5.1. When 
the procedures in this section are complete, refer to Section 3, Upgrading 800xA 
5.0 SP2 to 800xA 5.1 Online or Section 4, Upgrading 800xA 5.0 SP2 to 
800xA 5.1 Offline in this instruction to upgrade from 800xA 5.0 SP2 to 800xA 
5.1.

Upgrading an 800xA 3.1 System with 800xA for Harmony installed on any node 
in the system is a two-step process. Refer to 800xA for Harmony Release Notes 
(3BUA000112*) for detailed information.
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Functional Areas names will be used from that point through the remainder of the 
section.

Control Builder M Compatibility Issues
Refer to the compatibility issues detailed in Appendix B, Control Builder M 
Compatibility Issues before beginning the upgrade.

Upgrade Flow
This section is organized so that the instructions are presented in the proper upgrade 
order. Do not skip any steps that pertain to 800xA software being used in the current 
or upgraded system. Refer to Planning for the Upgrade on page 35 for additional 
information and ideas on how to streamline the upgrade process.

Figure 47 shows a high level flow of the upgrade paths.

The upgrade process is broken down into three processes:

• Preparation (Figure 48).
• Operating system and third party software upgrade (Figure 49).
• 800xA System software and configuration data upgrade (Figure 50).

Each flow chart has active links, indicated by blue text, to help navigate through the 
document (if viewing it online). Clicking in a flow element with blue text will 
advance the document to the related procedure. 

Table 8. Functional Area Naming

Name in 800xA 3.1 SP3 Name in 800xA 5.0 SP2

Control IT for AC 800M 800xA for AC 800M

FOUNDATION Fieldbus Device 
Integration

Device Management FOUNDATION 
Fieldbus

HART Device Integration Device Management PROFIBUS & 
HART

PROFIBUS Device Integration

AC 400 Connect 800xA for Advant Master

Safeguard Connect 800xA for Safeguard
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All paths require, after backup and before restore, installing the 800xA System 
software and creating the system as if it were a new installation.

Figure 47. High Level Upgrade Flow

Figure 48. Upgrade Preparation Flow
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Figure 49. Operating System, Third Party, and 800xA Software Upgrade Flow
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 Central Licensing System (Upgrade Flow A)

Consistency Check
Refer to Appendix D, Consistency Check and perform the necessary consistency 
checks.

Figure 50. System Restore and Post Upgrade Flow

Order new licenses for 800xA 5.0 SP2. The 800xA 3.1 SP3 licenses will not 
work.

Perform a consistency check before performing the 800xA System backup. 
Failure to do so could result in problems when restoring the system after the 
upgrade.
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Save Digital Signatures
The new support for version handling of aspect data will make all digital signatures 
in 800xA 3.1 SP3 invalid when upgrading to 800xA 5.0 SP2. To simplify the 
upgrade, two applications have been developed to support the re-signing of aspects 
in 800xA 5.0 SP2:

• AfwSignatureReport: Used to create a report with information about signed 
aspects in 800xA 3.1 SP3.

• AfwSignatureManager: Used in 800xA 5.0 SP2 to re-sign these aspects.

Perform the following before upgrading from 800xA 3.1 SP3 to 800xA 5.0 SP2.

1. Insert 800xA System Installation DVD 1 into the drive on a client in the 
800xA 3.1 SP3 800xA System.

2. Copy the AfwSignatureReport.exe from the following directory on 800xA 
System Installation DVD 1 to a directory on the client. 

Engineering & Development\Accessories\Digital 
Signatures Upgrade Tools\SV3

3. Open a Windows Command Prompt.

4. Change to the directory where AfwSignatureReport.exe was copied.

5. Run the following command:

AfwSignatureReport <filename>.xml

6. Save the signature report file <fileName>.xml on an external media during the 
upgrade.

External Alarm Service Group
Keep only one External Alarm Service Group and move the provider or providers to 
the Aspect Servers.

The digital signature must be valid before saving to the report file.
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Deploy all User Created Process Graphics
800xA System backups containing undeployed user created process graphics will 
result in warning and error messages later in the upgrade process. To avoid these 
messages, refer to Industrial IT, 800xA - Engineering, Graphics (3BSE030335*) 
and use the Display Tool to deploy all user created process graphics before 
beginning the 800xA System backup.

Backups
It is important to create backups of node hard disks and the 800xA System before 
starting the upgrade procedures. Valid backups insure that the system can be 
restored if necessary.

Hard Disk Backup

It is recommended that a third party backup/restore and/or disk imaging utility be 
used to save (and restore if necessary) hard disks before starting the upgrade 
procedures.

800xA System Backup

The Backup/Restore function makes it possible to make an online backup of a node 
and perform an offline restore of the same node. A full backup stores all aspect 
objects and aspect data (application data) in the Aspect Directory.

All system extensions that are part of the system must be installed and added on the 
node where the backup will be taken (usually the primary Aspect Server node). No 

Refer to Appendix D, Consistency Check and perform a consistency check before 
performing the 800xA System backup. Failure to do so could result in problems 
when restoring the system after the upgrade.

Avoid engineering or any other changes especially to the Aspect system during 
the 800xA Backup process.

Verify the Batch Management Servers are operating normally before and during 
800xA System backups (or usage of the Import/Export tool) of systems 
containing Batch Management nodes. This will ensure the backup of all batch 
data.



800xA System Backup Section 6  Upgrading 800xA 3.1 SP3 to 800xA 5.0 SP2

314 3BSE036342-511 G

 

changes can be made (especially to the Aspect directory) during the online backup 
process.

The following steps outline the 800xA system backup procedure. Refer to System 
800xA Maintenance (3BSE046784*) for more detailed information.

1. Create a Full Backup Definition object in the Maintenance Structure.

2. Configure the Scope and the Storage tabs. Disable the History and System 
Messages check boxes in the Scope tab.

3. Check the disk space and path in the Storage tab of the Backup Definition 
aspect. A large configuration could require a minimum of five gigabytes of free 
space.

4. Start the backup process.

5. In case of any warning or error messages (refer to Appendix A, Warning and 
Error Messages), take the appropriate measure and create a new backup.

6. Record the number of aspects and objects in the system. 

a. Select the Admin Structure\Adminstrative 
Objects\Domains\system_name, Domain\Domain Definition aspect.

b. Record the number of objects and aspects listed in the System Size 
Information area of the window.

c. Right-click the Control Structure\control_network_name, Control 
Network\Control Structure aspect of one of the control networks 
contained in the system.

d. Select Properties from the context menu.

e. Select the Statistics tab.

f. Record the number of objects listed.

Ensure that the Post Installation Procedure for Engineering Studio 3.1.0/2 
Rollup 2 (refer to Release Notes 3BDS011626R3101) has been performed. Refer 
also to Technical Description - Industrial IT System 800xA SV 3.x System 
Software Versions (3BSE037782* (latest revision)).

For background information, refer to Product Bulletin 800xA Eng.Workplace 
Eng.Studio SV3.1-SV4.0, Aspect Types falsely reset (3BDS100999).
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g. Right-click the Control Structure aspect within a controller project of the 
control network selected in Step c.

h. Select Properties from the context menu.

i. Record the number of objects listed.

j. Repeat Step g through Step i for all the controller projects within the 
control network.

k. Repeat Step c through Step j for every control network in the system.

l. Right-click the Control Structure\HSE_Subnet name, HSE Subnet\Control 
Structure aspect of one of the HSE Subnets contained in the system.

m. Select Properties from the context menu.

n. Select the Statistics tab.

o. Record the number of objects listed.

p. Repeat Step l through Step o for every HSE Subnet in the system.

q. Right-click the Control Structure\MB300_name, MB300 
Network\Control Structure aspect of one of the MB300 Networks 
contained in the system.

r. Select Properties from the context menu.

s. Select the Statistics tab.

t. Record the number of objects listed.

u. Repeat Step q through Step t for every MB300 network in the system.

Pre-Upgrade Procedures
Some 800xA System software requires preparatory steps before shutting down 
800xA System processes. Perform the applicable procedures in the order presented. 

Do not manually import or edit any information in backup files.
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Control IT for AC 800M

Use the following procedure to prepare for the Control IT for AC 800M upgrade:

1. Record the memory setting for OPC Server and Control Builder found in the 
Setup Wizard for each product.

2. Control Builder stores its settings (systemsetup.sys) on disk in the following 
directory:

...\ABB Industrial IT Data\Engineer IT Data\Control 
Builder M Professional

Copy this file to a safe media.

3. Save OPC configurations by selecting:

File > Save Configuration

in the OPC Server Panel.

4. The OPC Server stores configuration files (*.cfg) and settings 
(systemsetup.sys) on disk. Copy these files to a safe media. The 
systemsetup.sys file is located in:

...\ABB Industrial IT Data\Control IT Data\OPC Server 
for AC 800M

The configuration files are stored in the Files folder in the same location.

Device Management and Fieldbuses

Device Management FOUNDATION Fieldbus

User-made modifications to library objects representing FF standard blocks (these 
are blocks supported by the Device Type Standard FBs as indicated in the Block 
Info tab of the block class parameter dialog box) will be overwritten during 

Verify that the FOUNDATION Fieldbus Device Integration Version 3.1.0/2 
Rollup 1 and Rollup 2 have been installed before starting to save information. In 
this special case, Rollup 2 does not contain the contents of Rollup 1, so make sure 
that Rollup 1 has been installed before installing Rollup 2. If necessary, download 
the rollups from ABB SolutionsBank (document numbers: 3BDS009928 and 
3BDS009947).
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upgrade. If such changes have been made, they can be reconstructed manually. 
Refer to Device Management FOUNDATION Fieldbus on page 368.

Device Management PROFIBUS & HART

Historical data sets of Device Type Manager (DTM), exported via the Fieldbus 
Management aspect, along with device specific DTM files are stored as files on the 
Primary Aspect Server node. These files and the PROFIBUS/HART OPC Server 
configuration are stored after a successful 800xA System backup. The path to this 
folder can be found as follows:

1. Open the Plant Explorer Workplace on the Primary Aspect Server node.

2. Use the Structure Selector to select the Control Structure.

3. Use the Object Browser to select the Root Object type.

4. Select the FBB PH Settings aspect.

5. Record the path information for the Primary Aspect Server found in the FBB 
PH Settings aspect.

6. Use Windows Explorer to copy the folder (default: Fieldbus Builder PH) 
containing device specific configuration files (in the path recorded in Step 5) to 
the 800xA System backup folder, created as described in 800xA System 
Backup on page 313. 

7. If the folder name of the copied folder is not Fieldbus Builder PH, it must be 
renamed to the default folder name (Fieldbus Builder PH) in the 800xA System 
backup folder.

PROFIBUS Device Types

PROFIBUS Device Types in 800xA 5.0 and later are based on Hardware Libraries 
(HWLib). This is different from previous system versions, where these Device 
Types were based on Hardware Definitions (HWD). As a result, the PROFIBUS 
Device Types used in connection with the Device Integration software must be 
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linked to new delivered Hardware Libraries to ensure system and upgrade 
compatibility.

If the ABB_TZIDC_110-220_SP_Short module type is used in the Control Structure 
of the Plant Explorer, a special upgrade procedure must be performed to ensure 
upgrade compatibility in 800xA 5.0 and later. This module is delivered with the 
PROFIBUS Device Integration package and its system extensions and is supported 
by the ABB_TZIDC_110-220_YP0_v1_0 PROFIBUS Device Type.

1. Open the Engineering Workplace and select the Control Structure.

2. Open the Find Tool.

3. In the <Add attribute> selection box select Structure. 

4. In the <Structure> selection box select Control Structure.

5. In the <Add attribute> selection box select Object Type. This displays all 
instances available in the Control Structure.

6. Select the ABB_TZIDC_110-210_SP_Short module from the displayed list 
and click Search. If the module type is not available, this section can be 
skipped.

7. Open Bulk Data Manager in the Control Structure (right-click on the Root 
node and select Advanced > Bulk Data Manager).

8. Verify that the valid system is selected in the BDM sheet. 

9. Search for and select the ABB_TZIDC_110-220_SP_Short module in the 
Control Structure.

10. Select Control Properties in the Aspect List Area and move it via the drag 
and drop function to the BDM sheet on cell A1 in the Preview Area.

11. A new window will open in which all parameters will be selected. Confirm the 
Complete selection by clicking OK.

Perform the following procedure only if the exact PROFIBUS Device Type 
described is used. Otherwise, this procedure can be skipped.

The following steps requires Bulk Data Manager (BDM) (Engineering Platform) 
to be installed. Perform the described steps on an Engineering system node.
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12. Select cell A2 in the BDM sheet and enter the text Filter:Control 
Structure.

13. Select the project containing the ABB_TZIDC_110-210_SP_Short module in 
the Control Structure and move it via the drag and drop function into the 
BDM sheet on cell A3.

14. Select the Auto filter option in the Excel sheet (select Data > Filter > 
AutoFilter in the menu bar).

15. Select in line A in the BDM sheet, the column named Source Object (normally 
cell C1) and click Filter.

16. Search for and select the ABB_TZIDC_110-210_SP_Short module. This will 
now be the only module shown.

17. Enter the text delete for each listed module in the column named Command 
(normally cell A1). The Optional selection function can be used. 

18. Save the changes to the 800xA System by clicking Save All Objects. The 
modules will be deleted in the Control Structure.

19. Remove the text delete for each listed module in the column named 
Command.

20. The captions Short will be exchanged to Long for all listed modules in the 
column named Source Object. The name will now be ABB_TZIDC_110-
210_SP_Long for all listed modules.

21. Save the changes to the 800xA System by clicking Save All Objects. The 
modules will be created in the Control Structure.

AC 400 Connect and Safeguard Connect

Perform the following on each Connectivity Server node.

1. Make an RTA Board backup. Save the files:

• DATHR1.CD
• DATHR2.CD

 If the module is used in different projects, the steps must be repeated for the 
other projects.
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• DATHR3.CD

from the folder:

...\Program Files\ABB Industrial IT\OperateIT\AC 400 
Connect\AdvantBase\Data\RTA\Init\

and record which files belong to which node.

2. Save the Configuration Files

The configuration files in the Connectivity Servers can contain special 
configuration settings for Alarm and Event or Data access. Refer to 800xA for 
Advant Master, Configuration (3BSE030340*) for more information about 
these special configuration settings.

If such changes are available in the configuration files, perform the following 
on each 800xA for Advant Master and 800xA for Safeguard Connectivity 
Server node: Save the following files to a safe location:

– AdvDsMasterAdapter.csv

– AdvMbAeOPCServer.csv

The default location for the files is:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\Bin

3. The following settings must be documented for reconfiguration.

– Time synchronization registry key (REVERSED_SYNC_MODE):

HKEY_LOCAL_MACHINE\SOFTWARE\ABB\AFW\SystemModules\
AfwTimeServerAdaptor\1.0-0\Private

– MB300 node and network address for RTA board in RTA board 
Configuration aspect.

PLC Connect

1. If the PLC Connect IEC 60870 feature is installed and configured, the IEC 
configuration must be saved. Refer to the section on configuring the IEC 60870 
driver in System 800xA PLC Connect Configuration (3BSE035041*) for more 
information.
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2. If the PLC Connect Communication Server Pre Treatment function is being 
used in the application (refer to System 800xA PLC Connect Configuration 
(3BSE035041*) for more information), make a backup of PreTreat2.dll. 
Pretreat2.dll is located in the following folder on the PLC Connect 
Connectivity Server:

...\ABB Industrial IT\Operate IT\PLC Connect\Bin

3. Make a backup of the VB application projects for PreTreat2.dll.

4. If the Event Server Pre Treatment function is being used in the application 
(refer to System 800xA PLC Connect Configuration (3BSE035041*) for more 
information), make a backup of PreEvent.dll. PreEvent.dll is located in the 
following folder on the PLC Connect Connectivity Server:

...\ABB Industrial IT\Operate IT\PLC Connect\Bin

5. Make a backup of the VB application projects for PreEvent.dll.

Engineering Studio IO Allocation

Deactivate the auto update mode in IO Allocation.

1. Start the Engineering Workplace.

2. Open the IO Allocation tool on any object by right-clicking on the object and 
selecting Advanced > IO Allocation from the context menu that appears.

3. Verify that no check mark symbol is visible in the Options > Automatic Write 
Allocation to CBM menu item in the IO Allocation tool.

Asset Optimization

Preparing for the Asset Optimization upgrade requires recording some values for 
post upgrade and backing up data to a safe media.

The path is the default location of the file. If it has been placed somewhere else, 
make a backup from that location.

The path is the default location of the file. If it has been placed somewhere else, 
make a backup from that location.
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Record Values for Post Upgrade

1. Use the following procedure to record the value of the OPC Group Update 
Rate.

a. Open a Plant Explorer Workplace.

b. Use the Structure Selector to open the Control Structure.

c. Use the Object Browser to navigate to:

Root > Asset Optimization

d. Select Afw OPC-DA Asset Monitor Data Source in the Aspect List 
Area.

e. Record the value of OPC Group Update Rate (ms) shown in the Preview 
Area. This value must be reconfigured after the upgrade.

2. If using Maximo Integration, it is necessary to record the values of the Maximo 
Equipment ID Provider Properties, as these values will not be upgraded. Refer 
to Maximo Server Connection Properties in the System Setup section of 
Industrial IT, 800xA - Asset Optimization, Configuration (3BUA000118*) to 
access these values.

Back Up Data to Safe Media

Use the following procedure to back up Asset Optimization information (perform 
only the steps applicable to the system):

1. Asset Monitoring:

a. If Runtime Asset Monitors are being used in the system, save the Runtime 
Asset Monitor data directory (DeviceRunTimeMSLogicStore) to a safe 
media. The Runtime Asset Monitor data directory is located in:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AssetMonitorEnvironment\Bin

b. If XY Profile Deviation Asset Monitors are being used in the system, save 
the XY Profile Deviation Asset Monitor data directory 

Asset Monitoring directories will be found on the Asset Optimization Server 
node.
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(XY_Reference_Profiles) to a safe media. The XY_Reference_Profiles 
directory is located in:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AssetMonitorEnvironment\Bin

2. Save Maximo Integration:

a. Although the Maximo system is separate from the 800xA System, it is a 
good idea to back up the system in use. Follow Maximo standard practices 
for Maximo system backup.

b. If the MxDef files were customized per the instructions in Industrial IT, 
800xA - Asset Optimization, Configuration (3BUA000118*), back up the 
customized MxDef files to safe media.  

The customized MxDef files are located in the following directory:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\ABBAO\Services\MOM\MxDefs\server_name\
app_server

Where:

<server_name>\<app_server> is the combination of the MRO 
Server Name and the MRO Application Server Name fields from the 
Maximo Equipment ID aspect. These fields are configured in the Aspect 
System Structure in the Maximo Equipment ID aspect. These fields 
allow for customization of MxDef files on the Maximo Server level as 
well as on the Maximo Application Server level. Refer to the Maximo 
documentation for an explanation of Maximo Application Servers. 

For example, the resultant path to the customized MxDef files will look 
like:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\ABBAO\Services\MOM\MxDefs\Maximo5\
MxServer

3. DMS Calibration Integration. If DMS Calibration Integration is used:

If using Maximo Integration, the Maximo Integration information must be saved 
from all Asset Optimization Server nodes. Reference the Service Structure for 
the name of the Asset Optimization Server nodes.
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Restore DMS Calibration Integration information. Refer to the Meriam Process 
Technologies Device Management System User’s Guide for information about 
restoring DMS Server data.

PC, Network and Software Monitoring

Use the following procedure to prepare for the PC, Network and Software 
Monitoring upgrade.

1. If there are user defined Script, Resource, and Assembly files they need to be 
backed up. The user files are located in:

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Scripts\User

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Assemblies\User

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Resources\User directory

Copy the files in these directories to a safe location.

2. Shut down the PC, Network and Software Monitoring Server node.

a. Use the Structure Selector to open the Service Structure in the Plant 
Explorer Workplace.

b. Use the Object Browser to navigate to:

Services > OpcDA_Connector, Service > SG_IT Server, Service Group 
> OPCDA_Provider_Node Name, Service Provider

(where Node Name is the name of the PC, Network and Software 
Monitoring Server node).

c. Select Service Provider Definition in the Aspect List Area.

d. Click the Configuration tab to produce a view in the Preview Area. 

Asset Optimization DMS Calibration Integration 800xA 5.0 SP2 functions with 
DMS software Version 2.6.
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e. If the Enabled check box is selected, disable it and click Apply.

SMS and e-mail Messaging

Save all GSM Device hardware information. Record information for the GSM 
device on the SMS and e-mail Messaging GSM Hardware Setup Worksheet shown 
in Table 9.

Table 9. SMS and e-mail Messaging GSM Hardware Setup Worksheet

Item Setting/Value

Spooler Settings

Activate Outbox Spooler Checked (check and leave checked)

Activate Inbox Spooler Checked (check and leave checked)

Interval for Checking for Incoming 
Messages

Value: _____ Seconds Minutes (circle 1)

Port Settings

COM Port Value: COM _____

Baud Rate Value: _____

Data Bits Value: _____

Parity Value: _____

Stop Bits Value: _____

PIN and Properties

Query PIN Checked or Unchecked (circle one)

PIN (only if Query PIN is checked) Value: ___________________

Save PIN (only if Query PIN is 
checked)

Checked or Unchecked (circle one)

Own Number (telephone number of 
SIM card (including Country Code) 
in GSM hardware)

Value: ___________________



SMS and e-mail Messaging Section 6  Upgrading 800xA 3.1 SP3 to 800xA 5.0 SP2

326 3BSE036342-511 G

 

Initialization String for GSM Hardware Value:

_______________________________

_______________________________

_______________________________

_______________________________

General Service Properties

Name (GSM service provider) Value: ___________________

Port Value: COM _____

SMSC Value: ___________________

Default Country Code Value: ___________________

Default Prefix Value: ___________________

Number of Attempts Value: ___________________

Splitting Service Properties

Splitting Checked or Unchecked (circle one)

Optimize Splitting Checked or Unchecked (circle one)

Enumerate Splitting Checked or Unchecked (circle one)

Narrowband Sockets Checked or Unchecked (circle one)

Messaging Service Properties

Add Before Message Blank (verify and do not change)

Use for Delivery Notification Only Unchecked (verify and do not change)

Default Option 0 (verify and do not change)

Message General Properties

Replace CR LF for Incoming 
Messages

Checked or Unchecked (circle one)

Table 9. SMS and e-mail Messaging GSM Hardware Setup Worksheet (Continued)

Item Setting/Value
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Batch Management 

1. Verify all scheduled batches are completed or terminated.

2. To archive batch history, select the batch history archive aspect. By default a 
Batch History Archive aspect is located in:

Library Structure > Batch Management, Overviews

The Batch History Archive window contains the Batch Selection and Archive 
Destination tabs. However, this aspect can be added to any 800xA system 
object.

During the course of each batch process run, data that documents details about 
that specific batch is gathered and stored by the system in the batch database 
until manually removed. Data that has been archived can still be retained in the 
batch database. However, once data associated with a batch has been archived 
and placed in a safe place, the data for that batch should be removed from the 
batch database.

Archiving batch data has no effect on the uniqueness of the batch ID. Even 
after data associated with a batch ID has been removed from the system, a 
record of the batch ID will be retained on the system. The batch ID can never 
be reused.

Do not archive directly to or restore directly from CDs or DVDs. Archive to or 
restore from hard disk drives which can be backed up to CDs or DVDs using 
commercially available software.

3. Use the Batch Management backup/restore utility to back up and PFC color 
configuration information and batch IDs. Access this utility by selecting:

Start > Programs > ABB Industrial IT > 800xA System >
Batch Management > Backup Restore

Selecting any of the options listed in the backup/restore utility enables the 
Backup and Restore buttons. 

The options are:

– PFC color configuration.
– Batch IDs.
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When Backup is selected, a standard Open File window that allows browsing 
to any desired folder is presented. A confirmation window provides the chance 
to cancel before the backup file is written.

4. Disable the Batch Alarm & Event Service Group and Batch Service Group 
before proceeding. To disable the service groups:

a. Open a Plant Explorer Workplace.

b. Use the Structure Selector to open the Service Structure.

c. Use the Object Browser to select:

Services\Alarm & Event, Service\batch_group_name, 
Service Group

d. Select Service Group Definition in the Aspect List Area.

e. Select the Configuration tab in the Preview Area.

f. Clear the Enabled check box and click Apply.

g. Determine the name of the nodes that are currently Primary and 
Secondary Batch Servers,

h. Use the Object Browser to select:

Services\Batch Service, Service\batch_group_name, 
Service Group

i. Select Service Group Definition in the Aspect List Area.

j. Select the Configuration tab in the Preview Area.

k. Select the provider that is currently the Secondary Batch Server.

l. Clear the Enabled check box and click Apply.

m. Select the provider that is currently the Primary Batch Server.

n. Clear the Enabled check box and click Apply.

Information Management

Perform the following procedures to prepare for the Information Management 
upgrade.
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End Microsoft Excel Process via Windows Task Manager

Use Windows Task Manager to manually end the EXCEL.EXE process.

Recording Archive Group Associations

Archive Groups are associated with Profile, Message, and Report logs.

1. Record these associations so that after the upgrade, these logs can be 
reassociated with their respective Archive Groups. Refer to the Reading and 
Managing Archive Data section in Industrial IT, 800xA - Information 
Management, Data Access and Reports (3BUF001094*) to access the Archive 
Groups and record the information.

2. Back up the path to Archive Group Numeric Log Entry and IM Objects Entry.

ABB Process Administration Server (PAS)

Perform the following procedure to run the PAS utility.

1. Run the Process Administration Service (PAS) utility on the Information 
Management Application Server node. From the Windows Taskbar select:

Start > Settings > Control Panel > Administrative Tools > PAS > 
Process Administration

This opens the Process Administration Service dialog box. 

2. Click Stop All to stop all processes under PAS supervision. 

3. Click Close when the dialog box indicates that all processes are stopped.

4. Use standard Windows procedures, via the Services selection from 
Administrative Tools in Windows Control Panel, to place the ABB Process 
Administration Service into manual and insure that it is stopped.

Information Management Backup and Restore Utility

Use the Information Management History Backup/Restore utility, via:

Start > Programs > ABB Industrial IT 800xA > Information Mgmt > 
History > Backup and Restore
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to create all the backup files that are required to completely back up the Information 
Management History database. This includes all configuration data, log data from 
both file-based and ORACLE-based logs, and the Aspect System definition file.

During a backup operation, all data in the Oracle database owned by the Oracle 
History user is exported to the specified destination and compressed into a zipped 
archive, along with any files that have been created to store file-based property log 
entries (called flat files). 

The History database can be backed up to any drive, including any mapped network 
drives. The disk type should be NTFS for the backups. 

To avoid any ambiguity, the backup operation produces a zipped archive of 
compressed History database files for each drive that contains at least some portion 
of the database, where each archive contains only the database files that are stored 
on the corresponding drive. The backup utility uses the naming convention name-
drive.zip for the zipped archives that it produces. For example, if the History 
database is located entirely on the C:\ drive and you wish to back up the database to 
a zipped archive called hist, the backup operation will compress the database files 
into a zipped archive named histDB-C.zip.

If the data files exceed two gigabytes, or if there are more than 25,000 files, then 
multiple zip files will be created using the following naming convention:

• First File name-drive.zip
• Next File name-drive0001.zip
• Next File name-drive0002.zip

When backing up the History database, make sure the disk is ready and available on 
the workstation on which the procedure is to occur. The log file should be checked 
after the backup operation to make sure that the backup operation completed 
successfully. 

Make sure the system Archive is not getting full. Temp space is required to make the 
backup. If the log file indicates that the Oracle export failed, use the option to export 
to a disk with more space.

To make a backup:

1. Select:

It is recommended that the history database be cleaned before making the backup. 
Open a Windows Command Prompt window and enter hsDBMaint -clean.
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Start > Programs > ABB Industrial IT 800xA > Information Mgmt > 
History > Backup and Restore

2. Verify the Create Backup Files of Current Configuration option is enabled 
in the IM Historian Backup/Restore Utility window.

3. Click Next. A window for setting up the backup operation is displayed.

4. Specify the location where the backup files are to be created in the New 
Directory Path for the Backup field. This path must already exist and the 
directory must be empty. If necessary, click Browse to create a new directory. 
Add a D:\HSDATA\History as an additional option. 

5. Verify the Only Generate Aspect Definition File option is disabled.

6. Click Next. The HsBAR Output Window is displayed.

7. Select the Automatically Close Upon Completion option.

8. After the HsBAR Output Window closes, monitor the progress in the Progress 
Status area of the IM Historian Backup/Restore Utility window and click 
Finish when the backup is complete. 

Saving Other Information Management Related Files

There are several other files related to Information Management to be saved as part 
of a total system backup.

• History Archive Data: For each archive device, go to the location specified by 
the Device Filename and copy the folders under that directory to a safe 
location. Do this even if automatic backup is configured.

The backup of the History data must be in a directory of its own, not the 
D:\HSDATA\History directory. If the data is put into the D:\HSDATA\History 
directory, it will get lost.

If a message appears stating that there are inconsistencies between the log 
configurations in the Aspect System and the log configurations in Oracle, it may 
be because the database was not cleaned before running the backup. Use the 
hsDBMaint -Clean function to clean the database and then rerun the backup. If 
this does not fix the problem, contact ABB Technical Support for further 
assistance.
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• History Archive State Information: The folder that holds the last archive 
time and other archive state information must be copied to a safe location. The 
folder name is Archive and it is located in:

...\Documents and Settings\All Users\
Application Data\ABB\IM\Archive

Copy the entire folder.

• Reports: Save any report template files created in Microsoft Excel, 
DataDirect, and/or Crystal Reports ®. Also save report output files created as a 
result of running these reports via the Scheduling Services.

• Desktop Trends: Back up trend display, ticker display, and tag explorer files.

– Ticker files are located in:

...\My Documents\ABB Industrial IT\Inform IT\Desktop 
Trends\Ticker Files

– Trend Files are located in:

...\My Documents\ABB Industrial IT\Inform IT\Desktop 
Trends\HTML

– Tag Explorer files are located in:

...\Documents and Settings\~username\Application 
Data\ABB Industrial IT\Inform IT\Desktop Trends

• Display Services: Back up the directories for custom users, as well as display 
and user element definitions. The files are located in:

...\Program Files\ABB Industrial IT\Inform IT\Display 
Services\Server\Data

Save the user-built svg and vet files.

• DataDirect: Back up custom text files for object, object type, and attribute 
menus used on the DataDirect windows. The files are located in:

...\Program Files\ABB Industrial IT\Inform IT\Data 
Direct\etc.

Save the user-built text files.
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Scheduler Service (Application Scheduler)

Disable Schedules before stopping the servers and performing the upgrade. The 
Schedules will need to be manually enabled again following the upgrade. 

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Scheduling Service Object.

4. Select the Service Definition aspect.

5. Click the Configuration tab.

6. Clear the Enabled check box and click Apply.

Calculations Service

Disable Calculations before stopping the servers and performing the upgrade.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Calculations Service Object.

4. Select the Service Definition aspect.

5. Click the Configuration tab.

6. Clear the Enabled check box and click Apply.

Basic History Service Data

To save Basic History Service data:

1. Stop the Basic History Server from the Service Structure.

2. Use Windows Backup (not the 800xA Backup) to backup the files in the 
following directory:

...\OperateITData\History\{provider ID}

Back up the Basic History folder for each Basic History Service Provider in the 
Service Structure. Depending on the system, the Basic History Service data can 
be present on a number of different node types (Connectivity Servers, IM Servers, 
AO Servers, etc.). It is best to search for the directory described in this procedure 
on all nodes, and if there is data present, back up that data.
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3. Start the Basic History Server again from the Service Structure.

Alarm and Event List Configurations

Alarm and Event handling has changed significantly from 800xA 3.1 SP3 to 800xA 
5.0 SP2 (refer to Alarm and Event List Configurations on page 334). Document list 
configurations in the 800xA 3.1 SP3 system, so they can be checked against the list 
configurations in the 800xA 5.0 SP2 system.

System Upgrade (Upgrade Flow B)
The upgrade procedures differ if upgrading a Domain Controller node or if 
upgrading any other type of 800xA System node. 

Domain Controller Nodes

The Microsoft Windows Operating Systems supported for Domain Controller nodes 
in 800xA 5.0 SP2 are: 

• Windows Server 2003 R1 with SP2.
• Windows Server 2003 R2 with SP2.

The following procedures detail how to manually upgrade a Domain Controller 
node. There are three different scenarios:

• Upgrading Domain Controller Node and OS without Formatting Hard Disk.
• Upgrading Domain Controller Node with Compatible OS.
• Upgrading Domain Controller Node by Formatting Hard Disk.

Upgrading Domain Controller Node and OS without Formatting Hard Disk

To upgrade a Domain Controller node and its operating system from Windows 2000 
Server to Windows Server 2003 without disturbing the Active Directory, follow the 
instructions in the following Microsoft KB Article:

http://support.microsoft.com/kb/325379

After upgrading the operating system, perform the following procedure on the 
Domain Controller node:

If using Windows Server 2003 R2 with SP2, unless otherwise specified, do not 
enable any Windows components that are not enabled in the default installation. 

http://support.microsoft.com/kb/325379
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1. Use Add/Remove Programs via Windows Control panel to uninstall 
800xA System software.

2. Install Windows Server 2003 SP2 on Windows Server 2003 nodes. Follow the 
procedures provided by Microsoft to install the Windows Operating System 
service packs.

3. Install Internet Explorer. Follow the procedures provided by Microsoft to 
install Internet Explorer.

4. Disable Internet Explorer Enhanced Security on Windows Server 2003 nodes 
(including the Domain Controller nodes) that are using Internet Explorer 7.0 
(refer to Disable Internet Explorer Enhanced Security on page 346).

5. Disable Windows Firewall.

6. Refer to Third Party Software System 800xA (3BUA000500*) and install 
additional third party software, updates, and service packs for this release 
approved by ABB. This document is accessible from ABB SolutionsBank.

7. Refer to Group Policy Management for Upgrades on page 346 and configure 
the Group Policy Object.

8. Refer to Third Party Software System 800xA (3BUA000500*) and apply 
updates and hot fixes approved by ABB to the existing operating system. This 
document is accessible from ABB SolutionsBank.

9. Refer to System 800xA Manual Installation (3BSE034678*) and install all 
required 800xA System software.

– ABB RNRP.
– ABB Diagnostic Collection Tools.

800xA System software can be identified by items that mention ABB or 800xA in 
Add/Remove Programs.

The System Checker Tool is a standalone tool delivered with the 800xA System. 
It is designed for the purpose of checking, verifying, documenting, and trouble-
shooting an 800xA System, including third party software. The installation and 
use of the System Checker is described in System 800xA Tools 
(2PAA101888R5021). The installation program is accessible from the Manual 
Installation AUTORUN screen via Base Functionalities > Diagnostic Tools > 
System Checker Tool.
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– ABB System Checker Tool.

10. Refer to System 800xA Post Installation (3BUA000156*) and configure 
Windows Firewall.

Upgrading Domain Controller Node with Compatible OS

Perform the following procedure when upgrading a Domain Controller node with a 
compatible operating system (Windows 2003 Server):

1. Disjoin all 800xA System nodes from the Domain Controller by joining them 
to a Windows Workgroup. 

2. Use Add/Remove Programs via Windows Control panel to uninstall 
800xA System software.

3. Install Windows Server 2003 SP2 on Windows Server 2003 nodes. Follow the 
procedures provided by Microsoft to install the Windows Operating System 
service packs.

4. Install Internet Explorer. Follow the procedures provided by Microsoft to 
install Internet Explorer.

5. Disable Internet Explorer Enhanced Security on Windows Server 2003 nodes 
(including the Domain Controller nodes) that are using Internet Explorer 7.0 
(refer to Disable Internet Explorer Enhanced Security on page 346).

6. Disable Windows Firewall.

7. Refer to Third Party Software System 800xA (3BUA000500*) and install 
additional third party software, updates, and service packs for this release 
approved by ABB. This document is accessible from ABB SolutionsBank.

800xA System software can be identified by items that mention ABB or 800xA in 
Add/Remove Programs.

The System Checker Tool is a standalone tool delivered with the 800xA System. 
It is designed for the purpose of checking, verifying, documenting, and trouble-
shooting an 800xA System, including third party software. The installation and 
use of the System Checker is described in System 800xA Tools 
(2PAA101888R5021). The installation program is accessible from the Manual 
Installation AUTORUN screen via Base Functionalities > Diagnostic Tools > 
System Checker Tool.
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8. Refer to Group Policy Management for Upgrades on page 346 and configure 
the Group Policy Object.

9. Refer to Third Party Software System 800xA (3BUA000500*) and apply 
updates and hot fixes approved by ABB to the existing operating system. This 
document is accessible from ABB SolutionsBank.

10. Refer to System 800xA Manual Installation (3BSE034678*) and install all 
required 800xA System software.

– ABB RNRP.
– ABB Diagnostic Collection Tools.
– ABB System Checker Tool.

11. Refer to System 800xA Post Installation (3BUA000156*) and configure 
Windows Firewall.

Upgrading Domain Controller Node by Formatting Hard Disk

Perform the following procedure when upgrading a Domain Controller node by 
formatting the hard disk:

Precautions:

• Disjoin all 800xA System nodes from the Domain Controller by joining them 
to a Windows Workgroup. 

• The IP address of the original domain must be used when configuring the new 
Domain Controller.

• The Domain Name of the original domain must be used when configuring the 
new Domain Controller.

• The User and Group names of the original domain must be used when 
configuring the New Domain controller. 

Perform the procedures detailed under the following topics in Section 2 - 
Prerequisites of System 800xA Manual Installation (3BSE034678*) to create the 
Active Directory:

• Domain Controller and DNS Server.

• Users and Groups.

• Adding Nodes to a Domain.

• Adding 800xA Domain Users to the Local Administrator Group.
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Perform the following procedure after creating the active directory:

1. Install Windows Server 2003 SP2 on Windows Server 2003 nodes. Follow the 
procedures provided by Microsoft to install the Windows Operating System 
service packs.

2. Install Internet Explorer. Follow the procedures provided by Microsoft to 
install Internet Explorer.

3. Disable Internet Explorer Enhanced Security on Windows Server 2003 nodes 
(including the Domain Controller nodes) that are using Internet Explorer 7.0 
(refer to Disable Internet Explorer Enhanced Security on page 346).

4. Disable Windows Firewall.

5. Refer to Third Party Software System 800xA (3BUA000500*) and install 
additional third party software, updates, and service packs for this release 
approved by ABB. This document is accessible from ABB SolutionsBank.

6. Refer to Group Policy Management for Upgrades on page 346 and configure 
the Group Policy Object.

7. Refer to Third Party Software System 800xA (3BUA000500*) and apply 
updates and hot fixes approved by ABB to the existing operating system. This 
document is accessible from ABB SolutionsBank.

8. Refer to System 800xA Manual Installation (3BSE034678*) and install all 
required 800xA System software.

– ABB RNRP.
– ABB Diagnostic Collection Tools.
– ABB System Checker Tool.

Refer to System 800xA Post Installation (3BUA000156*) and configure Windows 
Firewall.

The System Checker Tool is a standalone tool delivered with the 800xA System. 
It is designed for the purpose of checking, verifying, documenting, and trouble-
shooting an 800xA System, including third party software. The installation and 
use of the System Checker is described in System 800xA Tools 
(2PAA101888R5021). The installation program is accessible from the Manual 
Installation AUTORUN screen via Base Functionalities > Diagnostic Tools > 
System Checker Tool.
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800xA System Nodes

The Microsoft Windows Operating Systems supported in 800xA 5.0 SP2 are: 

• Windows XP Professional with SP2.
• Windows Server 2003 R1 with SP2.
• Windows Server 2003 R2 with SP2.

The following rules apply:

• Any existing nodes that do not have one of these operating systems must be 
reformatted and the compatible operating system must be installed.

• All IM (Information Management) and 800xA for AC 870P/Melody Server 
nodes being upgraded must be reformatted and the operating system installed, 
even if the existing operating system is compatible.

• All nodes being upgraded, that are not IM or 800xA for AC 870P/Melody 
Server nodes, with a compatible operating system require that the existing 
operating system be updated.

• If PROFIBUS/HART Device Integration functionality is installed in the 800xA 
System, all nodes being upgraded must be reformatted and the operating 
system installed.

Refer to Upgrade Flow on page 308 for more information.

Existing Operating System

If upgrading using an existing operating system:

Refer to System 800xA System Guide Technical Data and Configuration 
(3BSE041434*) for specific information on what node types can be installed on 
each operating system.

If using Windows Server 2003 R2 with SP2, unless otherwise specified, do not 
enable any Windows components that are not enabled in the default installation. 

The installation will fail unless all Information Management Server, and 800xA 
for AC 870P/Melody Connectivity and Configuration Server nodes being 
upgraded are reformatted and the operating system installed. This is true even if 
the existing operating system is compatible. Refer to New Operating System on 
page 344. 
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1. Close all open Windows.

2. Use Configuration Wizard to disconnect each client from the 800xA System. 
This task is only visible in the Configuration Wizard on a client node when the 
client node is connected to the 800xA System.

a. Launch the Configuration Wizard.

b. Select Disconnect Client and click Next.

c. Choose the 800xA System from which to disconnect the client node and 
click Next.

d. Click Finish. The client node is now disconnected from the 800xA 
System.

3. Use Configuration Wizard from one of the server nodes to stop the 800xA 
System.

a. Launch the Configuration Wizard.

b. Select System Administration and click Next.

c. Select the 800xA System to stop and click Next.

d. Select Systems and click Next.

e. Select Stop in the Systems dialog box and click Next.

f. Click Finish in the Apply Settings dialog box.

4. Exit the Batch Redundancy Status by right-clicking the Batch Redundancy 
Status icon in the Windows tray (P, S, or C) and choosing Exit from the context 
menu (Figure 51).

5. Delete the system on each node.

a. Launch the Configuration Wizard.

Figure 51. Stopping the Batch Redundancy Status
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b. Select System Administration and click Next.

c. Select the 800xA System to delete and click Next.

d. Select Systems and click Next.

e. Select Delete in the Systems dialog box and click Next.

f. Click Finish in the Apply Settings dialog box.

g. Wait a few minutes. When the Configuration Wizard appears with the 
Systems dialog box the deletion of the system is complete.

h. Click Exit.

6. The System Services listed must be stopped at each individual 800xA System 
node. Stop these services in a controlled manner in the following sequence:

– 800xA System Clients.
– 800xA System Connectivity Servers.
– 800xA System Aspect Servers.

a. Use standard Windows procedures, via the Services selection from 
Administrative Tools in Windows Control Panel, to place the following 
services into manual and insure that they are stopped.

–ABB Application logger.
–ABB Client License Provider.
–ABB MMS Server for AC 800M.
–ABB OPC Server for AC 800M.
–ABB ServiceManager.
–ABB System Notification Icon.
–ABB Tool Routing Service for AC 800M.

b. Use the afwkill utility (Figure 52) to make sure all processes related to the 
800xA System are stopped. From the Windows Taskbar select:
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Start > Programs > Accessories > Command Prompt

c. In the Command Prompt window enter afwkill. 

d. The afwkill window should be empty, indicating that all processes are 
stopped. In this case click OK to close. 

If processes are listed in this window, click kill all, then click OK when 
the window indicates all processes are stopped (empty window).

7. Use Add/Remove Programs via Windows Control panel to uninstall 
800xA System and Functional Area software. Remove the application software 
before the base system software.

8. Manually delete the following folder:

...:\Documents and Settings\All Users\Start Menu\
Programs\ABB Industrial IT 800xA\System\Network

Figure 52. Running the afwkill Utility

There may be some 800xA software on nodes (such as 800xA RNRP on the 
Domain Controller node) that does not include Process Portal software. The 
800xA software on these nodes also requires upgrading.

800xA System and Functional Area software can be identified by items that 
mention ABB or 800xA in Add/Remove Programs.
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9. Reboot the workstation after all 800xA System and Functional Area software 
has been removed.

10. Install Windows Server 2003 SP2 on Windows Server 2003 nodes. Follow the 
procedures provided by Microsoft to install the Windows Operating System 
service packs.

11. Install Internet Explorer. Follow the procedures provided by Microsoft to 
install Internet Explorer.

12. Disable Internet Explorer Enhanced Security on Windows Server 2003 nodes 
(including the Domain Controller nodes) that are using Internet Explorer 7.0 
(refer to Disable Internet Explorer Enhanced Security on page 346).

13. Disable Windows Firewall on every node in the 800xA System.

14. Refer to Third Party Software System 800xA (3BUA000500*) and install 
additional third party software, updates, and service packs for this release 
approved by ABB. This document is accessible from ABB SolutionsBank.

15. Refer to Group Policy Management for Upgrades on page 346.

16. Refer to Adding Privileges to the 800xA Service User on page 352.

17. Refer to Third Party Software System 800xA (3BUA000500*) and apply 
updates and hot fixes approved by ABB to the existing operating system. This 
document is accessible from ABB SolutionsBank.

18. Refer to System 800xA Manual Installation (3BSE034678*) and install the 
License Server on the primary Aspect Server node and install the license file.

The System Checker Tool is a standalone tool delivered with the 800xA System. 
It is designed for the purpose of checking, verifying, documenting, and 
troubleshooting an 800xA System, including third party software. The 
installation and use of the System Checker is described in System 800xA Tools 
(2PAA101888R5021). The installation program is accessible from the Manual 
Installation AUTORUN screen via Base Functionalities > Diagnostic Tools > 
System Checker Tool.
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19. Refer to System 800xA Manual Installation (3BSE034678*) and install all 
required 800xA System software. 

20. Refer to Setting the PAS and IM Service Account and Password on page 353 
and perform that procedure before performing the 800xA System restore.

21. Refer to 800xA System Restore (Upgrade Flow C) on page 353 of this 
instruction and perform all necessary steps.

22. Perform all steps that pertain to the installed applications from 800xA 
Documentation Maintenance on page 358 through the remainder of this section 
in the order presented.

23. Refer to System 800xA Post Installation (3BUA000156*) and configure 
Windows Services and Windows Firewall.

24. Refer to Backups on page 313 and perform precautionary backups.

New Operating System

If upgrading using a new operating system:

1. Reformat the drive.

2. Refer to System 800xA Manual Installation (3BSE034678*) and install the new 
operating system.

3. Install Windows Server 2003 SP2 on Windows Server 2003 nodes. Follow the 
procedures provided by Microsoft to install the Windows Operating System 
service packs.

4. Install Internet Explorer. Follow the procedures provided by Microsoft to 
install Internet Explorer.

If Production Management - Batch Management software is being installed, 
initialize the Batch database during installation of the Production Management - 
Batch Management software.

If formatting the Domain Controller node, disconnect all 800xA System nodes 
from the Domain by joining them to a Windows workgroup before formatting the 
Domain Controller node.

There may be some 800xA software on nodes (such as 800xA RNRP on the 
Domain Controller node) that does not include Process Portal software. The 
operating system and 800xA software on these nodes also requires upgrading.
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5. Disable Internet Explorer Enhanced Security on Windows Server 2003 nodes 
(including the Domain Controller nodes) that are using Internet Explorer 7.0 
(refer to Disable Internet Explorer Enhanced Security on page 346).

6. Disable Windows Firewall on every node in the 800xA System.

7.Refer to Third Party Software System 800xA (3BUA000500*) and install 
additional third party software, updates, and service packs for this release 
approved by ABB. This document is accessible from ABB SolutionsBank.

8. Refer to Group Policy Management for Upgrades on page 346.

9. Refer to Adding Privileges to the 800xA Service User on page 352.

10. Refer to Third Party Software System 800xA (3BUA000500*) and apply 
updates and hot fixes approved by ABB to the existing operating system. This 
document is accessible from ABB SolutionsBank.

11. Refer to System 800xA Manual Installation (3BSE034678*) and install the 
License Server on the primary Aspect Server node and install the license file.

12. Refer to System 800xA Manual Installation (3BSE034678*) and install all 
required 800xA System software. 

13. Refer to Setting the PAS and IM Service Account and Password on page 353 
and perform that procedure before performing the 800xA System restore.

14. Refer to 800xA System Restore (Upgrade Flow C) on page 353 of this 
instruction and perform all necessary steps.

15. Perform all steps that pertain to the installed applications from 800xA 
Documentation Maintenance on page 358 through the remainder of this section 
in the order presented.

16. Refer to System 800xA Post Installation (3BUA000156*) and configure 
Windows Services and Windows Firewall.

The System Checker Tool is a standalone tool delivered with the 800xA System. 
It is designed for the purpose of checking, verifying, documenting, and 
troubleshooting an 800xA System, including third party software. The 
installation and use of the System Checker is described in System 800xA Tools 
(2PAA101888R5021). The installation program is accessible from the Manual 
Installation AUTORUN screen via Base Functionalities > Diagnostic Tools > 
System Checker Tool.
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17. Refer to Backups on page 313 and perform precautionary backups.

Disable Internet Explorer Enhanced Security

The Internet Explorer Enhanced Security component must be disabled on all 
Windows Server 2003 with SP2 nodes in the 800xA System that are using Internet 
Explorer 7.0.

1. Select:

Start > Control Panel

2. Double-click Add/Remove Programs to launch the Add or Remove Programs 
utility.

3. Click Add/Remove Windows Components to open the Windows 
Components Wizard.

4. In the Components list, disable the Internet Explorer Enhanced Security 
Configuration check box.

5. Click Next and then Finish.

Group Policy Management for Upgrades
The procedures differ depending on the environment (domain or Windows 
Workgroup).

Domain Environment

When upgrading from 800xA 3.1 SP3 to 800xA 5.0 SP2, it is necessary to add the 
800xA 5.0 SP2 Group Policy on the Domain Controller node. It is also necessary to 

This procedure only applies to Windows Server 2003 installations using Internet 
Explorer 7.0.

Windows Server 2003 with SP2 and Internet Explorer 7.0 must be installed prior 
to performing the following procedure.

Perform this procedure before installing 800xA System and Functional Area 
software.
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run a command on every other 800xA System node to force the new Group Policy 
Object from the Domain Controller down to each node.

Domain Controller Node

1. Insert 800xA System Installation DVD 1 into the drive.

2. Use Windows Explorer to locate gpmc.msi in the following directory:

3rd_Party_SW\Microsoft

3. Double-click gpmc.msi to install the Group Policy Management Console 
with SP2. Follow the instructions in the Installation Wizard to complete the 
installation.

4. When the Group Management Console with SP 1 installation is complete, from 
the Windows Taskbar, select:

Start > Run

5. Enter dsa.msc in the Run dialog box and click OK to open the Active 
Directory Users and Computers dialog box.

6. In the left pane of the Active Directory Users and Computers dialog box, right-
click the domain name and select Properties from the context menu to open 
the Domain Properties dialog box.

7. Select the Group Policy tab in the Domain Properties dialog box.

8. Click Open to open the Group Policy Management Console.

9. In the left pane of the Group Policy Management Console, right-click the 
domain name and select Create and Link a GPO Here... from the context 
menu to open the New GPO dialog box.

10. Type in a name for the new Group Policy Object in the New GPO dialog box; 
for example, IntranetName and click OK to return to the Group Policy 
Management Console.

11. In the right pane of the Group Policy Management Console, right-click on the 
new Group Policy Object and select Edit from the context menu to open the 
Group Policy Object Editor. 

Do not modify the default Group Policy Object itself. Create, link and modify a 
new Group Policy Object.
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12. In the left pane of the Group Policy Object Editor, navigate to:

User Configuration > Windows Settings > Internet Explorer 
Maintenance > Security

13. In the right pane of the Group Policy Object Editor, double-click:

Security Zones and Content Ratings

to open the Security Zones and Content Ratings dialog box (Figure 53).

14. Select Import the current security zones and privacy settings in the Security 
Zones and Privacy frame. Since Internet Explorer Enhanced Security was 
disabled under Disable Internet Explorer Enhanced Security on page 346, 

Figure 53. Security Zones and Content Ratings Dialog Box
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making this selection will open the Internet Explorer Enhanced Security 
Configuration dialog box shown in Figure 54.

15. Click Continue in the Internet Explorer Enhanced Security Configuration 
dialog box to close the dialog box and return to the Security Zones and Content 
Ratings dialog box (Figure 53).

16. Click Modify Settings in the Security Zones and Content Ratings dialog box to 
open the Internet Properties dialog box.

17. Click the Security tab.

18. Select the Local Intranet icon.

Figure 54. Internet Explorer Enhanced Security Configuration Dialog Box
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19. Click Sites to open the Local Intranet dialog box (Figure 55).

20. Disable the Automatically detect intranet network check box.

21. Select the Include all local (intranet) sites not listed in other zones check 
box.

22. Verify that all other check boxes are disabled.

23. Click OK three times to close all open dialog boxes.

24. Close the Group Policy Object Editor.

25. Reboot the node.

26. Return to Adding Privileges to the 800xA Service User on page 352.

All Other 800xA System Nodes

1. From the Windows Taskbar, select:

Start > Run

2. Enter gpupdate /force in the Run dialog box and click OK. This forces the 
new Group Policy Object from the Domain Controller down to this node.

Figure 55. Local Intranet Dialog Box
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3. Return to Adding Privileges to the 800xA Service User on page 352.

Windows Workgroup Environment

This procedure must be performed on every node in the Windows Workgroup. If the 
system is expanded at a later time, this procedure must be performed on each node 
added during the expansion.

1. From the Windows Taskbar, select:

Start > Run

2. Enter gpedit.msc in the Run dialog box and click OK to open the Group 
Policy Object Editor.

3. In the left pane of the Group Policy Object Editor, navigate to:

User Configuration > Windows Settings > Internet Explorer 
Maintenance > Security

4. In the right pane of the Group Policy Object Editor, double-click:

Security Zones and Content Ratings

to open the Security Zones and Content Ratings dialog box (Figure 53).

5. Select Import the current security zones and privacy settings in the Security 
Zones and Privacy frame. Since Internet Explorer Enhanced Security was 
disabled under Disable Internet Explorer Enhanced Security on page 346, 
making this selection will open the Internet Explorer Enhanced Security 
Configuration dialog box shown in Figure 54.

6. Click Continue in the Internet Explorer Enhanced Security Configuration 
dialog box to close the dialog box and return to the Security Zones and Content 
Ratings dialog box (Figure 53).

7. Click Modify Settings in the Security Zones and Content Ratings dialog box to 
open the Internet Properties dialog box.

If the system is expanded at a later time, this procedure must be performed on 
each node added during the expansion.

Perform this procedure before installing 800xA System and Functional Area 
software.
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8. Click the Security tab.

9. Select the Local Intranet icon.

10. Click Sites to open the Local Intranet dialog box (Figure 55).

11. Disable the Automatically detect intranet network check box.

12. Select the Include all local (intranet) sites not listed in other zones check 
box.

13. Verify that all other check boxes are disabled.

14. Click OK three times to close all open dialog boxes.

15. Close the Group Policy Object Editor.

16. Reboot the node.

17. Return to Adding Privileges to the 800xA Service User on page 352.

Adding Privileges to the 800xA Service User
This procedure only applies to the following node types. If these node types are not 
present in the system this procedure can be skipped.
• 800xA for AC 870P/Melody Configuration Server nodes.
• 800xA for AC 870P/Melody Connectivity Server nodes.
• AO Server nodes for Asset Optimization.

There are some services that run under the 800xA Service User account for the 
listed node types. Perform the following procedure to add the proper privileges to 
the 800xA Service User account.

1. Log off the 800xA Installing User account.

2. Log on the 800xA Service User account.

3. Log off the 800xA Service User account.

4. Log on the 800xA Installing User account.
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Setting the PAS and IM Service Account and Password
This procedure is only necessary if Information Management is installed in the 
800xA System.

The PAS and Information Management (IM) service account and password must be 
set, via the Information Management Configuration Assistant, before performing 
the 800xA System restore.

1. To launch the configuration assistant, select:

Start > All Programs > ABB Industrial IT 800xA >
Information Mgmt > Configuration Assistant

2. Select the first row, Item 1.0 Set PAS and IM Service Account and 
Password and click Run Selected Configuration Tool.

3. Perform the indicated actions and click Close in the Information Management 
Configuration Assistant.

800xA System Restore (Upgrade Flow C)

The backup/restore utility supports the restoring of 800xA system information. The 
following steps outline the 800xA system restore procedure.

Close the Information Management Configuration Assistant after performing 
Item 1.0 Set PAS and IM Service Account and Password. The rest 
of the configuration steps will be performed during post installation procedures 
after completing the software upgrade.

The User Account that is used for 800xA System restore via the Configuration 
Wizard must be a member of the following groups:
• IndustrialITUser.

• IndustrialITAdmin.

• Local Administrators.

Click Yes if during restore a message box appears stating:

A required system extension is not installed Name : 
System_Instruction

Refer to System 800xA Maintenance (3BSE046784*) for more information on 
restoring the system.
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800xA System Restore Procedure

Perform the following procedure to use the 800xA System Restore function on the 
Primary Aspect Server node.

1. Start the restore procedure.

a. Select:

Start > All Programs > ABB Industrial IT 800xA > System > 
Configuration Wizard

b. The Select Type of Configuration dialog box appears. Select Restore 
System and click Next.

2. Check for messages in the log file (select the View Log check box in the 
Configuration Wizard). Refer to Appendix A, Warning and Error Messages to 
resolve any received warning or error messages.

3. Check the CPU load in the workstation. The System Message service may 
generate a high load (>90%). If this continues for longer than approximately 
10 minutes, restart the service.

4. One node at a time, start up all nodes again and connect them to the 800xA 
system in the following order:

– Aspect Server nodes.
– Connectivity Server nodes.
– Application Server nodes.
– Client nodes.

a. Use the following guidelines while connecting nodes, using the 
Configuration Wizard. This must be performed on the node that is going to 
be connected, not on the node on which the restore was performed.

b. If the node is an IM Server, verify that the ABB Process Administration 
Service (PAS) is set to manual in the Services Control Panel (run 
Services.msc from the Run dialog box). Stop the service if it is running.

Restart the node when advised during the restore procedure.

If a message stating that a full deploy of the Generic Control Network is needed, 
click OK.
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c. Select Connect Node from the Select Type of Configuration dialog box.

d. Select the Primary Aspect Server (the server on which the system will run) 
in the Connect to another System on Node drop down-list box, in the 
Connect to System dialog box.

e. Set the current system as the default system when connecting nodes to the 
system.

– In some cases, problems may be encountered when connecting nodes to 
the system. Verify that the system software user settings are correct using 
the Configuration Wizard. Restarting the node again may also solve the 
problem.

– Wait until all services in the newly connected node are up and running 
before connecting the next node. Select the Node Administration 
Structure\connected_node_name\System Status Viewer aspect to monitor 
the status of services. If some services will not start up, restarting the node 
may help.

f. Restart each node after it has been connected to the system.

5. Record the number of aspects and objects in the system and compare these 
values to those recorded when the system was backed up. 

a. Select the Admin Structure\Adminstrative 
Objects\Domains\system_name, Domain\Domain Definition 
aspect.

b. Record the number of objects and aspects listed in the System Size 
Information area of the window.

c. Right-click the Control Structure\control_network_name, 
Control Network\Control Structure aspect of one of the control 
networks contained in the system.

Do not include services that were stopped manually as part of the pre-upgrade 
procedures. These will be manually restarted later in the post upgrade procedures.

Run the System Software User Settings until OK. Restart if it is not working and 
if the message:

Invalid User

appears.
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d. Select Properties on the context menu.

e. Select the Statistics tab.

f. Record the number of objects listed.

g. Right-click the Control Structure aspect within a controller project of the 
control network selected in Step c.

h. Select Properties on the context menu.

i. Record the number of objects listed.

j. Repeat Step g through Step i for all the controller projects within the 
control network.

k. Repeat Step c through Step j for every control network in the system. 

l. Right-click the Control Structure\HSE_Subnet name, HSE Subnet\Control 
Structure aspect of one of the HSE Subnets contained in the system.

m. Select Properties from the context menu.

n. Select the Statistics tab.

o. Record the number of objects listed.

p. Repeat Step l through Step o for every HSE Subnet in the system.

q. Right-click the Control Structure\MB300_name, MB300 
Network\Control Structure aspect of one of the MB300 Networks 
contained in the system.

r. Select Properties from the context menu.

s. Select the Statistics tab.

t. Record the number of objects listed.

u. Repeat Step q through Step t for every MB300 network in the system.

The number of aspects and objects after system restoration should be in the same 
range as those recorded during system backup, although there will likely be more.

The number of aspects and objects after system restoration should be in the same 
range as those recorded during system backup, although there will likely be more.
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IT Control Connection Items in Log Configuration Aspects

The Process Portal log will display the following error message after completing the 
800xA System Restore if there are IT Control Connection items in the Log 
Configuration aspect.

E_ADV_HT_NO_LOG (ox8abb1c19)No Log

This error occurs because the IT Control Connection aspects are recreated during 
the 800xA System Restore process.

Perform the following procedure to resolve the error:

1. Navigate to and locate AfwConsistencyCheck.exe in the following 
directory on the installation drive:

\Program Files\ABB Industrial IT\Operate IT\Process 
Portal A\bin

2. Double-click AfwConsistencyCheck.exe to launch the Consistency Check 
Tool.

3. Click Add Item to open the Select Item dialog box.

4. Select the Log Configuration aspects with the error message.

5. Click Add and then Close.

6. Click Check in the Consistency Check dialog box to perform the consistency 
check.

7. Select the row or rows with Repairable error messages (look in the 
Repairable column).

8. Right-click and select Repair Aspect from the context menu. 

9. Click Yes in the Repair dialog box. The consistency check will repair the 
problem and update the Consistency Report.

10. Click the Check button again to perform a new consistency check.

11. Verify the Log Configuration aspect in the Plant Explorer Workplace.

Other warnings may appear during system upgrade. These warnings can be 
ignored.
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Consistency Check

Refer to Appendix D, Consistency Check and perform the necessary consistency 
checks.

800xA Documentation Maintenance
Delete all documentation aspects (denoted by an open book icon) with a category 
name of Application Manual, Operating Manual, Installation Manual, or Technical 
Reference Manual found in the Product Type Structure.

The System Instructions system extension must be removed (unregistered). To 
unregister the System Instructions system extension from the 800xA system:

1. Use Windows Explorer to navigate to:

...:\Program File\ABB Industrial IT\Operate IT\Process 
Portal A\bin

2. Double-click AfwRemoveSystemInstructions.exe to execute the 
program.

Base System Considerations
There are considerations that must be taken into account with respect to alarms and 
events when working with the 800xA 5.0 SP2 System. It is important to read and 
understand the information about Alarm Categories in System 800xA Administration 
and Security (3BSE037410*).

Connections between Alarm List and Alarm and Event OPC Server

This connection is valid only for upgrading of Alarms and Events.

If any customer-specific documentation aspects have been added, it is necessary 
to browse through the Product Type Structure and delete the 800xA 
documentation aspects individually so that customer-specific documentation will 
not be accidentally deleted.

Use the Find Tool in the Plant Explorer Workplace to find the documentation 
aspects.
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800xA 3.1 SP3 has one layer between the clients (e.g. an alarm list) and the OPC 
Alarm and Event Server that provides the alarms. This layer is realized by the Alarm 
and Event Service, as shown in Figure 56.

800xA 5.0 SP2 has two layers, realized by the Alarm Manager which is on top of 
the Event Collector as shown in Figure 57.

T05252B

Figure 56. Alarm and Event Service Layer for 800xA 3.1 SP3

Figure 57. Alarm Manager and Event Collector Layers for 800xA 5.0 SP2
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Automatic Configuration

The object tree below the Alarm and Event Service is recreated below the Event 
Collector Service. The required library objects are also created.

The Alarm Manager Service is automatically configured. Some manual 
configuration is also required.

Manual Configuration

Manual configuration consists of several actions.

Configure the Event Collector Service

Manual configuration is required for Event Collectors connected to Connectivity 
Servers (such as, but not limited to, AC 800M).

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Use the Object Browser to navigate to:

Services > Event Collector, Service Group

and expand the tree.

4. Select a Service Group for a Connectivity Server.

5. Select Service Group Definition in the Aspect List Area.

6. Select the Special Configuration tab in the Preview Area.

7. Check to see if the item in the Collection Definition drop-down list box is the 
the new one that is to be used with 800xA 5.0 SP2. (The name should not end 
with (SV3)).

8. If the Collection Definition is not the new one that is to be used with 800xA 5.0 
SP2, change the value so that it is and click Apply.

9. Select the Configuration tab.

10. Clear the Enabled check box and click Apply.

11. Select the Enabled check box and click Apply. This will restart the Service 
Group.
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12. Repeat this procedure for all Connectivity Server Service Groups.

Organize the Library Objects

The upgrade code creates one library object per Alarm and Event Service Group 
that was found in the backup. The library objects are located below the Alarm 
Collection Definitions object in Library Structure. The intention, however, is that 
there should be one library object per OPC Alarm and Event Server type that exists 
in the system, because the library object describes the capabilities of an OPC Alarm 
and Event Server. All groups working towards a specific OPC Alarm and Event 
Server type can share one library object.

After an upgrade, the structure should be organized so that it complies with this 
intention. Do not forget to update the settings that refer to the library object in the 
Event Collector Service Groups, in the Special Configuration tab of the Service 
Group Definition aspect.

Check the Alarm Manager Service Configuration

In 800xA 3.1 SP3, it is possible to have a number of Alarm and Event Service 
groups, all with individual configurations. In 800xA 5.0 SP2, these groups are 
replaced with one group. Consequently, the individual configurations are replaced 
with one configuration. This common configuration is automatically generated from 
the individual configurations and should be checked, because:

• There are one or more new parameters that should be configured.

• Backed up data may be ambiguous. One Alarm and Event Service group might 
have another configuration than another group in the backed up system.

• Modifications might need to be made.
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The configuration is found in the Special Configuration tab of the Service Group 
Definition aspect of the Alarm Manager Service group (Figure 58).

Add Redundancy For Alarm Manager

The upgrade creates one service provider for the Alarm Manager, configured to 
execute in the node in which the upgrade takes place. If the backed up system had 
redundant Aspect Servers, it is recommended to add service providers for the Alarm 
Manager according to the same configuration as for other services that execute in 
Aspect Servers. However, this should be done after the server nodes have been 
connected to the system.

TC07437B

Figure 58. Service Group Definition Aspect (Special Configuration Tab)
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Restoring Application and Historical Data
The remainder of this section describes how to restore historical data and the 
necessary data for each Functional Area.

Device Management and Fieldbuses

After installation of 800xA 5.0 SP2 software all third party software for Device 
Type Objects used in the previous system version must be reinstalled. Additionally 
PROFIBUS Device Type Objects used in the Control Builder M project must be 
adapted to new delivered Hardware Libraries. Check that all licenses are valid for 
the restore, even for third party devices.

Restore Fieldbus Device Types

The following steps for Fieldbus Device Types need to be carried out on every 
800xA system node. Perform the System Restore Wizard procedure on the nodes in 
the following sequence:

• Aspect Servers (including redundant Aspect Servers).
• Connectivity Servers (including redundant Connectivity Servers).
• Application Servers.
• Clients.

1. Start the Device Library Wizard. Select:

If the system contains Fieldbus devices, the Restore Device Types procedures 
must be performed before restoring the Control Builder M project or the upgrade 
will fail. The Control Builder M upgrade can be done only once.

Restore the Device Types on the Primary Aspect Server node before starting to 
install them on other system nodes. Do not run parallel installations of Device 
Types on other system nodes unless all Device Types are restored on the Primary 
Aspect Server node. Installation of Device Types on other system nodes can be 
done in parallel after they are restored on the Primary Aspect Server node.

The procedures in the System Restore Wizard function in the Device Library 
Wizard must be performed for Fieldbus Device Types before restoring the 
Control Builder M project, otherwise the upgrade will fail. The Control 
Builder M upgrade can only be performed once.
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Start > All Programs > ABB Industrial IT 800xA > Device Mgmt > 
Device Library Wizard

-or-

double-click the Device Library Wizard icon on the desktop.

2. Navigate to:

Device Type Administration > System Restore Wizard

and choose the first option in the System Restore Wizard as shown in Figure 59 
and click Next.

Figure 59. System Restore Wizard (1)
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3. Choose whether or not this system node has been reformatted as shown in 
Figure 60 and click Next.

4. Depending on which fieldbus protocol is used in the previous system version 
environment, insert one of the delivered Device Library system DVDs in the 
DVD drive (e.g. Device Library HART – DVD).

5. Click Browse and navigate to the DVD drive.

6. When the drive has been selected in the Browse for folder dialog box, click OK 
in that dialog box and then Next in the ABB Device Library Wizard.

7. The Device Library Wizard scans the 800xA System for fieldbus device types 
that are already used and compares the results with the contents of the DVD. 

Figure 60. System Restore Wizard (2)

If the system node has not been reformatted (second option), the following steps 
are not necessary when PROFIBUS Device Types are not present in the system 
node. In this case, the Device Library Wizard will perform an update of Fieldbus 
Device Types (refer to Update Fieldbus Device Types on page 367).
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Device Types available in the 800xA System and the DVD are shown in the 
Extract tab of the Device Library Wizard (Figure 61).

8. Click Next to start the extraction process.

9. Device Types available in the 800xA System but not on the DVD are displayed 
in the Missing tab. If there are any Device Types showing in the Missing tab, 
Next in the Device Library Wizard is disabled. Navigate to the Browse dialog 
box by clicking Back and inserting a new Device Library DVD in the DVD 
drive. 

10. Repeat this procedure until all Device Types are extracted to the 800xA System 
node and the Missing tab does not list any device types.

11. If the Device Library DVDs do not contain all Device Types used in the 
previous system version, the missing Device Types must be downloaded from 
ABB SolutionsBank.

Figure 61. Extract Device Type Files

It is only possible to complete the Wizard if all Device Types have been 
successfully extracted.
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12. When the extraction process is completed successfully, the Device Types need 
to be re-installed on the 800xA System node. Click Next to launch the Re-
installation of Device Types dialog box shown in Figure 62.

13. Follow the Device Library Wizard procedure to complete the installation. The 
Device Library Wizard will automatically navigate to the main window after 
the process is completed.

14. Exit the Device Library Wizard and repeat the procedure on the other 800xA 
System nodes, if applicable.

Figure 62. Re-install Device Types Dialog Box
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Update Fieldbus Device Types

If the system node has not been reformatted (second option in Figure 60), all Device 
Types that exist in the 800xA System node and need updated are displayed in the 
Update tab (Figure 63).

1. Click Next to launch the update.

2. The Selection Summary dialog box will appear showing the Device Types to be 
updated. Click Next to continue.

3. Follow the Device Library Wizard procedure to complete the installation. The 
Device Library Wizard will automatically navigate to the main window after 
the process is completed.

Device Management FOUNDATION Fieldbus

Perform the following to complete upgrading Device Management FOUNDATION 
Fieldbus.

1. Return to the Plant Explorer Workplace and select FF Upload in the Aspect 
List Area.

Figure 63. Update of Device Types Dialog Box
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2. Check, Save, and Upload FF Libraries:

a. Open a Plant Explorer Workplace.

b. Use the Structure Selector to open the Object Type Structure.

c. Use the Object Browser to navigate to:

FF Libraries Object Type Group

d. Select FF Upload in the Aspect List Area.

e. Click Open Library in Fieldbus Builder FF.

f. Right-click FF H1 Device Library in the Libraries dialog box of the 
Fieldbus Builder FF.

g. In the Parameter dialog box, click Reload Standard Dictionary and 
browse to the following directory:

h. ...\Fieldbus Builder FF\ff

i. Select STANDARD.DCT and click Open and then OK.

j. Check the libraries for plausibility and store them in Fieldbus Builder FF.

k. Exit Fieldbus Builder FF.

l. Return to the Plant Explorer Workplace and select FF Management in the 
Aspect List Area.

m. Click Upload.

n. After a successful upload, the green traffic light symbol indicates that the 
FF libraries have been synchronized.

3. Optional: Reconstruct User-made Changes to Library Objects representing FF 
Standard Blocks: 

During upgrade, user-made changes to library objects representing FF 
standard blocks have been overwritten. Important substitutions have been 
logged.

a. If such changes were made, display the substitutions as follows:

– Open a Plant Explorer Workplace.

– Use the Structure Selector to open the Object Type Structure.

This step is only required if changes were made to library objects representing FF 
standard blocks.
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– Use the Object Browser to navigate to:

FF Libraries Object Type Group

– Select FF Management in the Aspect List Area.

– Select Library Merge Logger tab and read log.

b. For reconstructing user-made changes, reapply the changes to the library 
objects manually.

4. Check, Save, Commission, and Upload the HSE Subnet.

a. Open a Plant Explorer Workplace.

b. Use the Structure Selector to open the Control Structure.

c. Use the Object Browser to navigate to:

HSE Subnet

d. Select FF Management in the Aspect List Area.

e. Click Open Subnet in Fieldbus Builder FF.

f. Check to see if the configured HSE subnet ID is used for the OPC Server 
FF configuration in FF Network > Properties and modify it if required.

g. Check whole project for plausibility and save the configuration in 
Fieldbus Builder FF.

h. Perform device assignment for all linking devices LD 800HSE.

i. Perform precommissioning/commissioning for all objects for which this is 
necessary (discernible from engineering status).

j. Exit Fieldbus Builder FF and save changes if prompted to do so.

k. Return to the Plant Explorer Workplace and select FF Upload in the 
Aspect List Area.

Perform the following procedure for each HSE Subnet.

To assign all H1 devices in one step, use the Assign all devices function from the 
HSE Subnet context menu: Object > Assign all devices...

For downloading use the online dialog from the HSE Subnet context menu: 
Object > Online Dialog...
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l. The green traffic light symbol indicates that the HSE Subnet has been 
synchronized.

800xA for AC 800M

There may be Control Builder M compatibility issues when upgrading from 
800xA 3.1 SP3 to 800xA 5.0 SP2. Review the issues detailed in 800xA 3.1 SP3 to 
800xA 5.0 SP2 Compatibility Issues on page 425 before proceeding

Use the following procedure to restore 800xA for AC 800M information:

1. Configure the memory setting for OPC Server and Control Builder (found in 
the Setup Wizard for each product) to the saved and recorded values.

2. Control Builder stores its settings (systemsetup.sys) on disk in the following 
directory:

...\ABB Industrial IT Data\Engineer IT Data\Control 
Builder M Professional

Copy the previously saved file from the safe media to this folder.

3. New handling for Hardware Types was introduced in 800xA 5.0. All hardware 
types are now packaged in libraries. Because of this all Control Builder 
projects must be upgraded according to the following steps. 

a. Start an empty Control Builder M . 

b. Select:

Tools > Maintenance > Upgrade Project > from Control Builder 
Professional 3.4 or later

After upgrading a configuration containing one Engineering and one Production 
system to 800xA 5.0 SP2, the Control Builder M projects in the two systems 
should be made identical using the Import/Export tool, Engineering Repository, 
or by recreating the Engineering System using Backup/Restore before 
engineering work is restarted. Otherwise there will be a lot of false differences on 
the AC 800M aspects reported in the import difference report when moving 
solutions between the systems.

If the application contains FOUNDATION Fieldbus, HART, or PROFIBUS 
specific configurations, perform post upgrade procedures for Device Types via 
the Device Library Wizard (refer to Device Management and Fieldbuses on page 
363) before upgrading the project in Control Builder M.
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c. Select the Control Builder project to upgrade. This step will take a while. 
All hardware objects in the Control Structure are redirected by Control 
Builder to use hardware types from libraries. If the project contained 
custom hardware definition files, libraries with corresponding hardware 
types are automatically created by Control Builder.

d. Repeat Step a through Step c for all Control Builder projects in the 
system.

e. When all Control Builder Projects are upgraded the old hardware types 
should be deleted from the Object Type Structure.

In the Plant Explorer Workplace, navigate to the Object Type Structure 
and browse to:

Object Types > Control System > AC800M/C Connect - Controller 
Hardware

Right-click the Controller Hardware object and select Delete.

4. Modify the application program according to applicable issues in 800xA 3.1 
SP3 to 800xA 5.0 SP2 Compatibility Issues on page 425.

5. Load the controllers with their firmware and applications. Change Analysis 
Mismatches may be shown for objects in the Standard Libraries during the first 
download after the upgrade. Possible mismatches are:

Mismatch: Variable has changed data type.
Mismatch: Variable not found.
Mismatch: Control Module not found.

The mismatches reflect internal changes in the Standard Libraries. No Cold 
Retain Values will be lost. Click Next Mismatch to continue.

6. The OPC Server stores configuration files (*.cfg) and settings 
(systemsetup.sys) on disk. Add the files saved on the safe media to the system. 
The systemsetup.sys file is located in:

...\ABB Industrial IT Data\Control IT Data\OPC Server 
for AC 800M

The configuration files are stored in the Files folder in the same location.
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7. Restore OPC configurations by selecting File > Load Configuration in the 
OPC Server Panel.

800xA for Advant Master and 800xA for Safeguard 

Perform the following on each Connectivity Server node:

1. Copy the saved files:

– DATHR1.CD
– DATHR2.CD
– DATHR3.CD

to the folder:

...\Program Files\ABB Industrial IT\OperateIT\AC 400 
Connect\AdvantBase\Data\RTA\Init\

to the node where they belong.

2. Update the Configuration Files.

For each Connectivity Server, compare the following files saved in a safe 
location during the 800xA for Advant Master pre upgrade phase:

– AdvDsMasterAdapter.csv

– AdvMbAeOPCServer.csv

with the installed version of the files at the following location:

For 64-bit:

...\Program Files (x86)\ABB Industrial IT\Operate IT\AC 
400 Connect\Bin

For 32-bit:

...\Program Files\ABB Industrial IT\Operate IT\AC 400 
Connect\Bin

If any customization was done to the old files, update the installed version of 
the files with the corresponding changes.

Remember to enable autoloading of the configuration and provide the correct 
path to the file.
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3. Open the MB 300 RTA Settings dialog box in Configuration Wizard and 
reconfigure:

– MB 300 Node and Network Numbers.

– Check 800xA as Clock Master in case the time synchronization key 
REVERSED_SYNC_MODE was enabled before.

4. Always Restart the RTA board.

5. The Audible property must be 0 for events and 1 for alarms 800xA for Advant 
Master version 4.1 SP1 RU6 and newer. Refer to System 800xA Configuration 
(3BDS011222*) for configuration of audible alarms.

Safeguard standardevent 300 - 326 does not comply with this rule before 
800xA for 800xA for Advant Master Version 5.0 SP2. The Event numbers 
where the Audible property should be changed from 1 to 0 are:

– EVENT302.
– EVENT305.
– EVENT310.
– EVENT312.
– EVENT320.
– EVENT321.
– EVENT322.
– EVENT325.

PLC Connect

Perform the following post upgrade procedures for PLC Connect.

Modify Installation for IEC60870 or Basic Project Objects

If either the IEC60870 or Basic Project Objects features were installed:

1. Use standard Windows procedures to access Add/Remove Programs in 
Windows Control Panel. 

2. Select ABB PLC Connect. 

3. Select Change/Modify.

4. The InstallShield Wizard for PLC Connect appears. Refer to System 800xA 
Manual Installation (3BSE034678*) to select and install the desired features.
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5. If the IEC60870 feature is installed refer to System 800xA PLC Connect 
Configuration (3BSE035041*) and reload the saved IEC configuration.

Restoring PreTreat2.dll

To restore PreTreat2.dll:

1. If the PLC Connect Communication Server Pre Treatment function is being 
used in the application, copy PreTreat2.dll from the backup location to the 
same folder as it was backed up from on the PLC Connect Connectivity Server. 
If the default folder is used, that location is:

...\ABB Industrial IT\Operate IT\PLC Connect\Bin

2. Register the PreTreat2.dll file (refer to System 800xA PLC Connect 
Configuration (3BSE035041*) for more information). 

3. Restart the PLC Connect Connectivity Server for the changes to take effect.

4. Restore the VB project for PreTreat2.dll.

Restoring PreEvent.dll

To restore PreEvent.dll:

1. If the PLC Connect Event Server Pre Treatment function is being used in the 
application, copy PreEvent.dll from the backup location to the same folder 
as it was backed up from on the PLC Connect Connectivity Server. If the 
default folder is used, that location is:

...\ABB Industrial IT\Operate IT\PLC Connect\Bin

2. Register the PreEvent.dll file (refer to System 800xA PLC Connect 
Configuration (3BSE035041*) for more information). 

3. Restart the PLC Connect Connectivity Server for the changes to take effect.

4. Restore the VB application project for PreEvent.dll.

Redeploy the PLC Connect Configuration

To redeploy the PLC Connect configuration:

1. Use the Structure Selector to open the Control Structure in the Plant Explorer 
Workplace.
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2. Use the Object Browser to navigate to the first Generic Control Network 
object.

3. Select Deploy in the Aspect List Area.

4. Press the SHIFT key and click Deploy in the Preview Area to ensure that a full 
deploy is done. 

5. The deploy begins and the progress is displayed in the Preview Area. The 
deploy is completed when Deploy ended is displayed.

6. Repeat the procedure for any additional Generic Control Network objects.

Engineering Studio

Post upgrade procedures for Engineering Studio include those for IO Allocation, 
Engineering Templates, and Function Designer.

IO Allocation

800xA 5.0 SP2 supports merging of Hart devices and IO signals within one object. 
If Hart devices and IO signals will be merged into one object refer to Industrial IT, 
800xA - Engineering, Engineering Workplace, Basic Engineering Functions 
(3BDS011223*). 

IO Allocation has enabled new properties (e.g. Inverted) to be accessible for 
CBM_SignalParameter/CBM_PulseSignalParameter. These properties are 

Before working with the IO Allocation function in an upgraded system, check all 
Control Builder Name aspects of CBM_Signal instances to see if they contain a 
valid name.

All Control Builder Name aspects having an empty name or a name not 
introduced by synchronization from the Name aspect must be corrected 
accordingly. This can be performed using a Bulk Data Manager worksheet that 
reads out Name and Control Builder Name. The same worksheet can be used to 
write back the Name.

The following procedure is only required if HART devices and IO signals will be 
merged into one object.

The following procedure is only required when working with IO Allocation and if 
properties of IO boards have been changed directly in Control Builder M.
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initialized with a default value. If properties have been changed directly in the 
Hardware Editor of Control Builder M (as they were not supported by IO 
Allocation) these changes are not reflected in 
CBM_SignalParameter/CBM_PulseSignalParameter aspects after the upgrade. 
Therefore, when the menu write Allocation into CBM is performed, values may be 
overwritten with their default value. After upgrading, select controller by controller 
and perform the menu Read Allocation from CBM, which reads the property 
values from Control Builder M and updates the signal objects. 

Engineering Templates for Bulk Data Manager (BDM)

Engineering Templates are typically used from scratch, meaning data is dropped 
into the templates. The result is used for information or documentation. In this case 
no upgrade is required, because the installation of Engineering Studio 5.0 SP2 
exchanges the Engineering Templates in:

...\Documents and Settings\All Users\Desktop

However, if a worksheet containing data has been saved in the file system for 
writing back to the 800xA System after upgrade, either:

• Newly create the worksheet based on an Engineering Template delivered with 
Engineering Studio 5.0 SP2.

-or-

• Update the worksheet according to the description in:

...\Documents and Settings\All Users\Desktop\ 
Engineering Templates\ Upgrade Description Engineering 
Templates.doc

Function Designer

Modified Aspects of Function Designer System Extension. The Function 
Designer system extensions:

The Function Designer system extensions:

• Function Designer.
• Function Designer for AC800M Connect.
• Function Designer for AC 800M SB2 Libraries.
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• Function Designer for Fieldbus Builder PROFIBUS/HART.

mainly consist of:

• Functional Planning Object Types, including a Function Settings aspect at the 
Settings Object Type Group.

• Extension Libraries that add Function Designer Aspects to Object Types 
(Control Modules, Function Blocks, ...) created by basic libraries (AC 800M 
Connect, AC 800M SB2 Libraries, etc.).

After having loaded such a system extension in the 800xA 4.1 800xA System some 
of these aspects may have been modified; for example, to adapt Function Settings, 
or to change the color or layout of Function Blocks in Function Diagrams. 

During the 800xA System upgrade to 800xA 5.0 SP2 the system extensions of the 
new system are loaded. To keep the information about modified aspects, all aspects 
that had been created by a Function Designer system extension, but later on 
modified are listed in the Configuration Wizard log, and are written to Afw files, 
e.g.:

...\Function Designer\bin\Upgrade\313To501\Function Designer.afw

...\Function Designer\bin\Upgrade\313To501\Function Designer for 
Ac800M Connect.afw

...\Function Designer\bin\Upgrade\313To501\Function Designer for 
Ac800M SB2Libs.afw

...\Function Designer\bin\Upgrade\313To501\Function Designer for FB 
P/H.afw

The only way to bring these modifications back into the 800xA 5.0 SP2 System is to 
manually merge the changes. Do not import the Afw files above into the 800xA 5.0 
SP2 System, because some additional properties/data might get lost. In the case of 
Function Settings, look for each settings property in the 800xA 4.1 System and do 
the modifications again in the 800xA 5.0 SP2 System. In the case of modified 
Function Aspects (e.g. Diagram Template, Component Template), check the 
modifications done in the 800xA 4.1 System and do the modifications again in the 
800xA 5.0 SP2 System. 

Upgrade Diagram References and Diagram Variables. In the 800xA 5.0 SP2 
System (opposite to the 800xA 3.1 SP3 800xA System) Diagram References and 
Diagram Variables are by default created as Symbol Objects. This is not true for 
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Diagram References and Diagram Variables created during upgrade (restore) from 
800xA 3.1 SP3 800xA Systems. Convert them from Aspect Objects to Symbol 
Objects by use of the conversion function described in the following procedure.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Object Type Structure.

3. Use the Object Browser to navigate to:

Object Types > Functional Planning > Settings

4. Select Function Upgrade in the Aspect List Area to open the Function 
Upgrade aspect in the Preview Area.

5. Select the Convert Diagram References/Variables from Aspect Objects to 
Symbol Objects check box and click Apply.

6. Click Run Upgrade to perform the upgrade.

Check and Repair AES Variable Table (Applications, Controllers 
Diagrams/SCMs, and Diagram (Cm) Types). This function can be used to:

• Correct possible inconsistent data used for display of online values and external 
cross references.

• Delete obsolete data and reduce aspect size.

Perform the following procedure to use this application.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Object Type Structure.

3. Use the Object Browser to navigate to:

Object Types > Functional Planning > Settings

4. Select Function Upgrade in the Aspect List Area to open the Function 
Upgrade aspect in the Preview Area.

Differences between Aspect Objects and Symbol Objects are described in 
Industrial IT, 800xA -Engineering, Engineering Workplace, Function Designer 
(3BDS011224*).

This function is not suitable in the case of additional aspects on input/output 
references, e.g. Graphic Elements, for typical diagrams with input/output 
references that will get copied and connected via the Bulk Data Manager.
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5. Select the Check and Repair AES Variable Table (Applications, 
Controllers, Diagrams/SCMs, and Diagram (Cm) Types) check box and 
click Apply.

6. Click Run Upgrade to perform this upgrade.

Asset Optimization

Use the following procedure after upgrading Asset Optimization. Perform the steps 
applicable to the system.

1. Asset Monitoring:

a. Reconfigure the value of the OPC Group Update Rate:

– Open a Plant Explorer Workplace.

– Use the Structure Selector to open the Control Structure.

– Use the Object Browser to navigate to:

Root > Asset Optimization

– Select Afw OPC-DA Asset Monitor Data Source in the Aspect List 
Area.

– Update the value of OPC Group Update Rate (ms) in the Preview Area 
with the value recorded under Record Values for Post Upgrade on page 
322 and click Apply.

b. If Runtime Asset Monitors are being used in the system, restore the 
Runtime Asset Monitor data directory (DeviceRunTimeMSLogicStore). 
The Runtime Asset Monitor data directory is located in: 

Execute Check and Repair AES Variable Table in order to make the environment 
support work for Function Designer.

Asset Monitoring directories must be restored on the Asset Optimization Server 
node.
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...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AssetMonitorEnvironment\Bin  

c. If XY Profile Deviation Asset Monitors are being used in the system, 
restore the XY Profile Deviation Asset Monitor data directory 
(XY_Reference_Profiles). The XY_Reference_Profiles directory is 
located in:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\AssetMonitorEnvironment\Bin

2. Maximo Integration: 

a. If the MxDef files were customized, restore the MxDef files to the 
following directory:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\ABBAO\Services\ MOM\MxDefs\ 
server_name\app_server

Where:

<server_name>\<app_server> is the combination of the MRO 
Server Name and the MRO Application Server Name fields from the 

The saved data contains the Runtime Asset Monitor data present at the time of the 
save. Use the Runtime Asset Monitor faceplate to reset the asset monitors by 
adding the lost time to their accumulated run time or with some known values 
based on other records. Any alarms that were occurring during the backup should 
be ignored.

The Runtime Properties aspect on the Runtime Asset Monitor object type has 
been replaced with Runtime Asset Monitor Faceplate Inputs. If any configuration 
changes were made to the Runtime Properties aspect on instances of the object 
prior to taking the 800xA System Backup, the aspect will not be automatically 
deleted. In this case, the Runtime Asset Monitor will fail to load with an Add Item 
error for the Reset Signal. In order to complete the upgrade, search for all 
instances of the Runtime Properties aspect on the Runtime Asset Monitor objects 
and apply any configuration changes made to the new Runtime Asset Monitor 
Faceplate inputs, and then delete the Runtime Properties aspect.

If using Maximo Integration, the Maximo Integration information must be 
restored on all Asset Optimization Server nodes. Reference the Service 
Structure for the Asset Optimization Server.
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Maximo Equipment ID aspect. These fields are configured in the Aspect 
System Structure in the Maximo Equipment ID aspect. These fields 
allow for customization of MxDef files on the Maximo Server level as 
well as on the Maximo Application Server level. Refer to Maximo 
documentation for an explanation of Maximo Application Servers.

For example, the resultant path to the customized MxDef files will look 
like:

...\Program Files\ABB Industrial IT\Optimize IT\Asset 
Optimization\ABBAO\Services\MOM\MxDefs\Maximo5\
MxServer

Refer to Industrial IT, 800xA - Asset Optimization, Configuration 
(3BUA000118*) for more information on MxDef files.

b. It is necessary to configure the values of the Maximo Equipment ID 
Provider Properties, as these values are not upgraded. These values should 
have been recorded in Step 2 under Record Values for Post Upgrade on 
page 322. Refer to Maximo Server Connection Properties in the System 
Setup section of Industrial IT, 800xA - Asset Optimization, Configuration 
(3BUA000118*) to configure these values.

3. DMS Calibration Integration. If using DMS Calibration Integration:

a. Restore DMS Calibration Integration information. Refer to the Meriam 
Process Technologies Device Management System User’s Guide for 
information about restoring DMS Server data.

b. Perform an 800xA > DMS synchronization to insure that the 800xA 
objects correctly map to the Devices within DMS.

4. Asset Monitors that are assigned (via the Configure option drop-down list box 
on the Asset Monitor Instance on an Object) to a particular AO Server object 
and Asset Optimization Server aspect (by Object name:Aspect name pair), will 
not be correctly configured after the upgrade. The AOServer property will be 
unconfigured and the following error message will appear:

Unable to resolve AO Server for this Asset Monitor 
configuration

Asset Optimization DMS Calibration Integration 800xA 5.0 SP2 functions with 
DMS software Version 2.6.
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This must be resolved before the Asset Monitor Logic can be loaded into an 
AO Server:Asset Optimization Server for execution. Refer to the Object Type 
Structure for Asset Optimization, Object Type Group:AO Server, Object Type.

5. In the Control Structure, open the AOServer1, AOServer object, Asset 
Optimization Server aspect.

a. Service Hostname MUST be configured. It may be necessary to navigate 
into the Service Structure to the AssetMonitoring Service Provider to set 
the Node and enable the service. There is a navigation button for 
convenience.

b. Target State should be Service, i.e. Engine is running.

c. On all objects that have Asset Monitor aspects, check the Asset Monitor 
tab in the Config View of the aspect for the Server Assignment and 
Assigned to. These fields may upgrade as blank or unassigned.

6. After a restore of a 800xA 5.0 SP2 system, the Asset Optimization Server 
(Monitor Server/Engine) is running. The AO Server tab of the Asset 
Monitoring Server aspect will show a status of good: AM Engine running. 

a. Clicking the Asset Monitors tab and selecting AMs assigned to this AO 
Server will show that the values in the Status column are NOT Loaded, 
enabled. 

b. Click Load all AMs to reload all enabled Asset Monitors assigned to this 
AO Server. 

7. In earlier versions of Asset Optimization, all Asset Optimization alarms were 
written as alarm category soft alarm. Starting with Asset Optimization 800xA 
5.0, these soft alarms are replaced with two new categories: Asset Condition 
Alarm and Asset Monitoring Status Alarm. Therefore, any existing Alarm and 
Event Lists that filtered on soft alarms for the purpose of viewing Asset 
Optimization alarms, must have their filters changed.

8. Starting with Asset Optimization 800xA 5.0, Object Type Inheritance is 
supported. That is, an Asset Monitor on the Object Instance will inherit its 
configuration from the Asset Monitor in the Object Type if it was created via 
the Copy to all instances property check in the Type Definition aspect. When 
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importing an 800xA 3.1 SP3 configuration, the configuration inheritance 
changes shown in Table 10 will be made:

9. 800xA 3.1 SP3 supported assigning Asset Monitors on the same object to the 
different Asset Monitoring Servers. 800xA 5.0 SP2 requires that all Asset 
Monitors on the object be assigned to the same AO Server. When upgrading 

Table 10. Configuration Inheritance Changes

Type Change

Asset Monitor is on the Object Type. This Asset Monitor will be set to inherit from the 
Asset Monitor category.

For each of the 4 configuration tabs (Asset 
Monitor, Conditions, Asset Parameters, and 
Input Records) the configuration inheritance 
values will be set to their pre 800xA 5.0 SP2 
values.

Asset Monitor is on the instance of the generic 
object.

This Asset Monitor will be set to inherit from the 
Asset Monitor category.

For each of the 4 configuration tabs (Asset 
Monitor, Conditions, Asset Parameters, and 
Input Records) the configuration inheritance 
values will be set to their pre 800xA 5.0 SP2 
values.

Asset Monitor in the instance that has Object 
Type.
Corresponding Asset Monitor does not exist in 
the Object Type.

Asset Monitor in the instance that has Object 
Type.
Corresponding Asset Monitor exists in the object 
type and the Copy to all instances check box is 
disabled in the Aspect Control tab of the Object 
Type Definition aspect.

Asset Monitor in the instance that has Object 
Type.
Corresponding Asset Monitor exists in the object 
type and the Copy to all instances check box is 
selected in the Aspect Control tab of the Object 
Type Definition aspect.

This Asset Monitor will be set to inherit from the 
Asset Monitor of the Object Type.

For each of the 4 configuration tabs (Asset 
Monitor, Conditions, Asset Parameters, and 
Input Records) if the configuration matches the 
configuration in Object Type, inheritance values 
will be set to TRUE, else to FALSE.
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from 800xA 3.1 SP3 to 800xA 5.0 SP2, the AO Server for all Asset Monitors 
will be set to Default. All Asset Monitors that were assigned to None in 800xA 
3.1 SP3 will be marked as disabled in 800xA 5.0 SP2. If the user needs to load 
balance Asset Monitors between two different AO Servers, this should be done 
via the Assign Asset Monitors to this AO Srv context menu item in the AO 
Server aspect. Refer to Industrial IT, 800xA - Asset Optimization, 
Configuration (3BUA000118*) for more information.

PC, Network and Software Monitoring

1. If user defined Script, Resource, and Assembly files were backed up, copy the 
saved files from the safe media to the following directories:

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Scripts\User

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Assemblies\User

...\Program Files\ABB Industrial IT\Optimize IT\
PC, Network and Software Monitoring\bin\Configuration\
Resources\User

2. Perform the following steps on the PC, Network and Software Monitoring 
Server node.

a. Use the Structure Selector to open the Service Structure in the Plant 
Explorer Workplace.

b. Use the Object Browser to navigate to the:

Services > OpcDA_Connector, Service > SG_IT Server

object. If there is no object to navigate to, skip to Step l (letter l, not 
number 1).

Warnings may appear during system upgrade. These warnings can be ignored.

The following steps assume that the required system extensions were loaded on 
the primary Aspect Server node.
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c. Open the OPCDA_Provider_<servername> object and double-click on the 
Service Provider Definition aspect.

d. On the Configuration tab, clear and select the Enabled check box and 
click Apply. The Current field should change to Service.

e. Use the Structure Selector to open the Control Structure.

f. Use the Object Browser to navigate to the IT Server object.

g. Double-click OPC Data Source Definition in the Aspect List Area.

h. Click on the Service Group drop-down menu and select the SG_IT 
Server.

i. Click on the OPCDA_Provider_<servername> which was configured in 
step Step c.

j. Click Apply.

k. Skip to Step 3.

l. Use the Structure Selector to open the Control Structure.

m. Use the Object Browser to navigate to the IT Server object.

n. Double-click OPC Data Source Definition in the Aspect List Area.

o. Select New.

p. Click Add and select the appropriate Service Provider from the list.

q. Click OK twice.

r. Click Apply.

3. The IT General Setup aspect is used to point the IT OPC Server Network 
Object to the Asset Optimization Server for Asset Optimization, and the Asset 
Monitor Data Source. If Asset Optimization software is installed and loaded, 
then the following configuration is required:

a. Use the Structure Selector to open the Control Structure.

b. Use the Object Browser to navigate to:

IT Server, IT OPC Server Network

c. Select IT General Setup in the Aspect List Area.
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d. Refer to the IT General Setup Aspect topic in Industrial IT, Asset 
Optimization - PC, Network and Software Monitoring - Configuration 
(3BUA000447*) and configure the Asset Optimization Server and Asset 
Optimization Data Source.

e. Click Apply.

4. Migrate the IT Asset Monitors. If Asset Optimization and PC, Network and 
Software Monitoring were installed on the 800xA 3.1 SP3 System, then the 
following must be done for any existing IT Assets that had IT Asset Monitors 
configured for them. 

a. Use the Find Tool in the Plant Explorer Workplace to locate all the IT 
Asset Monitor aspect instances in the Control Structure.

b. Right-click on each of the found aspects and select Goto Object.

c. Delete the IT Asset Monitor aspect.

d. Open the IT Device Manager aspect and click Generate to recreate the IT 
Asset Monitor.

e. Repeat Step c and Step d for each object in the Find list.

f. Use the Object Browser to navigate to: 

Root, Domain > Asset Optimization, Asset Optimization > 
AO Server 1, AO Server

g. Select Asset Optimization Server in the Aspect List Area.

h. Enable the Enabled check box in the AO Server tab and click Apply.

i. Click Load all AMs in the Asset Monitors tab.

SMS and e-mail Messaging

Reconfigure the GSM Device hardware information recorded in the save operation 
(refer to SMS and e-mail Messaging on page 325).

It may be necessary to stop and start the Messenger Server Service in the Service 
Structure after the SMS and e-mail Messaging restore operation.
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Batch Management

Verify that the primary Batch Server is in primary mode (P is displayed in the 
Windows Taskbar) and the secondary Batch Server is in secondary mode (S 
displayed in the Windows Taskbar). If the proper modes are not displayed, enable 
the Batch Service Group before proceeding.

To enable the Batch Service Group:

1. Open a Plant Explorer Workplace.

2. Select the Service Structure.

3. Select the Services\Batch Service, Service\batch_group_name, Service 
Group\Service Group Definition aspect.

4. Select the Configuration tab.

5. Select the provider that is currently the secondary Batch Server.

6. Select the Enabled check box and click Apply.

7. Select the provider that is currently the primary Batch Server.

8. Select the Enabled check box and click Apply.

Batch data can be reloaded to the batch database from wherever it was archived. 

Perform the following to view any Batch data archived from SV5.0 or previous 
versions of the Batch product:

1. Create a Virtual Machine (VM) node with the existing system version and its 
components.

2. Restore Batch data using the Batch Restore window onto this virtual machine.

During the upgrade, a second Messenger Service Group and Messenger Service 
Provider will be created in the Service Structure. For instance:

Messenger SG_1, Service Group
Messenger SP_1, Service Provider

If there is already a Messenger Service Group and Messenger Service Provider 
configured, the new one may be deleted.

The Batch history archive and restore aspect has been removed in SV5.1.
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Once the restored data is in the batch database, it can be viewed using the Batch 
History Overview window. 

Do not restore directly from CDs or DVDs. Restore from hard disk drives which can 
be restored from CDs or DVDs using commercially available software.

Restoring Batches

To restore batch history, select the batch history restore aspect. By default a Batch 
History Restore aspect is located in Library Structure\Batch 
Management\Overviews. However, this aspect can be added to any 800xA System 
object. The Batch History Restore window is displayed.

To restore batches:

1. Click Pick Files.

2. Select the batch files to be restored in the standard Windows Open window.

3. Click OK.

4. Repeat Step 1 through Step 3 until all the desired batch files are selected.

5. Click Restore.

Use the Remove from List and Clear All buttons to delete the selected batch or all 
the batches from the list.

Click View Log to view a record of the actions taken during the last restore 
operation.

Use the Batch Management backup restore utility to restore PFC color configuration 
information and batch IDs. Access this utility by selecting:

Start > All Programs > ABB Industrial IT 800xA >
Production Mgmt - Batch > Restore Utility

Selecting any of the check boxes listed in the Restore Utility enables Restore. 

The labeled check boxes are:

• PFC color configuration.
• Batch IDs.
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When Restore is clicked, a warning is presented that states that the restore operation 
will overwrite the selected parts of the configuration database. The parts of the 
database that are overwritten are dependent on the option selections. A standard 
Windows open file window that allows browsing to any desired folder is presented. 
A configuration window provides the chance to cancel before the file is restored.

Selecting the Alarm Server

To select the Alarm Server:

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Use the Object Browser to select:

Services > Event Collector, Service > 
Batch_AE_Service, Service Group

4. Select Service Group Definition in the Aspect List Area.

5. Select the Special Configuration tab in the Preview Area.

6. Select Produce IT Batch OPC AE Server in the Alarm Server field.

7. Click Apply.

Basic History Service

Restore the Basic History Service data as follows. Perform this procedure on every 
node where the Basic History Service is running.

1. Stop the Basic History Server from the Service Structure.

2. Read {Provider ID} from the properties of the Basic History Server. This 
information may be needed when matching servers.

3. If it is necessary to keep historical data for the time since the system was 
started after the upgrade, move the Basic History log files in the following 
directory to a temporary directory:

Always perform the Toolbar configuration as described in System 800xA Batch 
Management Configuration and shutdown script procedure as described in the 
Batch Management section of System 800xA Post Installation (3BUA000156*).
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...\OperateITData\History\{provider ID}

These files will be inserted by using the Archive Tool as described in Step 7.

4. Delete all files under:

...\OperateITData\History\{provider ID}

5. Restore the files from the backup of Basic History Service Data to:

 ...\OperateITData\History\{provider ID}

6. Start the Basic History Service from the Service Structure.

7. If Step 3 was performed:

a. Open the AdvHtArchiveTool located by default in the following directory:

...\Program Files\ABB Industrial IT\Operate IT\Process 
Portal A \bin

b. Use the File/Select/Open Archive command and browse to the directory 
containing the history log files.

Information Management

Perform the following post upgrade procedures for Information Management.

Reconfiguring the IM Log Configuration

After restoring a system containing IM logs, the Service Group for the IM log 
template configuration might be missing. The IM log templates must be checked, 
and if the Service Group is missing, a new Service Group must be selected and 
saved.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Library Structure.

When creating the Oracle instance, select I am upgrading from SV3.x or SV4.x 
in the Configuration File Options dialog box to prevent the wizard from creating 
a history database. This will prevent History from starting until after the History 
Database is restored.

When the correct procedures are followed, no Log Templates should need to be 
modified, this is only a verification step.
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3. Use the Object Browser to navigate to:

History Log Templates, History Log Template Library > 
Default Log Templates, History Log Template Library

4. Select a log template.

5. Select Log Template in the Aspect List Area.

6. Select the Log Definition tab in the Preview Area.

7. If the Service Group in the Service Group drop-down list box is missing, it 
must be reconfigured. The Service Group drop-down list box contains all 
History servers defined in the system. Use this list to specify the server where 
this log will reside.

8. Repeat this procedure for all of the log templates.

Information Management History Backup/Restore Utility

Use the Information Management History Backup/Restore utility, via:

Start > ABB Industrial IT 800xA > Information Mgmt > History > 
Backup and Restore

to restore the Information Management History database and synchronize the 
Aspect Directory contents with the current Information Management History 
database configuration.

During the restore, the existing database is dropped, and a new one is created. 
Mount points and additional table spaces are created based on the database being 
restored. Oracle data is imported, and the file-based property logs are copied back 
into the system. Unless a different mount point is specified, the History database 
will be restored to its original location (its location prior to being backed up). 

The History database can be restored from any drive on the workstation, including 
any mapped network drives. The restore utility will first search a specified location 
for zipped archives matching a specific name and fitting the form name-drive.zip 
(such as histDB-C.zip, histDB-A.zip, and histDB-D.zip), and will then 
restore the compressed database files contained within the archives to their 
respective original locations (their locations prior to being backed up). 
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Considerations. When restoring the History database, make sure the disk is ready 
and available on the node on which the procedure is to occur. Also, ensure that no 
applications are accessing the Oracle database. The log file should be checked after 
the restore operation to make sure that the restore operation completed successfully. 

Running the Information Management History Backup/Restore Utility

To restore a backed up History database:  

1. Verify that the ABB Process Administration Service (PAS) is set to manual in 
the Services Control Panel (run Services.msc from the Run dialog box). Stop 
the service if it is running.

2. Ensure that no third party applications access the Oracle database during the 
restore operation. 

3. Select:

Start > All Programs > ABB Industrial IT 800xA > Information 
Mgmt > History > Backup and Restore.

4. Verify Restore configuration from a backup file(s) is enabled in the 
Welcome to IM Historian Backup and Restore Utility dialog box.

The path to PAS now changed to Control Panel > Administrative Tools.

This procedure can also be performed by using the pasgui command in the Run 
dialog box (Start > Run).

If it is suspected that the Inform IT History Service Provider has not stopped, it 
can be stopped now by selecting the Inform IT History Service Provider for this 
node in the Service Structure, selecting the Configuration tab on the Service 
Provider Definition aspect, disabling Enabled, and clicking Apply.
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5. Click Next. IM Historian Database Restore dialog box appears as shown in 
Figure 64. 

6. Specify the location of the backup files in the Path of IM historian backup: 
field (Figure 64).

7. Click Next. The HsBAR Output Window appears.

8. Select the Automatically close upon completion check box. 

9. Monitor the progress in the Progress Status area of the IM Historian 
Backup/Restore Utility window. Ignore the error messages indicating errors 
deleting aspect.

Shortly after the message indicating the import is complete, the database 
conversion tool will run automatically. Feedback will be provided in the 
HsBAR window.

TC08390A

Figure 64. IM Historian Database Restore Dialog Box

If new mount points need to be specified for file-based logs and/or a new Oracle 
tablespace definition file, click Browse.
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Shortly after the message indicating the database conversion is complete, the 
history synchronization tool will run automatically. Again, feedback will be 
provided in the HsBAR window. 

10. Click Finish when a message stating the execution is complete is displayed as 
shown in Figure 65.

If the Progress Status dialog box has warning messages with possible solutions as 
indicated in Figure 66, read the possible solutions carefully, then click Finish and 

The restore of the system requires an instance that matches the size of the 
database being restored. When creating the instance, be sure to select Small, 
Medium, or Large based on the size of the message log in the backup being 
restored. Select Large if the size is not known. If the wrong size is selected, the 
restore operation may fail with the Oracle Error Message 1652 - Unable to 
extend tmp segment in tablespace temp. Repeat the restore with the 
correct instance settings if the error occurs.

TC08391A

Figure 65. Execution is Complete Message
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proceed with the solution that best fits your problem. Refer to the Information 
Management Release Notes for further guidelines.

Restoring Other Information Management Related Files

There are several other files related to Information Management that need to be 
restored as part of total system restore. 

• History Archive Data: For each archive device, copy the appropriate folders 
from the safe media to the location specified by the Device Filename.

• History Archive State Information: Stop the Industrial IT Archive service in 
the Service Structure. Copy the folder that holds the last archive time and 
other archive state information from the safe media to:

...\Documents and Settings\All Users\Application 
Data\ABB\IM\Archive

TC08392A

Figure 66. Progress Status Dialog Box

Refer to Saving Other Information Management Related Files on page 331 for 
Desktop Trends, Display Services, and DataDirect file locations.
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• Reports: Restore any report template files created in Microsoft Excel, 
DataDirect, and/or Crystal Reports. Also restore report output files created as a 
result of running these reports via the Scheduling Services.

• Desktop Trends: Restore trend display, ticker display, and tag explorer files.

• Display Services: Restore the directories for custom users, as well as display 
and user element definitions.

• DataDirect: Restore custom text files for object, object type, and attribute 
menus used on the DataDirect windows. 

• Check Archive Path Specifications: If the disk configuration has changed 
from the previous system to the new system (i.e. letter designations for disks 
have changed: C, D, E, etc.), check the archive device configurations to make 
sure the Archive Path specification points to the correct disk drive and 
directory, as shown in Figure 67.

TC08388A

Figure 67. Checking the Archive Path Specification
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Complete the Information Management Post Install

1. Start all processes under PAS supervision. This will start the Inform IT History 
Service Provider. 

2. Restart the Basic History Service Provider for this node:

a. Select the Basic History Service Provider object for the Information 
Management node in the Service Structure in the Plant Explorer.

b. Select the Service Provider Definition aspect.

c. Select the Configuration tab.

d. Clear the Enabled option.

e. Click Apply.

f. Select the Enabled option.

g. Click Apply.

h. Open the Services Control Panel (run Services.msc from the Run dialog 
box), set the ABB Process Administration Service (PAS) to Automatic 
and start it.

i. Open the Information Management Configuration Assistant (Start > 
Programs > ABB Industrial IT > Information Mgmt > Configuration 
Assistant) and perform any incomplete steps.

Verify that all Information Management services are running.

Restoring Archive Group Associations

Profile, Message, and Report logs must be reassociated with their respective 
Archive Groups. This information was recorded before beginning the upgrade. 
Refer to Industrial IT, 800xA - Information Management, Configuration 

If it is suspected that the Inform IT History Service Provider has not started, it can 
be started now by selecting the Inform IT History Service Provider for this node 
in the Service Structure, selecting the Configuration tab on the Service 
Provider Definition aspect, selecting Enabled, and clicking Apply.
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(3BUF001092*) to access the Archive Groups and restore the Archive Group 
associations.

Calculations Service

The Const keyword is no longer allowed within the VBScript source code of the 
calculation; therefore, edit Calculations that use the Const Statement.

Calculations that were disabled prior to the upgrade must be enabled by selecting 
the Enabled check box in the Calculations dialog box. Refer to the section on 
Calculations in Industrial IT, 800xA - Information Management, Operation 
(3BUF001094*). 

To enable the Calculations Service:

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Calculations Service Object.

4. Select the Service Definition aspect.

5. Click the Configuration tab.

6. Select the Enabled check box and click Apply.

Scheduling Service (Application Scheduler)

Schedules that were disabled prior to the upgrade must be enabled by selecting the 
Enabled check box in the Scheduling dialog box. Refer to the section on 
Scheduling in Industrial IT, 800xA - Information Management, Operation 
(3BUF001094*). 

To enable the Scheduling Service:

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Select the Scheduling Service Object.

4. Select the Service Definition aspect.

5. Click the Configuration tab.
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6. Select the Enabled check box and click Apply.

Resigning Digital Signatures in 800xA 5.0 SP2
To resign digital signatures in 800xA 5.0 SP2:

1. Use Windows Explorer to locate AfwSignatureManager.exe in the 
following directory:

...\<Base System install directory>/bin

2. Double-click AfwSignatureManager.exe to launch the Signature Manager. 

3. Use the File menu to open the Signature Report file saved before the upgrade.

4. When a signer is selected in the Signer column, the Aspects Signed table will 
show all aspects signed by this signer and information indicating whether the 
signature was valid in the 800xA 3.1 SP3 System or not.

5. Select the aspects to re-sign and click Sign. 

6. A Signature dialog box will appear in which to validate the signature.

Restart the System
Restart the system after performing all post upgrade procedures.

Reconfigure Alarm and Event List Configurations
In 800xA 5.0 SP2, in most cases, the SourceName column contains GUIDs. The 
recommendation in 800xA 5.0 SP2 is to reconfigure the Alarm and Event List 
configurations to use the ObjectName column instead of the SourceName column.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Library Structure.

3. Use the Object browser to navigate to and select an Alarm and Event List 
Configuration aspect.

Use Ctrl+Shift+Click to select multiple aspects to sign in one operation.



Section 6  Upgrading 800xA 3.1 SP3 to 800xA 5.0 SP2 Information Management Maintenance

3BSE036342-511 G 401

 

4. Select Alarm and Event List Configuration in the Aspect List.

5. Select the Columns tab in the Preview Area.

6. Clear the SourceName check box and select the ObjectName check box.

7. Click Apply.

Alarm and Event handling has changed significantly from 800xA 3.1 SP3 to 800xA 
5.0 SP2 (refer to Alarm and Event List Configurations on page 334). Check the list 
configurations in the 800xA 5.0 SP2 system against those recorded for the 800xA 
3.1 SP3 system under Alarm and Event List Configurations on page 334.

Information Management Maintenance
Perform this procedure on all Information Management Server nodes.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Node Administration Structure.

3. Use the Object Browser to navigate to:

All Nodes, Node Group > IM Node > Inform IT History_IM 
Node, Service Provider > Inform IT History Object, 
Inform IT History Object

4. Select Inform IT History Control in the Aspect List Area.
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5. Expand the Maintenance tree in the Preview Area and select 
Synchronization. The Inform IT History Manager shown in Figure 68 
appears in the Preview Area.

6. Click Check Names.

7. A blank dialog box should appear. If it does, click OK. If it does not click 
Resynchronize Names.

8. Click Check Synchronization.

9. A blank dialog box should appear. If it does, click OK. If it does not click 
Force Synchronization.

Configure Windows Services and Windows Firewall
Perform all applicable post installation steps in System 800xA Post Installation 
(3BUA000156*), including configuring Windows Services and Windows Firewall.

Figure 68. Inform IT HIstory Manager
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Add Autostart Shortcut
It it is desired to enable the autostart of the Operator Workplace on client nodes, 
perform the following:

1. Define a default workplace.

2. The shortcut must be created from the ABB Workplace login window.

3. The shortcut is located in:

...:\Documents and Settings\UserName\Start 
Menu\Programs\Startup

4. Right-click the shortcut and select Properties from the context menu.

5. Add the following to the shortcut target:

/WS

-or-

/WaitForSystem

6. Click OK.

System Backup
Make a complete backup of the upgraded system as described in Backups on page 
313.
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Appendix A  Warning and Error Messages

The warning and error messages that can be generated by the 800xA backup/restore 
function are described in the following topics. Suggested solutions are also 
provided.

Failed to Serialize Aspect
Example

Tue Jul 01 08:41:03 2003 [Error]: Failed to serialize aspect 'Operator Messages 
Link Display' on object 'Web System Workplace'

Reason

It is not possible for the Backup function to save the aspect data.

Solution

Check in the system for the behavior of this aspect.

ASO Object Class xxxx
did not Implement IAfwAspectSystemObject. Failed to Create ASO. Forgot to 
Register dll?

Example

Tue Jun 10 19:02:17 2003 [Error]: ASO object class {7B7A13B3-8BB4-42A3-
8289-987C579797C2}did not implement IAfwAspectSystemObject Failed to create 
ASO. Forgot to register dll?
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Reason

This often occurs when a system extension is used, but not installed on the node 
from where the backup is taken. It can also happen if an update of a system 
extension has been installed, but not added to the system.

Solution

Install all system extensions on the node from where the backup is taken. Make sure 
that the correct version of the system extension is installed.

UnplacedObjects.afw
Example

[Warning] c:\PPABackup\MyBackup\UnplacedObjects.afw created

Reason

During backup process, the backup tool goes through all structures, if there is an 
object that doesn't exist in any structure, it will be placed in UnplacedObjects.afw 
and write a warning in the backup log, therefore, UnplacedObjects.afw is used for 
all objects which miss the structure.

Solution

Check if there is any important object in UnplacedObjects.afw. If there is an 
important object in UnplacedObjects.afw, your backup is considered to be not 
complete. In such case, investigate what kind of object it is, and try to repair the 
system. One solution could be to add the object into the structure it should belong 
to. Take another backup.

The System Cannot Find the Path Specified
Example

Error detected for aspect 'Empty A3P' of object 'Document Manager 
Templates/Document Manager File Templates/Drawings'

Tue Jun 08 00:43:30 2004    The system cannot find the path specified. 
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EbServiceHandler: Object Id = {9AFACBA5-6B6A-462A-9EDF-78765740CD52}, 
Aspect Id = {89F8A8C4-10F7-4874-B77D-A8E6445D5C93} 

EbServiceHandler: Failed to load document into stream!

Reason

When the backup was taken, the FSD cache was set too low. All data has NOT been 
backed up. There should be warnings in the System Event list about overflow in the 
Fsd cache.

Solution

Increase the Fsd Cache size (for all nodes).

System Extension ´xxxx´ with ID ´Guid` is not Installed on 
this Node

Example

System extension 'Engineering Base' with id {B775BEA4-7859-4649-AE16-
901790822886} is not installed on this node.

System extension 'AC800M Con 31SP1' with id {6F388AEC-E4FF-4614-AF80-
1D37EC3B141F} is not installed on this node.

Reason

There is a system extension, which is not available in the node where the backup is 
taken, or which is not properly removed. The latter can be the case if AC800 
Connect has been upgraded and the old version is still registered in Industrial IT 
800xA.

Solution

Use a backup node where all system extensions are installed.

Timeout by External Service
Example 

Thu Mar 04 02:34:55 2004 #1: Receiving files 



Graphic Aspect = xxx Cannot be Imported. Appendix A  Warning and Error Messages

408 3BSE036342-511 G

 

Thu Mar 04 02:34:56 2004 #1: Receiving files 

Thu Mar 04 02:34:57 2004 #1: Receiving files 

Thu Mar 04 02:34:57 2004 #1: Finishing 

Thu Mar 04 02:34:58 2004 

Thu Mar 04 02:35:08 2004 TimeOut by External Service

Reason

History or System Message data was backed up using the backup/restore function. 
This functionality is not yet supported.

Solution

History and System Message data has to be saved manually, as described in 
reference [2] Release Notes. Create a new backup, without including History or 
System Message data.

Graphic Aspect = xxx Cannot be Imported.
Example

Mon Mar 29 19:52:32 2004 [Error]: Object = WI Mezzanine Deck, graphic aspect = 
Page Prev cannot be imported. Source directory = 
d:\OperateITData\Temp\ActiveGraphics\{800BA917-3D7F-44B6-B647-
90C4B06A98FA}.restore.2.

Reason

Could be different reasons.

Solution

Check the source directory specified in the error message. The log file in this 
directory should give some hints of what caused the problem.

Too Many Aspects of Category
Example

Sat Jun 05 17:04:33 2004: Too many aspects of category 'Name' on object 
'{82416BDF-5464-4422-A443-35E08E1065BE}'
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Sat Jun 05 17:04:34 2004: Import/Export Error: Object {82416BDF-5464-4422-
A443-35E08E1065BE} ({82416BDF-5464-4422-A443-35E08E1065BE}) - 
E_AFW_AD_TOO_MANY_ASPECTS (0x8abb081b) To many aspect of a specific 
type. 

Sat Jun 05 17:04:34 2004: Failed to restore file C:\BWSC\BWSC Full Backup; 
2004-06-03; 03-00\Control Structure28.afw. The importer returned hr = 
0x8abb081b

Reason

The system was inconsistent at backup time (there were more than one aspect of 
category 'Name' on an object). The backup does not react on this, but restore will 
fail. The restore part will be fixed in a later release (it will be possible to import such 
an object, but a warning will be granted).

Solution

Open the file (in this case Control Structure28.afw) with the old import/export 
utility (<Install path>\bin\AfwImportExport_obsolete.exe), search for the aspect 
category and manually remove one of the two aspect categories.

Aspect Category is Missing
Example

Sat Jun 05 16:41:27 2004: Aspect '{506D9D24-E22A-4EDB-AFB0-
0753B6DB6990}' on object 'SoftPoint Object Types' cannot be restored because the 
aspect category is missing

Sat Jun 05 16:41:27 2004: ObjectId: {9574CC3B-0E5E-4B14-A83E-
F483CCDE6E44}

Sat Jun 05 16:41:27 2004: AspectId: {506D9D24-E22A-4EDB-AFB0-
0753B6DB6990}

Reason

One or more aspect categories have been removed, while there are aspects of that 
category still in the system. This inconsistency was present in the system when the 
backup was taken.
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Solution

If the aspect category has been removed then these aspects may not be of interest 
any more. Check if the aspects are needed. If not, ignore this message.

Unknown Transaction Error
Example 1

Mon Apr 19 13:39:40 2004: Unknown transaction error

Reason

If this is the only error message, there is probably a problem with some windows 
resources.

Solution

Check your windows resources.

Example 2

Mon Jun 28 08:37:08 2004: Loading C:\BACKUP\Full Backup; 2004-06-23; 10-
39\Aspect System Structure0.afw ...

Mon Jun 28 08:37:09 2004: Aspect 'Batch Management Operation' on object 'Batch 
Management Documents' failed to unserialize itself.

Mon Jun 28 08:37:09 2004: ObjectId:    {814786F8-E6CC-44B0-9A2A-
1787FADDFE6F}

Mon Jun 28 08:37:09 2004: AspectId:    {2CE41978-DE94-44AC-9D38-
B216FBA93C3A}

Reason

It is not possible for the Restore function to restore the aspect data.

Solution

No solution available.
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Appendix B  Control Builder M Compatibility
Issues

This appendix lists the compatibility issues when upgrading from the various 
system versions to 800xA 5.1.

800xA 5.0 SP2 to 800xA 5.1 Compatibility Issues
Table 11 lists and describes Control Builder M compatibility issues, including 
solutions to the issues, when upgrading from 800xA 5.0 SP2 to 800xA 5.1.

T

There are no compatible issues when upgrading from 800xA 5.1 and Feature 
Packs (FP1 through FP3).

Table 11. 800xA 5.0 SP2 to 800xA 5.1 Control Builder M Compatibility Issues

Application Issue Solution

Upgrading from 
800xA 5.0 SP2 to 
800xA 5.1 and later.

Loosing all the parameter 
or pin properties for the 
Fuction Block instances in 
Single Control Modules 
might not show the 
expected values in the BU 
specific tools.

After uprgrading the Control Builder M project, 
Single Control Modules created using Function 
Diagram would loose all the parameter or pin 
properties for the Function Block instances. As 
a result of this, some of the BU Specific tools 
(for example Interlock Viewer) might not show 
values as expected. Perform configuration data 
generation to enable the properties.
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Upgrading from 
800xA 5.0 SP2 to 
800xA 5.1 and later.

The signal configuration 
for CI860 must be 
checked and changed 
when UnitStatus is 
accessed by the 
application.

After upgrading the Hardware libraries for 
CI860 the UnitStatus signals must be moved 
from IW10.6510 to IW10.6518. Otherwise the 
application will not display the correct values or 
in addition a succeeding download will be 
stopped with an error or OLU (Online Upgrade) 
will fail in Step 7 (Refer Appendix C, Online 
Upgrade Controller Level). The change must be 
done before first download, after normal 
firmware upgrade or before starting OLU.

Mixing formal and 
informal parameter 
passing in a function 
call is not allowed.

Prior to 800xA 5.1 it was 
allowed to mix formal and 
informal parameter 
passing in a function call.

The Control Builder 
compiler in 800xA 5.1 
gives a compile error for 
mixed parameter passing.

Allowed: 

AddSuffix( String := 
StrVar,  Suffix := StrSuffix 
);

or

AddSuffix( StrVar, 
StrSuffix );

Not allowed:

AddSuffix( String := 
StrVar, StrSuffix );

Correct the code to use either formal or informal 
parameter passing for all parameters in the 
function call.

Table 11. 800xA 5.0 SP2 to 800xA 5.1 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Writing to 
components of a 
structured function 
block parameter with 
direction [in] via 
control module 
parameter is 
prohibited.

If a function block has a 
parameter p1 with 
direction [in] of a 
structured data type, it 
was possible to write to its 
components by 
connecting it to a control 
module that writes to the 
parameter. This is 
prohibited in 800xA 5.1

Correct the code to not use this illegal 
construction.

New attributes for 
function block, control 
module, and data 
types have been 
introduced.

Some new attributes have 
been introduced in 800xA 
5.1 that affect function 
block, control module, and 
data types.

For example:

- Direction attribute on 
control module 
parameters.

- Reverse and ISP 
attribute on datatype 
components.

For detailed information on the new attributes 
and their consequences refer to System 800xA 
Control AC 800M Configuration.

Upgrade of 800xA 5.0 
SP2 projects 
containing CI851 and 
CI852 units.

The hardware libraries for 
CI851 and CI852 do not 
work together with 800xA 
5.1 controller firmware.

When Upgrade Project is performed in Control 
Builder the user must select to not upgrade to 
800xA 5.1 firmware in the controllers.This is not 
compatible with the hardware libraries for CI851 
and CI852.

After Upgrade Project is performed, verify that 
the controller is using BasicHWLib 5.0-2 and 
the hardware libraries for CI851 and CI852 as 
applicable.

Table 11. 800xA 5.0 SP2 to 800xA 5.1 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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800xA 4.1 to 800xA 5.1 Compatibility Issues
Table 12 lists and describes Control Builder M compatibility issues, including 
solutions to the issues, when upgrading from 800xA 4.1 to 800xA 5.1.

Table 12. 800xA 4.1 to 800xA 5.1 Control Builder M Compatibility Issues

Application Issue Solution

Upgrading from 
800xA 4.1 to 800xA 
5.1 and later.

The signal configuration 
for CI860 must be 
checked and changed 
when UnitStatus is 
accessed by the 
application.

After upgrading the Hardware libraries for 
CI860 the UnitStatus signals must be moved 
from IW10.6510 to IW10.6518. Otherwise the 
application will not display the correct values or 
in addition a succeeding download will be 
stopped with an error or OLU (Online Upgrade) 
will fail in Step 7 (Refer Appendix C, Online 
Upgrade Controller Level). The change must be 
done before first download, after normal 
firmware upgrade or before starting OLU.

Mixing formal and 
informal parameter 
passing in a function 
call is not allowed.

Prior to 800xA 5.1 it was 
allowed to mix formal and 
informal parameter 
passing in a function call.

The Control Builder 
compiler in 800xA 5.1 
gives a compile error for 
mixed parameter passing.

Allowed: 

AddSuffix( String := 
StrVar,  Suffix := StrSuffix 
);

or

AddSuffix( StrVar, 
StrSuffix );

Not allowed:

AddSuffix( String := 
StrVar, StrSuffix );

Correct the code to use either formal or informal 
parameter passing for all parameters in the 
function call.
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Writing to 
components of a 
structured function 
block parameter with 
direction [in] via 
control module 
parameter is 
prohibited.

If a function block has a 
parameter p1 with 
direction [in] of a 
structured data type, it 
was possible to write to its 
components by 
connecting it to a control 
module that writes to the 
parameter. This is 
prohibited in 800xA 5.1

Correct the code to not use this illegal 
construction.

New attributes for 
function block, control 
module, and data 
types have been 
introduced.

Some new attributes have 
been introduced in 800xA 
5.1 that affect function 
block, control module, and 
data types.

For example:

- Direction attribute on 
control module 
parameters.

- Reverse and ISP 
attribute on datatype 
components.

For detailed information on the new attributes 
and their consequences refer to System 800xA 
Control AC 800M Configuration.

Table 12. 800xA 4.1 to 800xA 5.1 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Upgrade of 800xA 4.1 
projects containing 
CI851 and CI852 
units.

The hardware libraries for 
CI851 and CI852 are not 
part of AC 800M Connect 
in 800xA 5.1 and does not 
work together with 800xA 
5.1 controller firmware.

To upgrade a Control Builder Project from 
800xA 4.1 that has controllers containing CI851 
or CI852 units, the following system extensions 
must be installed and loaded after the restore to 
the 800xA 5.1 System is performed, but before 
Upgrade Project is performed in Control 
Builder:

- AC800M Classic system extension (contains 
the hardware libraries for CI851 and CI852).

-AC800 SV5.0 SP2 Coexistencesystem 
extension (contains BasicHWLib 5.0-2).

After Upgrade Project is performed, verify that 
the controller is using BasicHWLib 5.0-2 and 
the hardware libraries for CI851 and CI852 as 
applicable.

Force I/O from SIL2 
applications 
prohibited 

In order to better enforce 
the counting of maximum 
number of forces in High 
Integrity Controllers, the 
possibility to force I/O 
signals directly from code 
has been removed. This 
means that no writing will 
be allowed to the .Forced 
component of an IO data 
type in a SIL1-2 or SIL3 
application. It will result in 
a compile error. 

The only possibility to force I/O in a SIL 
application will be via the Safe Online Write 
function (confirmed write) from operator 
graphics.This restriction will also improve the 
response time when resetting forces in the 
controller.The reset of individual forced signals 
from code will still be possible by using the new 
firmware function ResetForcedValue(), which is 
introduced in 800xA 5.0 SP2. This implies that 
constructions where variables of IO data type 
(i.e. BoolIO, RealIO, DWordIO, or DintIO) are 
copied or connected via out parameters in 
function blocks, will no longer work. However, 
parameter passing via in or in_out parameters 
is not affected.

Table 12. 800xA 4.1 to 800xA 5.1 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Discontinued 
functions for Safe 
MMS communication 
(function blocks)

Due to the restriction 
described in Force I/O 
from SIL2 applications 
prohibited, the SIL2 
marking of function blocks 
writing to IO data types 
has been removed. The 
affected function blocks 
are:

• MMSRead4BoolIO.

• MMSRead4DintIO.

• MMSRead4RealIO.

Consequently, these 
function blocks can not be 
used in SIL applications 
but will still be available for 
use in non-SIL 
applications.

The corresponding 
definition function blocks 
(MMSdef4xxxxIO) will still 
be available from SIL 
applications and 
consequently reading IO 
from SIL to non-SIL 
applications will still be 
possible.

In SIL applications it is recommended to 
replace the MMSRead4xxxxIO with the 
MMSRead4xxxx function blocks and only 
transfer the .Value component of the IO data 
type.

Safety Operator User 
Group

An operator must be a 
member of the Safety 
Operator User Group to 
be able to write data to 
objects running in a SIL 
application in the 
controller.

Make the operator a member of the Safety 
Operator User Group.

Table 12. 800xA 4.1 to 800xA 5.1 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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No Time Sync 
warning in controller

Some controllers might 
get a No time sync 
warning in the controller 
log after upgrade to 
800xA 5.0 SP2.

Set the CS Protocol Type for controllers that are 
not intended to be synchronized No Synch in 
order to avoid the warning.

Accessing Local 
Variables in Function 
Blocks. 

It has been possible to 
access local variables in 
Function Blocks from 
surrounding code.

According to the IEC 
61131-3 standard, local 
variables shall only be 
accessible within the 
containing software 
element.

A compilation error is 
given if local variables are 
accessed from the 
outside.

Correct any such warnings before performing 
the download. Local variables used in this 
fashion need to be changed to parameters 
instead.

Code sorting loops 
treated as errors.

Code sorting loops in 
applications are by default 
considered as errors in 
800xA 5.0 SP2.

It is not possible to 
compile and download an 
application if it contains 
code sorting loops.

First, try to correct the sorting loops. Refer to 
Interpret and Correct Code Loop Errors in 
Industrial IT, 800xA - Control and I/O, 
Application Programming, Introduction and 
Design (3BSE043723*).

Another alternative is to change the compiler 
switch for Code Sorting Loops:

1. Mark the project in Project Explorer.

2. Right-click and select Settings > Compiler 
Switch.

3. Set the global Loops in Control Modules 
switch to Warning.

Table 12. 800xA 4.1 to 800xA 5.1 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Applications having 
integer literal values 
too large as initial 
values.

Compile error 1040 might 
appear in Control Builder 
projects that previously 
did not contain any 
compile errors.

Control Builder now 
makes more stringent 
compiler checks on initial 
values for variables. It 
previously allowed illegal 
(too large) integer literal 
values as initial values. 
The actual used value 
was zero.

Correct the compile error.

e.g. by entering a smaller, legal value on the 
literal.

Table 12. 800xA 4.1 to 800xA 5.1 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Self defined serial 
communication using 
the Serial 
Communication 
Library.

The Serial 
Communication Library 
has undergone a major 
internal redesign that in 
some cases may lead to 
compatibility issues.

Use of firmware functions:

Firmware functions used for serial 
communication handling are no longer 
supported.

This means that user-built libraries where these 
firmware functions have been used, can no 
longer be used.

The no longer supported firmware functions 
are:

• OpenDevice

• UpdateDeviceSetup,

• SetDeviceClearRead

• CloseDevice.

• ReadStringDevice

• ReadLineDevice

• WriteStringDevice

Improvement were made in the following 
areas:

• Clear buffer when entering the listen 
operation of the SerialListen function 
block.

• If the SerialWriteWait function block is 
triggered when the timeout has elapsed, 
the read/listen buffer is cleared in between 
the retry operations in connection to the 
write operation.

• Behavior of the SerialWriteWait 
function block in previous versions: If 
the function block is triggered after the 
application stopping phase is entered, the 
function block propagates the status code -
15 via the Status -parameter.

Table 12. 800xA 4.1 to 800xA 5.1 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Self defined serial 
communication using 
the Serial 
Communication 
Library.

(continued)

The Serial 
Communication Library 
has undergone a major 
internal redesign that in 
some cases may lead to 
compatibility issues.

(continued)

If the power fails, and a function block was in a 
pending state, the Status -5331 is derived from 
it after the controller is powered up again.

• Behavior of the SerialWriteWait 
function block in previous versions: If 
the function block was triggered after the 
application stopping phase was entered, 
the function block should normally 
propagate status code -15. But this was 
masked, and instead, after the finished 
application change, the function block 
automatically retriggered the write 
operation.

Table 12. 800xA 4.1 to 800xA 5.1 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Self defined serial 
communication using 
the Serial 
Communication 
Library.

(continued)

The Serial 
Communication Library 
has undergone a major 
internal redesign that in 
some cases may lead to 
compatibility issues.

(continued)

Printing a string longer than 140 characters:

The behavior of the SerialWrite operation is no 
longer synchronous. Therefore, the possibility 
to call one and the same function block time 
after time to print a longer string than 140 
characters is no longer supported.
Instead, do like the following:

To be able to print a string longer than the 
maximum length of 140 characters, call 
subsequent function blocks in order:

Write1( Req := TRUE, 

           Id := Id, 

            EndChar := EndChar_Write1, 

            Done => Done_Write1, 

            Error => Error_Write1, 

            Status => Status_Write1, 

            Sd := Sd_Write1 );

Write2( Req := TRUE, 

           Id := Id, 

            EndChar := EndChar_Write2, 

            Done => Done_Write2, 

            Error => Error_Write2, 

            Status => Status_Write2, 

            Sd := Sd_Write2 );

Printing the two strings Sd_Write1 + Sd_Write2 
by calling the two function blocks will be queued 
up, and it will be printed in a series.

Table 12. 800xA 4.1 to 800xA 5.1 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Compiler warnings 
occur if there is a risk 
for task collisions.

If there is a risk that tasks 
can collide in the 
controller, a warning will 
be displayed during 
compilation. The 
compilation warning will 
look like:

Warning 9155: 
Controller_1:HW 
Task Normal and 
Fast may have 
colliding start 
times

Apply proper task offsets so that the tasks can 
no longer collide.

Applications using 
SattBus on TCP/IP.

SattBus on TCP/IP will not 
work after the upgrade.

The COMLI 
communication function 
blocks have been used 
also for SattBus on 
TCP/IP, but this is no 
longer the case. A new 
library including a set of 
new function blocks 
should be used instead.

Change the application to use function blocks 
and data types from SattBusCommLib as 
follows:

Function Blocks

Before After

COMLIConnect ComliSBConnect

COMLIRead ComliSBRead

COMLIReadCyc ComliSBReadCyc

COMLIReadPhys ComliSBReadPhys

COMLIWrite ComliSBWrite

COMLIWriteDT ComliSBWriteDT

Data Types

Before After

Comm_Channel_COMLI
Comm_Channel_ComliSB

Table 12. 800xA 4.1 to 800xA 5.1 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Some project 
constants have been 
removed from 
SupervisionBasicLib 
(cSinit.*), BasicLib 
(cEnable.*), and 
SupervisionLib 
(cInit.*). Refer to 
Removed Project 
Constants on page 
436 for a list of the 
removed project 
constants.

1. If these project 
constants have been used 
in code there will be 
compile errors after 
upgrading the project.

2. If the value of the 
project constants was 
changed in the project in 
800xA 5.0 SP1a, it will 
lead to changed behavior 
of the code after the 
upgrade, because these 
project constants have 
been used as default 
values on parameters.

1. Change to the correct literal value in the 
places where the project constants are used.

2. Check if the value of the removed project 
constant was changed in the project in 800xA 
5.0 SP1a. This can be done by opening the 
Project Constants dialog box after the upgrade 
and seeing if the project constants are listed.

In that case the parameters previously using 
the project constant as a default value must be 
manually connected to a literal with the 
corresponding value.

Table 12. 800xA 4.1 to 800xA 5.1 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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800xA 3.1 SP3 to 800xA 5.0 SP2 Compatibility Issues
Table 13 lists and describes Control Builder M compatibility issues, including 
solutions to the issues, when upgrading from 800xA 3.1 SP3 to 800xA 5.0 SP2.

Table 13. 800xA 3.1 SP3 to 800xA 5.0 SP2 Control Builder M Compatibility Issues

Application Issue Solution

No Time Sync 
warning in controller

Some controllers might 
get a No time sync 
warning in the controller 
log after upgrade to 
800xA 5.0 SP2.

Set the CS Protocol Type for controllers that are 
not intended to be synchronized No Synch in 
order to avoid the warning.

Valid for users that 
have copied a 
template object from, 
for example, a 
Process Object 
Library, and are using 
its Display Element 
Reduced Icon.

The Visual BASIC ® resize 
code of the Display 
Element Reduced Icon 
becomes corrupt after 
deploy in Graphics 
Builder.

Remove the source comments around the 
UserControl_Resize method before deploying 
the Display Element Reduced Icon. 

Edit the Display Element Reduced Icon, 
removing the comments, and then deploy the 
Display Element Reduced Icon.

The source comments are:

‘ 
$$ABB_BEGIN_USERCONTROL_RESIZ
E

---

‘ $$ABB_END_USERCONTROL_RESIZE

NOTE: Delete only the comment lines. Do not 
delete the source code between the comment 
lines.

Internal MMS 
Communication 
between applications 
residing in the same 
controller.

The behavior of internal 
communication between 
two applications in the 
same controller has 
changed.

This kind of communication is now 
asynchronous; all data may no longer always 
be received in the same scan.
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User-Defined 
Hardware Definition 
Files when 1131-
application variables 
of type dInt and 
dWord are written 
from the application 
to I/O-channels.

The behavior has been 
undefined when the 1131-
variable has a very large 
value (larger than the 
maximum value possible 
to write on a specific 
hardware unit). The very 
large value has really 
been truncated, a 
hardware unit receiving 8-
bit data has received the 8 
lowest bits in the dInt or 
dWord.

The behavior is redefined as follows:

• The hardware unit will be written with the 
largest, which is different depending on 
hardware, possible value if 1131-variable 
has a very large positive value.

• The hardware unit will be written with the 
largest, which is different depending on 
hardware, negative value if 1131-variable 
has a very large negative value.

FF HSE input I/O 
channels.

The mapping of FF-status 
in input I/O channels 
(BoolIO, RealIO, etc.) 
connected to CI860 
channels has been 
changed.

Previously, the FF-status of in-channels has 
been mapped into both the MSB and the LSB of 
the status word. This has changed so that the 
LSB now is remapped into OPC-status (since 
this byte now is sent to the OPC-server).

Example:

The FF status 16#80 was previously mapped 
as 16#80000080 into the status word in the I/O 
data type. It is from now mapped as 
16#800000C0. The result is that the OPC 
Server sends 16#C0 to its OPC clients.

Table 13. 800xA 3.1 SP3 to 800xA 5.0 SP2 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Accessing Local 
Variables in Function 
Blocks. 

It has been possible to 
access local variables in 
Function Blocks from 
surrounding code.

According to the IEC 
61131-3 standard, local 
variables shall only be 
accessible within the 
containing software 
element.

A compilation error is 
given if local variables are 
accessed from the 
outside.

Correct any such warnings before performing 
the download. Local variables used in this 
fashion need to be changed to parameters 
instead.

Table 13. 800xA 3.1 SP3 to 800xA 5.0 SP2 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Standard libraries 
included in AC 800M 
Connect.

NOTE: These issues 
are only valid for 
users that have used 
either 
SupervisionLib or 
FireGasLib. Other 
users will not be 
affected by these 
issues.

800xA 5.0 SP2 includes 
the new library versions 
as well as the old library 
versions in order to 
handle the upgrade for 
those who have used 
them. The use of the old 
versions is, however, not 
supported. Users must 
reconnect to the new 
library versions and 
modify applications before 
they go into supported 
operation.

SupervisionLib

1. Parameters for the Inhibit function in the 
detector modules are modified. Parameter 
names are changed; e.g. from 
GTHAndNotInhibited to GTHAct. Parameters 
are modified to comply with connected 
SignalLib library. The Inhibit logic is now placed 
inside the Function Blocks defined in SignalLib.

2. Parameters are added for the enable 
function; e.g. EnableH, GTHStat, and 
HEnabled. Parameters are added to comply 
with the connected SignalLib library. The 
Enable function was earlier limited to 
alarm/event, but is now controlling the 
activation signals (GTHStat and GTHAct) as 
well.

3. In Detector1Real and DetectorRemote, LevelH is 
used instead of LevelHHH. In Detector2Real, 
LevelH and LevelHH are used instead of LevelHH 
and LevelHHH. All affected parameter names are 
thus altered.

4. The CommonOutput control module is 
removed from the SupervisionLib library. The 
handling of common outputs is simplified and 
improved. The module OutputOrder shall be 
used instead of CommonOutput, for both 
common outputs and area outputs. This 
enables feedback supervision for both types of 
outputs.

5. One parameter is added on the OutputOrder 
control module; OrderIn. The OrderIn 
parameter enables connection to OrderOr 
modules, for common outputs activation logic.

6. On the OutputOrder module, parameters for 
activation due to connected protection systems 
are removed.

Table 13. 800xA 3.1 SP3 to 800xA 5.0 SP2 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Standard libraries 
included in AC 800M 
Connect.

NOTE: These issues 
are only valid for 
users that have used 
either 
SupervisionLib or 
FireGasLib. Other 
users will not be 
affected by these 
issues. (continued)

800xA 5.0 SP2 includes 
the new library versions 
as well as the old library 
versions in order to 
handle the upgrade for 
those who have used 
them. The use of the old 
versions is, however, not 
supported. Users must 
reconnect to the new 
library versions and 
modify applications before 
they go into supported 
operation. (continued)

7. The control modules DetectionSite, 
DetectionAreaGroup, DetectionArea are 
removed from the SupervisionLib library. These 
'example modules' gave a misleading guideline 
and was difficult to use because they had to be 
copied (instead of instantiated like other control 
module types).
An example project is delivered with Control 
Builder (instead of the removed modules), 
similar to other standard libraries.

800xA 5.0 SP2 includes 
the new library versions 
as well as the old library 
versions in order to 
handle the upgrade for 
those who have used 
them. The use of the old 
versions is, however, not 
supported. Users must 
reconnect to the new 
library versions and 
modify applications before 
they go into supported 
operation.

FireGasLib

1. A new control module type, FGOutputOrder, 
is added in FireGasLib. This is similar to the 
OutputOrder module in SupervisionLib, but with 
the parameters for activation due to connected 
protection systems (i.e. connected Co2, 
Deluge, Sprinkler modules).

2. The control modules FGSite, FireAreaGroup, 
FireArea are removed from the FireGasLib 
library. These example modules gave a 
misleading guideline and were difficult to use 
because they had to be copied (instead of 
instanciated like other control module types).

Table 13. 800xA 3.1 SP3 to 800xA 5.0 SP2 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Code sorting loops 
treated as errors.

Code sorting loops in 
applications are by default 
considered as errors in 
800xA 5.0 SP2.

It is not possible to 
compile and download an 
application if it contains 
code sorting loops.

First, try to correct the sorting loops. Refer to 
Interpret and Correct Code Loop Errors in 
Industrial IT, 800xA - Control and I/O, 
Application Programming, Introduction and 
Design (3BSE043723*).

Another alternative is to change the compiler 
switch for Code Sorting Loops:

1. Mark the project in Project Explorer.

2. Right-click and select Settings > Compiler 
Switch.

3. Set the global Loops in Control Modules 
switch to Warning.

Applications having 
integer literal values 
too large as initial 
values.

Compile error 1040 might 
appear in Control Builder 
projects that previously 
did not contain any 
compile errors.

Control Builder now 
makes more stringent 
compiler checks on initial 
values for variables. It 
previously allowed illegal 
(too large) integer literal 
values as initial values. 
The actual used value 
was zero.

Correct the compile error.

e.g. by entering a smaller, legal value on the 
literal.

Table 13. 800xA 3.1 SP3 to 800xA 5.0 SP2 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Applications using 
SattBus on TCP/IP.

SattBus on TCP/IP will not 
work after the upgrade.

The COMLI 
communication function 
blocks have been used 
also for SattBus on 
TCP/IP, but this is no 
longer the case. A new 
library including a set of 
new function blocks 
should be used instead.

Change the application to use function blocks 
and data types from SattBusCommLib as 
follows:

Function Blocks

Before After

COMLIConnect ComliSBConnect

COMLIRead ComliSBRead

COMLIReadCyc ComliSBReadCyc

COMLIReadPhys ComliSBReadPhys

COMLIWrite ComliSBWrite

COMLIWriteDT ComliSBWriteDT

Data Types

Before After

Comm_Channel_COMLI
Comm_Channel_ComliSB

Compiler warnings 
occur if there is a risk 
for task collisions.

If there is a risk that tasks 
can collide in the 
controller, a warning will 
be displayed during 
compilation. The 
compilation warning will 
look like:

Warning 9155: 
Controller_1:HW 
Task Normal and 
Fast may have 
colliding start 
times

Apply proper task offsets so that the tasks can 
no longer collide.

Table 13. 800xA 3.1 SP3 to 800xA 5.0 SP2 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Self defined serial 
communication using 
the Serial 
Communication 
Library.

The Serial 
Communication Library 
has undergone a major 
internal redesign that in 
some cases may lead to 
compatibility issues.

Use of firmware functions:

Firmware functions used for serial 
communication handling are no longer 
supported.

This means that user-built libraries where these 
firmware functions have been used, can no 
longer be used.

The no longer supported firmware functions 
are:

• OpenDevice

• UpdateDeviceSetup,

• SetDeviceClearRead

• CloseDevice.

• ReadStringDevice

• ReadLineDevice

• WriteStringDevice

Improvement were made in the following 
areas:

• Clear buffer when entering the listen 
operation of the SerialListen function 
block.

• If the SerialWriteWait function block is 
triggered when the timeout has elapsed, 
the read/listen buffer is cleared in between 
the retry operations in connection to the 
write operation.

Table 13. 800xA 3.1 SP3 to 800xA 5.0 SP2 Control Builder M Compatibility Issues (Continued)

Application Issue Solution
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Self defined serial 
communication using 
the Serial 
Communication 
Library.

(continued)

The Serial 
Communication Library 
has undergone a major 
internal redesign that in 
some cases may lead to 
compatibility issues.

(continued)

• Behavior of the SerialWriteWait 
function block in previous versions: If 
the function block was triggered after the 
application stopping phase was entered, 
the function block should normally 
propagate status code -15. But this was 
masked, and instead, after the finished 
application change, the function block 
automatically retriggered the write 
operation.

• Behavior of the SerialWriteWait 
function block in previous versions: If 
the function block is triggered after the 
application stopping phase is entered, the 
function block propagates the status code -
15 via the Status -parameter.

If the power fails, and a function block was in a 
pending state, the Status -5331 is derived from 
it after the controller is powered up again.

Table 13. 800xA 3.1 SP3 to 800xA 5.0 SP2 Control Builder M Compatibility Issues (Continued)

Application Issue Solution



800xA 3.1 SP3 to 800xA 5.0 SP2 Compatibility Issues Appendix B  Control Builder M Compatibility 

434 3BSE036342-511 G

 

Self defined serial 
communication using 
the Serial 
Communication 
Library.

(continued)

The Serial 
Communication Library 
has undergone a major 
internal redesign that in 
some cases may lead to 
compatibility issues.

(continued)

Printing a string longer than 140 characters:

The behavior of the SerialWrite operation is no 
longer synchronous. Therefore, the possibility 
to call one and the same function block time 
after time to print a longer string than 140 
characters is no longer supported.
Instead, do like the following:

To be able to print a string longer than the 
maximum length of 140 characters, call 
subsequent function blocks in order:

Write1( Req := TRUE, 

           Id := Id, 

            EndChar := EndChar_Write1, 

            Done => Done_Write1, 

            Error => Error_Write1, 

            Status => Status_Write1, 

            Sd := Sd_Write1 );

Write2( Req := TRUE, 

           Id := Id, 

            EndChar := EndChar_Write2, 

            Done => Done_Write2, 

            Error => Error_Write2, 

            Status => Status_Write2, 

            Sd := Sd_Write2 );

Printing the two strings Sd_Write1 + Sd_Write2 
by calling the two function blocks will be queued 
up, and it will be printed in a series.

Table 13. 800xA 3.1 SP3 to 800xA 5.0 SP2 Control Builder M Compatibility Issues (Continued)

Application Issue Solution



Appendix B  Control Builder M Compatibility Issues 800xA 3.1 SP3 to 800xA 5.0 SP2 Compatibility 

3BSE036342-511 G 435

 

ProcessObjectAE 
Function block 
parameter name 
change

The Name parameter on 
the ProcessObjectAE 
Function Block in 
AlarmEventLib has a 
changed name. The 
parameter is now called 
CondNameObjErr. 

This means that 
applications using the 
ProcessObjectAE will not 
be able to be downloaded 
after the upgrade. There 
will be compilation errors 
for unknown parameter 
names.

Applications using this Function Block need to 
be changed to use the CondNameObjErr 
parameter instead.

Some project 
constants have been 
removed from 
SupervisionBasicLib 
(cSinit.*), BasicLib 
(cEnable.*), and 
SupervisionLib 
(cInit.*). Refer to 
Removed Project 
Constants on page 
436 for a list of the 
removed project 
constants.

1. If these project 
constants have been used 
in code there will be 
compile errors after 
upgrading the project.

2. If the value of the 
project constants was 
changed in the project in 
800xA 5.0 SP1a, it will 
lead to changed behavior 
of the code after the 
upgrade, because these 
project constants have 
been used as default 
values on parameters.

1. Change to the correct literal value in the 
places where the project constants are used.

2. Check if the value of the removed project 
constant was changed in the project in 800xA 
5.0 SP1a. This can be done by opening the 
Project Constants dialog box after the upgrade 
and seeing if the project constants are listed.

In that case the parameters previously using 
the project constant as a default value must be 
manually connected to a literal with the 
corresponding value.

Table 13. 800xA 3.1 SP3 to 800xA 5.0 SP2 Control Builder M Compatibility Issues (Continued)
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Removed Project Constants
Some project constants have been removed from SupervisionBasicLib (cSinit.*), 
BasicLib (cEnable.*), and SupervisionLib (cInit.*).

SupervisionBasicLib (cSinit.*)

• cSinit.Latch shall be replaced by ‘true’.
• cSinit.LevelHH shall be replaced by ’80.0’.
• cSinit.LevelH shall be replaced by ’60.0’.
• cSinit.LevelL shall be replaced by ’40.0’.
• cSinit.LevelLL shall be replaced by ’20.0’.

BasicLib (cEnable.*)

SupervisionLib (cInit.*)

Table 14. BasicLib (cEnable)

cEnable.InputOverUnderRange bool Default value in library BasicLib 1.4-11 (bool): 
false

cEnable.OutputOverUnderRan
ge

bool Default value in library BasicLib 1.4-11 (bool): 
false

Table 15. SupervisionLib (cInit.*)

cInit.AckreqAtErr bool Default value in library SupervisionLib 2.3-7 (bool): 
false

cInit.AckReqToReset bool Default value in library SupervisionLib 2.3-7 (bool): 
false

cInit.ActOnError bool Default value in library SupervisionLib 2.3-7 (bool): 
false

cInit.AEClass dint Default value in library SupervisionLib 2.3-7 (dint): 
1



Appendix B  Control Builder M Compatibility Issues SupervisionLib (cInit.*)

3BSE036342-511 G 437

 

cInit.AEConfigCableBreak dint Default value in library SupervisionLib 2.3-7 (dint): 
0

cInit.AEConfigDetectorFaul
t

dint Default value in library SupervisionLib 2.3-7 (dint): 
0

cInit.AEConfigDiffInput dint Default value in library SupervisionLib 2.3-7 (dint): 
1

cInit.AEConfigDiffOutput dint Default value in library SupervisionLib 2.3-7 (dint): 
3

cInit.AEConfigErr dint Default value in library SupervisionLib 2.3-7 (dint): 
1

cInit.AEConfigH dint Default value in library SupervisionLib 2.3-7 (dint): 
1

cInit.AEConfigHH dint Default value in library SupervisionLib 2.3-7 (dint): 
1

cInit.AEConfigL dint Default value in library SupervisionLib 2.3-7 (dint): 
0

cInit.AEConfigLoopFault dint Default value in library SupervisionLib 2.3-7 (dint): 
0

cInit.AEConfigMaintenanc
e

dint Default value in library SupervisionLib 2.3-7 (dint): 
0

cInit.AEConfigPrewarn dint Default value in library SupervisionLib 2.3-7 (dint): 
1

cInit.AEConfigShortCircuit dint Default value in library SupervisionLib 2.3-7 (dint): 
0

cInit.AESevCableBreak dint Default value in library SupervisionLib 2.3-7 (dint): 
800

cInit.AESevDetectorFault dint Default value in library SupervisionLib 2.3-7 (dint): 
800

Table 15. SupervisionLib (cInit.*) (Continued)
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cInit.AESevDiffInput dint Default value in library SupervisionLib 2.3-7 (dint): 
800

cInit.AESevDiffOutput dint Default value in library SupervisionLib 2.3-7 (dint): 
300

cInit.AESevErr dint Default value in library SupervisionLib 2.3-7 (dint): 
800

cInit.AESevFeedback dint Default value in library SupervisionLib 2.3-7 (dint): 
300

cInit.AESevH dint Default value in library SupervisionLib 2.3-7 (dint): 
800

cInit.AESevHH dint Default value in library SupervisionLib 2.3-7 (dint): 
800

cInit.AESevL dint Default value in library SupervisionLib 2.3-7 (dint): 
800

cInit.AESevLoopFault dint Default value in library SupervisionLib 2.3-7 (dint): 
800

cInit.AESevMaintenance dint Default value in library SupervisionLib 2.3-7 (dint): 
800

cInit.AESevPrewarn dint Default value in library SupervisionLib 2.3-7 (dint): 
800

cInit.AESevReleased dint Default value in library SupervisionLib 2.3-7 (dint): 
300

cInit.AESevShortCircuit dint Default value in library SupervisionLib 2.3-7 (dint): 
800

cInit.AlarmLimit real Default value in library SupervisionLib 2.3-7 (real): 
40.0

cInit.ConfirmedLimitH dint Default value in library SupervisionLib 2.3-7 (dint): 
2

Table 15. SupervisionLib (cInit.*) (Continued)
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cInit.ConfirmedLimitHH dint Default value in library SupervisionLib 2.3-7 (dint): 
0

cInit.ConfirmedLimitOr bool Default value in library SupervisionLib 2.3-7 (bool): 
true

cInit.DelayTime time Default value in library SupervisionLib 2.3-7 (time): 
TIME#10s

cInit.EnableCommonReset bool Default value in library SupervisionLib 2.3-7 (bool): 
true

cInit.EnableRangeConvers
ion

bool Default value in library SupervisionLib 2.3-7 (bool): 
false

cInit.Latch bool Default value in library SupervisionLib 2.3-7 (bool): 
true

cInit.LevelCableBreak real Default value in library SupervisionLib 2.3-7 (real): 
1.0

cInit.LevelDetectorFault real Default value in library SupervisionLib 2.3-7 (real): 
3.0

cInit.LevelDiff real Default value in library SupervisionLib 2.3-7 (real): 
10.0

cInit.LevelLoopFault real Default value in library SupervisionLib 2.3-7 (real): 
3.5

cInit.LevelMaintenance real Default value in library SupervisionLib 2.3-7 (real): 
2.5

cInit.LevelShortCircuit real Default value in library SupervisionLib 2.3-7 (real): 
19.0

cInit.OneLevelH real Default value in library SupervisionLib 2.3-7 (real): 
10.0

cInit.OneLevelL real Default value in library SupervisionLib 2.3-7 (real): 
5.0

Table 15. SupervisionLib (cInit.*) (Continued)
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cInit.OutputResetDelay time Default value in library SupervisionLib 2.3-7 (time): 
TIME#1s

cInit.PrewarningLimit real Default value in library SupervisionLib 2.3-7 (real): 
5.0

cInit.RedIncDecLim real Default value in library SupervisionLib 2.3-7 (real): 
10.0

cInit.ResetTime time Default value in library SupervisionLib 2.3-7 (time): 
TIME#5s

cInit.ResponseTime time Default value in library SupervisionLib 2.3-7 (time): 
TIME#5s

cInit.RText string Default value in library SupervisionLib 2.3-7 
(string): 'R'

cInit.TwoLevelH real Default value in library SupervisionLib 2.3-7 (real): 
20.0

cInit.TwoLevelHH real Default value in library SupervisionLib 2.3-7 (real): 
60.0

cInit.UseLevelPar bool Default value in library SupervisionLib 2.3-7 (bool): 
True

Table 15. SupervisionLib (cInit.*) (Continued)
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Appendix C  Online Upgrade Controller Level

The information in this appendix is intended only as a high level introduction to the 
online upgrade of the controller level. Detailed information appears in the controller 
and control software instructions.

Online Upgrade Controller Level
Redundant AC 800M controllers can be upgraded with new firmware versions 
online. Online upgrade is initiated from Control Builder by a nine-step wizard. 
Refer to the Maintenance and Troubleshooting section in 800xA - Control and I/O, 
Basic Control Software, Introduction and Configuration (3BSE035980R*) for more 
information.

In order to use online upgrade for the controller level:

• Refer to the Control and I/O, Control Software for AC 800M section of System 
800xA Release Notes New Functions and Known Problems (2PAA106188*) for 
the controller versions that support online upgrade.

• AC 800M Controllers require the client and server level to be of the same or 
higher 800xA System version/revision.

• AC 800M Controllers must be redundant. A redundant controller consists of 
two redundant processing units connected to I/O modules or CI modules.

• AC 800M Controller firmware and its CI modules can be upgraded 
independently. 

– AC 800M controller firmware and the SM810 (safety) CI module must be 
upgraded simultaneously.

• Different AC 800M Controllers with different 800xA System 
versions/revisions can coexist. This allows for extensions of an 800xA System 
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with new AC 800M Controllers or other new 800xA System functionality 
without having to upgrade all existing controllers. 

– Starting from 800xA 5.0, upgrading to newer versions of Control Builder 
and/or OPC Server does not require a controller upgrade. Controllers with 
different firmware versions can coexist in the same network, and newer 
versions of Control Builder and OPC Server can connect to controllers of 
older versions (not older than 800xA 5.0). Refer to the Control and I/O, 
Control Software for AC 800M section of System 800xA Release Notes 
New Functions and Known Problems (2PAA106188*) for the controller 
versions that support coexistence.

– Hardware types can coexist in different 800xA System versions/revisions 
in the same 800xA System.

– Controllers that need to take advantage of new functionality are the only 
ones that have to be upgraded. Other controllers can remain untouched. 
This backwards compatibility is typically kept for two previous system 
versions.

• Upgrading nonredundant AC 800M Controllers is accomplished with 
minimized plant disturbance by stopping and upgrading one controller at a 
time. The client and server level can still be upgraded online, as long as the 
conditions are met for performing an online upgrade on the client and server 
level.

Hot swap is the method to be used for a nonredundant AC 800M controller with 
redundant CI modules and unchanged controller firmware.

Flowchart for Upgrading Controller Level
Figure 69 shows the upgrade flow for the controller level.
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Figure 69. Online Upgrade Flowchart for Controller Level
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Flowchart for Extending Controller Level
Figure 70 shows the flow for extending the controller level to add new AC 800M 
Controllers with the latest 800xA System version/revision to an existing plant with 
or without upgrading the existing AC 800M Controllers.  

T05264A

Figure 70. Flowchart for Extending Plant with New Controllers
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Appendix D  Consistency Check

This Appendix describes the consistency check performed on the 800xA 
System.

The following is an overview of the consistency check functionality in the 
800xA System.

• Perform consistency checks both before and after the upgrade.

• The consistency check is continuously improved between releases. If a 
consistency error is detected after the upgrade, it does not necessarily mean that 
the error was introduced by the upgrade process. It might have been there from 
the beginning, but went undetected.

• Try to correct all consistency errors before the upgrade. This will make the 
upgrade process easier. Consistency errors may cause the upgrade to either fail, 
or continue, but without having done exactly what was intended. Since it is 
very difficult to know where the upgrade handling will do changes, it is 
desirable to make the system as consistent as possible before the upgrade. It is 
also good to keep a system with the old version running so it is possible to go 
back and do more corrections in the old system if problems occur during the 
upgrade.

– However, the upgrade will often work even though there are some 
remaining consistency errors. In some cases it is easiest to correct the 
errors after the upgrade (because the repair functionality has been 
improved in the new release), so it may be worth an attempt at continuing 
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with the upgrade. It is recommended to keep a list of the detected 
consistency errors for future reference.

• In 800xA 5.0 and later, perform the consistency check with the Consistency 
Check tool (started by clicking the question mark icon in top right corner of 
Plant Explorer Workplace). In 800xA 4.1 the Consistency Checker aspect must 
be used.

• Perform consistency checks on the user-defined libraries in the Object Type 
Structure or Library Structure, the Control Project in Control Structure, 
and the Functional Structure.

• The general part of the upgrade process consists of importing new versions of 
standard libraries, and propagating object type changes to user libraries and 
user applications. It is only necessary to correct consistency errors regarding 
object type, object type references, and similar configurations for the general 
part of the upgrade process to work. Other inconsistencies such as unresolved 
references should normally not lead to problems.

– However, special upgrade handling designed by the Functional Areas may 
also update the references of aspects, so it is best to correct also broken 
references before the upgrade.

– In the Library structure, navigate to Library Version Definition aspect 
present in the user defined libraries. Select the Consistency tab and click 

During the consistency check the following error messages might come from 
PROFIBUS Hardware Libraries in system version 5.0 and later:

[Error] Library key must not be used on
'ABB_TFx12_PA 1.2-0:Aspect Category
Definition'. ... : Library Version Definition
[Error] Aspect 'ABB_TFx12_PA 1.2-
0:Hardware Library' contains multiple library
keys. ... : Library Version Definition
[Error] Library key must not be used on
'ABB_TFx12_PA 1.2-0:Object Type
Structure'. ... : Library Version Definition
3 error(s) reported by 1 aspect(s).
1 aspect(s) can be repaired

This will have no impact on system upgrade.
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Check Consistency. Correct any errors that may appear during the 
consistency check (This is valid for 800xA 4.1 and 800xA 5.0 systems).

Performing the Consistency Check
In 800xA 5.0 and later, perform the consistency check with the Consistency Check 
tool (started by clicking the question mark icon in top right corner of Plant Explorer 
Workplace). In 800xA 4.1 the Consistency Checker aspect must be used. This 
instruction only includes the 800xA 5.0 and later procedure. Refer to System 800xA 
Tools (2PAA101088*) for more detailed information on running the 800xA 5.1 
consistency check. The 800xA 4.1 procedure can be found in 800xA 4.1 specific 
documentation. 

Perform the following to perform a consistency check:

1. Open a Plant Explorer Workplace.

2. Click the Consistency Check Tool icon at the top of the Plant Explorer 
Workplace to launch the Consistency Check Tool.

3. Click Add Item to launch the Select Item dialog box.

4. Browse to the desired location.

5. Select the desired items (use Ctrl+Click or Shift+Click to select multiple 
items). If a subtree is selected, all objects and aspects in the subtree will be 
selected. If a library or application is selected, everything in this entity will be 
selected.

6. Click Add and Close.

7. Click Check.

8. If errors are found, and they are marked Repairable, perform an automatic 
repair by selecting Repair Aspect in the context menu.

Perform a consistency check before performing the 800xA System backup. 
Failure to do so could result in problems when restoring the system after the 
upgrade.

If using Asset Optimization, be sure to run the Consistency Check tool and delete 
any inconsistent Asset Monitor Control Connection Properties aspects. 

Rather than performing Step 3 through Step 6 it is also possible to drag the 
desired items to the Consistency Check Tool. 
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9. If errors are found that are not automatically repairable, try to manually 
reconfigure the aspects to repair the consistency errors.

Returning to the Pre-Upgrade Procedures
These links are designed for online viewing. If using a hard copy, go back to the 
point in the procedure that referred to this appendix.

Click here to return to 800xA 5.0 SP2 to 800xA 5.1 Online Upgrade.

Click here to return to 800xA 5.0 SP2 to 800xA 5.1 Offline Upgrade.

Click here to return to 800xA 4.1 to 800xA 5.1 Offline Upgrade.

Click here to return to 800xA 3.1 SP3 to 800xA 5.0 SP2 Upgrade.

Returning to the Post Upgrade Procedures
These links are designed for online viewing. If using a hard copy, go back to the 
point in the procedure that referred to this appendix.

Click here to return to 800xA 5.0 SP2 to 800xA 5.1 Online Upgrade.

Click here to return to 800xA 5.0 SP2 to 800xA 5.1 Offline Upgrade.

Click here to return to 800xA 4.1 to 800xA 5.1 Offline Upgrade.

Click here to return to 800xA 3.1 SP3 to 800xA 5.0 SP2 Upgrade.
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Appendix E  Recording the Number of
Aspects and Objects

This Appendix records the number of aspects and objects in the system in order to 
compare the number before the 800xA System Backup and after the 800xA System 
Restore.

Recording the Number of Aspects and Objects in the 
System

Perform the following procedure to record the number of aspect and objects in the 
system.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Admin Structure.

3. Use the Object Browser to navigate to:

Administrative Objects\Domains\system_name, Domain

4. Select Domain Definition in the Aspect List Area.

5. Record the number of objects and aspects listed in the System Size Information 
frame in the Preview Area.

6. Use the Structure Selector to open the Control Structure.

7. Use the Object Browser to navigate to:

control_network_name, Control Network

of one of the control networks contained in the system.

8. Right-click the Control Structure aspect and select Details from the context 
menu.
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9. Select the Statistics tab.

10. Record the number of objects listed.

11. Right-click the Control Structure aspect within a controller project of the 
control network selected in Step 7.

12. Select Details from the context menu.

13. Record the number of objects listed.

14. Repeat Step 11 through Step 14 for all the controller projects within the control 
network.

15. Repeat Step 7 through Step 14 for every control network in the system. 

16. Use the Object Browser to navigate to:

HSE_Subnet name, HSE Subnet

of one of the HSE Subnets contained in the system.

17. Right-click the Control Structure aspect and select Details from the context 
menu.

18. Select the Statistics tab.

19. Record the number of objects listed.

20. Repeat Step 16 through Step 19 for every HSE Subnet in the system.

21. Use the Object Browser to navigate to:

MB300 name, MB300 Network

of one of the MB 300 Networks contained in the system.

22. Right-click the Control Structure aspect and select Details from the context 
menu.

23. Select the Statistics tab.

24. Record the number of objects listed.

Step 11 through Step 15 are not applicable to systems with only 800xA for 
Harmony. 

The number of aspects and objects after system restoration should be in the same 
range as those recorded during system backup, although there will likely be more.
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25. Repeat Step 21 through Step 24 for every MB300 network in the system.

Returning to the Pre-Upgrade Procedures
These links are designed for online viewing. If using a hard copy, go back to the 
point in the procedure that referred to this appendix.

Click here to return to 800xA 5.0 SP2 to 800xA 5.1 Online Upgrade.

Click here to return to 800xA 5.0 SP2 to 800xA 5.1 Offline Upgrade.

Click here to return to 800xA 4.1 to 800xA 5.1 Offline Upgrade.

Returning to the Post Upgrade Procedures
These links are designed for online viewing. If using a hard copy, go back to the 
point in the procedure that referred to this appendix.

Click here to return to 800xA 5.0 SP2 to 800xA 5.1 Online Upgrade.

Click here to return to 800xA 5.0 SP2 to 800xA 5.1 Offline Upgrade.

Click here to return to 800xA 4.1 to 800xA 5.1 Offline Upgrade.

The number of aspects and objects after system restoration should be in the same 
range as those recorded during system backup, although there will likely be more.
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Appendix F  Information Management
Upgrade

This Appendix describes the Information Management upgrade procedures.

Information Management Pre-Upgrade Procedures
Perform the following procedures to prepare for the Information Management 
upgrade.

End Microsoft Excel Process via Windows Task Manager

Use Windows Task Manager to manually end the EXCEL.EXE process.

Recording Archive Group Associations

Archive Groups are associated with Profile, Message, and Report logs.

1. Record these associations so that after the upgrade, these logs can be 
reassociated with their respective Archive Groups. Refer to the Reading and 
Managing Archive Data section in Industrial IT, 800xA - Information 
Management, Data Access and Reports (3BUF001094*) to access the Archive 
Groups and record the information.

2. Back up the path to Archive Group Numeric Log Entry and IM Objects Entry.

This appendix is not applicable to the 800xA 3.1 SP3 to 800xA 5.0 SP2 upgrade 
path. Refer to Section 6, Upgrading 800xA 3.1 SP3 to 800xA 5.0 SP2 for more 
information.

Recording archive group associations only applies to 800xA 4.1 to 800xA 5.1 
upgrades.
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ABB Process Administration Service (PAS)

Perform the following procedure to run the PAS utility.

1. Run the Process Administration Service (PAS) utility on the Information 
Management Application Server node. From the Windows Taskbar select:

Start > Administrative Tools > PAS > Process Administration

This opens the Process Administration Service dialog box. 

2. Click Stop All to stop all processes under PAS supervision. 

3. Click Close when the dialog box indicates that all processes are stopped.

4. Use standard Windows procedures, via the Services selection from 
Administrative Tools in Windows Control Panel, to place the ABB Process 
Administration Service into manual and insure that it is stopped.

Cleaning the History Database

It is recommended that the history database be cleaned before making the backup.

1. Open a Windows Command Prompt and enter hsDBMaint -checkDB.

2. If any problems are found, enter hsDBMaint -clean to fix them.

Information Management History Backup and Restore Utility

Use the Information Management History Backup/Restore utility to create all the 
backup files that are required to completely back up the Information Management 
History database. This includes all configuration data, log data from both file-based 
and ORACLE-based logs, and the Aspect System definition file.

During a backup operation, all data in the Oracle database owned by the Oracle 
History user is exported to the specified destination and compressed into a zipped 
archive, along with any files that have been created to store file-based property log 
entries (called flat files). 

The History database can be backed up to any drive, including any mapped network 
drives. The disk type should be NTFS for the backups. 

The IM Server must be connected to an active aspect system at this time. The 
following steps require acesss to the aspect directory.
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To avoid any ambiguity, the backup operation produces a zipped archive of 
compressed History database files for each drive that contains at least some portion 
of the database, where each archive contains only the database files that are stored 
on the corresponding drive. The backup utility uses the naming convention 
name-drive.zip for the zipped archives that it produces. For example, if the 
History database is located entirely on the C:\ drive and you wish to back up the 
database to a zipped archive called hist, the backup operation will compress the 
database files into a zipped archive named histDB-C.zip.

If the data files exceed two gigabytes, or if there are more than 25,000 files, then 
multiple zip files will be created using the following naming convention:

• First File name-drive.zip
• Next File name-drive0001.zip
• Next File name-drive0002.zip

When backing up the History database, make sure the disk is ready and available on 
the node on which the procedure is to occur. The log file should be checked after the 
backup operation to make sure that the backup operation completed successfully. 

Make sure the system drive is not getting full. Temp space is required to make the 
backup. If the log file indicates that the Oracle export failed, additional options can 
be passed to hsBAR to use another disk for the Oracle export.

To make a backup:

1. Select:

Start > All Programs > ABB Industrial IT 800xA > Information 
Mgmt > History > Backup and Restore

2. Verify the Create Backup Files of Current Configuration option is enabled 
in the IM Historian Backup/Restore Utility window.

3. Click Next. A window for setting up the backup operation is displayed.

4. Specify the location where the backup files are to be created in the New 
Directory Path for the Backup field. Create a new directory such as 
E:\IMbackupSV5SP2. 

The backup of the History data must be in a directory of its own, not the 
D:\HSDATA\History directory. If the data is put into the D:\HSDATA\History 
directory, it will get lost.
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a. Specify additional hsBAR options if needed. When the system drive is low 
on space, it is typical to specify: 

-a D:\Export

The -a option enables an alternate location for temporary and Oracle DB 
export files during the backup process. The folder should be created ahead 
of time and the files system must be NTFS. Use this option to specify a 
different folder for the oracle export file. 

5. Verify the Only Generate Aspect Definition File option is disabled.

6. Click Next. The HsBAR Output Window is displayed.

7. Select the Automatically Close Upon Completion option.

8. After the HsBAR Output Window closes, monitor the progress in the Progress 
Status area of the IM Historian Backup/Restore Utility window and click 
Finish when the backup is complete. 

Saving Other Information Management Related Files

There are several other files related to Information Management to be saved as part 
of a total system backup.

• History Archive Data: For each archive device, go to the location specified by 
the Device Filename and copy the folders under that directory to a safe 
location. Do this even if automatic backup is configured. If the automatic 
backups are on local disks, locate these folders and back them up to a safe 
location.

• History Archive State Information: The folder that holds the last archive 
time and other archive state information must be copied to a safe location. The 
folder name is Archive and it is located in:

...\Documents and Settings\All Users\
Application Data\ABB\IM\Archive

If a message appears stating that there are inconsistencies between the log 
configurations in the Aspect System and the log configurations in Oracle, it may 
be because the database was not cleaned before running the backup. Use the 
hsDBMaint -clean function to clean the database and then rerun the backup. If 
this does not fix the problem, contact ABB Technical Support for further 
assistance.
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Copy the entire folder.

• Reports: Save any report template files created in Microsoft Excel, 
DataDirect, and/or Crystal Reports ®. Also save report output files created as a 
result of running these reports via the Scheduling Services.

• Desktop Trends: Back up trend display, ticker display, and tag explorer files.

– Ticker files are located in:

...\Documents and Settings\~username\My Documents\ABB 
Industrial IT\Inform IT\Desktop Trends\Ticker Files

– Trend Files are located in:

...\Documents and Settings\~username\My Documents\ABB 
Industrial IT\Inform IT\Desktop Trends\HTML

– Tag Explorer files are located in:

...\Documents and Settings\~username\Application 
Data\ABB Industrial IT\Inform IT\Desktop Trends

• Display Services: Back up the directories for custom users, as well as display 
and user element definitions. The files are located in:

...\Program Files\ABB Industrial IT\Inform IT\Display 
Services\Server\Data

Save the user-built svg and uet files.

• DataDirect: Back up custom text files for object, object type, and attribute 
menus used on the DataDirect windows. The files are located in:

...\Program Files\ABB Industrial IT\Inform IT\Data 
Direct\etc.

Save the user-built text files.

Returning to the Pre-Upgrade Procedures
These links are designed for online viewing. If using a hard copy, go back to the 
point in the procedure that referred to this appendix.

Click here to return to 800xA 5.0 SP2 to 800xA 5.1 Online Upgrade.
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Click here to return to 800xA 5.0 SP2 to 800xA 5.1 Offline Upgrade.

Click here to return to 800xA 4.1 to 800xA 5.1 Offline Upgrade.

Information Management Post Upgrade Procedures
Perform the following post upgrade procedures for Information Management. Files 
only have to be restored when a new node is being loaded from backups. The Oracle 
upgrade and database conversion procedure will upgrade existing or restored 
files.

Reconfiguring the IM Log Configuration

After restoring a system containing IM logs, the Service Group for the IM log 
template configuration might be missing. The IM log templates must be checked, 
and if the Service Group is missing, a new Service Group must be configured.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Library Structure.

3. Use the Object Browser to navigate to:

When creating the Oracle instance, select I am upgrading from SV3.x or SV4.x 
or newer system in the Configuration File Options dialog box to prevent the 
wizard from creating a history database. This will prevent History from starting 
until after the History Database is restored.

The procedures presented here are different than those in System 800xA Post 
Installation (3BUA000156*). Unless otherwise noted, perform the procedures 
presented here.

When creating the database, it is possible to select small, medium, or large for the 
database size. If it is not known what the size of the database will be, select large.

PAS is not initialized at this point in the process, and it should not be.

When the procedure is followed, the IM service group is preserved and all Log 
Configurations should have a valid setting. If there is not a valid setting, a 
previous step was not followed and this procedure will correct the problem.
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History Log Templates, History Log Template Library > 
Default Log Templates, History Log Template Library

4. Select a log template.

5. Select Log Template in the Aspect List Area.

6. Select the Log Definition tab in the Preview Area.

7. If the Service Group in the Service Group drop-down list box is missing, it 
must be reconfigured. The Service Group drop-down list box contains all 
History servers defined in the system. Use this list to specify the server where 
this log will reside.

8. Repeat this procedure for all of the log templates.

Information Management History Backup/Restore Utility

Use the Information Management History Backup/Restore utility, via:

Start > ABB Industrial IT 800xA > Information Mgmt > History > 
Backup and Restore

to restore the Information Management History database and synchronize the 
Aspect Directory contents with the current Information Management History 
database configuration.

During the restore, the existing database is dropped, and a new one is created. 
Mount points and additional table spaces are created based on the database being 
restored. Oracle data is imported, and the file-based property logs are copied back 
into the system. Unless a different mount point is specified, the History database 
will be restored to its original location (its location prior to being backed up). 

The History database can be restored from any drive, including any mapped network 
drives. The restore utility will first search a specified location for zipped archives 
matching a specific name and fitting the form name-drive.zip (such as histDB-
C.zip, histDB-A.zip, and histDB-D.zip), and will then restore the 
compressed database files contained within the archives to their respective original 
locations (their locations prior to being backed up). 
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Considerations

When restoring the History database, make sure the disk is ready and available on 
the node on which the procedure is to occur. Also, ensure that no applications are 
accessing the Oracle database. The log file should be checked after the restore 
operation to make sure that the restore operation completed successfully. 

Running the Information Management History Backup/Restore Utility

To restore a backed up History database:  

1. Verify that the ABB Process Administration Service (PAS) is set to manual in 
the Services Control Panel (run Services.msc from the Run dialog box). Stop 
the service if it is running.

2. If it is suspected that the Inform IT History Service Provider has not stopped, it 
can be stopped now by selecting the Inform IT History Service Provider for this 
node in the Service Structure, selecting the Configuration tab on the Service 
Provider Definition aspect, disabling Enabled, and clicking Apply.

3. Ensure that no third party applications access the Oracle database during the 
restore operation. 

4. Before restoring the database, it is necessary to create an Oracle database to 
restore the backup.

a. Start the Oracle Instance wizard using:

Start > All Programs > ABB Industrial IT 800xA > Information 
Mgmt > History > Oracle Instance Wizard

b. Create a database to restore an 800xA 3.x, 800xA 4.1 or 800xA 5.x 
system. Be sure to select the correct size for the database. If the previous 
system had more than four million entry message logs, select large, for 

This procedure can also be performed by using the pasgui command in the Run 
dialog box (Start > Run).

If PAS is not in the manual mode, it is possible the log configuration has been 
modified and will not match the IM backup. If this is the case, the 800xA System 
Restore may have to be repeated to correct the problem.
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one to four million select medium, and for less than one million select 
small.

5. Restore the database. Select:

Start > All Programs > ABB Industrial IT 800xA > Information 
Mgmt > History > Backup and Restore.

6. Verify Restore configuration from a backup file(s) is enabled in the 
Welcome to IM Historian Backup and Restore Utility dialog box.

7. Click Next. IM Historian Database Restore dialog box appears (Figure 71). 

If a database previously existed, drop it and create the correctly sized database.

TC08390A

Figure 71. IM Historian Database Restore Dialog Box
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8. Specify the location of the backup files in the Path of IM historian backup: 
field (Figure 71).

9. Click Next. The HsBAR Output Window appears.

10. Select the Automatically close upon completion check box. 

11. Monitor the progress in the Progress Status area of the IM Historian 
Backup/Restore Utility window. Ignore the error messages indicating errors 
deleting aspect.

Shortly after the message indicating the import is complete, the database 
conversion tool will run automatically. Feedback will be provided in the 
HsBAR window.

Shortly after the message indicating the database conversion is complete, the 
history synchronization tool will run automatically. Again, feedback will be 
provided in the HsBAR window. 

If new mount points need to be specified for file-based logs and/or a new Oracle 
tablespace definition file, click Browse. This will be required if the partition 
letters where the IM data is stored have changed.

The restore of the system requires an instance that matches the size of the 
database being restored. When creating the instance, be sure to select Small, 
Medium, or Large based on the size of the message log in the backup being 
restored. Select Large if the size is not known. If the wrong size is selected, the 
restore operation may fail with the Oracle Error Message 1652 - Unable to 
extend tmp segment in tablespace temp. Repeat the restore with the 
correct instance settings if the error occurs. This will not happen if the correct 
database for upgrade is selected. For example, if the database is using a 12 
million entry OPC message log, the large option should be selected. This will 
insure that enough TEMP and rollback are created.
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12. Click Finish when a message stating the execution is complete is displayed as 
shown in Figure 72.

If the Progress Status dialog box has warning messages with possible solutions as 
indicated in Figure 73, read the possible solutions carefully, then click Finish and 

TC08391A

Figure 72. Execution is Complete Message
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proceed with the solution that best fits your problem. Refer to the Information 
Management Release Notes for further guidelines.

Restoring Other Information Management Related Files

There are several other files related to Information Management that need to be 
restored as part of total system restore. 

• History Archive Data: For each archive device, copy the appropriate folders 
from the safe media to the location specified by the Device Filename. If the 
disk configuration has changed from the previous system to the new system 
(i.e. letter designations for disks have changed: C, D, E, etc.), check the archive 
device configurations to make sure the Archive Path specification points to the 

TC08392A

Figure 73. Progress Status Dialog Box
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correct disk drive and directory, as shown in Figure 74. Repeat for the backup 
archive path if configured.

• History Archive State Information: Stop the Industrial IT Archive service in 
the Service Structure. Copy the folder that holds the last archive time and 
other archive state information from the safe media to:

c:\programData\ABB\IM\Archive

• Reports: Restore any report template files created in Microsoft Excel, 
DataDirect, and/or Crystal Reports. Also restore report output files created as a 
result of running these reports via the Scheduling Services.

• Desktop Trends: Restore trend display, ticker display, and tag explorer files to 
the following path:

C:\Users\800xaservice\AppData\Roaming\ABB Industrial 
IT\Inform IT\Desktop Trends

TC08388A

Figure 74. Checking the Archive Path Specification
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• Display Services: Restore the directories for custom users, as well as display 
and user element definitions to the following path:

...\Program Files(x86)\ABB Industrial IT\Inform 
IT\Display Services\Server\Data

• DataDirect: Restore custom text files for object, object type, and attribute 
menus used on the DataDirect windows to the following path:

C:\ProgramData\ABB\IM\DataDirect\etc

Starting PAS

1. Open the Services Control Panel (run Services.msc from the Run dialog box), 
set the ABB Process Administration Service (PAS) to Automatic and start it.

2. Open the Information Management Configuration Assistant (Start > All 
Programs > ABB Industrial IT 800xA > Information Mgmt > 
Configuration Assistant) and perform any incomplete steps.

3. Select the Basic History Service Provider object for the Information 
Management node in the Service Structure in the Plant Explorer.

4. Select the Service Provider Definition aspect.

5. Select the Configuration tab.

6. Clear the Enabled option.

7. Click Apply.

8. Select the Enabled option.

9. Click Apply.

Restoring Archive Group Associations

Profile, Message, and Report logs must be reassociated with their respective 
Archive Groups. This information was recorded before beginning the upgrade. 
Refer to Industrial IT, 800xA - Information Management, Configuration 
(3BUF001092*) to access the Archive Groups and restore the Archive Group 
associations.

Restoring archive group associations only applies to 800xA 4.1 to 800xA 5.1 
upgrades.
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Instance_config.txt File Creation

The instance_config.txt file needs to be recreated (using the following procedure) if 
both of the following conditions are met:

• An existing database has not been restored.
• The node is using the Windows 2008 Server Operating System.

To create the instance_config.txt file:

1. Select:

Start > All Programs > ABB Industrial IT 800xA > Information 
Mgmt > History > Oracle Instance Wizard

2. Click Apply. The instance_config.txt file will be created in the following 
directory:

c:\programData\ABB\IM\History

This folder is defined as %HS_DATA% environment variable.

Updating Archive Logs

Absolute names are now included as part of the archive storage. Archive links now 
use an absolute reference that is independent of the name of the log. Run the archive 
maintenance to update the _RST log references to use the absolute log 
reference.

1. Open a Plant Explorer Workplace.

2. Use the Object Browser to navigate to:

IM Node > Archive Service Provider

3. Click Archive Service Aspect in the Aspect List Area.

4. Click Maintenance in the Preview Area to launch the Maintain Archive 
References dialog box.

5. Click Validate Archive Logs.

This procedure is not necessary if archives are not being used.

This procedure only needs to be performed one time no matter how many 
Information Management nodes are in the system.
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6. Run a consistency check on all log configurations.

Information Management Maintenance

Perform this procedure on all Information Management Server nodes.

1. Open a Plant Explorer Workplace.

2. Use the Structure Selector to open the Node Administration Structure.

3. Use the Object Browser to navigate to:

All Nodes, Node Group > IM Node > Inform IT History_IM 
Node, Service Provider > Inform IT History Object, 
Inform IT History Object

4. Select Inform IT History Control in the Aspect List Area.

5. Expand the Maintenance tree in the Preview Area and select 
Synchronization. The Inform IT History Manager shown in Figure 75 
appears in the Preview Area.

6. Click Check Names.

Figure 75. Inform IT HIstory Manager
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7. A blank dialog box should appear. If it does, click OK. If it does not click 
Resynchronize Names.

8. Click Check Synchronization.

9. A blank dialog box should appear. If it does, click OK. If it does not click 
Force Synchronization.

Running hsDBMaint -stagger

It is recommended to run hsDBMaint -stagger for all IM configurations. The 
defaults are adequate for most configurations. If the average request rate is near or 
over 1,000 per minute, refer to System 800xA Information Management 
Configuration (3BUF001092) for hsDBMaint -stagger recommendations.

1. Open a Windows Command Prompt and enter hsDBMaint -stagger.

2. When the operation is complete run the Process Administration Service (PAS) 
utility on the Information Management Application Server node. From the 
Windows Taskbar select:

Start > Administrative Tools > PAS > Process Administration

This opens the Process Administration Service dialog box.

3. Click Restart All to restart all processes under PAS supervision.

4. Click Close when the dialog box indicates that all processes are restarted.

Returning to the Post Upgrade Procedures
These links are designed for online viewing. If using a hard copy, go back to the 
point in the procedure that referred to this appendix.

Click here to return to 800xA 5.0 SP2 to 800xA 5.1 Online Upgrade.

Click here to return to 800xA 5.0 SP2 to 800xA 5.1 Offline Upgrade.

Click here to return to 800xA 4.1 to 800xA 5.1 Offline Upgrade.
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Appendix G  800xA for Harmony Upgrade

This Appendix describes the 800xA for Harmony upgrade procedures.

Special considerations must be given when upgrading 800xA for Harmony from the 
following:

• 800xA 5.0 SP2 to 800xA 5.1
• 800xA 4.1 to 800xA 5.1
• 800xA 3.1 SP2 to 800xA 5.1

The term upgrade refers to moving from one 800xA release to a later 800xA 
release, whether it is a major or minor release.

The term update refers to adding service packs, patches, hot fixes, or rollups to an 
existing 800xA System.

Execute the 800xA for Harmony System VerifyHelper.exe file (accepting all 
defaults) on all Harmony Servers and Aspect Servers BEFORE using the System 
Planner tool or performing any other upgrade or update procedure. 

This file is located on 800xA System Installation DVD 1 in the 

System installer\Installation 
Tools\Upgrade\HarmonyVerifyHelper

This is applicable only when upgrading from 800xA 4.1 to 800xA 5.1.

Refer to Section 3, Upgrading 800xA 5.0 SP2 to 800xA 5.1 Online to upgrade an 
existing 800xA 5.0 SP2 to 800xA 5.1 and Section 5, Upgrading 800xA 4.1 to 
800xA 5.1 Offline to upgrade 800xA 4.1 to 800xA 5.1. 
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Prerequisites

When an online upgrade of an 800xA 5.0 SP2 system is performed on a system that 
includes 800xA for Harmony, the 800xA 5.0 SP2 and 800xA 5.1 systems must be 
kept on separate network(s) until the 800xA 5.0 SP2 system is no longer required. 
For more information, refer to the Online Upgrade procedure provided in Section 3, 
Upgrading 800xA 5.0 SP2 to 800xA 5.1 Online. An online upgrade requires 
redundant Aspect Servers, Harmony Connectivity Servers and Domain Controllers 
in the case of a domain.

During an online upgrade the second domain controller must be promoted to a 
primary domain controller, upgraded to Server Operating System, the domain roles 
transferred to the node and finally moved to the isolated 800xA 5.1 network(s). In 
the case of a standalone Configuration Server node, the Configuration Server node 
must be upgraded before the primary Connectivity Server node. In the case of a 
combined 800xA for Harmony Configuration Server and Connectivity Server node, 
upgrade the combined server to 800xA 5.1 before the redundant Connectivity 
Server.

Node Order

The upgrade is a node-by-node procedure that must be performed in the following 
node order:

Online Upgrade Node Order

• Redundant Domain Controller. 
• Redundant Aspect Server(s).
• Configuration Server or 800xA for Harmony Configuration Server with 

Connectivity Server node.
• Primary Connectivity Server if not combined with Configuration Server.
• Application Server(s).

Two additional network switches are required for network isolation when 
performing an online upgrade.

Do not make any configuration changes on the 800xA system running the older 
version during the online upgrade.

This node order is different than what is described in Section 1, Introduction and 
System 800xA Automated Installation (3BSE034679*) user manual.



Appendix G  800xA for Harmony Upgrade 800xA for Harmony Upgrade Procedure

3BSE036342-511 G 473

• Client(s).
• Redundant Connectivity Server(s).
• Primary Connectivity Server.
• Primary Aspect Server.
• Primary Domain Controller.

Offline Upgrade Node Order

Upgrade redundant servers before primary servers.

• Domain Controller(s).
• Aspect Server(s).
• Configuration Server(s).
• Combined Configuration and Connectivity Server(s).
• Connectivity Server(s).
• Application Server(s).
• Client(s).

800xA for Harmony Upgrade Procedure
Perform the procedure as follows:

1. Create a backup of the 800xA System from the Maintenance structure. Refer to 
System 800xA Maintenance (3BSE046784*) user manual.

2. For an online upgrade in a domain environment, prepare the node to move to 
the isolated network(s) by performing the following steps:

a. Disable Firwall on Primary Domain Controller 2003 before performing 
the upgrade of Redundant Domain Controllers.

b. Stop following the manual upgrade at the step Removing the Redundant 
Domain Controller on page 46. 

c. Move Redundant Domain Controller to isolated 800xA 5.1 network(s).

d. Upgrade 800xA software on Domain Controller once the machine is on 
the isolated 800xA 5.1 network(s).

3. Transfer the node setup package to each node.

4. Some 800xA System software requires preparatory steps before shutting down 
800xA System processes. Perform the applicable pre-upgrade procedures from 
Section 3, Upgrading 800xA 5.0 SP2 to 800xA 5.1 Online for 5.0 SP2 to 5.1 
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upgrade and Section 5, Upgrading 800xA 4.1 to 800xA 5.1 Offline for 4.1 to 
5.1 upgrade. 

5. In a domain environment remove the next node to be upgraded from the 
domain.

6. For an online upgrade move the node to the isolated network(s).

7. Reformat the hard drive.

8. Complete the installation following the procedures outlined in the System 
800xA Automated Installation (3BSE034679*) user manual or complete the 
procedures in Section 4, Upgrading 800xA 5.0 SP2 to 800xA 5.1 Offline.

9. Reboot the node.

10. Install the Harmony VB graphics extension on the node being upgraded.

11. Perform an 800xA System Restore. Refer to the post upgrade procedure from 
Section 4, Upgrading 800xA 5.0 SP2 to 800xA 5.1 Offline.

12. Load the Harmony VB graphics system extension by performing the 
procedures from Loading the VB Graphics Extensions on page 182.

13. Perform any post installation steps that are required including the 800xA 4.1 
Configuration Server backup and synchronization of the aspect system. Refer 
to the System 800xA Post Installation (3BUA000156*) instruction.

14. Repeat Step 4 through Step 9 as applicable for all nodes in the system.

15. If in a domain environment and all the nodes are in the new system except the 
primary Domain Controller, load the operating system of the remaining 
Domain Controllers with the Server Operating System and then move the node 
to the new network(s). Once on the new network(s), promote to a domain 
controller.

a. Load the operating system of the remaining Domain Controllers installing 
an additional Server Operating System Domain Controller to Server 
Operating System outlined in Section 2, Upgrading Redundant Domain 
Controllers. Make sure the hard drive is reformatted during the operating 
system load.

b. Move remaining Domain Controllers to isolated 800xA 5.1 network(s).
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c. Upgrade 800xA on remaining Domain Controllers once it is on the 
isolated 800xA 5.1 network(s).
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Appendix H  Mapping of Deprecated IT Asset
Object Types

This Appendix describes the mapping of deprecated IT Asset Object types.

Mapping
This section describes the mapping of deprecated IT Asset object types with their 
replacements available in the PNSM device library. The supported PNSM device 
library object types are listed in Table 16.

Table 16. Mapping Deprecated IT Asset object types with replacements in PNSM Device Library

Deprecated IT Asset Object Types Replacement in PNSM Device Library

Cisco 12-port Switch

Cisco 24-port Switch

Cisco 48-port Switch

Cisco 12_24_48_Port Switch_v1_0 

Batch Nodes

Batch Client

Batch Primary Server with Client

Batch Secondary Server with Client

Generic Computer Node

Inform IT Nodes

Generic_Computer_Node_v1_1
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PPA Nodes

800xA AS (Tertiary)

800xA AS

800xA Client

800xA Combined AS-CS

800xA CS

PPB Nodes

PPB Client

PPB Config Server

PPB Harmony RTDS with Client

PPB Historian

PPB Melody RTDS with Client

PPB OPC RTDS with Client

Hirschmann RS2 Switch Hirschmann_RS2_v1_0

Hirschmann Mach 3000 Switch(1) 1.Hirschmann_RS20_RS30_v1_2

2.Hirschmann_RS40_v1_2

3.Hirschmann_MS20_MS30_v1_2

4.Hirschmann_MS4128_v1_2

5.Hirschmann_MACH_4000_v1_2

6.Hirschmann_MACH_1000_v1_1

7.Hirschmann_RSR20_RSR30_v1_1

Generic Network Interface Generic_Network_Interface_v1_0

Generic Printer Node Printer_v1_0

Network Monitoring

• Network Utilization

• Node to Node Utilization

• Single Node Utilization

Network_Utilization_v1_0

Node_to_Node_Utilization_v1_0

Single_Node_Utilization_v1_0

Table 16. Mapping Deprecated IT Asset object types with replacements in PNSM Device Library

Deprecated IT Asset Object Types Replacement in PNSM Device Library
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IM Performance Assets

hsMsgServer Messages In per Minute

hsMsgServer Messages in Queue

hsMsgServer Messages Out per Minute

PDL Messages In per Minute

PDL Messages in Queue

PDL Messages Out per Minute

Disk Free

Failures

DA Collection

HDA Collection

Storages

Inform IT Calculations

Inform IT Complete

Inform IT Display

Inform IT History

Inform IT ODA

Inform IT Scheduler

Inform IT SoftPoint Server

Not supported

Symmetricom XLi Clock Not supported

(1) Hirschmann Mach 3000 switch is obsolete. The replacement object type in 
PNSM is not available.

Table 16. Mapping Deprecated IT Asset object types with replacements in PNSM Device Library

Deprecated IT Asset Object Types Replacement in PNSM Device Library
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Revision History

This section provides information on the revision history of this User Manual.

The following table lists the revision history of this User Manual. 

The revision index of this User Manual is not related to the 800xA 5.1 System 
Revision. 

Revision 
Index

Description Date

- First version published for 800xA 5.1 64-bit FP1 December 2011

A Updated for 800xA 5.1 Rev B Release June 2012

B Updated for 800xA 5.1 Feature Pack 3 release August 2012

C Updated for 800xA 5.1 Rev C Release November 2012

D Updated for 800xA 5.1 Feature Pack 4 release February 2013

E Updated for 800xA 5.1 Feature Pack 4 - 
Intermediate release

April 2013

F Updated for 800xA 5.1 Rev D and FP4 releases December 2013

G Updated for 800xA 5.1 Rev E and FP4 Rev E 
release.

July 2015
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Updates in Revision Index A
The following table shows the updates made in this User Manual for 800xA 5.1 
Rev B.

Updated Section/Subsection Description of Update

About the User Manual Changes made to subsection Version Described in 
this Document.

Minor changes are done in the different sections.

Section 3. Upgrading 800xA 5.0 SP2 to 
800xA 5.1 Online

Changes made in the subsection Redundant Aspect 
Server.

Renamed System 800xA Installation to System 
800xA Manual Installation.

800xA for Harmony/Melody Connectivity Server 
Node Update subsection added.

Section 4. Upgrading 800xA 5.0 SP2 to 
800xA 5.1 Offline

Changes made in the subsection System Upgrade.

Renamed System 800xA Installation to System 
800xA Manual Installation.

800xA for Harmony/Melody Connectivity Server 
Node Update subsection is added.

Section 5. Upgrading 800xA 4.1 to 800xA 
5.1 Offline

Changes made in the subsection System Upgrade.

Renamed System 800xA Installation to System 
800xA Manual Installation.

Section 6. Upgrading 800xA 3.1 SP3 to 
800xA 5.0 SP2

Renamed System 800xA Installation to System 
800xA Manual Installation.

Appendix B. Control Builder M 
Compatibility Issues

Updated the issue in the 800xA 5.0 SP2 to 800xA 5.1 
Compatibility Issues subsection.

Appendix G. 800xA for Harmony Upgrade This is newly added Appendix.
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Updates in Revision Index B
The following table shows the updates made in this User Manual for 800xA 5.1 
Feature Pack 3 release.

Updates in Revision Index C
The following table shows the updates made in this User Manual for 800xA 5.1 
Rev C.

Updated Section/Subsection Description of Update

About the User Manual Changes made to subsection Version Described in 
this Document.

Minor changes are done in the different sections.

Section 3. Upgrading 800xA 5.0 SP2 to 
800xA 5.1 Online

Changes made in the Redundant Aspect Server 
subsection.

Section 4. Upgrading 800xA 5.0 SP2 to 
800xA 5.1 Offline

Changes made in the System Upgrade subsection.

Section 5. Upgrading 800xA 4.1 to 800xA 
5.1 Offline

Changes made in the System Upgrade subsection.

Updated Section/Subsection Description of Update

Front Cover Minor changes are updated on the Front cover.

About the User Manual Changes made to subsection Version Described in 
this Document.

Minor changes are done in the different sections.

Section 3. Upgrading 800xA 5.0 SP2 to 
800xA 5.1 Online

Changes made in the subsection Redundant Aspect 
Server.

Changes made in the Device Management 
FOUNDATION Fieldbus subsection on page 111 and 
page 112.
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Updates in Revision Index D

The following table shows the updates made in this User Manual for 800xA 5.1 
Feature Pack 4 release.

Section 4. Upgrading 800xA 5.0 SP2 to 
800xA 5.1 Offline

Changes made in the subsection System Upgrade.

Changes made in the Device Management 
FOUNDATION Fieldbus subsection on page 182 and 
page 183.

Section 5. Upgrading 800xA 4.1 to 800xA 
5.1 Offline

Changes made in the subsection System Upgrade.

Changes made in the Device Management 
FOUNDATION Fieldbus subsection on page 254 and 
page 255.

Section 6. Upgrading 800xA 3.1 SP3 to 
800xA 5.0 SP2

Changes made in the Device Management 
FOUNDATION Fieldbus subsection on page 349 and 
page 350.

Updated Section/Subsection Description of Update

About the User Manual Changes made to subsection Version Described in 
this Document.

Minor changes are done in the different sections.

Section 3. Upgrading 800xA 5.0 SP2 to 
800xA 5.1 Online

Changes made in the Redundant Aspect Server 
subsection.

Updated Upgrade Control Builder M Projects 
subsection.

Section 4. Upgrading 800xA 5.0 SP2 to 
800xA 5.1 Offline

Changes made in the System Upgrade subsection.

Updated Upgrade Control Builder M Projects 
subsection.

Section 5. Upgrading 800xA 4.1 to 800xA 
5.1 Offline

Changes made in the System Upgrade subsection.

Updated Section/Subsection Description of Update
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Updates in Revision Index E
The following table shows the updates made in this User Manual for 800xA 5.1 
Feature Pack 4 intermediate release.

Section 1 Introduction Updated Supported Upgrade Paths subsection.

Appendix B Control Builder M Compatibility 
Issues

Updated the section.

Updated Section/Subsection Description of Update

Section 2. Upgrading Redundant Domain 
Controllers

Changes made in the following subsections.

• Preparation

• Preparing a Domain for Windows Server 2008

Appendix G. 800xA for Harmony Upgrade Changes made in the 800xA for Harmony Upgrade 
Procedure subsection.

Section 3. Upgrading 800xA 5.0 SP2 to 
800xA 5.1 Online

Changes are updated both in Pre-Upgrade and Post 
Upgrade sections of 800xA for Advant Master and 
800xA for Safeguard, Device Management 
PROFIBUS & HART.

Section 4. Upgrading 800xA 5.0 SP2 to 
800xA 5.1 Offline

Changes are updated both in Pre-Upgrade and Post 
Upgrade sections of 800xA for Advant Master and 
800xA for Safeguard, Device Management 
PROFIBUS & HART.

Section 5. Upgrading 800xA 4.1 to 800xA 
5.1 Offline

Changes are updated both in Pre-Upgrade and Post 
Upgrade sections of 800xA for Advant Master and 
800xA for Safeguard.

Section 6. Upgrading 800xA 3.1 SP3 to 
800xA 5.0 SP2

Changes are updated both in Pre-Upgrade and Post 
Upgrade sections of 800xA for Advant Master and 
800xA for Safeguard.

Updated Section/Subsection Description of Update
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Updates in Revision Index F
The following table shows the updates made in this User Manual for 800xA 5.1 Rev 
D and Feature Pack 4 releases.

Updated Section/Subsection Description of Update

Section 3. Upgrading 800xA 5.0 SP2 to 
800xA 5.1 Online

Changes made in the following subsections.

• Engineering Studio Function Designer System 
Extensions

• Online Upgrade

• Device Management PROFIBUS & HART

• IEC 61850 Connect

• Advant Master

• Melody

Section 4. Upgrading 800xA 5.0 SP2 to 
800xA 5.1 Offline

Changes made in the following subsections.

• Engineering Studio

• System Upgrade

• Device Management PROFIBUS & HART

• Exporting Locally Stored Parameter Value Sets

• IEC 61850 Connect

• Advant Master

• Melody

Section 1. Introduction Changes updated in the Supported Operating 
Systems subsection.

Section 6. Upgrading 800xA 3.1 SP3 to 
800xA 5.0 SP2

Changes are updated in the Device Management 
FOUNDATION Fieldbus subsection.

Appendix F Information Management 
Upgrade

Changes updated in Starting PAS section.
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Updates in Revision Index G
The following table shows the updates made in this User Manual for 800xA 5.1 Rev 
E and Feature Pack 4 releases.

Updated Section/Subsection Description of Update

Section 3. Upgrading 800xA 5.0 SP2 to 
800xA 5.1 Online

Changes made in the following subsections.

• Engineering Studio Function Designer System 
Extensions

• Device Management PROFIBUS & HART

• 800xA for Advant Master and Safeguard

Section 4. Upgrading 800xA 5.0 SP2 to 
800xA 5.1 Offline

Changes made in the following subsections.

• Engineering Studio

• Device Management PROFIBUS & HART

• 800xA for Advant Master and Safeguard

Section 5. Upgrading 800xA 4.1 to 800xA 
5.0 SP2

Changes made in the 800xA for Advant Master and 
Safeguard subsection.

Section 6. Upgrading 800xA 3.1 SP3 to 
800xA 5.0 SP2

Changes made in the 800xA for Advant Master and 
Safeguard subsection.

Appendix F Information Management 
Upgrade

Changes are done in the following sections:

• ABB Process Administration Service (PAS)

• Running the Information Management History 
Backup/Restore Utility

• Starting PAS

• Running hsDBMaint -stagger
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